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© Copyright 2021 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE® Colors displayed in the software application or in the user documentation may not match
PANTONEéidentified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright ©1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.
Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, lllustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
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JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFl and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 - 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.
Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrijksesteenweg 1095

B - 9051 Gent

info.eur@esko.com
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2. What's New in WebCenter 21.03

WebCenter 21.03 is a minor release of the WebCenter including new and much improved functionality
in the following areas:

Inline Editing in Dashboards

« Additional document sources available
« Document source inline action-buttons
« Setrequired fields in dashboard forms

« Version-up in upload landing

« Upload anew Version of document

« Required Fields

Content Management Improvements

« Performance Improvements
« Textinheritance
« Drop-down support

Flexible Approvals

«  Workflow Node: Add and Replace Approvers

- Add/remove or Replace approvers without stopping approval cycles
« Reason(s) for Forced Rejection

« Route on Reason for Rejection from any stage

3D Assembly Improvements

« Create assemblies directly from CAD and Collada files
« Improvements to View component widget

14
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3. WebCenter Administration Basics

WebCenter installs with a minimal configuration because every installation has different needs. This
guide explains as how to set up WebCenter and make it ready for use.

3.1. A Note on Web Browsers

Due to differences between the Web browsers, some configuration issues in Firefox and Safari require
extraaction in order for WebCenter to function properly. Anyone using WebCenter with either of these
browsers on any platform should consider performing these configuration changes.

Mozilla Firefox

Refreshing pages may not get the most current data from the WebCenter Web server. In order to
ensure the most current data is seen, caching must be disabled, or you must press ctrl-r on any
suspect pages to forcibly reload them.

To disable caching, do the following:

1. Loginand start Firefox.

2. Inthe Address field, type about:config and press enter.

3. Scroll down to the network.http.use-cache entry and double-click it so that its value changes from
true to false.

4. Restart Firefox.

Safari

When using Safari, the built-in browser for Apple Macintosh computers running 0S X, there is no way to
configure caching. When using the Back button, click Refresh to ensure you see the most current data.

3.2. Understanding the WebCenter Page Layout

Header
The top right of the WebCenter page always shows:

« the name of the current user,
a E icon to go back to the user's start page,
a Discussions icon which indicates the unread messages and redirect to My Discussions. You

can view all discussions related to Project or Document or Tasks that you are involved in. For more
details, refer to Discussions in WebCenter

* theCart ,

-
BS

AvatarL..] icon displays the user initials (first letter of first name and last name),or an image, if any

is uploaded in the User page.

15
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« alinkto the WebCenter Welcome page,

« Admin (if the user is a member of the Admins group),

- Contact,
« Logout.
Top Menu Bar

WebCenter

By default, the top menu bar contains the following menus: My Work, Projects, Task Types, Search,
My WebCenter, Create (if you are a Project Manager) and Upload (see The Default WebCenter Menus for

more details). An administrator can customize the menus.

@ MyWork Projectsv Task Typesw  Search+  MyWebCanterv  Create~  Upload

If you have the optional Task Management module and the User Can Create Task Type permission,

Task Types also appears in the top menu bar.

Documents Pages

Below is a sample of project's Documents page, in grid layout, for a user who is a Project Manager.

Arealis the project actions area, allowing you to perform actions on the whole project (for example,

mail a link to the project to a reviewer, add the project to your favorite projects...)

2 ] RSl Sy

4 Y e pr 5

1 S bl i i
Mo, - e A
Decuments i 3
Vil L 0, Vierw wed Arrbale L 5 blore..
B Frofect Dooumenty e —. R el iplosded  Taaka
|
31 ARA
mil =

» Area2isthe Project Details area, containing the project icon, the name and description of the

project, the project status...

» Area 3 shows links to the project pages. For example, click Members to view the project members.

The page you are on is shown in bold.

16
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« Areas 4 andb are part of the content pane, that changes depending on the project page you are on.
Here, on the Documents page, they show the project folders and documents.

« Area4isthe Folders pane, showing the projects folders. Click a folder to see the documents it
contains.

« Areab5isthe document pane, that can show the documents in alist or grid view, with or without
thumbnails.

Notes

« Toact on many documents at once, select their check boxes and then choose an action in the
Actions menu.

« Toselect alldocuments in the current folder, select the check box before the Documents header.
« Toswitchtoalist layout, click Show as List.
« Hovering over a thumbnail shows a larger version of it in a pop-up window.

For Graphic documents viewable by the WebCenter Viewer, you can click the zoom icon to show
an even larger thumbnail (500 x 500 pixels). This is applied to all Graphic documents on which you
hover until the page is reloaded.

The pop-up window closes when you move the cursor off the thumbnail.

There is usually more than one way to accomplish a task by using a combination of menu entries,
action menus, and clicking status messages. Many methods will lead to the same result.

Note: This layout is the default layout. However, your layout might be different depending on your
customization.

3.3. Filtering Content

As more information is managed over time by WebCenter, some pages can potentially show large
amounts of information. To reduce the time needed to show the page when it first loads, some pages
have a filter.

To use the filter, enter a search string with an asterisk either before it, surrounding it, or afteritin the
Search field, and click@ . For example, on the Companies page, to only see those companies with the
word Containers in their name, enter *Containers* and click &.

When filtering users, use the last name of the user.

To show all the items, up to the truncation limit, click Q with nothing in the field.

Note: The truncation limit prevents lists of thousands of items from impacting response time; if you
know in advance that your search will return that many items, refine it with the filter. The truncation
limit can be changed; contact Professional Services at your local Esko office for more information.

3.4. The Admin Menu

All administration is done initially by Admin, the administrative user who has full control over
WebCenter.

17



ESKO«

18

WebCenter

The Admin user and members of the Admins group have the Admin ﬂ' button in the right side of the
header.

Click the Admin 'ﬁ button to go to the Admin menu. The Users page is shown by default.

To return to the normal WebCenter menus, click the Exit Admin E button.
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4. WebCenter Preferences

The Preferences menu in the Admin section of WebCenter allows you to set system-wide preferences
in a number of categories:

« General
« Password Preferences
- Security

« Document Types
+ Notifications

« Menus

« My Work

« Customizations
* Reports

4.1. General Preferences

Click General on the Preferences bar to set system-wide preferences.

Note: The individual users can override nearly all of these properties for themselves in My WebCenter
> My Preferences. Those users who have changed these settings are not affected by later changes
made to the same fields in Admin > Preferences > General by an administrator.

General

« Language sets the language used by the user interface.

« Start Page sets the page that appears when you log on. It could be either Dashboard, Document
Search, My Favorites, My Locked Documents, My Preferences, My Profile, My Work, Projects, Project
Search, Saved Search, Welcome page. If Dashboard or Saved Search is chosen, further drop down is
shown to chose from the existing Dashboard or Saved Search.

- Default Project Page sets the page that appears when clicking a project name. It could either be
Project Dashboard, Documents Page, Attributes page, Tasks page, Bills of Materials page.

Note: When Dashboard is chosen as Default Project Page or Start Page, you can either chose from
the existing dashboards or Create New Dashboard.

« Default Document Page sets the page that appears when clicking a document name.

It could be either be History, Approval, Attributes or Details page.

« Units sets units for all measurements to either Metric (mm, cm, dm, m) or Imperial (in, ft, yd).

« Thumbnails: selecting Show thumbnails shows thumbnails in document lists by default.

« Cart: Clear Cart on Logout is always enabled by default. Disable this option if you want your users to
access their Cart contents across sessions.

Project Lists

« Show ... rows sets the number of projects displayed in the List layout.

Document Lists

- Default Layout sets the default view for document lists: Grid or List layout.
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« Show in Grid sets the number of documents displayed on a single page in the Grid layout (defined as
a number of Columns and Rows in the grid).

+ Show in List sets the number of documents displayed on a single page in the List layout (defined as
anumber of Rows in the list).

Search Results - All

Show in List sets the number of documents displayed on a single page in the Search results List layout
(defined as a number of Rows in the list).

Show Cards sets the number of individual document objects that are displayed as a table of document
thumbnails on a single page in the Search Results.

You can choose to Show date and time for Date Attributes/Specifications. By default date attributes
in Search Results will not show time information.

Search Results - Documents

- Default Layout sets the default view for document Search results pages to Grid, List or
Cardslayout.

« Show in Grid sets the number of documents displayed on a single page in the Search results Grid
layout. You can also specify the position of the Thumbnail position in the results as Top or Left.

Search Results - Projects
- Default Layout sets the default view for project Search results pages to Grid or List layout.

- Show in Grid sets the number of projects displayed on a single page in the Search results Grid
layout. You can also specify the position of the Thumbnail position in the results as Top or Left.

Discussions

- Discussions per Page sets the number of discussion threads displayed per page on the
Discussions pages.

« Postings per Page sets the number of discussion posts displayed per page on the Discussions
page.

Roles

Invite Group Default sets the system-wide default state of the Invite Group check box, available on
the Manage Roles page and in the Members area of the Project Creation page (when creating a project
based on a project/template that contains roles).

Bill Of Materials

Use Bill of Materials enables the Bill of Materials functionality for the entire WebCenter system. See Bill
of Materials on page 407 for more information.

My Work Defaults

« My Approvals Assignee Filter sets what users view by default in the My Approvals section of their
My Work page (approvals assigned to Me, Me or Group | Am In or Group | Am In).

« My Tasks Assignee Filter sets what users view by default in the My Tasks section of their My Work
page (tasks assigned to Me, Me or Group | Am In or Group | Am In).

« Non Started Tasks sets whether users' My Work page displays tasks assigned to them that aren't
started yet.
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Project Autoname Generation
Use the Project Autoname Generation settings to automatically generate project names.

These settings use a naming template (Prefix, Suffix and Counter Length) to define the automatically
generated names.

Define Prefix and Suffix by selecting from Smart Namesdrop-down menu.

Note: Make sure to read the notes at the bottom of the page for restrictions. The building blocks are
case-sensitive.

The Counter Length is a numerical field that gets incremented for each new Project using the same
prefix. It is placed between the prefix and the suffix.

In the Counter Length field, enter the length of that incremental counter. For example, enter 5 for
numbers that will be five digits long.

Select Use Automatic Naming for Creation of Blank Projects if you want to automatically generate the
names of projects created from a blank project.

Discussions

- Discussion Counter option is enabled by default. When enabled, the counter will display all the
unread messages including the unread messages from private discussions within a project, where
the PM / Admin users are also part of. This option only affects the global counter on the top menu
bar.

« Default Participants: This is a radio button option. You can either choose

« To start the discussion with everyone who has access to the current Project / Document/ Task
« Torestrict the option to have the default participant as the Discussion Creator.

Other Preferences

« Host URL sets the URL at which the WebCenter site can be accessed. This is the URL used to send
automatic email notifications.

« Host URL for internal use sets the URL at which internal components, like Automation Engine, can
access the WebCenter site. Use this to go through the local network (using your WebCenter server's
local computer name) instead of through the internet (using your WebCenter server's public IP or
computer name).

You should use this if, due to your setup, the DNS doesn't know the WebCenter server's public name
inside your Local Area Network.

Note: You can only use this when Automation Engine and WebCenter are on the same LAN.
If thisis not filled in, Automation Engine will connect to WebCenter using the Host URL.

For both Host URL and Host URL for internal use, you can choose to use either http:// or https://.
Choose the protocol defined during the WebCenter installation.

PDF Download Options

Admin user can set options to add some more information to the PDF documents when they are
downloaded by selecting the required options.

« Add Approval information to downloaded PDF
« Show Approval information in landscape layout
« Prepend Approval Information
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«  Show User Company / Location in a separate column

You can also add the Project Attribute IDs and Document Attribute Ids of either Text or Date/Time
attribute type in the respective fields, which are then displayed in the report when the document is
downloaded.

Note: You may contact Esko Solution Architects for further details.

System History Logs

All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.
4.1.1. Viewer

« Select your Viewer Type. You can set your preference to the HTML5 Viewer or keep at the default (
Java Viewer ).

Note: You can always switch to Java Viewer from HTML5 Viewer using the £ putton.

« Viewer and Workflow Applet: When opening a document in the Viewer or when creating a workflow,
WebCenter will download a Java applet to your computer.

From Java 1.7.0_21(for Windows and Mac 0S X 10.7 or later), you will get a security warning as the
one below when the applet is downloaded. This makes the WebCenter applet look like a security risk
for your computer.

Security Warning 3 x|
Do you want to run this application ?

| An unsigned application from the location below is requesting
\ ' ’ permission to run.
L ]

Location: http:/fwebcenterd,esko,com/, . fviewer-applet.jnlp

Running this application may be a security risk

Select the box below, then click run to start the application

[T Iaccept the risk and want ko run this app.

| [

[ Do not show this again For this app

You can adapt how this security warning will look like when downloading the applet. In Viewer and
Workflow Applet, choose either:

- Signed (sandboxed) if you want to run the applet in a strict sandboxed environment (with no
access to your computer's resources). As the applet is signed by Esko, the security warning
looks less threatening.
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x |
Do you want to run this application ?
Name: WebCenter Viewer
Publisher: Esko Software bvba
From: htkp: ffrdymwc05{. .. fsigned-viewer-applet, jnlp
This application will run with restricked access that is intended to protect yvour
computer and personal information,
v Do not show this again Far apps From the publisher and location above
ﬂ More Information Cancel |
A =

Note:

As the applet is sandboxed, it will also show a warning when trying to print from the Viewer. You
will just need to click OK to be able to print.

Security Warning K x|

The applet has requested access to the printer. Do you «
want to allow this action? =’ I

Name: viewer

[~ abways allow this applet to access the printer.

Cancel

J

- Signed (not sandboxed) if you want to run the applet without restricting it to a sandbox(the
applet can request additional access to your computer's resources). This means that you will not
get an additional warning when printing from the Viewer.

As the applet is signed by Esko, the security warning looks less threatening.

23



ESKO

24

WebCenter
oy
Do you want to run this application?
Name: WebCenter Viewer
r"\
=> Publisher: Esko Software bvba
e
From: htkp: /.. Jsigned-unrestricked-viewer-applet. jnlp

This application will run with unrestricted access which may put vour computer and
personal information at risk, Run this application only if yvou trust the publisher,

[~ Do nat show this again for apps from the publisher and location above

ﬂ More Information Cancel I

- Unsigned if you want to run the applet as a default unsigned applet. You will get the default
security warning that does not mention Esko, but the applet will be sandboxed. This means that
you will have an additional security warning when printing from the Viewer, as for the Signed
(sandboxed) applet.

Tip:
By default, the applet is set to run as Signed (sandboxed). This will work fine for most users.

More frequent users may want to switch to the Signed (not sandboxed) option to avoid always
having to click an extra warning away when printing from the Viewer.

Mac 0SX 10.6 users running Java 1.6.0 may also want to switch to the Signed (not sandboxed)
option to avoid getting a warning when closing the Viewer by clicking #.

With the latest versions of Java 1.7 installed, most browsers block unsigned applets by default. In
this situation, it is recommended to use one of the signed settings instead.

Viewer Style (Java Viewer) sets the Viewer mode as:

« Normal(Default): AllHTML5 Viewer features are available in this mode.

» Restricted: In this mode, the user cannot access features such as Channels widget, CAD widget
and View widget.

The side panels displaying the widgets will be in a collapsed format by default.
« Advanced: In Java Viewer all features are activated.

Viewer Workspace: Select any workspace from the drop down or Create new Workspace by
selecting the option. Select the gear icon to open the Workspace Configuration pop-up window and
view the options available in workspace selected or to edit the configuration in the workspace.

You can choose to add or delete any tool or widget to the workspace or altogether delete the
workspace itself.

Unregistered User Viewer Workspace: A workspace is configured specifically for unregistered
users who access WebCenter viewer, when they are shared with a document to view or to approve.
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Other workspaces or tools/ widgets are not visible apart from the workspace configured by the
Admin User. Admin user can also create a new workspace specifically for this purpose.

Annotation Color sets the color in which annotations will be displayed in the Viewer (you can set
Viewer Default or choose a color from the list).

Annotate Approved Documents sets if and how the users are allowed to annotate documents that
are already approved.

« Select Enabled if you want the users to be allowed to annotate approved documents.

« Select Warn if Approved if you want to display a warning before allowing the users to annotate
approved documents.

« Select Read-Only if Approved if you don't want the users to be allowed to annotate approved
documents.

+ Select Warn if Approved or Rejected if you want to display a warning before allowing the users
to annotate approved or rejected documents.

« Select Read-Only if Approved or Rejected if you do not want the users to be allowed to annotate
approved or rejected documents.

Annotate Documents under Approval sets who can add annotations in the documents under
approval.

Note: A document version is considered under approval as soon as an approval cycle is started

Choose from the following settings:

« AllUsers: This is the default setting. All users with view access to a document can annotate that
document once the approval cycle has started.

« All Approvers and Approval Master: The Approvers and Approval master defined in the
document approval setup (all stages) for the current version can annotate during the approval
cycle.

« All Approvers: All approvers defined in the document approval setup (all stages) can annotate
the document while it is being approved.

« Pending Approvers and Approval Master: Only an approval master or approvers who can submit
an approval state (Approve or Reject) for the current version can annotate the document during
the approval cycle.

« Pending Approvers Only: Only approvers who can submit an approval state (Approve or Reject)
for the current version can annotate the document during the approval cycle.

Specify the Viewer Quality as:

- Best Performance (Default): In this mode, the Viewer uses less compression to transfer images.
These images are transferred faster but may contain small compression artifacts.

« Best Quality: In this mode, the Viewer uses less compression to transfer images. It takes longer
to transfer these images. However, you can view them without compression artifacts.

Note: This settingis applicable to both the HTML5 and Java Viewers.

Settings for Automated Artwork
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Note: The below options are visible only when Automated Artwork license is enabled.

« Task Type for Bulk Text Replace: Choose from the list of task types shown. The selected task
type is used in the Files marked for Edit widget when editing Artworks in the Viewer.

« Text Replace Library: Choose from the list of Text Document Saved Searches shown. The
selected Saved Search is used in the Action List Widget. Read more about it here.

Note: This option requires Packaging Content Management License.

« PCM Attribute for linking Text Statements: Choose from the list of document reference
attributes shown. The selected document reference attribute is used to attach text content
documents (such as .wcc) when saving a graphic file modified with Action Lists in the viewer.

Note: This option requires the Packaging Content Management License.

+ Logout user wheninactive Select this option, to log out the users whose sessions are not active
for a period of time. Option is given to log in again and continue when the user returns to the viewer.

« Stream video through WebCenter proxy Enable this option to open video files located in Asset
management system in the HTML5 viewer.

- Show Discussions in Viewer Enable this option to view discussions widget in the viewer and view all
the discussion posts about the document viewed.

Note: Project Managers who can Force Approve or Force Reject is not considered an approver. They
can add annotations only if the setting is All Users.

Configuring Viewer Workspace

Workspace

You can configure Workspaces specifically for Roles, Users, and at System level in WebCenter. It is
also possible for users to customize their own workspace in the viewer.

Admin users can create new workspace or assign a workspace or configure a workspace or delete a
workspace from the following locations :

+ General Preferences where workspace selected is for all the users in the WebCenter
+ Role configuration where workspace selected is for the specific Role

« User Preferences where workspace selected is for the specific user only

Workspace Configuration

On selecting the gearicon in the Viewer Workspace field, Configure Workspace pop up window is
available to make changes to the workspace.

Each of the tool is either in Visible state, or Available or Hidden state.

« Visible: Check box is selected for for the tool or widget is not visible for the user but it is available.
The user can add the Tool or Widget in the Viewer

« Available: Check box with a dash. Tool or Widget is not visible for the user but it is available. The
user can add the Tool or Widget in the Viewer

« Hidden: Tool is neither visible nor available for the user, so the user will not be able to use the tool or
widget in the workspace.
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Only the tools and widgets in Visible and Available state are shown in the workspace for the users to
configure.

You can also choose the Color Theme of the viewer specific to the workspace in the Configure
Workspace pop up.

4.1.2. Approval

Approval Cycle Start when Uploading New Document or Version

Define what should happen to a document approval cycle When uploading a new document or version.
You can choose to:

. Startif previous version's approval is on-going or finished
« Always start (if Approval setup exists)

+ Never start

Select the checkbox

« Always allow the document owner to start/stop the Approval cycle to allow the document owner
to start or stop the approvals on the document(s).

« Allow the uploader to override the approval cycle start to allow the user to overwrite the approval
start behavior upon upload.

Require Approval Comments on Viewable Documents

Use this option to require the approvers to add their comments as annotations in the document.
Select:

«  Prompt to start a dialog with a comment field when the Approver Rejects or Approves with a
Condition. The Approver can choose to comment in the dialog or leave the comment field empty.
This is the default setting.

« Any Annotation to enforce that at least one annotation is present while Rejecting or Approving with
a Condition. The comment field will contain the following message.

Document
annotated

« User Annotation to force the Approver to add at least one annotation in the document version

before Rejecting or Approving with Condition. The comment field will always contain the following
message.

Document annotated

Note: This setting will be applied when submitting an Approval Status from pages outside the viewer.

Block approval when an annotation was set/changed on current version

Check this option to prevent users who have created an annotation on the current version of a
document from submitting the Approved status without a condition.

If Approved with Condition is not enabled, you can submit only the Rejected approval state. If users
have replied to an existing annotation from another user, they will no longer be able to approve the
document without condition.
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Note:

This setting will also be applied when submitting an Approval Status from any page outside the Viewer.
The user will then get the corresponding feedback.

Reasons for Rejection List

After configuring and uploading a list of Reasons for Rejection, an admin user can choose the list from
the drop down to enable reasons for rejection on the system. Then, when a user rejects a document,
the reasons for rejection can be picked from this structured list. Read more on how to configure the
list of Reasons for Rejection.

Note: When the Reasons for Rejection are enabled in the system, bulk rejection is automatically
disabled.

4.1.3. ArtiosCAD

To open your document in the ArtiosCAD desktop application directly from the WebCenter server, you
need to set the ArtiosCAD Preferences accordingly.

Open ArtiosCAD Documents

« No Application: This is the default Preference. When this is selected, you cannot open the
documents in the ArtiosCAD desktop applications.

« ArtiosCAD Standard Edition: Select this setting to be able to download ArtiosCAD documents and
open them in your ArtiosCAD desktop application.

« ArtiosCAD Enterprise Edition: Select this to open your ArtiosCAD documents in the installed
ArtiosCAD Enterprise Edition directly from WebCenter.

The documents will open in the managed mode allowing you to make modifications to the file and
update it without having to browse to the corresponding project and folder.

Note: This optionis only supported from ArtiosCAD Enterprise 14 onwards.

Document Upload Preferences

« Allow raising Document Revision when uploading a new Document Version: Enable this to allow
the users to raise the revision while uploading a new document version.

« Allow Instant uploading when selecting documents: X Choose this option to start uploading
documents immediately when they are selected, while the rest of the page is still being filled in or
other documents are still being selected.

4.1.4. Packaging Content Management

28

Note: You need the Packaging Content Management license to be able to use this module.

Smart Role Names for Editors and Approvers
To work with language specific Smart Role Naming on page 460 specify your:
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« Language Editor Role Prefix/ Language Editor Role Suffix
« Language Approver Role Prefix /Language Approver Role Suffix
« Add Language Role Prefix/ Add Language Role Suffix

The specified prefixes and suffixes are used automatically to create Role names specific for each
language in the Role Mapping > Manage Permissions page.

If the Roles column in Manage Permissions is left blank, values in Language Editor Role Prefix,
Language Editor Role Suffix, Language Approver Role Prefix,Language Approver Role Suffix, , Add
Language Role Prefix and Add Language Role Suffix are taken to calculate the role names for Editor,
Approver Text Content and Add Language permissions.

A change in a Text document creates a new document version. To allow or prevent the users from
creating new Revisions use the Revision Raise option:

Select Raise revision when Master Text Contents are updated to allow raising a Revision when master
text is updated.

Select Never raise revision if master text changes should not be saved as a new Revision.

Note: This settingisindependent of the Allow raising Document Revision when uploading a new
Document Version setting.

Copy comments from a text document

Choose either to Keep Comments or Remove comments if state reverted to Draft or Remove
Comments always when copying a document.

You can choose the option Keep Comments to copy all the comments when copying a document.

Comments are cleared if the state of the element is changed to draft, when the option Remove
Comments if state reverted to Draft is chosen.

Similarly, all the comments in the elements are cleared while copying, when the option Remove
Comment always is chosen.

Note: Same behavior isreplicated in workflow when documents are copied using Copy/ Move
Document. Move document option does not respect this setting.

4.1.5. Workflow Editor

By default, HTML5 is used as Workflow editor.

4.1.6. User Creation

To create a new approval User from an approval page quickly, you can select and apply a particular
user's settings as the Approval User Template.

Tip: If you do not want to take up a license for a Template User, deactivate the user by unchecking the
Active User option in the Profile page.

It is possible to configure this at two levels.

« To specify a global template, go to Admin > Preferences > General > User Creation Preferences.
Select a particular user existing in the system as your Approval User Template.
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This template will be set as the system wide approval user template. However, it is possible to
override this in My WebCenter > My Preferences > User Creation Preferences.

« To specify a template for a User who can create other users, go to My Preferences > User Creation
Preferences and specify an Approval User Template. You have the following options and your
choice will override the admin settings:

Do No Use a Template

Use Global Approval User Template to apply the user template specified in the Admin
Preferences.

Note: If you have not explicitly selected the Do not Use a Template option or has any other user
specified as the template, the global template will be applied by default.

You can select a particular user as your template. In the drop-down you will see your own Users if
you are a Project Manager and all Users if you are an administrator.

The following Preferences and settings of the template are copied to the newly created user:

1. Preferences:

Language

Units

Start Page

User Menu

My Work Setup

Viewer Preferences

Collada Viewer Preferences

Workflow Editor Preferences

Document Upload Preferences

ArtiosCAD Preferences

Download Formats(copied only if the user creating the new user is an Administrator)
Group Memberships(copied only if the user creating the new user is an Administrator)

Other Preferences are the user preferences not mentioned above (for example: show
thumbnails or not, search results layout, etc.).

2. The Authentication Settings(Deactivation, SSO, etc.)

Project creator

A new user type has been introduced from WebCenter 18.1 onwards called Project Creator. This user
can create new projects, but cannot manage them. This user type is similar to Project Manager but the
main difference is that the Project Creator does not have any rights over the project, once the project
is created.
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Note: A Project Creator user can access the project created,

- if added as a member of the project either directly or in a Group or Role within the project
- if the option Project Creator becomes Salesperson after Project Creation is enabled by the admin
user.

When WebCenter is under the Named User License model, a dedicated license is available for the
Project Creator users. Similar to the other named user license types, you can create as many Project
Creator users as you have licenses.

When WebCenter is running in the concurrent license model, you can create an unlimited number of
Project Creator users.

You can have two types of permissions for Project Creators users, namely:

« Limited Visibility of Companies and Groups: Can view only the list of Groups / Users, Company and
locations that are limited to the user’s visibility scope

« Full Visibility: Can view all Groups/ Users, Company and locations without any restrictions.

4.1.7. Delegation Preferences- System Wide

Delegation Restrictions

To ensure that your user(s) delegate to a limited list of users, you can use the Delegation Restrictions
either as a system wide settings or per user.

The Administrators can specify system wide delegation restrictions. Admin users can place
restrictions on delegation based on various factors like:

« No Delegation which prevents your users from delegating their work.

- All Visible Users which allows to delegate any user who are visible in his or her list.

- Users in the same Company which allows you to choose delegates, only within the same company.
« Usersin the same Location which allows you to choose delegates, only within the same location.

« Users in the same Group which allows you to choose delegates, only within the same group.

You can also enable Delegator receives e-mail notifications during delegation period option to
receive email notifications when a user has delegated the work.

System History Logs

All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

4.2. Password Preferences

The Password Preferences determine whether passwords must meet security requirements, whether
they expire, and whether or not users need to provide their passwords when approving or rejecting
documents.

Password Complexity

You can enforce a number of password rules by enabling Passwords must meet complexity
requirements. When this feature is not enabled the only requirement is that passwords be non-blank.
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If Passwords must meet complexity requirements is enabled, WebCenter passwords:

« May not contain the user's username, first name, or last name

« Must contain characters from three of the following four categories:

« English uppercase characters (A through Z)

- English lowercase characters (a through z)

« Base 10 digits (0 through 9)

« Non-alphanumeric characters (for example: ! S # %)

« Admin can also additionally enable two more options in Password Complexity namely :

« Set minimum password length which can be between 6 to 16 characters.

Note: Enabling this option or changing the value expires all passwords. Users will be required to
change their password on the next login. By default, it is set to eight characters.

- Set enforce password history reflects the number of unique passwords the users has to change
before an old password can be reused. This can be set between 1to 20 and by defaultissetto 1.

Expiration Settings

Enabling password expiration allows you to limit the length of time that a password may be used. When
a userlogsin with a password that has not been changed in the required number of days, he/she will be
required to change their password before accessing the site.

To enable password expiration, select the option Expire user passwords when they are ... days old and
type a number of days.

Note: To immediately expire all passwords without changing the other password preferences, click
Expire all passwords now in the top right of the page.

Consecutive Failed Logins

If there are Consecutive Failed Logins, you can select the option Block authentication after __ failed
consecutive login attempts or you can choose to Never block authentication after failed login
attempts.

Digital Signature

« Enable the option Require password for Approvals/Rejections, if you want to force users to
provide their passwords whenever they approve or reject a page or document in WebCenter. Admin
users can also set additional options like

« Prompt for password : This is the default option. When this option is chosen, only the password
has to be provided for approval or rejection.

« Prompt for username and password: When this option is chosen, both the User name and
password has to be provided.

« Prompt for username and password once, afterward only prompt for password: When this
option is chosen, user name has to be provided in the first instance and thereafter only the
password has to be provided.
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Enable the option Allow alternative passwords to be used for Approval/ Rejections and Tasks,
in case the users need another level of authentication other than the WebCenter password
authentication.

You can choose Block browser auto complete on password confirmation to ensure passwords are
not stored for any users in WebCenter.

Note: Itis applied to both the login page and also when the user does re-authorization for
Approvals and Task completion.

System History Logs

All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

4.3. Security Preferences

Use the Security preferences if you want to tighten the security in WebCenteryour Web Center.

By default, all the actions are allowed unless mentioned otherwise in the explanation. Deselect them if
you don't want any user to perform these actions.

Approval

Allow Approval outside the Viewer option allows approval only in the HTML Viewer and the
approval option is disabled otherwise.

Allow Force Approval By and

Allow Force Rejection By : Both these options have the following drop down to choose from:

« PM, Administrators and Approval Master
+ PMand Administrators
« Approval Master

Allow Conditional Approval option in Approval setup allows a conditional approval option in the
approval setup. When you do not want to allow conditional approval in approval setup, simply
disable this option. Only the Admin can set this system-wide option. When this is disabled, the
allow conditional approval option will not be available for the users while setting up approval on
documents, projects or folders.

Note: Enabling or disabling this option will not influence the approval cycles that are already
existing or started.

Approved Documents

Allow removing Documents with Approval actions option lets Project Managers or Project
members with the Delete right to delete documents that have already been approved /rejected /
commented by at least one person or group.

Allow changing Attributes of approved documents option lets Project Managers or Project
members with the Change Properties right to edit the attributes of already approved
documents.

Attributes
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Allow non-Administrators to change the Attribute Category of Projects/Documents option
allows Admin users to restrict other users from changing the Attribute Category of a Project or
Document. (By default, this option is enabled)

Allow importing from/exporting to JDF on Attributes page option allows Admin users to
restrict the importing or exporting of Attributes to JDF. (By default, this option is enabled)

+ Inactive Projects

Allow changing Attributes of inactive projects lets Project Managers of the respective project
or the Admin user to edit the attributes of inactive projects (projects with the Non Active,
Completed, On Hold or Canceled status).

Allow changing members of inactive projects lets the Project Managers and Admin users to
edit the members'list for inactive projects.

Allow Document operations on inactive projects lets the project members with the Change
Properties right to edit documents in inactive projects.

When this is selected, project members can:

1. download documents (the project history is updated in that case),
2. view the document

3. see adocument history or the project history

4. copy documents to other projects (but not within the same project).
5. annotate documents.

But cannot:

1. upload documents to the project,

2. startanapproval cycle or do approval operations on documents,
3. move documents,

4. delete documents,

Note: Administrators and the Project Manager for the inactive project can perform all document-
related actions.

« Discussions

Allow removing Discussions and Discussion Messages

« Archived Projects

Allow non-administrators to see Archived Projects

« History Require adding a change comment.
- Email Notifications and Download Link

34

Allow Project Members with Download permission to e-mail a link for non-authenticated
download of a document, allows Project Managers and members of a project with Download
permissions to send a download link for a file within their project to non-WebCenter users.

Allow large Document preview (approval e-mail notifications) adds a preview of the graphics
and CAD documents in the approval related notification emails.

Allow non-authenticated download of Documents (approval e-mail notifications) adds a
Download Document link to the default approval emails generated by WebCenter.

This link will only be valid for a certain number of days (enter that number in the The download
link will be valid for ... days field). The default value is 14 days.
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Note:

By default, this option is deselected.
If you deselect this option after non-authenticated download links have been sent, these
download links will become invalid.

When a non-WebCenter user clicks a link that is invalid, expired or tampered with (for example if
the URL was changed), the user will see a web page stating that the link is invalid.

Changing the link validity (number of days) will only apply to new links.

« Forward Link- Registered Users

Allow sharing Viewer Link allows sharing of link from the Viewer or Document Action menu, to
the users already available in WebCenter.

Allow Forward Approval option in Approval setup allows sharing of link for Approval in the
Approval Setup (Project or Folder or Document ), to the users who are already available in
WebCenter.

Allow Forward to choosing one of the options enables the approver(s) to share the document
with

- Any Visible user(s) means any user irrespective being present in the role or groups or within
the project.

- User(s)in the same project means restricted to the users present in the project as an
individual member or in a Role or in a Group within the same project.

« User(s)in the same Approval Scope means can forward to anyone within the same Group or
Role as the forwarding user.

« Forward Link - Unregistered Users

Allow sharing Viewer Link allows sharing of link from the Viewer or Document Action menu, to
any unregistered user.

Allow Forward Approval option in Approval setup allows sharing of link for approval to
unregistered users from Project or Folder or Document.

You can commit the changes made in this page using the Save button.

System History Logs

All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

4.4. Document Type Preferences

Document Types

The Document Types page controls the kind of files WebCenter supports. The document types you
enable here are available for selection:

«  When uploading a new file.
« Inthe Search for field when searching for documents.
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You can edit the Document Type preferences inPreferences > Document Types.

To enable or disable a specific Document Type, check or uncheck the option in the Enable column.
Click Save to confirm.

Note:

If you disable a document type and you already have documents of that type in WebCenter, they can
still be found by selecting A11 in the Search for field when searching.

Document Details pages for those document types will still be available, and the documents can still be
downloaded and have new versions uploaded.

Other Preferences

On this page you can control the system wide settings for Automatic Document Naming, Default
Attribute Category and Start Task for new Documents/Versions. You can either choose None or choose
a different value.

Note:

These settings are found in each project and template on the Document Creation page where you can
specify:

+ None
« Default (using the system wide settings)

« Custom (defining project/template wide settings)

For each Document Type, you can set up:

- Automatic Document Name

Note: Optionally, you can enable the general option: Enable File Extension Specific Counter. This
will make sure that you have different counters for different types of documents.

« Default Attribute Category

You can setup a task to start automatically when you upload a specific file type as a new document or a
new version by enabling the following options:

- Start task for new Documents

. Start task for new Versions (new version of)

To selectively apply the above settings to documents in blank projects, you can enable or disable the
options (for all document types):

« Apply Automatic Naming to Documents in Blank Projects
« Apply Default Attribute Categories to Documents in Blank Projects
« Apply Default Start Task options to new Documents in Blank Projects

« Apply Default Start Task options to new Versions in Blank Projects

System History Logs

All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.
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4.4.1. Find and Unlock Locked Documents

Locked documents are documents that users have downloaded and are working on, and want to flag to
prevent others from working on them.

The Admin user (or any member of the Admins group) can find locked documents belonging to all users
and unlock them so that others may work on them without receiving warnings that they are locked.

This is particularly useful for freeing up documents that have been locked by users who are absent for
longer periods of time, or who have left the project entirely.

1. Click Admin > Project Management > Find Locked Documents.

2. Either filter for users by entering (part of) their last name in the Search users by last name field, or
click Go right away to see all locked documents.

3. Select the document(s)to unlock by selecting the corresponding boxes.
4. Click Unlock checked items .

4.5. Notifications Preferences

The Notifications page allows you to specify exactly which events in WebCenter should trigger an e-
mail notification to the users involved.

For every event or action in WebCenter, you can determine whether it:

» isloggedinthe project history (select Include in Project History).

« triggers an e-mail notification to:

- the Project Manager only (select Manager),

« allthe members involved with the event (select Involved People),

Tip: Click on Involved People to see a list of involved people for each event.

- allthe project members (select Members).

You can also set up WebCenter to Send a reminder to the assignee or an approver when a Task or an
Approval is overdue and Repeat the reminder every x days until the Task or Approval is finished.

To limit the number of overdue reminders, you can set the system to only send reminders for Started
tasks or Tasks that can be completed (for example, for tasks having a predecessor needing to be
completed before they can be started).

Those options are available when Send areminder... is selected.

System History Logs

All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

37



ESKO —

4.6. Menus

The Menus preferences allow you to define what users can see by customizing the WebCenter menus.
For example, you can remove certain menus for some users, so they have a simpler user interface to
work with (they only see the menus they need to use).

You can assign custom menus to users and / or companies (see Edit a User on page 213 and Edita
Company on page 202).

The Menus page contains the Default menu, and any custom menu you have already created.

Note:

You cannot edit or delete the Default menu, but you can use it as a basis for creating custom menus.

From here, you can create/update a custom menu either through the WebCenter user interface or using
XML. You can also delete a custom menu.

System History Logs
All Menu related events like
+ MenuCreated
« MenuDeleted and
« MenuChanged

are recorded and stored in System History. Read this page on how to access the records.

4.6.1. Create a Custom Menu through the WebCenter User Interface

You can create a custom menu for each category of users, to make it more convenient for them.
You will need to:

1. Determine which menus a particular group of users needs, and which menus they don't need.
2. Onthe Admin > Preferences > Menus page, click Add Menu.
3. Create your custom menu.

Note: If you do not have Task Management License, the Task related items will show the following
warning:

Task Types & [
Types =

Specification
This menu item will not be displayed. It requires a special license which is currently not installed on the system.

Restrict
Statuses

Add Menu tem

4. Assign the menu to the user, group or company you created it for.
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5. Loginto WebCenter as one of the users to which you gave the custom menu, and check whether

the menu works.

Create a Custom Menu

4.

On the Admin > Preferences > Menus page, click Add Menu.
On the Add Menu page, enter a Menu Name and Menu Description for your new menu.
Click the type of menu you want to customize: Main Menu, Project Details or Document Details.

You are starting with a copy of the Default Menu.

Menu Name * Menu Description

Custom Menu

[ enus [

¥ Show Keyword Search

this is my custom menu

Main Menu sject Details ocument Details

Menu Gallery

My Work I

Projects

Favorite Projects

Manage

Projects

Task Types

Search

Projects

My WebCenter

y Work Setu
Projects | am invited to Selp
- es Locked Documents
Create Project
Task Types

Statuses

Search Edit Menu: My Work
Projects abel Type Existing Localized v English{en My Waork
Documents
Tasks Language Tag MY_WORK_TAG Frenc Mon travai
Results # a0l Users German(de) Eigene Arbeit
Saved Searches
Administrators
Reports Spa Mi Trabajo
Project Managers
My WebCenter Create Task Rights talian(it) Il Mio Lavoro
My Profile visible To Create User Rights Dute Mijn Werk
MNormal Users
Polish(pl) My Work
In Groups
Japanese(jp) A 77
Chinese(cn) FhELfE

On the left hand side, you can see the Menu Gallery (1) containing the default menu items in bold,
and the default sub menu items under them.

On the right side, you can see the Menu Builder Canvas (2)(which is a graphical representation of
the menu). This reflects any changes you make.

At the bottom (3), you can see and edit the details of the menu or sub menu item currently selected.

At the top (4), there is a menu to switch between different types of pages. The toggle on the left
allows you to switch between Menus and Actions.

Edit the menu as desired:

« Add a Default (Sub) Menu Item on page 40,
« Add a Custom(Sub)Menu Item on page 42,
+  Remove a(Sub)Menu Item on page 45.
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Tip: You can also re-order the menus, or the sub menus within a menu, by drag-and-dropping them
on the Menu Builder Canvas. You cannot drag-and-drop a sub menu to a different menu though.

5. Click Save at the bottom of the page.
6. When you are done editing your custom menu, you can click Return to go back to the Menus page.

Add a Default (Sub) Menu Item
To add a default menu or sub menu item:

1. Dragit from the Menu Gallery into the Menu Builder Canvas.

Note:

You can add the same sub menu item to different menus on the Menu Builder Canvas, but you
cannot add the same sub menu item twice to the same menu, or add the same menu twice to the
Menu Builder Canvas.

To quickly see whether a(sub) menu item is already used in your custom menu, you can select it in
the Menu Gallery: this highlights where it is used on the Menu Builder Canvas.

Tip: After making a change, you will see that the Default Menu label above the Menu Gallery
becomes Custom Menu. You will also see a Revert Menu link under it. Click this link if you want to
cancel all your changes and go back to an unedited copy of the default menu.

2. Inthe Edit Menu area at the bottom, you can change the properties of your (sub) menu:
a) Todefine what the (sub) menu is called:

« If you don't want to translate the (sub) menu (it will have the same name in all languages):

1. Choose Simple as Label Type.
2. InLabel, enter the name to give your (sub) menu.

« If youwant to define a new name in different languages:

1. Choose New Localized as Label Type.

2. InLanguage Tag, enter a new language tag to associate to that menu name in all
languages (this language tag is how WebCenter refers to that menu name internally. It
must be unique).

3. Inthe dialog that opens at right, enter the translations of that menu name in all your
WebCenter languages. You need to enter at least the English name.

Note:

Make sure your customizationConfig.xml file contains language tags for all the
languages you use here (see Customize the Language Files).

If this is the case, your translations will automatically be added to your custom language
files. If you didn't have a custom language file for one or more languages in which you add
a translation here, these files will be created automatically.

Otherwise, your (sub) menu will use the value your entered in the Language Tag field as a
Simple Label (it will be shown as it is for all languages).
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- If youwant to use an existing WebCenter string (piece of user interface text)and its
translations as menu name:

1. Choose Existing Localized as Label Type.

WebCenter

2. InLanguage Tag, enter the language tag that is associated with the string you want to
use in your language files (in your custom language files if you have any, otherwise in your

default language files).

Tip: When you start typing a language tag, the Language Tag field shows all language
tags starting with the characters you typed; you can select the desired one in the list.

3. Thedialog that opens at right shows the translations of that string in all your WebCenter
languages.

Note: You can edit those translations(click Edit and enter the new translations), but then
they will be changed on every WebCenter page that uses that string.

b) To define who can see it:

Edit the menu item to limit the visibility. Specify the Visible To > In Groups as Specific Groups.

If you want to limit the menu's visibility to certain groups, select Groups and enter the names of
the groups that can see the menu, separated by a semicolon (example: GROUP1; GROUP2). You

can see this example when hovering on the field.

EE Actions Mzin Menu #

#IShow Keyword Search
-

Menu Gallery

Projects. Add
Favrite Projects

cts

cts | Manage
Projects | am invited 1o

Create Project

Task Types

Search Label Type Existing Localized
Projects Language Tag * MY_WORK_TAG
Documents

@Al Users
Tasks and Approvals
Results Administrators
Saved Searches Project Managers
Reports Create Task Rights

My WebCenter Create User Rights
My Profile Visible To * Project Creators
My Password Normal Users
My Preferences Hide for delegates
My Locked Documents In Groups

== 2l Groups.
roup’s Taska Specific Groups
roup's Members
My Delegates
URL Type Provide URL

Creat
reate URL mytadolistizn
Greate Project

Parant Menu Top Menu
Create Task "
Craste User
Craste User
Upload

B3 v e

Create Project

u hem

Edit Menu: My Work

Task Types

English(en)
Frenchifr)
German(de)
Spanish{es)
Italianit)
Dutch(nl)
Palish(pl}
Japaneselip}
Chinese(cn)

Chineze(tw)

Hungarian(hu)

Portuguese(br)

Russian(ru)
Turkish(tr)
Croatian(hr)

LABEL](abel)

- Defult
Search My WebCenter
Frojects My Profile

Documents My Passward

asks and Approvals Preferences

Locked Documents
Users

Reports

Group's Tasks

Text Coment Search Group's Members

Delegates

Add Menu ltem

My Wark
[Men travail
Eigene Arbent
[Mi Trabajo

il Mio Lavoro

suzaedu
Mé prace
Sajét munka
Meu trabalho
[Mon paGora
5im

Maj rad

[MY_WORK_TAG:My Work]

©Add Top Menu
Defauit

Create
Create Project
Create Task
Create User

Create User
Add Menu tem
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c) Todefine where a user goes to when clicking it:
- If you want the (sub) menu to link to a specific page (within WebCenter or external):
1. In URL Type, select Provide URL.
2. InURL, enter or paste the URL of the page to link to.
- If youwant it to show the results of a(global) saved search:
1. InURL Type, select Saved Search.
2. In Saved Search, select the global saved search you want to link to.
« Ifyouwant it to use it as a shortcut to create a Project with a specific characteristic:
1. InURL Type, select Create Project with Characteristic.
2. In Characteristics, select the characteristic you want to use for the Project.
« If youwant it to use it as a shortcut to create a Project from a specific template:
1. InURL Type, select Create Project with Template.
2. InProject Template, select the template you want to use for the Project.
« Ifyouwant it to show alist of Projects that have a specific characteristic
+ 1. InURL Type, select Project List with Characteristic.
2. In Characteristics, select the characteristic of the Projects you want to show.
+ If you want the (sub) menu to show a Dashboard

+ InURL Type, select Dashboard.

» InDashboard, select the dashboard from the drop down or Create New Dashboard

Note: You can only select a Parent Menu when creating a new (sub) menu, not when editing an
existing one.

3. Click Save at the bottom of the page.

Add a Custom (Sub) Menu ltem

1. Onthe Menu Builder Canvas, click where you want to add your sub menu (if you want to add a top-
level menu, you can click anywhere on the canvas).

2. Inthe Edit Menu area at the bottom, click Add Custom Menu.
3. Stillin the Edit Menu area, define the properties of your (sub) menu:
a) To define what the (sub)menu is called:

« If you don't want to translate the (sub) menu (it will have the same name in all languages):
1. Choose Simple as Label Type.
2. InLabel, enter the name to give your (sub) menu.

« If youwant to define a new name in different languages:

1. Choose New Localized as Label Type.
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2. InLanguage Tag, enter a new language tag to associate to that menu name in all
languages (this language tag is how WebCenter refers to that menu name internally. It
must be unique).

3. Inthe dialog that opens at right, enter the translations of that menu name in all your
WebCenter languages. You need to enter at least the English name.

Note:

Make sure your customizationConfig.xml file contains language tags for all the
languages you use here (see Customize the Language Files).

If this is the case, your translations will automatically be added to your custom language
files. If you didn't have a custom language file for one or more languages in which you add
atranslation here, these files will be created automatically.

Otherwise, your (sub) menu will use the value your entered in the Language Tag field as a
Simple Label (it will be shown as it is for all languages).

+ If you want to use an existing WebCenter string (piece of user interface text)and its
translations as menu name:

1. Choose Existing Localized as Label Type.

2. InLanguage Tag, enter the language tag that is associated with the string you want to
use in your language files (in your custom language files if you have any, otherwise in your
default language files).

Tip: When you start typing a language tag, the Language Tag field shows all language
tags starting with the characters you typed; you can select the desired one in the list.

3. Thedialog that opens at right shows the translations of that string in all your WebCenter
languages.

Note: You can edit those translations(click Edit and enter the new translations), but then
they will be changed on every WebCenter page that uses that string.

b) To define who can see it:
Edit the menu item to limit the visibility. Specify the Visible To > In Groups as Specific Groups.

If you want to limit the menu's visibility to certain groups, select Groups and enter the names of
the groups that can see the menu, separated by a semicolon (example: GROUP1; GROUP2). You
can see this example when hovering on the field.
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EE Actions  Main Menu # | Project Derails

#IShow Keyword Search

-

Menu Gallery -

Create Project
Add M

Projects

Favorite Projects

Projects
ots | Manage
Projects | am invited to

Create Project

Task Types
Types
Specifications

Restricted Sets

Statuses Edit Menu: My Work
Search Label Type
Projects Language Tag
Documents

Tasks and Approvals
Results
Saved Searches
Reperts

My WebCenter

My Frofile Vieible To *

assword

references
ocked Documents
s

up's Tasks

roup's Members

elegates
URL Type

Create
Craste Project
Craste Task
Craste User
Craste User

Upload

Favorite Projects

Projects

Existing Localized

_WORK_TAG

WAl Users
Administrators
Project Managers
Create Task Rights
Create User Rights
Project Creators
Normal Users

Hide for delegates

In Groups

®all Groups

Specific Groups

Provide URL

[mytodolistisp

Top Menu

Projects

Task Types

English(en)
Frenchifr)
German(de)
Spanish{es)
inalianit)
Dutchin|
Palish(pl)
Japaneseljp!
Chinese(cn

Chinese(tw]

Hungarian(hy

Portuguese(br)

Russian(ru)
Turkish(tr)
Croatian(hr]

LABEL](abel)

Search
Projects
Documents

Tasks and Approvals

Eigene Arbent

[Mi Trabajo

I Mio Lavoro

[My Wark
702
B L {E
e L {E
aumasdu
M3 préce
Sajét munka
Meu trabalhe
[Mon paGora
im

[Moj rad

[MY_WORK_TAG:My Work]

Default
My WebCenter
My Profile
My Pasaward
My Preferences

Locked Documents

WebCenter

©Add Top Menu
Defauit
Create
Create Project
Create Task
Create User

Create User
Add Menu ltem

c) Todefine where a user goes to when clicking it:

- If youwant the (sub) menu to link to a specific page (within WebCenter or external):

1. InURL Type, select Provide URL.
2. InURL, enter or paste the URL of the page to link to.

- If you want it to show the results of a(global) saved search:

1. InURL Type, select Saved Search.
2. In Saved Search, select the global saved search you want to link to.

« If youwant it to use it as a shortcut to create a Project with a specific characteristic:

1. InURL Type, select Create Project with Characteristic.

2. In Characteristics, select the characteristic you want to use for the Project.

« If youwant it to use it as a shortcut to create a Project from a specific template:

1. InURL Type, select Create Project with Template.

2. InProject Template, select the template you want to use for the Project.

« Ifyouwant it to show a list of Projects that have a specific characteristic

+ 1. InURL Type, select Project List with Characteristic.
2. In Characteristics, select the characteristic of the Projects you want to show.
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- If youwant the (sub) menu to show a Dashboard

+ InURL Type, select Dashboard.

» InDashboard, select the dashboard from the drop down or Create New Dashboard
d) To define where to put it in the menu structure:

+ If you want this menu item to be a top-level menu, select Top Menu in Parent Menu. This will
place it at the right of the Menu Builder Canvas, after all the other menus.

Tip: You canre-order the menus by drag-and-dropping them.

« If youwant it to be under an existing menu item, select this existing menu item in Parent
Menu.

Tip: You can also re-order the sub-menus within a menu by drag-and-dropping them.

Note: You can only select a Parent Menu when creating a new (sub) menu, not when editing an
existing one.

Click Add when you are done.
4. Click Save at the bottom of the page.

Remove a (Sub) Menu Item

1. Toremove a menu or sub menu item from your menu, select it in the Menu Builder Canvas and click
the grey cross . beside it.
2. Click Save at the bottom of the page.

Custom Actions

Just like custom Menus, you can customize Action buttons. This feature allows you to remove and re-
arrange default Actions for different (groups of) Users. Also, you can add new custom Actions( such as
aJavaScript, Create Task, Start Workflow etc.) with custom icons.

There are different types of Actions such as:

« inatable header

« inthe header of a Project or Document
« atthetop right of pages

« andinside tables(icon-only)

Just like customizing Menu items, you can add or remove them, set a Label and Visibility and modify
their display order. You can also specify:

« Action Type
» Priority

« Selection

« Rendering
« lcon
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« lconColor

Note: The available settings depend on the Type of Action that is being customized.

Custom Actions in Different Locations

In the Menu Builder, select Actions to customize them. Menus and Actions. Once Actions is enabled,
different types of pages become available in the menu:

« Project Lists
» Project Details
» Document Details

« Search
. Cart
« My Work

Under every page type, the individual pages or sections that can be customized are listed. Here you can
find an overview of the meaning of each of these different sections:

Project Lists

You can customize the Actions displayed in the table header of the following pages: Favorite Projects,
Projects | am invited to, Projects | Manage, and Projects.

For each of the pages you can add or remove Header Actions and Table Actions. The Header Actions
are the buttons displayed top right, like Create New Project in the example below. The Table Actions
are the buttons listed in the table header, such as Add to Favorites and Add to Cart in this example.

projcts
Add to Favorites = Add to Cart & Delete 2 Change Manager 4 Update Project(s) Q L 4
Project Description Project Status Manager Created  Modified | Due On
Requesi0004 - Keizer, Debbie (DEKE) Jun 27,2016  Jun 27,2016
Completed
4 @ Request00! =y Keizer, Debbie (DEKE) Jun 27,2016 Jun 27,2016
Active
@ Request00l C!’\:HDd Keizer, Debbie (DEKE) Jun 27,2016 Jun 27,2016
@ Request000 “ Keizer, Debbie (DEKE) Jun 27,2016 Jun 27,2016
Active

Project Details

In this section Project Detail type pages and sections are listed. The Project Header has Left Actions
and Top Actions. The Top Actions are not used by default, but allow you to move (part of) the buttons
on the left to the top right of the page.
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Customer:

Project: Request0001
Manager: Keizer, Debbie (DEKE)
Due On:

+ Upload Multiple Documents
Mail link to
More...» Description:

Modified: Jun 27, 2016

Project Documents (Table) and Project Bill of Materials (Table) determine the Actions in the table
headers on the Project Details Documents and BOM pages.

Q, View and Annotate @ Compare in Viewer % Download # Delete Document(s) More...r

«| Documents

Project Documents (Document)and Project Bill of Materials (Document) define the Action buttons that
are displayed when you hover over individual Documents listed (typically compact icon-only buttons).

Documents Version

L bluebird.png (122.1k8) Q s 11
4

Document Details

For now, this item only contains the Document Header. It works in a similar way as the Project Header
with Left Actions by default, and optional Top Actions. Note that some of the available Actions still
depend on Document Type. For example, the Run as Standard Action will only be shown for CAD Design

files.
BlueBottle.png
Mail link to Document: ElueBottle.png(755.4KB)
- e o

Q View and Annotate Veirs.lon_

k1 Description:
More...» Approval: No Approval Required

Search

It is possible to customize the table header Actions for both Project and Document Search Results.

Search Results

Q, View and Annotate 3 Compare in Viewer & Download = Add to Cart
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For Document Search Results, Action buttons can also be customized. In case this is already done in
the Saved Search setup, WebCenter will combine the two setups. For example, if the Download button
is presentin both, it is displayed, if it is not present in one of them, it is not shown.

Elue Bottle.png

For Search, it is possible to add an extra filter in individual Saved Searches based on Tag values defined
in the Action configuration. See Action Settings on page 49 for more details.

Cart

The Cart Projects and Document pages have table header Actions which can be customized.

My Cart

The Cart will not be cleared on logout. Change in My Preferences.

Documents
Q, View and Annotate ¥ Compare in Viewer Mail link to More...v
Documents Version Description

My Work

On the My Work page, it is possible to customize the table header Actions for the My Approvals section.
The individual Document Actions can be customized for: My Approvals, My Recently Submitted
Approvals, and Approvals to Follow Up.

w My Approvals

Document

v i deke_shiny_bag1.zae Q v 3 O
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Action Settings

Depending on the Action type and location, following settings may be available:

Priority
Priority determines if and how the Action button is displayed, there are a few options:

« Primary (always visible) - this type of button is always visible and has the primary color selected in
the Customization (by default a dark blue/grey shade).

- Secondary (always visible) - this button is similar to the primary button, but uses the default
button color selected in the Customization (by default: white).

- Default (visible if space available) - this button is similar to the secondary button, but is only
displayed if there is enough room, if not, the button is listed in a More dropdown menu allowing for
optimal use of available space.

- Available (always in "More") - this option is always displayed in the More dropdown menu.

Selection

The Selection setting determines when the button becomes available. You can set it to No selection
required if it is not needed to select anything to perform the Action, if one or more items are required,
select one of the other options (for example: to delete a Document, you need to select at least one
item).

Rendering and Icon

The Rendering setting can be used to determine whether to show only an icon, only the label, or both.
At the top of the settings panel, you can see a preview of your button.

[ My Custom Button

In the lcon dropdown you can find a number of icons to choose from. It is not possible to add any
additional icons, but new icons will be added in future versions of WebCenter. Use the Color dropdown
to select one of the standard colors for your icon.

Tag

The Tag field is only available for custom Actions in Search. For Search, it is possible to add an extra
filter in individual Saved Searches based on Tag values defined in the Action configuration.

When the Custom Actions setting in the Search Layout Options of your Saved Search is enabled,
tags can be entered separated by a comma, by default there is a "default” tag. A * matches all tags.
When the checkbox is disabled, no custom Actions buttons will be shown for the Saved Search. When
the checkbox is enabled, all custom Actions which do not have a “tag” will be shown as well as all the
custom Actions which have one of the tags mentioned in the input field.

¥ Custom Actions |default

[4¢]
I7e]
[4¢}
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Task Settings

For Workflow and Create Task buttons, several settings are available such as Task Type, Start Task
and which fields to show. For more details, see: Custom Action Types on page 50.

Custom Action Types

With the introduction of the customizable Action buttons, you can not only rearrange and remove the
regular Actions, but also add your own custom Actions. Following types are available in the gallery:

JavaScript

The custom JavaScript button has an additional JavaScript field (mandatory) where you may copy/
paste your own custom code.

It is possible to use fixed variables to reference WebCenter Projects or Documents in this JavaScript
code. These variables can be used for example when creating buttons that redirect to specific Project
or Document Details pages. An overview:

Variable Type How to use

selected|Ds Array If a Project list or Document list is available in the action context, the IDs
of the corresponding items (for Documents, this is the Document version
ID)is available in the variable “selectedIDs".

projectID String | If asingle Project is available in the action context, the ID of this Project is
available in the variable “projectID".

docVersionlD | String | |f a single document is available in the action context, the document
version ID of this document is available in the variable “docVersionlD".

menuFile String | Where possible, the current Menu file selection (controlling the display of
the primary WebCenter Menu) s available in the variable “menufFile".

Note: Itis not guaranteed that JavaScript segments relying on other parts of the browser page DOM or
detailed implementation of WebCenter pages will be supported in future versions.

Note: Using other (undocumented)variables is not supported and highly discouraged.

Start Workflow

The custom Start Workflow button allows you to select a Workflow Task Type to launch upon clicking
the button. Any selected Documents will be added to the Workflow. In a Project context, it is possible to
either launch one Workflow per Project or one per selected Document using the Options setting.

Create Task

Using the Create Task custom Action button, it is possible to immediately create a new Task from the
selected Task Type. Use the Start Task options to either immediately start the Task, or at a later point
in time.

The Show setting allows you to enable/disable different fields on the Create New Task page. This
setting allows you to hide unwanted fields and elements from the page and reduce clutter. Disable
all checkboxes to immediately go to the Task Execution page or create the Task. The After Creation
setting determines whether the Task Execution page is displayed or not.
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Action Type Create Task

Task Type Simple Task r

¥ITop buttons
¥ Task Type
¥IStatus
#ICreated by
¥ Allowed Assignee
¥ Assigned to
¥/Name

Show * ¥IDescription
¥Predecessors
¥|| ead time
¥Due date/time
#|Estimated
#IStart Task options
¥Icompletion action

#IBottom buttons
Start Task Default v

After Creation * ¥IShow Task Execution page

If all buttons are disabled, and enough information is defined in the Action to create the Task, it is
possible to create a Task without any additional user input needed and (optionally) redirect to the Task
Execution page for supplying, for example, Task Specifications to the created Task (or Workflow).

Assisted OA Tool
This custom Action Type is available in all action contexts with Document Lists.

«  Project Documents(Table)

« Project Bill of Materials(Table)

« Document Search Results(Table)
« Cart Documents

« My Approvals(Table)

To configure the selected Action button for Assisted QA, specific properties are to be updated.

Assisted QA Tool: (Mandatory) Select the QA Tool that you want to open, when the icon is selected in
the menu. If more than one QA tool is configured, then the list of all the available QA tools are viewable
in the drop down.

How to Create a Custom Action Button
Follow the steps below to create a custom Action button:

1. Inyour custom Menu, use the toggle top left to switch to Actions.

Menus Project Lists Project Details Document Details Search Cart My Work
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2. Select the page/section you would like to customize.

3. Select the Action type you would like to add from the Action Gallery and drop it into the location
where you want to show it.

4. Make sure to select your Action and inspect the settings in the table below it. You can now change
settings such as Label, Visibility, Rendering, etc. A preview of your button is displayed in the header
of the settings panel. Also see: Action Settings on page 49.

5. Once your are done, save your Menu.

Note: To see the Menu changes in effect, any User assigned this particular Menu needs to logout
and login.

4.6.3. Update a Custom Menu through the WebCenter User Interface

Note: You cannot edit the Default menu.

1. Onthe Admin > Preferences > Menus page, click the name of the menu you want to update.

2. Onthe Edit Menu page, edit your menu as desired (as explained in Create a Custom Menu on page
39).

3. Click Save at the bottom of the page when you are done editing the menu.

4.6.4. Create a Custom Project Details / Document Details Menu through the
User Interface
You can create a custom menu item for Project Details / Document Details page. For example, you can
create a menu item for adding a Saved Search using SmartNames.

You can also specify the visibility of this menu item for particular groups or for certain types of
projects.

1. Onthe Admin > Preferences > Menus page, click Add Menu.
2. Onthe Add Menu page, enter a Menu Name and Menu Description for your new menu.
3. Click the type of menu you want to customize: Project Details or Document Details.

In the menu builder, you will see all the menu items of a default Project Details or Document Details
menu.

On the left hand side, you can see the Menu Gallery containing the default menu itemsin bold, and
the default sub menu items under them.

On the right side, you can see the Menu Builder Canvas (which is a graphical representation of the
menu). This reflects any changes you make.

At the bottom, you can see and edit the details of the menu or sub menu item currently selected.
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M sctions|  MainMenu 4 Project Details 4 | Document Details 2
- Add Tap Menu
Menu Gallery
Documents (]
Bill Of Materials Documents Browse Documents []  Tasks
Task Information
Tasks Specifications
Task Information Documents
Specifications Checklist
Documents Discussions
Checklist Workflow
Discussions
Workflow
Discussions Edit Menu: Browse Documents
Label Type simple M
View Discussion
Label * Browse Documents
Characteristics
#Iall Users

Attributes ‘Administrators

i ) Project Managers
Project Information

Create Task Rights

Approval Visible To Create User Rights
Normal Users
Notifications
In Groups
Members ‘All Groups
® Specific Groups

Security Designer

Project URL Type Saved Search v

Folders -

Saved Search DRUPA16_Signs v

4. Edit the menuitem. Select the URL Type as:

« Saved search if you are configuring a Saved Search as the menu item. Select your search from
the Saved search drop down list below.

« Attribute Category View to configure a menu item with a specific attribute category view.

Specify the Name as the attribute category view name.

Note:

The name entered here has to match the custom Attribute Category View name of the Attribute
Category (of the current Project or Document).

Your users can edit the attribute values and save them from this custom view.

Note:
From this Project Details attribute category view, the users cannot:

« change the attribute category.
« export orimport the attribute category.

Read also Use Case: SmartName Search to find Related Projects on page 176.

5. Optionally:

You can assign a Project Details menu item for a certain group of Projects having a specific
Characteristic. This allows you to create menu items (for example, dedicated Saved Searches)
visible only in certain types of Projects.

1. Create a specific Characteristic for configuring a menu item. You can create characteristics for
your custom menu items as well as the default ones.
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2. Create a Custom Project Details menu or select the default menu item to edit.

3. Select the specific Characteristic in the Project Visibility field. You can select this from the drop
down list.

This menu item will appear in the Project Details page only if the specified Characteristic was
assigned to the project or the template.

As an administrator, you can switch this on and off in the Project Details > Characteristics page.
6. Assign the menu to the user, group or company you created it for.

Create a Custom Menu Using XML

You can create a custom menu for each category of users, to make it more convenient for them.

Note:

Menus are XML files, so you can edit them using an XML editor (you can find various freeware XML
editors on the internet, for example XML Marker or Notepad++).

For more details on how to edit the XML files to create custom menus, you can read Create a Custom
Menu in the WebCenter Customization Guide.

You will need to:

1. Determine which menus a particular group of users needs, and which menus they don't need.

2. Download the default menu to use as a starting point (click the Download Menu link corresponding
to the Default menu, then save it to a file when it opens in your browser).

3. Inan XML editor, remove the menu items that are not necessary for those users.

This allows you to simplify the WebCenter interface, especially for occasional users. For example,
you can create a menu that only contains My Work for approval users.

4. Add custom menu items, to link to the WebCenter pages of your choice.

This allows you to make the pages most used by your users more accessible. For example, you can
add menu items linking to saved searches, or to project creation from a specific project template.

5. When you are done editing the menu file, save it under a meaningful name.
6. Upload your custom menu:

a) click the Menu Upload button on the Menus page

b) onthe Menu Upload page, browse to your XML file,

c) give your custom menu a Name and a Description,

d) click Upload.
7. Assign the menu to the user, group or company you created it for.

8. Loginto WebCenter as one of the users to which you gave the custom menu, and check whether
the menu works.

Update a Custom Menu Using XML

To update a menu you have created:

1. Onthe Menus page, click the Download Menu link corresponding to the menu to update.
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2. Edititinan XML editor (see the WebCenter Customization Guide).
3. Onthe Menus page, click the Menu Update link corresponding to the menu to update.
4. Onthe Menu Update page:

a) browse to the XML file you edited,
b) change the menu's Name and / or Description if necessary,
c) click Update.

This updates your custom menu.

Note: You cannot edit the Default menu.

4.6.7. Menu: Visibility Groups

4.6.8.

4.6.9.

You can decide the group visibility of a menu item present in the Main menu / Project Details /
Document Details page.

For example, you can create a Project details menu item with a custom Saved Search using
SmartNames and make it visible only to a particular group.

Follow the steps below:

« Onthe Admin > Preferences > Menus page, select the menu.

« Click the type of menu for which you want to edit the visibility: Main menu or Project Details or
Document Details.

At the bottom, you can see and edit the details of the item currently selected.
- Edit the menu item to limit the visibility. Specify the Visible To > In Groups as Specific Groups.

If you want to limit the menu's visibility to certain groups, select Groups and enter the names of the
groups that can see the menu, separated by a semicolon (example: GROUP1; GROUP2). You can
see this example when hovering on the field.

Customize the Project Details Menu Using Characteristics

You can assign a Project Details menu item for a certain group of Projects having a specific
Characteristic. This allows you to create menu items (for example, dedicated Saved Searches) visible
only in certain types of Projects.

1. Create a specific Characteristic for configuring a menu item. You can create characteristics for your
custom menu items as well as the default ones.

2. Create a Custom Project Details menu or select the default menu item to edit.

3. Select the specific Characteristic in the Project Visibility field. You can select this from the drop
down list.

This menu item will appear in the Project Details page only if the specified Characteristic was
assigned to the project or the template.

As an administrator, you can switch this on and off in the Project Details > Characteristics page.

Delete a Custom Menu

To delete a custom menu:
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1. Onthe Menus page, click the Delete Menu link corresponding to the menu to delete.
2. Click OKin the confirmation dialog.

3. If your menuis assigned to users and / or companies, you need to assign another menu to them. In
the Menu Deletion page:

a) Select the new menu to assign to them.

Note: This will assign the same menu to all those users / companies. If you want them to
have different menus, you need to edit the users / companies individually from the Users or
Companies page.

b) Click Delete.

4.7. My Work Preferences

The My Work preferences allow you to define what users can see on their My Work page.

Default and Custom My Work Pages

As an Admin, you can define a default My Work page, that will be available to all WebCenter users by
navigating to Preferences > My Work > Default My Work Setup

You can also define custom My Work pages for specific users or companies, when editing that user or
company (see Create a User on page 211 and Create a New Company on page 202).

Users can then customize their personal My Work page to a certain extent, by adding or removing
predefined sections (using My Work > Edit My Work Setup).

Admin Users can define which sections are available for specific groups or user types.
In the My Work preferences, you can:

. create a new My Work section (to use in the default or custom My Work pages),

« change what the default My Work page looks like.

System History Logs
All My Work section related events like

« My Work section created
« My Work section deleted

« My Work section changed

are recorded and stored in System History. Read this page on how to access the records.

4.7.1. About My Work page

A My Work page can be customized using various blocks that are available.
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WebCenter has the following default sections, that you can use in the default and custom My Work

pages:
This section... will show...
My Approvals alist of documents a user has to approve or

reject.

My Recently Submitted Approvals

alist of documents a user has recently approved
or rejected.

My Approvals to Follow Up

alist of documents for which a user is Approval
Master.

My Tasks

a list of tasks assigned to a user
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This section... will show...
My Recently Handled Tasks a list of tasks a user has recently handled
My ToDo List shows Approvals and Tasks to be done by the user
Custom My Work Sections

You can create a My Work section from any html page. You can define which users will be able to see
and use the sections you create, and you can even specify the height the section will take in the page.
For details, see Custom My Work Section on page 58.

4.7.2. Custom My Work Section

58

To create a section to use in My Work pages, you need an html page, whose content will be shown in the
section.

Click Admin > Preferences > My Work. The My Work Sections page appears.
Click Create New My Work Section.

Give your new section a Name.

oo oo

In the Type option, indicate if this section will show:

- aHTML page specifically designed for this purpose (Generic),

Note: Please contact Esko's Professional Services if you require such a web page.

- aSaved Search (a search you have saved, see To Save a Search for more information),
« an External Web Page.

Note: We recommend you do not add WebCenter pages as My Work sections.

5. If you have chosen to show a saved search, select the Saved Search to show.
6. If you have chosen to show an external web page, enter or paste its address in the External Web
Page field (for example: http://www.esko.com).
For saved searches and external web pages, the URL field is filled automatically by WebCenter.
7. If desired, you can change the height of the section.
To do this, add sh= followed by the desired height in pixels at the end of the URL. For example
iframe.jsp?url=http://www.esko.com&h=400 has a height of 400 pixels.
WebCenter calculates the width automatically.
8. InScope, choose which type of users will be able to use this section in their My Work page:
« AllUsers,

» Administrators,
« Project Managers.

Note: You can also change this for the default My Work sections.

9. You can use groups to further filter the users that will be able to see the section. In Role Groups,
choose either:

« AllUsers if you want all users of the type specified in Scope to be able to use the section,
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» Specific Groups if you want to restrict the section's visibility to specific groups (within that user
type).

In this case, select the groups which will able to use this section.
10. Click Create.

4.7.3. Edit the Default My Work Page

You can customize and setup My Work page for all the users. Admin users can access it from Admin >
Preferences > My Work > Default My Work Setup.

You can drag and drop the various blocks from the dashboard builder drop-down in the right hand side.
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E) Counter
[ od My work Page _art_design_1 i
. ® Discussions
B ¥ My Todo Feed b ) # Show simplified My Work page
Image Spinner
e w Reset to Default
B My Todo Feed Name: BLSA_Task_Datatime_1
Assigned to: Sathish, Bala Styling
My Todo List (BLSA) tylineg
Dashboard Layout
T Rich Text Block Status: @ Scrollable Columns =
[@] Saved Search Spacing
& Selection Details Mame: PCM Collate Artwork O Ea sopx
Master Text
v Layout _ Background Color
= Assigned to: 27 PCM_CONTENT
_— : MANAGER #adedes
B collapsible Section 28 ADMINS
[T] Column Layout Status: @
[ Left Side Panel Layout
B List Layout
Name: PCM Collate Artwork
o e Master Text
My Work
Assigned to: 25 PCM_CONTENT = S —
Approvals to Follow Up MANAGER
1 ADMINS ESESES 29 | |29
[#] My Appravals [ r e B
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My Recently Handled Tasks an ssEem
SEEEEEEED
-
[E] My Recently Submitted Approvais
B Show more... (130) [ ] . . . | N ]

My Tasks

£

v Approvals done _Last week

Following options are available in the drop down:

« All: This option displays all the blocks that are available.

« My Work : All the available blocks of My Work Section are displayed. Default blocks available are

« Approvals to follow up Displays the list of Documents and their current Approval status for
which the current User is set as their Approval Master

« My Approvals Displays the list of Documents waiting for approval decision from the current user.
« My Recently Handled Tasks Displays Tasks that the current user has completed in a given time.

« My Tasks Displays the pending Tasks, waiting to be handled by the current User.
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« My Todo list Displays a merged overview of all Task and Approvals for the current User.
This block has the following configurable parameters which are all enabled by default:
+ Show Tasks: Displays all the pending tasks.
« Show Approvals: Displays all the pending approvals.

« Categorize by Time: You can specify if the block should have categories by time or no
categories.

» Maximum Height: Specify in Pixels or in percentage and by default has no value.

Note: My Work section can only be added once to the Dashboard.

« Layout: You can drag the layout blocks to customize the look of the dashboard. This is similar
to the customizing your search results dashboard. Read more about layouts at Configuring the
Search Dashboard Layout and Blocks on page 183

« General

- Discussions Widget: You can add this to view the current discussions you are part of. You may
choose to display Project or Task or Document discussions or all the discussions. You can
enable Always show Mobile View to view discussions in a compact format.

- Rich Text Block: You can add a block of text and also display the translations of the text in the
languages of your choice.

« Counter: You can specify a Saved Search and the results of the search will be counted in the
Counter. Read more here Building a Search Based Counter on page 184

- Image Spinner: Read more about this block Image Spinner on page 189
« My Work (Custom)

This section contains all defined custom My Work Sections of the system.

Menu Options in My Work Page
You can perform actions in the My Work page using the menu options
» Undo/ Redo: To perform Undo / Redo actions in the My Work page.

- Show simplified My Work page: Enable this toggle in the Edit My Work Setup to display the My Work
page with no links to Project and Document details page.

« Reset to Default: Admin users or the user can revert the My Work page to default settings by
clicking this button.

« Save: Any changes done will be saved.

Tip: To make the page mobile friendly, define minimum widths on columns to ensure that the columns
will reflow to a new row and fit horizontally.

4.7.4. Edit My Work Page for a User

60

Admin user can set up a customized My Work dashboard to any user.
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Note: When a user has no custom setup he/she will see the company My Work setup or Default My
Work setup.

Set up a custom My Work setup for the user, follow the steps below:

1. Click Admin > Users > My Work Setup tab.
2. Click on Setup Custom My Work to edit and configure a dashboard for the particular user.

3. You can customize the My Work dashboard as described here Edit the Default My Work Page on page
59

4. Click Save to make changes.

Similarly a customized My Work page can be set up for a Company's user. Read more about it here Set
up My Work page on page 205.

4.8. Dashboard

Admin users can view the global list of dashboards by navigating from Preferences > Dashboards.
These dashboards can be used as:

+  Menultems

« StartPage

« Landing Page of a Project or Default landing page of all projects
+ My Work

Create Dashboard

You can create a dashboard by clicking on Create Dashboard option. To know more about Dashboard
Configuration, read Dashboard Builder on page 62.

Note: You can find five example dashboards in the list of dashboards. Use Save As option to make use
of these dashboards. Note that every time the database script are run the dashboards are overwritten.

Dashboard Functions

Dashboards can be created for either simply viewing some information or for editing the data that is
shown or to create a new project.

Import/Export of Global Dashboards
You can import or export one or selected dashboards from the list of Global Dashboard(s).

To export, select the dashboards and select Export. This generates an XML/Zip containing the full
configuration of the Dashboard that can be used to migrate the Dashboard configuration to another
WebCenter Instance.

To Import a dashboard, select Import from Admin > Preferences > Dashboards. Choose the XML file
containing the Dashboards and click Import..

View History

You can view the Dashboard Created, Dashboard Deleted and Dashboard Changed events when you
click on this option. You can filter based on the date of the event or the event itself or by the last name
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of the user who made the change. History results can also be sorted in chronological order or by the
type of notification or the user last name.

Note: Dashboard Changed event does not capture any changes made within the widgets in the
dashboard.

Delete Dashboards

You can delete a dashboard by selecting from the list and clicking on Delete Dashboard(s) option.

System History Logs
All Dashboard related events like

- Dashboard Created
« Dashboard Deleted and
« Dashboard Changed

are recorded and stored in System History. Read this page on how to access the records

4.8.1. Dashboard Builder

62

Dashboard Name

Dashboard Name is a mandatory field in the dashboard. Ensure that the name provided is unique.

Note: If Dashboard is named WELCOME then it is loaded in the Welcome page and any dashboard
named CONTACT is loaded on the Contact page.

Context
You can create Dashboards in the context of where it appears, like

« Project

+  Document

« Task/Approval

« My Work

« Unspecified

There is an option to change the context of the Dashboard that you are building. Based on the context
selected for the dashboard, the gallery is updated with different blocks.

Dashboard Functions

- Edit Form: Makes it possible to edit. Make sure to add a save button to be able to save the changes.
+ View (default): Shows information about a Project or Document or Task.
« Creation Form: Only available for Projects. You can build a form to create a project from Dashboard.

Styling and Layout
There are two layouts available in Dashboard, namely:

« Default where the blocks are shownin a list
« Scrollable Columns where they allow you to scroll every column separately

You can set the background color of the dashboard. All layout blocks have the Spacing and/or Padding
parameter, which allows you to create visually appealing dashboards.
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Conditional Formatting
When the dashboards are created in Project, Task or Document context, the rendering can be
formatted using conditions. This works exactly similar to Search Results Formatting and can be read
here. Options available for conditional formatting depends upon the context of the dashboard.

Note: This option is not visible when the dashboard is created for unspecified context and in scrollable
columns.

Duplicate Blocks

Dashboard blocks can be easily duplicated in the dashboard builder by clicking on the duplicate icon in
the top-right of the block. This feature is useful, when you have a block that is already configured and a
similar block as the existing block has to be created.

OO«

Duplicate Block

Duplicating also works on all the layout blocks. When layout blocks are duplicated, all the blocks in that
particular layout block are duplicated. This allows for fast layout creation in the dashboard.

Drag and Drop

You can now easily configure the dashboard with simple drag and drop operations. Columns can also
be rearranged or new columns can also be created with drag and drop.

Dashboard Context Simulator

You can view the Dashboard for a selected Project, Document or Task with this option.
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4} Dashboard Settings

Configuration
Dashboard Name

Dashboard_Doc_Test

4} Dashboard Settings

Configuration
Dashboard Name

Dashboard_Doc_Test

WebCenter

£} Dashboard Settings

Configuration
Dashboard Name

Dashboard_Doc_Test

Context Context Context
Document $ Project - Task/Approval -
Styling < Allow Users to go to Project Details Styling
Dashboard Layout Dashboard Layout
Default $ Styling Default s
Dashboard Layout B
Spacing Spacing
—— Default : ————
Opx 50px Opx 50px
Spacing
Padding ——— Padding
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Padding
Background Color —— Background Color
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Background Color
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Project Project
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Document Froject Tasks and Approvals
Docl.pdf - napr_Nideapproval - Add ‘Document_A -

In the Dashboard Context Simulator option when

« Projectis selected, drop-down lists all the projects from which you can select the project.
« Document is selected, drop down list all the projects in the system from which you can select the

document.
« Taskis selected, drop down list all the projects in the system from which you can select the task.

Note: This optionis not visible when the dashboard is created for unspecified context.

Bulk configuration of blocks

You can select multiple blocks and apply changes to them at once using this option. Select the blocks
by clicking on the selection icon in the block and perform Styling and Configuration actions once.
Options that can be configured may vary depending on the blocks chosen.
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Delete Blocks

You can delete any block in the dashboard by clicking the ™ (delete)icon on the right top corner of the
block and the block is removed from the dashboard.

Gallery Panel Actions

You can add gallery blocks into the dashboard by clicking on the +. You also have Undo and Redo action
in the panel along with save. You can select the ellipsis to view the Dashboard Settings or make a copy
of this dashboard using Save As option.

E » » +

4} Dashboard Settings

M Save As

You can view any dashboard when it is built using the preview E icon in the bottom left corner. In
the preview mode, you have the gear icon which returns back to the dashboard builder.

Dashboards Shortcuts
Dashboard Editor Keyboard Shortcuts

« Ctrl+s: Save the dashboard

« Ctrl+z:Undo

« Ctrl+y: Redo

« Ctrl+click: Multi select blocks
« Shift +click: Multi select blocks
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Delete/backspace: Remove all selected blocks

Ctrl+g: Open the gallery. You can now directly start searching for blocks, press tab to select a block
in the gallery, and press enter to add the block to the top of the dashboard.

Ctrl + e: Toggle between edit mode and preview mode

Esc: Close the gallery

Dashboard Gallery

Gallery consists of all the blocks that can be added to make a dashboard. It is located in the left side on
the Dashboard configuration page. You can open the gallery by hovering on the +.

This lists all the available blocks and it varies upon the context of the dashboard created.

General

This comprises of the blocks which are available irrespective of the context of the Dashboard.

Counter: You can specify a Saved Search and the results of the search will be counted in the
Counter.

Dashboard Block: To reuse a configuration in different dashboards in the current dashboard.

Note: Use this option sparingly, as this might slower the speed at which the dashboard is rendered.

Discussions: To view the current discussions you are part of. You may choose to display Project or
Task or Document discussions or all the discussions.

Image Spinner: Read more about this block Image Spinner on page 189

My ToDo feed: To show your Tasks and Approvals in a custom way based on the dashboard context.
For example, you can create a dashboard for Task and Approvals for Todo items or in a Project
dashboard to show pending tasks. Read More here.

My Todo list Displays a merged overview of all Task and Approvals for the current User.
This block has the following configurable parameters which are all enabled by default:
« Show Tasks: Displays all the pending tasks.

« Show Approvals: Displays all the pending approvals.

» Categorize by Time: You can specify if the block should have categories by time or no
categories.

- Maximum Height: Specify in Pixels or in percentage and by default has no value.

Rich Text Block: You can add a block of text and also display the translations of the text in the
languages of your choice.

Viewer Block: You can add this block to view the viewable files in the Dashboard itself. Read more .

Saved Search: To show a Saved Search where the context of the Dashboard is used to resolve the
smartnames of the Saved Search.

Selection Details: To show a Dashboard for each selected item in the Search Results

Text Content Block: Add this block shows a Text or Table (wcc or wtc) document from the
Packaging Content Module in a Document Dashboard. You can both view and edit the Text and Table
Content in the Text Content Block.
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» ButtonBlock : Add Button block when you want to link a button in the dashboard to an action. You
can read about the Button block here.

« Content Sheet Block: Enables you to easily compare the contents of an artwork with content sheet
or two versions of the Artwork. Read detailed information about Content Sheet here.

Layout

You can use combinations of list, left side panel, column layouts and collapsible section to present
your blocks in the dashboard. Drag and drop the Layout blocks into your canvas to create a interactive
dashboards. To Configure your layout blocks available in dashboards:

« Select List Layout for a vertical list of blocks and Column Layout for a horizontal arrangement.
Spacing between these blocks can be specified and Padding can be specified for each direction
independently.

« Select Left Side Panel Layout to present info in a left side Column Layout with an embedded List
layout. This pre-defined layout can be modified to suit your needs.

« Select Collapsible Section to present info which can also be hidden and expand one or more blocks
based on the requirements.

« Select Column Layout to display blocks in configurable columns. When the user adds a Column
Layout to the dashboard, the layout is preconfigured with 2 columns and padding can be specified
for each direction independently.

» Select Menu Layout to show your Dashboard content by linking to other dashboards or to other
blocks. Detailed information of Menu layout can be read here and you can read about how to use a
Menu layout to create a project here.

Context based blocks

Dashboard can be created for different contexts like Project, Document or Task and Approvals. There
is also an option to create Dashboards with no specified content called Unspecified. The blocks
available in the gallery show information based on the context selected for the dashboard. All the fields
which can be searched in a Project/Document/Task/Approval Search are available as separate blocks.
It is possible to configure conditional formatting on these blocks which behaves the same as in Search.
Some of the blocks available are

«  Thumbnail block: shows the thumbnail of the Project or Document

» Project Attributes, Document attributes, Task specifications: these blocks show a view of the
attributes category of the Project, Document or Task in read-only mode.

« Approval setup : shows the approval setup of a Document. This block is available only for document
context.

Action Buttons
Document Actions:This block is available in Document and Task/Approval context.

Use this block to show Document Actions which are configured in the menu builder or in the block
itself. All actions which are available on Document Search Results are available in this block.

Task Actions: The block is available in Task/Approval context. You have two options namely:
+ Execute Task: opens the Task Execution Page
« GotoProject: opens the Project

Approval Buttons This block is available only for Document and Task and Approval dashboards. You can
configure approve, reject and comment buttons.

67



ESKO

68

WebCenter

Viewer Block

The Viewer block is available for Document and Task and Approval Dashboards.
You can configure the Viewer block with the following parameters:

« Height: Specify the height of the widget in px (pixel) or in % (percentage).

- Make Collapsible: Enable this to allow the block to be collapsible.

The viewer block shows basic text selection when the block is used in a search or in combination with a
saved search block.

For Graphic files a limited number of tools are available in the viewer:

« Zoomto fit
« Rotate View and
« Current page number/ total number of pages

For documents with multiple pages, the block shows the current page and the total number of pages.

You can navigate to the previous or next page with the back and forward buttons, when the text search
matches are on multiple pages.

Content Sheet Block

Content sheet block in Dashboard, enables to view and compare the content sheets easily. Content
Sheets are typically created as a collection of all the elements required within the artwork as
document references. You can read more about Product Content sheet here.

A Content Sheet block shows the selected document references in a predefined layout.

Content sheet block can be configured to show the referenced contents of a component or an artwork
document. The contents are shown in multiple tabs namely, Text, Table, Images, Symbol and Barcode
with default tab as Text content. In the Text Content tab, Master and Translation texts are shown along
with the Reference scope.

Get Set.ai Version: 1 BH=z=mno OB ® o content Sheet

Position Variant Pack Type English - United States Dutch - Belgium Configuration

+ PCM Technical DocRef Show All Document References

Manufacturer statement [1] Back Coconut Corrugate PACKAGING POWERED BY VERPAKKING AANGEDREVEN Show All Reference Filters
Manufacturer statement.wee &Berry dBox
Ingredients header [1] Eront  coconut Corrugate EACH 200 mL SERVING CONTAINS: ELKE PORTIE VAN 200 ml BEVA'
ngredients header.wcc &Berry dBox
Net content statement [1] Front Coconut Corrugate 560 mL
Net content statement.wce &Berry dBox
w PCM Legal DocRef
Consumer guarantee [1] Back Coconut  Corrugate 2
Consumer guarantee_1.wcc &Berry dBox

Coconut  Corrugate

Back &Berry dBox

Consumer guara

Consumer guarantee

Consumer guara

Coconut  Corrugate 3

Back &Berry dBox

I Consumer guaral

w PCM Marketing DocRef

Variant Back  coconut Corrugate COCONUT AND BERRY COCONUT AND BERRY
Variant.wce &Berry dBox
Packaging claim Coconut Corrugate ENERGY DRINK ENERGIEDRANKJE
- L . . Bottom AR
Packaging claim.wcc &Berry dBox
[ | e DIl

Configuration of the Block
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« Show All Document References
« Show All Reference Filters
Comparison of Different elements
You can compare any of the two different
« content sheetsor
« versions of the same artworks or
« artworks which has the same attributes
Get Set.ai Version: 1 / Tropical blend sheet .wpc Version: 1 © E Mmoo =
Delta Position Wariant Pack Type  English - United States
w PCM Technical DocRef
Corrugated
Manufacturer statement [1] Tep | - Box
Manufacturer statement.wcc Back Coconut PACKAGING POWERED BY
& Berry
Ingredients header = - ed EACH 200 mL SERVING CONTAINS:
Ingredients header.wcc - Coconut w m ’
& Berry
Coconut
& Bemry
Met content statement T Saten 560 miL
Met content statement wee Front ggrmrugaled m
v PCM Legal DocRef
Consumer guarantee [1] S - Geten -
Consumer guarantee_1.wcc Coconut g;rugaled
& Berry
Consumer guarantee [2| Back - _ed ]
Consumer guaraniee_2 wcc & Coconut B{;ﬂm
& Berry

When you choose to compare a document with another document, the Delta column shows the status
whether the contents have Changed or Removed or Added.

The differences are shown specifically in each of the content for changes as follows

Text: Color coded highlights on the exact location of the change on the text content itself for each
of the language present.

Table:Status to indicate a table has changed or not.
Images: Change of values to the EXTERNAL_IMAGE_PATH are shown.
Symbols: Change of values to the SYMBOL_NAME are shown.

Barcode:Change of values to the BARCODE_BASECODE and
BARCODE_COMPOSITE_COMPONENT are shown.

Note: EXTERNAL_IMAGE_PATH, SYMBOL_NAME, BARCODE_BASECODE and
BARCODE_COMPOSITE_COMPONENT are all hard coded attributes.

Apart from the changed and unchanged statuses, the content Removed from the Source document
and content Added to the source document are shown specifically in the each of the tabs.
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Menu Layout

A new layout option has been introduced that makes dashboards more interactive and visually
appealing. User Interface can be designed to alternate between views within the same context, in the
same dashboard.

Welcome to WebCenter 20.0! | R webCenter

 h Atioscap MediaBeacon

R ArPro A single source of truth for your images, video, audio, artwork, 3D, labels, and
other digital files.

Rk AE

Tabs can be added either to top or left or in the bottom. Above screen shots example shows tabs added
with all the three options.

Configuration of Menu Layout

The Menu Layout blocks configuration consists of buttons and a content block which are linked to each
other and it can be used to control the content of a block with buttons. The buttons are automatically
linked to the content block when adding the Menu Layout to the Dashboard. You can create Projects
within Menu layout. Read more about it here.

Note: When there are multiple Menu layouts added within the same Dashboard, change the name of
the content blocks so that it is easier to recognize them in the configuration panel.

Button Block

Button block is available In the Dashboard Builder of a My Work, Search or Global Dashboard and shows
a button with a text and/or anicon.

Configuration of Button Block

This block is versatile and can be configured for various uses with the following parameters:

« Labels and lcons which are customizable.

« Linkto: Specify where the button has to be linked to. Depending on the option linked, further
configuration options are shown. Buttons blocks can be linked to

« Dashboard : Choose from the existing Dashboards available in the drop down or create a new
dashboard. You have the option to show the configured Dashboard in the Current window or
New Browser Tab or Pop up or in Menu Layout.

« Saved Search: Choose from the existing Global Saved searches available in the drop down and
you can further specify to open either in the same Window or in a New Browser tab.

« Create Project : Choose either a Project or Template available in the drop down, based on which
anew Project is created. See how to create a project in Dashboard using Create Project option.
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« Download Document: You can create a link to a document, that can be downloaded from a
specific Project.

« URL where you can specify an URL to be opened either in the Current Window or a New browser
tab.

Styling options available for Button block

This block can be customized with various styling options available like Background Color, Use
Contrast color for text or Custom Text Colors based on your preference.

Button blocks can be rendered either as Text or Icon or lcon and Text . Along with this you can also
choose the Alignment Border, Border Color, Size and Padding (slider bar) for the Button block.

The block itself can be made to render in various sizing options like small, medium, large or extra large
based on your requirements.

Button block can be used in multitude of ways and one them is detailed here.

How to Configure My ToDo feed
My ToDo feed has the following configurable parameters:
« Show Tasks/Approvals: These two parameters define the items that are visible in the list.

« Task Dashboard/Document Dashboard: The configured dashboards are used to show the entries
of the todo list. It is possible to select a different dashboard for tasks than for documents.

Note: Use context specific information blocks to view your tasks and approvals along with Action
buttons to perform actions your Todo items.

« Padding: Spacing between the cards and the border/frame of the block can be set and adjusted

« Spacing: spacing between two cards can be set and adjusted. When you view this block in the
dashboard, you can perform the following actions

« Refresh: To update the information.
« Filter: To filter the items that are visible in the Block.

The Tasks and Documents that are shown in the My Todo Feed are the same as in the My Todo List
block.

Project Creation from Dashboard

Dashboards are more interactive to edit the data which can be saved and have forms where input
can be added. Project creation has been incorporated to enable easier collection of information with
specific action driven pages in Dashboard.

Admin users can now choose the Dashboard function as a Creation Form in the Project context. Then
an option is available to add a Save and Cancel button.

€) This Dashboard now behaves as a Form. Do you want Add Buttons X

to add a Save and Cancel Button?
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You can create customized Projects from an existing Project or a Template which are available in the
drop down. Or when no Project or Template is selected, a blank project is created.

Save and Cancel buttons can be formatted with various configuration parameters available for the
blocks.

Creating Project from Button Block
Here is an example of a Project created from Button block.

You can configure a Button block to open a Dashboard and the Dashboard can be further configured to
open a project creation form as shown in the image below.

Column Column

Configuration
List Layout w Label
List Layout My Button (1]

Icon

K icon-WCR_WF-Select

Kk My Butten
Link to

Dashboard -

Dashboard
efrProjectCreation -
List Layout Open in

Column Layout Popup -

Column Celumn

List Layout

oo Example Project =3 e :

M roomnle Fuamela FYALIPLEY

To use the Button with a Project Creation dashboard, follow the steps below.

1. Create a Dashboard with Project as Context.

Choose the Function as Creation Form.

Choose the Project or Template that you wish to create the Project from.

You can optionally choose to navigate to the new Project when it is created or open in the same
browser window.

Choose your Styling, Padding, Background color options for the Creation form

You can add the Document Sources from which document can be added for the project created.

7. Now create another Dashboard with any context that you need and choose the Button Block and link
it to the dashboard created earlier.

8. Save the Dashboard.

RS

o a

Creating Projects from Menu Layout

Similarly in the Menu Layout, you can create a Dashboard as stated above. Select the Button block in
the Menu Layout (with Bottom or Top or Left option).

Below screenshot shows project created from Dashboard.
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Create Project in Menu Layout using a
Project Creation Dashboard Label
Column Column Create A Project from Doshboard
@ create Project using Link to lean
_ o ican-WCR_ACAD -
| | ¥ Project from Dashboard
—_—l Link 1o
£~ Dashboard in Browser tab Dashboard -
h
3 Dashboard in pop up Dashboard
BLsacreate project - rd
K Dashboard in Menu Layout Open in
W Menu Lavout Placehalder Hei brawisentab -

Configuring list of Documents as Tables

Configure list of Documents as a Table

Dashboards can be configured and customized to show the list of Documents in different Table layouts
like List or Grid layouts. This functionality works only with Document Reference Attributes in Project
or Document contexts and with Documents and Document Reference Specifications in Tasks and
Approvals Context in Dashboards.

An Administrator user can configure a list of documents for any of the Project or Document or Task
information fields in dashboards as a table.

A Display Style option allows you to configure the list for the Information field as either a

« Simple Text: Shows only the name for the list of documents

- List Layout: Shows as table with the information shown in columns

« List Layout, with no headers: Shows as table with no headers

« Grid Layout, Thumbnail on Top: Shows list as blocks with thumbnails at the top
« Grid Layout, Thumbnail Left: Shows list as blocks with thumbnails to the left

« Card Layout: Shows the list as cards

When any option other than Simple Text is chosen for Display style, the below options are available.

« Configure Columns allows to configure the information in columns. Read in detail here

« Conditional Formatting allows you to set conditions based styles for display of the information.

« Configure Sources :allows you to configure Drop zones and Buttons for adding documents. Read in
detail here.

- More options open a popup where you can choose the layout options (similar to search results
Layout)

View and Edit Lists in Dashboard

Dashboards are enabled to show preconfigured lists ( like in Attribute Category page)and it can also be
made editable. This allows using the Dashboard as an input page with restricted values and also to save
the values from the dashboard.

Admin users can set this up in Dashboards with attributes that has list configured in Project or
Document or Task Dashboards where each of the attributes can be linked to a single list or column
combination.

To set up alist in Dashboard, follow all steps as provided here and add it to the configured attribute
category for the Project or Document or the Task that you wish to add the Dashboard.
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Functionalities like distinct values, filtering of linked attributes, anomaly handling, and task
specifications are available in Dashboards as well.

Options available in the Configure List window like

« Allow other values

» Autoselect Matching Values when other values are filled out outside of Attributes page(e.qg.
Workflow)

are also applied in Dashboards.

Project Dashboards setup with attributes that has lists configured, can be used as a landing page
to choose values from the dropdown in Projects, where the attribute category contains the same

attributes.
Country: I B x .
Market: HA p

Restricted Set: option 13

Value taken from
Restricted Set:

Document Reference:

Drop Files Here to Upload

Document Name Description Project Name City Country Market Restricted Set Value taken from Restricted Set

‘a e

Melbourne - Australia X - APAC option 1 X -

Cancel B save |

Similarly with Tasks and Document Dashboards, the same attributes have to be presentin the
Attribute Category of the Project, where the Task is executed or the Document that is present.

Note: Excel based lists are not compatible with Dashboards

Document Sources for Dashboards

You can create specified areas in Dashboard that can be configured to drop the documents, like for
example for Project Creation. You can configure document sources for the field when the layout option
chosen is not Simple Text. You can either have a Drop Zone or a Button configured as a document
source. You can select one of the type of Document Source in the dropdown and add or delete the
document source.

You can configure the document sources in the Dashboard with the Configure Actions & Sources
option.

Live preview of the configuration of the Configure Sources are reflected at the top of the window in
the preview area.

Buttons

Buttons can be configured with one of the following ways given below.
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Buttons
¥ Asget Management Connection
Browae

Saved Search

Dropzones

Upload

« Browse: Allows you to upload files from your system and you can specify the file extensions, along

WebCenter

Asset Management Connection Browse Saved Search

Configuration

Asset Management Connection
Label
Connection
Document Template
Folder
Popup Title

Primary Butten Label

with the Document Template and folder.

« Saved Search: Allows you to choose files from the Saved Search results where the name of the

Saved Search is shown in the pop up. Operations like Copy or Use by Reference are possible on the

document and you can specify the Document Template and folder. When the saved search with

SmartNames are chosen, the SmartNames are resolved and rendered.

« Asset Management Connection: Allows you to select one of the configured asset management
connection from the Connection drop down and update the connection details like the Folder,
Popup Title, Button Label. Currently WebCenter and MediaBeacon connections are supported.

Note: This option is available with advanced connect license only.

Drop Zones

Drop zones are designated locations in the Dashboard where you can add Documents to Projects or
Tasks either from a Saved Search or by uploading the document. You can add a document from a
Saved Search or upload the document. The documents from the saved search can be dragged and

dropped into the Drop zone configured.

Note: Document Sources option where you can create a Drop Zone or a Button are only available when
the Dashboard Function is set to Edit Form or Creation Form
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Drop zones can be presented with multiple versatile styling options in the dashboard. Extensive
Layout options, Spacing (Automatic/Compact/Wide), customizable label field, and the Icons can be
configured.

Styling Options

Layeut | Buttons below Label -
$pu|;|ng Automatic -

Labed and lcon Label and lcon -

Labal Draa filas for your new project ';L
)
2ipg
ltems shown as Counter with Popup -
Counter Color | #5cbaSc .

The added items can be shown as a table or the number of documents added can be shown in counter.

D20 Asset Validation
DacRef:

i

Documents added to Dropzone

You can configure the Drop zone to add the document from either of the options below

« Saved Search: Documents from the saved search can be dragged and dropped into a drop zone
configured to create a new project. The dropped documents are copied to the Document list. You
can also specify the operations on the document namely whether it is copied or used by reference.
Apart from this, you can also specify the document template and the folder.

« Upload: Add the document from the system. You can specify the following parameters for the
uploaded documents namely allowed file extensions, Document Template or Folder.

If there are multiple dropzone sources configured, then the dropzone are showed next to each other.
For both types of sources, it is possible to configure a custom translatable label and the order of the
buttons/dropzones.

Inline Document Actions

The inline actions that can be performed on the document sources can be configured in this tab for a
document list block. Live preview is updated to reflect the changes done and most document actions
are available.
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Configure Actions & Sources

Document Sources

Buttons &

Hower Actions

Approve

Approval Info

Add to Cart
Comment
Download

Lock

Mail Download Link
Mail link to

Open in ArtsosCAD
Remaove

Reect

Upload New Version
WView and Annatate
View in 30

Dropzones

Upload New Version

Configuration

Lakbel
lcon/Label
lcon

Color

Button Style

View in 3D

lcon Ondy

A Actions-2012

WebCenter

Each document action is shown in a row and can be set to either Visible or Visible on hover.

Uploading a new version of the document

You can upload new versions of the documents to the editable dashboard blocks with a configurable
button, provided you have the Update permissions on the document.
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Document Namae Description Project Mame
Li
°
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You can configure the document sources of the attribute dashboard block, either by

- adding the upload new version button to the document row (hover action) or
« inthe dropzone

Unsaved changes on the previous version are also applied on the new Document Version.

Note: Currently new version upload is not supported for page list documents and version comments is
required for all uploaded documents.

Remove

You can configure a remove button for the documents added. This button removes the document

from the document reference, but does not delete the document from the project. Similarly when the
remove button is used when uploading the document, it allows to cancel the ongoing upload of the new
version.

Configure Columns

You can configure the visible information of the table in the Configure Columns pop up window.

Configure Columns

Order Calumn Label Vizibility Editable Configuration
1 Document Marme Hamg of the Document ??‘ Wigible - .
2 Descriplion Details Vil Awailable -
3 Project Mame Vil fvailable -
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You can order the columns by entering the value in the Order field and enter customized column names
in the Label field. You can also set visibility of the field as Available or Visible. Fields that are allowed to
be edited, have the Editable check box next to it.

Configuration field shows if any additional configuration is present for the specific column. You can
also add or delete a column.
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5. Reports

You can derive a Report of selected parameters of a document derived by querying the database. You
can produce Tables, Pie Chart and Bar Chart in these reports and output them in PDF, DOCX, XML,
XLS, CSV, TXT, RTF and HTML formats. This feature uses the Jasper Reporting engine to create these
reports. You can customize the terminology, look, logo’s and the parameters.

Use Reports to:

« calculate averages and compare actuals to targets (KPI's).
« create charts, such as Bar Chart and Pie Chart.
- tocreateageneral report and related sub-reports.

The report is created based on a report template. There are built-in reporting templates available to
admin users. However, you can upload custom reporting templates as a JRXML file or as a ZIP file. If
you would like to add supporting files such as images and stylesheets, you can create a ZIP with the
JRXML file, images and stylesheets.

Using WebCenter Reports, you have the:

- Ability to calculate averages and compare actuals to targets (KPI's).

» Ability to create charts, such as Bar Chart and Pie Chart.

« Freedom onterminology, look, logo’s, amount of detail required to be displayed.

« Choice of report output to PDF, DOCX, XML, XLS, XLSX, CSV, TXT, RTF and HTML.

- Ability to create one PDF with a general report and iterate over a set of sub-reports

Note:

« You can create these reporting definition templates in iReport. Read more technical details about
thisin: Custom Reporting.

«  You need database access to derive these reports and if you are using WebCenter as a SaaS
customer, you cannot generate these reports yourself.

« |fareportis generated for a template containing background image in the DOCX format, then the
output will not have the background image.

You can access these reporting templates in Admin > Preferences > Reports.

System History Logs
All Report related events like

« Report created
+ Report deleted and
« Report changed

are recorded and stored in System History. Read this page on how to access the records.

5.1. Accessing WebCenter Reports

The WebCenter Reports feature can be accessed by an Admin or member of the Admin group.
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Login to WebCenter as an Admin user.
Click Admin > Preferences > Reports.
The Reports page appears with the list of available reports.

This page displays the report name, report actions, report description, last modified and the user
who uploaded the report (Creator). The Reports page also displays Upload Report, Download
Report, Update Report and Delete Report buttons.

Note: The built-in reports cannot be deleted.

Click the desired report name to go to report details page, where you can run the report.

5.2. Types of Reports Available

The WebCenter Reports comes with two default reports. The default reports have a typical WebCenter
look. However the report definitions can be downloaded and changed in iReport to a different look.

Note: Reporting is a separate license in WebCenter. Without this license you can only run the default
reports.

The default reports provided are as follows:

Approval Statistic (built-in) report: This report is on duration of approvals. This report has lots of
parameters to filter the report on customers, duration and influence on what is shown in the report
and how it is displayed.

‘WebCenter
o

e e [ |

—

2

Task Management (built-in) report: This report is on the duration of tasks. This report comes
with many parameters, for example to filter on a task type (showing all CAD Design tasks and
disregarding all other tasks).
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Attribute Category (Built In) Report: Built-in reports are available for Attribute Category in both

PDF and Excel formats.

By default, these reports are not enabled in the Project's or Document’s Attributes page. To enable

built-in reports follow the below configuration:

1. Download one of the built-in the reports

« Sample Attribute Category Excel - built-in report template for XLSX format
« Sample Attribute Category PDF - built-in report template for PDF format
2. Upload a new report as Default Attribute Category Report. You can also rename the report in

the name of the attribute category for which report has to be generated.

Download the built-in report and upload new report as name Default Attribute Category Report or
name the report exactly as the Attribute Category in the required Project or Document for which

report is generated.

To get a specific project or document attribute category as a built-in report, upload the template
ZIP file with the report name same as the project or the document attribute category name. Report

name can also contain optional suffix.

Example: If the attribute category name is - Doc Attr Category, then there can be multiple
reports with different names such as Doc Attr Category_PDF, Doc Attr Category_Excel, Doc Attr

Category_CSV.

Note: To change the template, download the Jasper Report template, update using Jasper Studio

and upload back to WebCenter.

You can also create a custom report using iReport tool. To create a new custom report, you can start
from a blank template, use the template provided by Esko, or just modify the built-in reports. Upload
these to WebCenter and then let WebCenter run the report. One report design is typically used over and

over again, for example to create a weekly or monthly report.

Note: To learn how to create such reports, read the CustomReport.doc document.
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™ New file X

T\ A report is used to display values from a data source lke a database or an XML file.
\ Select a starting point for your report of choose the wizard to guide you,

Report SINoLUeTe Lanascape simpie Biue A
# Tree Title
Style I -
i
p }l ' -
Chart Theme
Tree WebCenterTemplate
@ i T
Resource Bundle B

ﬁﬁ' Other file Types
Wood

Open this Template ][ Launch Report Wizard H Cancel

J

5.3. Configuring a Report

To configure a WebCenter Report:

1.

2,

Click on the desired report name link on the Reports page.
In the Reports Details page that appears, specify the Report parameters.

This can be very simple or very complex depending on the amount of parameters foreseen by the
report design. Most often, the time span on which to calculate the report is a parameter. But equally
so the report could accept a customer ID (a drop down of customers will be shown) or an option to
show more or less detail or what type of charts to use.

The mandatory fields (parameters) are marked by an *.
Under Report Output:

a. Click the Upload Report to Project check box, if you want to upload the generated report
directly to the required project folder. When it is not selected, the report is generated on the
User Interface.

b. Specify the report Document Name and output Format. By default PDF is the output format.

Note: XHTML format is not available if the Upload Report to Project option is selected.

In Report is visible for groups, select or enter the name of the groups that can run this report. To
remove a selected group, click the minus sign in front of its name.

In case the jrxml defines projectld as a parameter (with uiTypelD set to PROJECT), an additional
Project Report checkbox appears on the report details page. In case this option is enabled, this
report will only be used as a project report.

83



ESKO

WebCenter

You can also set which roles in the project(s) can run this report (in addition to the groups you
defined). This way it is possible to create a report that can only be run by the CSR or the SALES
person but not by other people (for example suppliers and other external people).

In Report is visible for roles, select or enter the name of the roles that can run this report. To
remove a selected role, click the minus sign in front of its name.

6. Click the Save button, to save the parameters. The next time you want to run this report, you can
use the same parameters. If you want to run the same report with two sets of saved parameters you
need to upload the report definition twice.

5.4. Running a Report

To run a WebCenter Report:

1. Click on the desired report name link on the Reports page.
2. Inthe Reports Details page that appears, specify the Report parameters.

This can be very simple or very complex depending on the amount of parameters foreseen by the
report design. Most often, the time span on which to calculate the report is a parameter. But equally
so the report could accept a customer ID (a drop down of customers will be shown) or an option to
show more or less detail or what type of charts to use.

The mandatory fields (parameters) are marked by an *.
3. Click the Run Now button. The report is generated as per your specification. The Report
Successfully created message appears in the Reports Details page.

Note: Itisrecommended to run Find Lost Documents built in report during off peak hours, as it can
utilize lot of system resources.

5.4.1. Built In Reports

84

Built In reports are system reports which can be usually accessed only by Administrators.
Administrators can view the report but it is not possible to update, delete or download the built-in
reports.

To view the built in reports, navigate to Preferences > Reports. Click on the report name to view the
report details page. Administrators can modify the Report Name, Description and select Groups which
can be provided access to run the report manually.

Groups which has permissions assigned, can access the reports from Search > Reports page.

Find Lost Documents Report

Alost document is a document in the project for which no files are found on the File Store. Either the
file has been removed from the File Store or the document is of the URL type.

The Administrators can run this report in the reports page by selecting the Find Lost Documents.

On running the report, the page displays an overview of Lost Documents. Number of lost documents
countisindicated at the top of the page.
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Note: Run this report during the off peak hours, as it utilizes a lot of system resources and may slow
down the WebCenter Application.

The Lost Document report is displayed in a tabular form in which the following details of each
document is shown:

« Document Name
« DocumentID

« Version|ID

« Version Number
« File Number

The user can go to the Document Details page by clicking on a Document Name.

Document Project History Report

WebCenter has a built-in report for Project History Report. You can run this report from the Reports
and select Project History Report.

On execution, Search Projects History page is displayed with an overview of projects. Administrator
users can see all the projects, while the other users can see projects they manage only.

Search History Project is displayed in a list with a sequence number, along with

« Project Name

« Description

« Project Status

+ Project Manager
« Creation Date

« Modification Date

To view a project history of any project, click the Project Name. You can filter the results on Manager
Last Name, Manager Group Name or Modified date or Project Status. You can also restrict the number
of records displayed in a page.

The order of the results can be changed by clicking on a column header in the results table or by
changing the Sort By option in the filter section. Select Print to print the report.

Sample Attribute Category Report
This is an built-in report that can be run by the admin users.

By running the report, you can download the list of all the attributes and its values along with the
document references. This report can be run for both project attribute category or document attribute
category.

There are two Sample Attribute Category built in reports based on the way it can be exported:

« Sample Attribute Category PDF : Best suited to get the reports in the pdf format along with
thumbnails for reference documents

« Sample Attribute Category Excel: Best suited to get the reports in sheets separately for each
document type

To generate this report for the first time:

1. Navigate to Reports > Sample Attribute Category (PDF / Excel).

2. Run Report page is opened.

3. You can select Upload Report to Project option and specify the project name, document name and
folder in which the report has to be uploaded.
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The report is generated in the format selected.
How to get the Attributes Report in the Attributes Page

Download Sample Attribute Category Excel/PDF (built-in) report from the Reports page. Upload it as
a new report with the name as Default Attribute Category Report to get the Attribute Reporticonin
the Attributes page of all the documents and projects which has attribute category specified.

Note: Attributes Reports can be accessed by any user based on the Reports permissions.

In case you want only specific Project/Document Attribute Category to get built-in report, upload
the template ZIP file with report name same as the Project/Document Attribute Category name. The
Report name can also contain optional suffix.

This report will show the label of the Attributes as defined in the Create New Attribute page and also
the last modified date of the attribute. If SmartName or internationalization is used for the attributes,
or the attributes is of Document Reference type, then only the attribute names are shown.

Example : If the attribute category name is Attributel, then the uploaded report should be named as
Attribute 1XXX

Attributes page in the Project/ Document with the specified Attribute Category will have the
Attribute Reporticon.

Note: If you want to change the template of the report, then download the Jasper Report template.
Update the reports using Jasper Studio and upload back to WebCenter.

5.5. Managing Reports
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The Reports page also helps you in managing the existing reports. You can Download Report, Update
Report and Delete Report using the inline buttons.

Note: The built-in reports cannot be deleted.

Reports

1 Upload Report

Report Description Creator Modified

Approval Statistic (built-in)-Testing 1 , W Atestreport ADMIN Dec 19,2013
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6. CHILI

You can edit your documents online using WebCenter - CHILI Publish integration.

6.1. Configure WebCenter-CHILI Server Connection

Administrator users can configure the CHILI server connection by navigating to Chili > CHILI Setup .

In the Chili Setup page, the following fields must be specified:

Name : Used to identify the CHILI setup

Address to the CHILI server URL example: http://chiliOT/CHILI/main.asmx

CHILI Share example: \\chiliOT\chilishare

CHILI Environment Name - name of the CHILI environment

User login/ User Password - user login and password (defined within the CHILI environment)

You can choose to select the following optional fields
» Use HTMLS5 Editor, to open the CHILI documents in HTML5 Editor.

« CHILI View in side by side Preview mode to open the side by side view (Document Attribute
Category and CHILI view side by side) from thumbnail. View in Preview Mode. When this option
is enabled,Show Content based side by side Preview option is visible to show PCM -optimized
view when enabled.

Users can also view the Attributes and the Chili document side by side in the Preview tab( which
can be customized )and this option requires Packaging Content Management and Chili license.

« Trimleading and trailing spaces from text before applying to CHILI Variable to remove any
extra spaces present in the text

- Exit CHILI side by side Preview after saving a new version When this option is selected, the
CHILI Side-by-Side Preview is closed and return to the previous page on saving the CHILI
document as a new version.

Note: Users can also view the Attributes and the Chili document side by side in the Preview
tab( which can be customized ) and this option requires Packaging Content Management and Chili
license.

On Save, the configuration is validated and stored in the WebCenter.

On the page, you also find a drop down Edit Alternative CHILI Setup: : Choose the CHILI setup from
the drop down of the configured CHILI setup instances. There is an additional option to Create New
Setup. You can setup multiple CHILI servers with this option and it is also possible to connect to the
same server with different settings.
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Note: Thisis required only if multiple CHILI servers are to be setup.

6.1.1. Chili Preview

You can preview the CHILI documents and edit its content when the View in Preview mode is enabled
in the CHILI setup.

When you click on the thumbnail of any CHILI document, you can preview the chili document along
with all the referenced contents and attributes (optionally) for the document side by side with the CHILI
editor. Preview of the document is exited or reloaded based on the selection made for the Exit CHILI
side by side Preview after saving a new version option in the CHILI Setup configuration.

You can also show values of a pre-configured document dashboard in the content block.
Following are the the hardcoded dashboard names.

o CHILI_SIMPLE_ATTRIBUTES: To render the attributes of CHILI document
o CHILI_TEXT_DETAILS: To render additional text details
« CHILI_IMAGE_DETAILS: To render image details

Note: This functionality is available with PCM license only.

6.2. Upload a CHILI Package

In the Document Types page, a new type “CHILI" will be added. This document type will only be visible if
the right license is purchased.

A CHILI Package has the .zip extension. When uploading a zip file in the single document upload page,
you will now get the possibility to select “CHILI Package” as Document Type. If you upload the CHILI
package with the extension .chp, it will be automatically recognized as a CHILI package, without having
to select it. However, this is not an official CHILI extension. It is a way to make the upload go easier(e.q.
it can be used for multiple file upload).

6.3. Locking behavior
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When a user is editing a CHILI document in the editor, the document will be locked automatically. The
document can be unlocked only manually, by saving a new version or by just exiting the editor without
saving your changes as a draft. When the editor is opened in read-only mode, however, the document
will remain unlocked.

When a user has no editing rights and has no specific workspace assigned, the document will be
opened in read-only mode. The editor will also be opened in read-only mode when the document is
locked by another user or if it's not the latest version of the document. In the read-only mode, the file
can still be viewed, but no changes can be made. The save buttons are not shown, but approval buttons
will still be shown to approver if an approval cycle is ongoing.
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The CHILI administrator is able to set up a customized read-only view. WebCenter will look for a
workspace named “Read-0nly” on the CHILI server. Only if that workspace is not found, the default
CHILI read-only mode will be loaded.

Note: Draft versions are saved as long as the document is locked. When the document is unlocked, the
draft version will be removed. To reset the document, the user can simply remove the lock and start the
editor again. To save the changes permanently, the user will have to save the document as new version.

6.4. Download CHILI Documents

A user may want (or be allowed by the Administrator) to download different kinds of output of a CHILI
document. Some will want to download the original CHILI package or the CHILI XML, while others want
download a PDF file. An artwork creator will want the XML to update the master Illustrator document.

When the user wants to download a CHILI document, a page with the available formats will be shown.
Users can have different permissions for different download formats. The ‘CHILI Package’ format is the
default optionin places where an explicit choice of a target Download Format is not available. If a user
has none of the available Download Formats enabled for CHILI document type, he will not be able to
download a CHILI document from within any Project.

The different download types are also supported in the SDK. A new parameter was introduced for the
DownloadDocument.jsp SDK call

downloadtype: Name of the download format to download. If it is not specified, the default download
type will be used.

Example:

http://mywebcenter.mycompany.com/WebCenter_Inst/DownloadDocument.jsp?
username=myusername&password=YWJjZGVmé&docversionid=00002_0000000018&downloadtype=PDF

Note: When a document is being edited (has a draft version), the downloaded version will not contain
the changes of the draft.

Setup of different download types for a CHILI WCR Document

In order to maintain a highly secure environment - enabling/disabling CHILI Download Formats is only
available for an Administrator user and is done for individual User/Group at a single moment. User
settings can be derived from a sum of Groups Download settings for all the Groups that the Useris a
member of.

When a new Download Type is defined on the system level it is initially disabled for all Users and Groups
in the system.

There are two levels of enabling or disabling CHILI download types. You can either do this system wide
or per user/group.

If you want to disable or enable a download type system wide, you can go to the page “Admin > CHILI >
CHILI Download Types”, where you have a checkbox with the available Download types. A default setup
will have three download types pre-installed which are all enabled by default:

« Chili Package
«  CHILIXML
. PDF
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For the PDF output, PDF Export Settings named '‘Default' must be defined at the CHILI server. An
additional column is displayed at the 'CHILI download types' page with the name and availability check
(icon) of the PDF Export Settings at the CHILI server.

If you want to set it per user or group, go to the user or group section and click on the user/group you
want to give download rights. Then go to the download tab. You will see that the section CHILI Package
is added, where all download types that are enabled system wide can be enabled or disabled (disabled
by default) for that user or group.

For a user, if you click on “Use Group Permissions”, the CHILI download types are also updated with
those of the groups the userisin.

6.5. Dynamically assign workspaces and constraints to CHILI
Documents

CHILI workspaces can be assigned dynamically by matching workspace names with role names. When
auserisassigned toarole in the project the CHILI document is in, WebCenter will look if the CHILI
server has a workspace with the name of that role and assign that workspace upon loading the editor.
E.qg. If the user has the roles “Approver and the CHILI server has a workspace “Approver”, the CHILI
editor will be opened in workspace "Approver”.

If no workspace was assigned to the user, and that user has edit rights, WebCenter will look for the
workspace name “Default” and assign it to the user. If the workspace “Default” was not found, the editor
will openin real-only mode. If a user has multiple workspace/constraint matches, the user will have to
select a workspace before the editor opens.

Note: For linked documents, the available workspaces are accumulated.

6.6. Loading Assets into the CHILI Editor
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An asset is a WebCenter document that is uploaded in the project document library. At the Project/
Template > Configure > Document Templates page, an administrator user can select a project or a
template to serve as a document library.

For the CHILI document, documents from the document libraries of all projects the current document
version is linked to can be used as assets. The documents/folders will be filtered out by the WebCenter
security settings. In case of a project document library, the user must have download rights for the
document/folder, to be able to use it as an asset. There are no restrictions on using documents from a
template document library.

The external assets panel shows a tree structure, where each project/template represents a top level
folder. For each document/asset a thumbnail is shown.

To set this up, the CHILI administrator has to add an "External Assets" panel within the workspace and
leaves point the "Directory List URL"and "Asset List URL" to the WebCenter SDK with the following calls.

Directory List URL:

http(s)://[<WebCenter_URL>/<WebCenter_Instance>/GetDocLibraryDirectoryList.jsp;jsessionid=
%qs_sessionid%?docversionid=%qs_docversionid%
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Asset List URL:

http(s)://[<WebCenter_URL>/<WebCenter_Instance>/GetDocLibraryDocumentList.jsp;jsessionid=
%qs_sessionid%?folderid=%id%&documentid=%qs_documentid%

Note: We don't support "Search URL" and "Post URL" options. Note that these calls can also be used for
image variables pointing to external assets.
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7. Project Management for Administrators

Most Project Management tasks in WebCenter will be carried out by dedicated members with the
Project Manager role.

However, Administrator users have some additional options: they can view and edit all Projects, create
project and document Templates, and Find Locked Documents in the system, so they can reset them.

7.1. Projects

The Project Management page (Admin > Project Management > Projects) lets members of the Admins
group manage all projects in WebCenter.

For more information about managing projects, see the WebCenter User Guide.

71.2. Project Templates
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Members of the Admins group can create and configure project Templates. Those are pre-configured
projects that Project Managers use to quickly and easily create new projects.

You can manage all project templates from WebCenter's Templates Management page (Admin >
Project Management > Templates).

« Click Create a new template in the header to create a new project template.

Note: You can also save a project as a template.

« Click the name of an existing template to edit it.

« Todelete atemplate, select it in the list and click Delete in the actions menu. Click OK to confirm
the deletion.

Note:

If you try to delete a template with a custom document creation setting and if this template is being
used by other projects / templates, you will get an error message.

Go to the relevant projects/templates configuration tab and select another template before trying
to delete.

System History Logs
All Project/Template related events like
+ Project/Template created
+ Project/Template deleted
« Project/Template imported
« Project/Template restored

are recorded and stored in System History. Read this page on how to access the records.
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7.2.1. Create a Template from Scratch

oo s

5.

Click Admin > Project Management > Templates, then Create a new template.

In the Create a new template page, select Start from a Blank Template and click Continue.
Enter the Template Name and optionally a Description.

To use a custom thumbnail, select Specify New Thumbnail and Browse for it.

To use the default thumbnail, leave that choice selected.
Click Finish.

Your template is created. You can now define Attributes, Upload a document to the template, Add
project members.

7.2.2. Create a Template from a Project Template

Click Admin > Project Management > Templates, then Create a new template.
In the Create a new template page, select Use a Project Template and click Continue.
Select the Template to use and click Continue.

Tip:
« Use thefilter to only show certain templates. For Project Manager users and Project Creator
users with limited visibility only the templates applicable are shown.

« Click atemplate to view its details in another window. Click Close Window to return to the
Create a new template page when you are done looking at the template details.

4. Enter the Template Name and optionally a Description.

7

Choose the Thumbnail to use:

» Touse anew thumbnail, select Specify New Thumbnail and Browse for it.

» Touse the default thumbnail, leave that choice selected.

« To keep the thumbnail of the project template you are using, select Use Template Thumbnail.
You can Invite Members and also create a new user to the project. To do this, Select New Project
Members drop down and scroll down to Create and Invite New User.

Click Finish.

Your template is created. You can now define attributes, upload a document to the template, Add
project members.
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Note:

« The project template is created with the same folder structure, documents, characteristics,
attributes, discussions, members, and security as in the original template.

« Anydocumentsin the template are copied into the new template as new standalone documents,
even if they were linked documents in the template.

« Any documentsin the template are copied into the new template as new standalone documents,
even if they were linked documents in the template.

7.2.3. Save a Project as a Template

1.2.4.

1. Create the project as desired, or open an existing project.
2. Onthe Project Details page, click More actions and Save as Template.
3. Enter the name of the template and a description in the appropriate fields.

To use a custom thumbnail, click Specify New Thumbnail and enter the complete path and filename
in the associated field or Browse for it. To use the default thumbnail, leave that choice selected.

4. Click Finish.

The template is created.

Configure Project Creation Terminology
It is possible to change the terminology used for project creation so that the Project Creation page
talks about "Designs" instead of "Documents”, or "Client" instead of "Customer”, for example...

You can achieve this by customizing the terminology in the attribute category of the project or
template used as a basis for project creation.

You need to:

1. Make an attribute category with custom project creation terminology.

1 Attention: Your custom terms will not be automatically translated, and will show as you
enter them for all languages in which you run WebCenter.

2. Make a project template (or a project that will be used to create other projects) using that attribute
category.

Users creating projects from this project template will see your custom terminology on the Project
Creation page.

7.2.5. Configure Customized Document Rendering in projects
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You can configure the Upload Document section, when a new project is created from an existing
project or a project template. Ensure that the upload document is enabled in the Project Source or
Project Template.

To customize the upload document section in the Project Creation form, navigate to Projects >
Configure > Document Rendering in the Project Source or Project template.
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You can read on how to customize at Create an Advanced Table Rendering on page 319.

7.5. Document Templates

As an Admin, you can create and configure Document Templates. These templates will serve as
"dummy" documents (placeholders) that have a document type, file format, and attributes already
specified. This information will be useful to real-life projects.

Those document templates will be used by Project Managers / other users to create document
placeholders for future project documents.

For example:

1.

2.

You (the Admin) create a Document Library Project containing the document templates, and project
templates referring to that document library (see Create Document Templates on page 95).

When creating a project from one of these project templates, the Project Manager will create
placeholders from the document templates, to mark where the project deliverables should go.
When using the Upload function, a project member (with the Add right) can also create a
placeholder from a document template, to indicate the characteristics (document type, file format,
and attributes) of the final document to be uploaded.

Note: This is only possible through the normal WebCenter upload (see Uploading a Document
via Upload and Copy / Create Multiple Documents), not the Java applet upload or when uploading
documents from other applications like Automation Engine and ArtiosCAD.

7.3.1. Create Document Templates

1.

Create a Project Template that will contain all your document templates (this will be your Document
Library).

Having all the document templates in one location makes them easier to manage, and saves disk
space.

If desired, create a folder to contain your document templates.

Note: If the project in which placeholders are created contains a folder with the same name, that
folder will be used as default destination for the placeholders.

To create document templates:
a) Upload a document of the right file format into the Document Library.

You can use any document type (enabled in the Preferences) except Page Lists.

b) Define attributes for your document template: choose an Attribute category and fill in default
attributes values.

Note: When users will create documents from this document template, they will inherit these
attributes (and default values).

c) Repeat for all document templates you want to create.
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Tip:
- |fyouwant a document template to always be used when creating placeholders of a certain file
type, callit Default.<extension>, using the extension of that file type.

For example, call it Default.pdf soitis always used when users create . pdf placeholders(in
projects using document templates from the Document Library).

- You can also create a generic document template called De fault (without the extension), that
will be used automatically for file types who don't have a Default.<extension>template
associated.

For example if a user wants to create a . png placeholder but there isno Default.png
document template in your Document Library, then the Default template will be used.

4. Create a Project Template for each kind of project that will be required by Project Managers.
5. Ineach of these Templates configure the Document Library as follows:

a) Inthe Project Details page, Configure > Document Templates.
b) Select Project or Template and select your document template library from the drop-down.

Documents Tasks Attributes Project Information Approva Members Security Configure
Workflow Connection Document Templates  Project Creation  Document Types ~ Document Creation Project Statuses
Please select the Template or Project that will serve as a Document Library
Do not use a Document Library
Template
® Project | PCM Text Templates v
When the Document library contains ARD files, how do you want to use these ARD files when creating a new Document?
® Always run the ARD as a standard

Run the ARD as a standard when the IsStandard Attribute is set to 'yes'

Never run the ARD as a standard

c) If your document library contains ARD files, and you want to use them to run ArtiosCAD
standards, select either:

« Always run the ARD as a standard if you want to be able to use any ARD document template
in the document library to run a CAD standard,
« Run the ARD as a standard when the IsStandard attribute is set to 1if you only want to use

some ARD document templates to run CAD standards.

These ARD document templates must have the IsStandard attribute assigned, with the
default value setto 1.

Select Never run the ARD as a standard if you are not working with CAD standards.
d) Click Save.
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Projects created from one of those project templates will keep the project template's link to the
document library.

Project Members can then create placeholders from the document templates in the document library.

Note:

If you know that the Project Managers will always use the same set of placeholders in all their projects,
you can also:

1. Create adocument library Project Template.
2. Add Document Templates to the Project.

3. Go to Project Details > ConfigureDocument Templates and select the same Project in the
Templates list.

4. Project Managers can create projects directly from this Template to have the Document Templates
as placeholders.

Note that this approachis less flexible!

1.4. Project Creation Settings

As an Admin user, you can configure the Project Creation Settings for a project or template. You can
find these settings in the project or template's Configure section, under Project Creation. These
settings define what is displayed on the Project Creation Page when you create a new project from
this project or template.

First of all, you can choose whether you want to Use Auto Naming and define the naming scheme.

Furthermore, you can choose what features are displayed on the Project Creation Page. You can
choose the following options:

« Set Project Manager: Show/hide the project manager selection on the project creation page. If
you hide it, the project manager will be the same as used in the template or parent project. If you
choose to show this section, it will default to the person creating the project.

« Set Status: Show/hide the project status selection on the project creation page. If you hide the
project status, the new project will be created using the first available active project status.

« Set Customer: Show/hide the customer selection. You can make this a required field. Hide this field
to use the customer set in the source project or template.

« Set Description: Show/hide the description field. You can make this as a required field.
« Set Due Date: Show/hide the due date selection. You can make this as a required field.

« Upload Documents: Show/hide the documents section. You can make this section required, so that
the project creator has to add at least one document.

Note: You can configure the document upload section in the source project or the project
template. Refer to Configure Customized Document Rendering in projects

« Assign Roles: Show/hide the role assignment section. You can decide for each role whether it is
required to assign a group or user to it and/or whether you can assign multiple users or groups to
this role.

« Invite other members: Show/hide the members section to enable/disable adding additional
members to the project.
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Note: When the Admin Users or the User creators assign Roles, deactivated users are shown in
the drop down who can be activated and added to the project. User creators have access to only
activate the users they created, whereas admin users can activate any deactivated users.

« Set Attributes: Show/hide the attributes section. You can show or hide the creation view of the
project attributes of the source template or project.

« Select Thumbnail: Show/hide the project thumbnail section. If you hide this section, the thumbnail
of the source project or template will be used.

« Set Planning (Tasks): Show/hide the task planning section. You can make these fields required.

« Default Planning Method: You can set the default planning method to Forward or Backward. Even
if the Set Planning section is not displayed, the setting you choose here will be used for the new
project.

7.5. Document Creation Settings

As an Admin user, you can configure the Document Creation settings for a project or template. You can
find these settings in the project or template's Configure section, under the Document Creation tab.

When a project manager creates a project based on a template or an existing project, you can add
Documents using the Default options or Custom options.

You can create a custom document creation set up in your template. In this setup, for each row in the
configuration, a link is added to the specified section in the same order.

» Default
The default document creation options will be:
+ Browse
- Copy

« New(when atemplate library is configured)

Note: New document creation is only possible if a Document Template library is linked in this
template.Read more in: Create Document Templates on page 95.

« Another Template's Document Creation Setup
Use this to copy a setup from a template with a custom document creation set up.
« Custom

When you select this, you will see a list of customizable options:

Source Where the document will be sourced from.

Label The link description. You can create a custom label, suchas Upload a
graphic file.
- Standard
« Simple
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- Translated

Details Additional information such as:

- Allowed Extensions

« Document Template Selector

Here you can select the already specified document templates. Read
also:Document Templates on page 95

Operation The operation depends upon the Source button. For example, if you have
chosen Project+Folder, the operations would be Copy, Move or Link the
document

Sections The configured upload source is made available in these sections. By default,

all the options will be available and enabled. You can deselect the sections to
disable some of the locations.

« the Project Creation Documents
- the Project Creation Bill of Materials
« Bill of Materials

- Upload (Copy or Create Multiple Documents)

Note: You can also drag and drop multiple files onto an Upload button.

Target The destination folder

Folder

To add a new source type, click Add Document Source. The document sources in the list can be
deleted by clicking the delete icon.

You can configure:

a simple Browse link for the user to upload a document.

Note: You can also drag and drop multiple files to the upload button.

Document Templates from the template library. This will serve as a place holder with pre-
configured settings such as attribute categories. Read more about templates in Document
Templates on page 95.

Current Project

Saved Search: Use this option to allow the user to select a file from a saved search. When the user
clicks the document reference as a link (with a custom label), saved search results will appear in a
pop-up with all the configured options.

Asset Management System: Use this to allow selecting a file from the configured Asset
Management Systems. Read more in Configure Asset Management Connections on page 372

If you want to delete a template with a custom document creation setting, make sure that it is not
being used by other projects/templates for document creation. If it is being used, you have to select
another template in the relevant projects/templates before attempting deletion.
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7.6. Document Types

As an Admin user, you can configure settings for each of the Document Types for a project or template
in Configure > Document Types. These settings define what happens when you add documents to your
project.

The settings are organized per Document Type. Per type you can set the following options:

« Automatic Document Naming: Use this setting to enable/disable autonaming for a specific
document type. Choose None to disable autonaming. Choose Default to use the system wide
autonaming settings or choose Custom to enter a specifc naming scheme for this project or
template.

- Default Attribute Category: Use this setting to assign an attribute category to a specific document
type. Choose None to not use a default attribute category. Choose Default to use the system wide
settings or choose Custom to select a specific attribute category.

« Start Task for new Documents: Use this setting to start a task of the specified type when adding
adocument to the project. The task is automatically started, assigned to the uploader and the
uploaded file is linked to the task. Choose None to not start a task upon upload. Choose Default to
use the system wide settings or choose Custom to select a specific task type.

« Start Task for new Versions: Use this setting to start a task of the specified type when adding a
new versions of a document to the project. Choose None to not start a task upon upload. Choose
Default to use the system wide settings or choose Custom to select a specific task type.

1.7. Create Project Thumbnails Automatically from
Documents

As an Admin user, you can configure a setup to create automatic thumbnails from the document
images.

When a new graphics or CHILI document is being uploaded to a Project or Template, the user will have
an option to check if the document image needs to be taken as the Project Thumbnail.

If this option is checked, the Project thumbnail will be set as the document image after checking and
registering.
1. Create a text Attribute called Make Project Thumbnail.
2. Set Values to Restricted Set.
Create the check box by entering Yes and No as values of the restricted set. The values are case

sensitive.
3. Create an Attribute Category and include Make Project Thumbnail in the attribute.
4, Create aProject Template.
5. Inthe project template, go to Configure > Document Types.
6. Specify the Default Attribute Category as the Project thumbnail Attribute category for the desired

document types.
The user has to select Make Project Thumbnail during the upload of documents to use this feature.
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Attributes: Hame Value Type

Malke project thumbnail WES OF No

Note: When multiple documents in a project have the attribute MAKE PROJECT THUMBNAIL set,
each upload overwrites the previous thumbnail in the natural sequence they happen. In case of
multi-document upload at the same time, thumbnail can be set from any of the document based on
the sequence they are returned from OBGE.

If the documents are published from Automation Engine, (when the view files are generated on AE
and not on the OBGE), then the project thumbnail will not change.

Changing the project thumbnail on upload is guaranteed to work, only if the upload is through
WebCenter.

7.8. Deleted Projects and Templates

Admin users can view the list of deleted projects or templates in the system by navigating to Project
Management > Deleted Projects and Templates.

The list is by default sorted by modification date showing the most recent deleted project first but

sort can be performed on any other columns as well. The filter section at the top allows searching

for particular projects. You can click on the project name to see the history of the deleted project/
template containing all the events logged during the life cycle of the project/template, for example who
deleted the project. The deleted projects and templates are only shown until the cleanup tool is run.

7.9. Project Statuses

The Project Status feature allows you to review the current project standing. This feature can be
accessed by an Admin user or a member of the Admin group, Project Managers and an User.

An administrator can add statuses in WebCenter. This works similar to task statuses (whereas the
statuses are not shared). A status has a name, an icon and a type. The types are Non-active, Active,
Archived and Completed. The WebCenter has the functionality to limit the actions possible in not-
active and completed projects. It is most typical to add active statuses, for example: Briefing, Design,
Prepress, Printing. An administrator can limit the statuses for a project and this can be done for every
project individually.

The project status is displayed in the project header (and in available other locations such as search):

Note: This can be set asread only. Read more atPrevent direct changes to Project Status on page 110
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Project: Lumi+ Purple [[Euchd

Manager: Keizer, Debbie (DEKE)

Cust :
s+ Upload Multiple Documents ustomer
Due On:

Mail link to Modified: Jul 1, 2016
More...» Description:

The Project Manager can perform following:

« Setthe Project Status.
« View Project Status.
« Search Project Status and Filter projects based on Project Status.

An administrator can limit the statuses for a project and this can be done for every project separately.
Go to a project or a template as an administrator and click on the Configure tab. By using Add Project
Statuses and Remove Project statuses (select with the check boxes and take remove from the action
drop down), you can get a specific set of statuses.

An Administrator can link milestones to project statuses to see the timeline of projects in a calendar
view by setting up a date/time attribute for project statuses. Each active status can have a date/time
attribute linked and the same date/time attribute can be used multiple times with different offsets.
The linked date indicates the intended end of the project phase, but will not trigger an automatic
project status change. The actual date will depend on the related attribute value in the project context.

The administrator can decide the sequence of the statuses. This sequence is purely used for sorting.
When the projects are sorted based on Project Status, this is the sequence used. The sequence is
system wide.

Apart from showing the Project Status in many project overview pages (and also in the search results),
the project statuses can be used in the Workflows. For example: To decide different operations or
assignees depending on the current project status.

Note: By using the Set Project Status node in Workflow, you can set the status for the current project.

In the following example, let us consider five statuses allowed for this project. The Project Statuses
are set as 01- Briefing, 02 - Concept, 03 - Artwork, 04 - Prepress and 05 - Closure. The WebCenter
has many more statuses, but only these statuses are allowed for this project. The statuses are in this
seqguence in the entire system.

Note: You can only decide per project whether you can have these statuses, but you cannot change
the sequence of the statuses per project.
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Project: Lumi+ Purple LERSRNTYSIEEES
+ Upload Manager: Keizer, Debbie (DEKE)
. Cuss G
st Upload Multiple Documents ustomer
Due On:
Mail link to Modified: Jul 1,2016
More...» Description:
Documents Bill Of Materials Tasks Discussions Characteristics  Attributes Project Infermation Approval Motifications Configure More...~
Workflow Connection Document Templates  Project Creation ~ Document Type Document Creation  Project Statuses
== Add Project Statuses
Name Active Color lcon
01 - Briefing (Complete) Active Il Esko Green Concept > Artwork > Prapress > Closure )
02 - Concept (In Progress) Active . Esko Green Briefing Concept > Artwork > Prepress > Closure >
03 - Artwork (In Progress) Active B Esko Green Artwork > Praprss > Closure )
04 - Prepress (In Progress) Active . Esko Green Briefing Concept. Artwork
05 - Closure (In Progress) Active . Esko Green Briefing Concept Artwork Prepress m

A new Project Status type has been introduced called Archived. You can set this status based on the
stage of the project. Archive Project status is visible to users based on the setting specified by the
Administrator in the Security Preference.

Read more on Project status as Archived here.

On archiving the Project, the project is excluded in the Project list and is not shown in the My Projects
or Project | Manage menu items. The Project as well as the Tasks and Documents within the project
does not show up in Search Results or in My Work page.

Trying to access the Project with an URL from a notification for an archived project gives a permission
denied message.

7.9.1. Viewing a List of Project Statuses

The available Project Statuses can be viewed in the Project Status page. In the Project Status page,
you can add, edit or delete the Project Status. You can also choose or add an icon, add a custom color
for the Project Status and decide the sequence of the statuses. When you use custom colors, text
colors on the Project status is automatically adjusted to make it visible.

To view Project status, navigate from Admin > Project Management > Project Status. The Project
Status page appears.
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[ Display Order Name Language Key Active
1 Non-active PS_NONACTIVE Non-active
0 =z Briefing [ | Active
o s oA | [ | active
0 Files uploaded by suppll| | | active
O s Imaging to plate | | active
[mi Waiting for Gonfirmatior| [L_WAITING_FOR_CONFI| Active
o 7 Miarkiert | [ | active
[m Template Uploaded | | | active
[ a Projact Created | [ | Active
0O 10 Stepping in progress | | | active
[miRET Waiting for Artwork | [LZWAITING_FOR_ARTWI| Active
0 1z Artwork creation | [ | Active
0 13 Client Agproval | | Active
O s SOBK Status] | [ | mWon-active
15 Active PS_ACTIVE Active
[miET SOBK Status2 | | Active
o 7 MASTER_COMPLETED | [PS_COMPLETED | completed

System History Logs

Color

Light Gray

Esko Green

Brown

Dark Red

Fed

Light Blus

Magenta

Vialet

Custom

Elue

Custom

Esko Green

All Project Status related events like

are recorded and stored in System History. Read this page on how to access the records.

Project Status created

Project Status deleted and

Project Status changed

7.9.2. Adding a Project Status

-l

- |-

Ll

©

oA
Files uploadad by supplier

maging to plate

e

s
Template Uploaded
Project Created

Stepping in progress

e .

Artwork creation
client Approval

SOBK Status1

i

SOBK Status2

© QO 0

WebCenter

File
select leon | Choose File | Mo file chosen
Select keon | Choose File | Mo file chosen

seleeticon | Choase File | o file chosen

Select icon | Choase File | Mo fil= chosen

Select lcon | Choose Fils | Mo fils chosen
Select icon | Choas File | No file chosen

Select lcon | Choose Fils | Mo file chosen
Select leon | Choose File | Mo file chosen

Selectlcon | Choase File | Mo fils chosen

Select lcon | Choose File | Mo file chosen
Select lcon | Choass File | Mo file chosen

Select lcon [ Choose File | Mo file chosen
Seloct lcon | Choose File | Mo file chosen

Select lcon | Choose File | Mo file chosen

Selecticon | Choase Fila | Mo file chosen

Select icon [ Choose Fila | No file chosen
Selact lcon | Choose Fila | Nofile chosen

You can add a new Project Status through the Project Status page. You can also choose or add anicon,
a color for Project Status and decide the sequence of the statuses.

1. Click the Add Status button on the Project Status page.
2. Inthe New Status page, type the Name of the status and select the Project Status type.
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You can add multiple statuses at a time. When the new status is marked as Active, it is added just
behind the previous active status. When the new status is marked as Non Active or Completed, it is
added at the end of the Project Statuses list with no rules applied.
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3. Click the Save button to make changes. The Project Status page appears with the new status.

New Statuses

E3 Clear this Form
# Mame
0 Project Started
Project In Progress
2 Project Discussion
3 Project Testing

4 Project Completed

10

m Cancel

WebCenter

Project Status Type

Active

Won-active

Active

Active

Completed

Select

Select

Select

Select

Selact

Select

L

Note: The new status will get a default color and no icon added to it. This can be changed in Project
Status page.

7.9.3. Editing a Project Status

You can edit the existing or newly added Project Statuses through the Project Status page. In the
Project Status page, you can change the Name, Language key, Sequence number, Add Icon and Set

Color.
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Project Statuses

4 Add Status

W Delet

Display Order Name Language Kay Active Color
1 01 - Briefing In Progress Active Esko Green
2 01 - Briefing At Risk Active Orange
3 01 - Briefing On Hold Active Red
4 01 - Briefing Complate Active Dark Graen
3 02 - Design In Progress | | Active Esko Green
[ 02 - Design At Risk | | Active Orange
7 02 - Design On Hold | | Active Red
a 02 - Design Approval Active Light Blug
] 02 - Design Complate Active Dark Green
10 03 - Artwork In Progress) Active Esko Green
1 03 - Artwork At Risk Active Orange
12 03 - artwork On Hold Active Rad
13 03 - artwork Approval Active Light Blue
14 03 - Artwork Complete Active Drark Graen
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leon File

v Briefing In Progress select lcon

v Briefing At Risk select lcon
C o R | ot
* Eriefing Complete Select lcon

N | Deslign In Progress select lcon
M Design At Risk Select lcon
* m Select lcon
v Dreslgn Approval Salect lcon
* 1l Select lcon
| Artwork In Prog ress Select lcon
A Artwork At Risk Select lcon
* H m Select leon
- Artwork Approval Select lcon

AN | Artwork Complete Select lcon

Chooge File

Choose File

Choose File

Chooge Fila

Choose File

Choose Fila

Choose File

Choose File

Choose File

Choose File

Choose File

Choose File

Choose File

Choose File

Type the sequence number in the Display Order column to change the sequence number. The change
in sequence number appears only after saving the changes.

The language string key has to be added to the XML formatted language key file (wcstrings_<2
character IS0 language code>.xml for English: westrings_en.xml) for all used languages. By default the

language (en) has to be added.

Note: The language key field is not mandatory. If you want all languages to follow the same names (Not
translated stage names), you leave the language key field empty.

Type the Name of the Project Status to change the Project Status name and click the Save to make

changes.

The new status will be set to Esko Green as default color. You can select a Color for a dropdown for
each project status. This color will be used in the calendar-view of the project overview.

Note: You cannot add your own new color.

Once you select the required color from the drop down list, click the Save button to make changes.

Here, the Color is changed to Re

Project Statuses

Changes were made since last Save

Display Order Name Language Key
1 01 - Briefing In Progress
2 01 - Briefing At Risk

d.

Active Color Icon File
Active Esko Green ME | Briefing In Progress Selectlcon | Choose File | No file chosen
Active Red e | Briefing At Risk SelectIcon | Choose File | No file chosen

Mo file chosen

Mo file chosen

Mo file chosen

Mo file chesen

Mo file chosen

Mo file chosen

Mo file chosen

Mo file chosen

Ma file chosen

Mo file chosen

Mo file chosen

Ma file chosen

Mo file chosen

Mo file chosen
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You can change an icon for the exisiting Project Status in the Project Status page. The Project Status
icon can selected from the Icon Gallery or you can also upload an icon. WebCenter allows JPG, JPEG,
GIF, BMP and PNG files types as icons.

Note: The Ul is optimized for an icon height of 16 pixels. Icons will be placed in overviews without any
scaling.

Click the Select Icon button, to select the required icon from Icon Gallery.

In the lcon Gallery window, select an icon via the radio button and click the OK button. The gallery
allows filtering of icons by its name.

Icon Gallery

Total: 400 Fier | |

Briefing AtRisk | 01-Briefing At Risk png

01-Briefing Complete.png
ariefing In Progress  01-&riefing In Progress png
BEAINGIONIEIl  01-&riefing On Hold.png
Design Approval | 02-Design Approval.png
Design AtRisk | 02-Design At Riskpng
02-Design Complete.png

Designin Progress  02-Design In Progress png

Click the Browse button to upload an icon of your choice. The icons can be re-used for other statuses.

Note: You can change the icon of the built-in Project Statuses. When noicon is set, the name of the
status is used instead.

7.9.4. Deleting a Project Status

You can delete a Project Status and this status will be marked as deleted/obsolete in the WebCenter
database. When a project status is marked as deleted, it will no longer appear in any of the locations
where a Project status can be selected. The Projects and Templates having the deleted status will still
keep this status. You can however no longer change projects to the deleted status. To delete a Project
Status,

1. Select the required Project Status and click on Delete in the Actions menu.
2. Click the OK button to confirm the deletion.

7.9.5. Customizing a Project Status
An Administrator can set allowed statuses for Templates or for Projects. By doing this an Administrator

can limit the number of Project Statuses to be used for a specific project. When adding a new project
status to the system, this status will be also added to all projects and templates. When a project is
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created from a template or from another project, it inherits the allowed statuses from its source. This
happens only once and does not happen when the template changes later.

1. LogintoWebCenter as an Admin user.

2. Click the Admin > Project Management and select Projects or Templates.

3. Click the required Project or Template link from the list.

4. Click the Configure > Project Statuses. This displays a table with the current allowed statuses for
this Template or Project.

5. Select the required Project Status from the list and then click the Add Project Statuses link.

Note: By default a blank Project will get the list of all statuses as allowed statuses.

6. Click the Save button to make changes.

Note: The Project Status cannot be re-ordered here, the order is inherited from the system order.

You can remove allowed statuses for a template or project by selecting the status and select Remove
from the Actions menu.

7.9.6. Searching based on a Project Status

You can search for projects based on their Project Status. Choose Search from the menu bar and
select Project or Tasks and Approvals. On the (advanced) Project Search page and the Task Search
page, the list box will contain the list of all the Project Statuses.

In addition to all individual project statuses, the list also contains the following:

« Show All(default): show all projects (or tasks of all projects).

« Show All Active: show only projects or tasks of projects with an active status.

« Show All Not Active: show only projects or tasks of projects with a non-active status.
«  Show All Completed.

108



ESKO

WebCenter

Project Name

Description
Project Status Show all |1
|
Created Show All Active v
Show All Not Active
Show All Completed
Modified | nop-active v
Active
Due Concept Art (at risk) v
Briefing (at risk)

Briefing (on track)
Customer/Location | Cancept Art (on track)
Lancement
PAD Contrile
Erreur Contrile
En attente Lancement
Project Manager | PAO Contréle OK
PitStop oK
PitStop Avertissement
Pitstop Erreur
En cours de traitement
Add Role | Naouvelle Soumission = ||

Salesperson

Manager's Location

Attributes...

You can also search on Project Status Started, Project Status Due Project Status Completed, Project
Status Duration, and Project Status Time Left in the Project Search page.

7.9.7. Filtering based on Project Status

In Favorite Projects, Projects | Manage, and in Projects | am Invited to, you can filter on all Project
Statuses individually. You can also use the filters to look for a combination of statuses: Show All, Show
All Active, Show All Not Active, Show All Completed.

7.9.8. Archiving Projects

Project Status -Archived

A new Project Status type has been introduced called Archived. You can set this status based on the
stage of the project. The visibility of Archived projects depends on the setting chosen by the Admin
user in the Security Preferences. Admin user has an option to allow non-admin users to view the
archived projects.

Visibility of Archived Projects

Archived projects are visible to Admin users by default. Visibility to archived projects for other users
are set optionally by the Admin users in the Admin > preferences > Security Page. Enabling Allow
non-administrators to see Archived Projects option makes the Projects in Archived status visible.

Note: Changing the option triggers search index re-crawl and that may interfere with Search Results
on Archived projects until the recrawl is complete.
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When this option is not selected by the Admin user in the security preferences, changing the status by
the Project Manager (who is not an Admin user) to Archived restricts the access to view the project for
all users in the project including the Project Manager.

Once the project is archived, the project is excluded in the Project list and hence is not shown in the My
Projects or Project | Manage menu items. The Project as well as the Tasks and Documents within the
project does not show up in Search Results or in My Work page.

Trying to access the Project with an URL from a notification for an archived project gives a permission
denied message.

Project Status -Set Status to Archived

When the Project is set to a project status, which is of Project status Type Archived, the project is no
longer visible to anyone except Admin user unless enabled by Admin user.

Project Status Filter

Admin users can now set the Project Status type to Archived. From the WebCenter 20 onwards, Project
status can be filtered/ searched as Active or Completed or Non-Active or Archived.

7.9.9. Setting a Project Status to Active or Non Active

10

An Administrator can set a project to Active by giving it an Active status. Whether a status is active or
not is determined when the status is added.

If a project has been set to a Non Active status, by default the permissions for all members are masked
with the View and Download permissions, so that these two permissions are still enabled if and only if
they were enabled already, while all other permissions are disabled.

However, whether certain actions can still be performed in non-active projects, also depends on

the security settings for the system. An Admin user can change these settings on the Security page
(Preferences > Security). It is possible to allow or disallow changing attributes, changing members and
document operations in inactive projects.

Prevent direct changes to Project Status

As an Admin user, you can prevent project status changes by the project manager. When this option is
enabled, the project status becomes read-only in the header of a Project.

To prevent direct change to Project status, navigate to Projects > Configure > Project Statuses in the
Project template and disable the option Project Status can be modified by Project Manager. All the
projects(also previously) created from the template will adhere to this setting.

By default, the option is checked in the template, and allows Project Managers to change the Project
Status.

However, the Project status can still be changed:
« whenataskis completed and the task is configured to change the project status on
completion

« when a workflow node changes the Project Status
« byadminsviaan SDK call changing the project status
« byadminsinasaved search allowing to change the project status.
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« ifthe projectis not created from a project template.

JavaScript Rule Action

7.10.1.

7.10.2.

Admin Users can use the JavaScript Rule Actions to execute JavaScript from a rule without a
workflow. In the JavaScript Rule Actions you can Add a rule, Edit or delete the rules.

System History Logs
All JavaScript Rule Action related events like
- JavaScript Rule Action Created
- JavaScript Rule Action Deleted
« JavaScript Rule Action Changed
are recorded and stored in System History. Read this page on how to access the records.

You can read more about API's for WebCenter here.

Add JavaScript Rule Action

You can customize Rules to perform specific actions. This can be done by adding rules which are
written and executed in JavaScript.

To add a rule in JavaScript:

1. Click Admin > Project Management > Add JavaScript Action Rule .
2. AEdit JavaScript Rule Action window is opened on selecting this option.

3. Enter the name for the rule, description and the script. Save the Rule to view the list of JavaScript
Rules.

4. To edit an existing rule, double-click on the JavaScript Rule Action from the list. To delete the rule,
click once to enable the delete icon on the row selected.

View JavaScript Rule Action

1. Click Admin > Project Management > Find Locked Documents.

2. Either filter for users by entering(part of) their last name in the Search users by last name field, or
click Go right away to see all locked documents.

3. Select the document(s)to unlock by selecting the corresponding boxes.
4. Click Unlock checked items.

7.11. Delete View Files

View files (that make files viewable in the WebCenter Viewer) take a certain amount of disk space. If
necessary, Admin users can delete those view files.

m
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Note: You can only delete view files per project (for all of the project's documents at once), not per
document.

1. Use the Search to find the projects whose view files you want to delete.
2. Select the projects whose view files you want to delete, and click Delete View Files in the actions
menu =7

Confirm your choice by clicking OK.

Note: When deleting view files, Viewer annotations, document metadata and thumbnails are kept.

You can see that the view files have been deleted on each document's Documents Details page.

Graphics_00002.png

Mail link to Document: Graphics_00002.png(11.4KB) R View files are deleted
Q View and Annotate @ Version: 3
Description
4 Download
More...~

Approval: No Approval Required

7.11.1. Regenerate View Files

7.12.

Users can regenerate documents'view files as needed provided that:

« they have the View permission on those documents,

« those documents'view files can be regenerated.

Note:
Most view files can be regenerated, except for:

« page lists coming from Automation Engine,

« documents uploaded via Automation Engine with the Upload only view files option.

If you need to regenerate the view files:

1. Gointo the project whose view files you deleted.
2. Select the documents for which you want to regenerate view files.
3. Click View and Annotate in the actions menu.

Configure a Landing Page for a Role

12

Administrators can configure the start page of a Project per Role in the Project Template. This means
that when a particular Role-User come into the Project Details, he or she will see the specified Landing
Page first. This feature allows you to configure different start pages for different types of users(Roles).

To configure Landing Page per Role:

« Go to Project Template > Details > Configure > Landing Page section. Click New Landing Page.
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& New Landing Page @ Delete La
Role Landing Page Details
Legal Documents Page -
Marketing Attributes Page -
Technical Tasks Page -
=1
« Specify the Role and the Landing Page. Choose from the following pages.
Options Description
Documents Specify the folder in the Details section.
Attributes Specify the Attribute Category View in the

Details section.

Note: If you leave this section empty, the user
will see the Default View.

Saved Search Specify the name of the Saved Search in
Details.

Note: The Role-user will be directed to the
Saved Search which is plugged into the User's
Project Details menu.

Approval Page Details section is read-only.
Tasks Details section is read-only.
Bill of Materials Details section is read-only.
Dashboard Choose the dashboard that you require as

landing page. You can also create a new
dashboard from this drop down.

« The Landing Page configuration is copied when you copy a Template or Project.
«  When you export your template, the landing page configuration is included in the XML.

7.13. Configure Rules in a Project

What is a Rule?

You can configure a Rule to execute specific Actions based on one or more Trigger events. The Rule
setsreside in Project Templates and will be applicable in all Projects created from them, including the
previously created ones. This administrator feature lets you establish communication between Child
and Parent Projects or between any two Projects. See an example use case at the end of this chapter.
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Note:

You need the WebCenter Task Management Advanced or WebCenter Life Cycle Management license
to be able to define Rules.

To set up Rules, go to Project Template > Configure > Rules Setuptab.

Note: Although Rules are configured within a Project Template, you can create Rules that are
triggered after the project is created from the template.

Triggers

A Trigger is an event that happens in the system (for example, the Child Project Status changes to
Completed). A successful Trigger condition will execute a Task based Action.

You can specify multiple triggers and actions in a Rule. When one Trigger event(as specified in the
Rule) happens, the system evaluates the Rule and executes the corresponding Action(s).

See the supported Triggers below:

Project Status Change: The Action is executed when the Project Status changes.

Project Attribute Change: The Action is executed when the specified Project Attribute changes.
You can specify the attribute from a drop-down.

Project Due Date Change: Any change in the Project Due Date will trigger the specified Action.
Date/Time Reached trigger lets you define an exact time stamp to execute the Rule. When the

server time passes the Trigger time, the Rule will be executed. There are 2 options:

« Specific Date: the actions will be executed on the specific date and time
« Datein Project + Offset: the actions will be executed on the selected Project Due Date or Date/
Time attribute plus or minus an offset of days and/or hours.

Note: The calculation is done in working days/hours.

Actions
Start Task: This action launches a Task in the same Project where the Rule is configured. Specify
the Task by selecting it from the drop-down.

Execute Javascript: This action launches a specified JavaScript Rule Action. You can specify one
from the Javascript Rule Actions configured in the system.

It is possible to configure multiple actions by clicking on the '+ sign. Use X’ to remove existing actions.

Example

See the example of a Project Template's Rule below. This Rule gets executed when the specified
Date/Time Reached.
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Edit Rule

Rula Mame *

Check the State of the Campa .,.'l

Enabled
+
Description
Will gk the state of the camp aign two days before a milestone is reached
Order
1
hen ari of these Jgers pos
[x] Date/Time Reachad - rivbie Milestanes 1 - y -
+
[x] Execiie Javascript - mivbe Calculate Campaign At Risk -

i triggers can potentially take a while. T

o -

The Javascript Rule Actions are configured in Admin > Project Management > JavaScript Rule

Actions. See the example script below.

var children = API.getProject().getChildProjects(); if(children.length >
0){ var atRisk = false; var inDelay = false; for(var i = 0;

i<children.length; i++){ var child = childrenl[i];

if (child.getStatusName () !=
} else if(child.getStatusName () ==

'Completed'){ atRisk = true;

'Non-active') {
inDelay = true; }
Campaign
} else if (inDelay) {

State") .setValue ('At risk');
Campaign State").setValue('In

API.getProject () .getAttribute ("mvbe
delay'); }
else { API.getProject () .getAttribute ("mvbe Campaign

State") .setValue ('On
schedule'); } }

Two days before the milestone, this Rule will get executed. Depending on the child Projects'
statuses, the Program Project's status will be updated.

} if (atRisk){ API.getProject () .getAttribute ("mvbe
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8. Advanced Search Setups in WebCenter

8.1. Advanced Searching

There are advanced search features using which you can design and create dedicated search pages.
You can:

« Save a Search with advanced settings.

« Find assets which were stored in WebCenter with certain Attributes or with a certain project
criteria. This will help you to:

« Find, collect and download pictures for a certain product line. You can also send these as
download links.
« Searchaccording to criteria to find required Packaging types: for example Carton Boxes.

« Search based on Project Status. For example, you can find all projects with a status Initial
design. Display the Project Status as text, icon, color or both. Select your Project Status setting
as Show Color Label to get the project status bar in your search.

« Perform bulk operations.

« Alter the column order in the View column and search based on Projects or Documents or Tasks and
Approvals and choose to not show the same parameter in the search results.

« Refine Search Results using a search parameter panel. Using this, users can limit the list of items

to be searched.

« Define the sequence of columns in results. Alter the column order in the View column and search
based on Projects or Documents or Tasks and Approvals and choose not to show the Project Name
or Document Name or Task and Approval name in the search results.

« Create dedicated Global Saved Searches for Users. Global Saved Searches are accessible to
all users and hence advanced search option access can be given judiciously to users. You can
customize these as Asset Browsers which can be incorporated into the menu.

« Create Saved Searches with Projects Calendar View on page 137.

« You can search by selecting multiple options in drop downs or even type the text to search.

« Ifanaction has been done as delegate of another user, it is shown in the corresponding field in
search results. For example, in the field created by for a task search.

« Click on any of the gear icon in the date/time fields to Show Time except for attributes and search
is either sorted or filtered on this. For Project Status, gear option gives the configuration options
like Automatic or Label and Icon, Only Icon, Only Label, and Color Label. For Pending Approvers,
gear option gives configuration option to Show Assignee details (original Group /Role).

System History Logs

All Saved Search related events like
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- Saved Search created
- Saved Search deleted and
« Saved Search changed

are recorded and stored in System History. Read this page on how to access the records.

8.2. Creating Advanced Saved Searches

Normal and keyword searches may be saved for future use as a Saved Search and can be plugged into
menu items (of the main menu or Project details menu), My Work and as a document source during
project creation and in document referencing.

To access saved searches, click Search > Saved Searches. Shown below is a sample Saved Searches
page.

Searches can be saved as:

» aPersonal search visible only to the individual user.

« aGlobal search visible to all WebCenter users.

Note:

1. Foreach Global Saved Search, an Administrator can determine a set of Groups/Companies/
Locations whose members can view this Saved Search.

2. Itisnot possible to set Visibility for Personal Saved Searches.

Saved Searches can be configured with advanced Drilldowns and extensive and visually enhanced
Dashboards. You can plug these

« Toexecute a Saved Search, simply click its name from the Saved Searches page. Or select it from
the Search window in the menu bar.

&l Projects

[ Documents

s Saved Search

To edit a saved search, click 4 Edit Search.
To Make Search Personal, click 2

To Make Search Global, click %

Smart Names :: enabled Searches do not have the Make Search Personal option.

To create Global Saved Searches dedicated to a company or group, click Edit Visibility @ link.

In the next window, select the Available Groups, Available Companies/Locations to whom you
want to give the exclusive visibility. In this case, if you assign the visibility to a group, a company or
location, the search will be visible to either the group or the company or both.
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Visible to all
® Visible to selected Groups and Companies
Available Groups

Please select or start typing... -

Available Companies/Locations

Please select or start typing... -

All Locations -

Note:

If you select a company without specifying any of its locations, all the company locations will be
able to access the saved search.

If you remove the Available Groups/Companies /Locations, the visibility settings will be modified.

« Todelete saved searches, select them and click Delete. Use Select All and click Delete to delete all

of them.

8.2.1. Search Panel Design

18

The saved searches can be setup for Projects, Documents and Tasks and Approvals. These saved
searches can be edited by an administrator. The administrator decides for each saved search (and for
each operation) whether these operations are allowed or not.

All users can design searches via the Search Results options. However, administrators get an extra
check box Search Panel Design.

In the Search page:

1. Select the Search Panel Design Options. The Visibility, Label, Row, Column will appear in the
search page.

Additionally, the check boxes in the View column will become drop downs when enabling this
option.
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Fillin one or more fields. Prefer less fields? Try Keyword Search.

Search for. Al v
Use Advanced Search Characters Search Panel Design Options Search Results Options
# Search Panel Design Enable Smarthames Label visibility Row Column) View Calumn Order
Document Name Hidden |~ Vigible
Version Author ¥ Hidden |~ Hidden | ~
Auther's Location Hidden - Hidden -
Description Hidden | - visible | - 2
Created - Hidden - Hidden - | {3
Modified - Hidden | = Hidden | - |{F
Keywords Hidden | -
Antribute Category | Hiddan - Hidden -
Reference | Maiches - Hidden | -
Referenced by | Maiches - Hidden | =
Appraval Status - Hidden |~ Hidden | ~
Approval Status Completed - Hidden |~ Hidden |~ I
Approval Started - Hidden |~ Hidden |~ |
Approval Due - Hidden |~ Hidden |~ I
Approval Completed - Hidden | - Hidden | - |}
Approval Duration - +- days Hidden | = Hidden | - {F
Approval Time Left - +- days Hidden | = Hidden | - |{F
Current Approval Stage Hidden | - Hidden | -
Pending Approvers | 8 | #8 | ¥ Hidden | = Hidden | = |1
Reason(s) for Rejection | Default - Hiddan - Hidden -
Here:
Column Description

Visibility

Determines whether the criterion will appear in the saved search top panel.
The available values are Hidden, Available and Visible.

Label

Alabel is the name of the criteria as it needs to appear. A label can be given
regardless of the setting of visibility. The label will automatically applied

to the column header in list layout and will be visible in grid layout too. If
the field is left empty then, the label will be the same as the criteria and not
different to other localized languages.

Row and
Column

Position where the criteria will appear. Row and column are filled in
automatically but can be changed by the user. The second criteria can

have the same values for row and column. For example: If the Project Name
criteria has the value Row 1and columnis 2, the criteria will appear in column
two of the Ul

For example; when the Visibility is set to Visible for Approval Completed, the following results page

appears.

19
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Search Resulis Clear this Farm Save Search As... Save Results to Excel
Document Mame | * pdf
Description
Approval Started | this month -
Approval Status Completed -
— Select criterion — -
i @ Compare in Viewer 4 Download & Add to Cart Sortby | Decument Name -
\@#$%hdoc2_{} (2)pdf = 1.pdf = 114_pagelist pdf 1_pl.pdf = 3_Green_Hanger MP.. = 5.pdf =

label.pdf packaging_braille_bar.. = pagelist. pdf utgo_pcm_scope(Pl_.. =
When your users use this search (for example as an asset browser), they can use the design panel to
further refine the criteria. You can now

¢ EskD
O h

6.pdf

1) mrbtorem sgprent ivermetes

- a8 - _

revolutionary

Set up first visible Column in Search Result

In WebCenter 20.0, you can configure any searchable field as the first column of the Search Results
other than the name of the Project/Document/Task. In fact, you can choose to hide the Name column
and/or choose any another column as the first column. Inline actions are shown on top of the first
column.

Note: In Card Layout header, Focus Layout header and Selection section, some of the fields like
calendar view, text statements, rich text attributes, project/approval/task statuses, users/groups and
company /locations are not supported.

Internationalize Labels for Search
Search labels can be also be translated to other languages. To find or create new translated labels,
select the blue global icon in the Search Panel Design options. A Find or Create Translated Labels
window is opened.

Find or Create Translated Labels

Search existing labels... Q OR Ereate new label... (e.g. CAMPAIGN

You could find translations for search labels or create a new label in the language you want it
translated.
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Find or Create Translated labels on page 249

8.2.2. Setting Search Result Layout Options

You can configure advanced searches for Projects, Documents and Tasks and Approvals. Using Show
Result Layout Options, you can configure the search results interface for the users. You can also
enhance these searches with Dashboards to display the search results in a graph/chart/counters.

The available options are different depending on whether it is a Project / Document / Task search.
Some of the options available commonly are

You can use Use a custom Search Title to modify or rename the Search Title while viewing the
results. The custom search title field is translatable which is indicated with the blue globe icon.
Limit cell height ( expand by request) which is enabled by default limits the height of the results
shown. You can turn off this option to view all the content of the cells.

You can get the Larger Thumbnail on Hover in the search results page by hovering on the search
result row. Optionally you can also disable this action. You can also enable the larger thumbnail on
click for which a button is displayed in the right corner of the image.

You may choose to hide the button to show/ hide the thumbnail in the results by choosing Show
"Hide Thumbnail" Button.

You also have an option to choose whether the thumbnail display will be as per the Default (User
Preferences) or Show Thumbnail or Hide Thumbnail. This option is available for only Projects and
Documents search.

You can alter the Column order and select whether or not you want to make fields visible in the View
column. This allows you to order the results based on some fields, and display entirely different
search fields/columns in the result page.

You can also hide the first field namely Project Name or Document Name or Name ( for Tasks and
Approvals Search) by unchecking it.

Enable 'Show as Grid/List/Cards’ Button to show this button for Documents and Projects Search
results.

Choose the units to be used when exporting to Excel in the Save Search Results option. You choose
to export the results in either Metric, Imperial or Use User Preferences. You can also configure the
order of search results. Read more about Configured Order on page 129

Choose whether to Show clear this form button in the search results layout.

Allow Changing Attribute Category, where-in the Change Attribute Category will show up in the
actions bar for Projects and Document Searches.

Enable/disable the Table Bulk Actions per saved search. You can check the Show Bulk Edit Actions
for fields marked as editable. In List layout in Search Results page, you can still access bulk editing
by clicking on the pencil icon (inline) in the column header.

Display Labels in grid layout.

Setup Show Drilldown using a Saved Search.

You can enable or disable Save this Search, Save Search Results and Search buttons to customize
your searches.

Configuring Initial Search Results Style

For Document and Project searches, you can also configure Initial Search Results Style. Select from:

Default (determined by the User's Preferences)
List

Grid

Card

Focus Layout
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The selected view style will be applied on the Search Results page instead of the default user
preference.

Note: Users can change the view of the search results by clicking the Show as Grid/List/Cards/Focus
buttons if these are not disabled.

Project Search Layout Options
To select your options for project, go to Search > Projects > Show Result Layout Options > You can
choose to:

« Remove the links to Hide Thumbnail, Show as Grid and also Save Search Results.

« Choose the units to be used when exporting to Excel in the Save Search Results option. You choose
to export the results in either Metric, Imperial or Use User Preferences. You can also configure the
order of search results. Read more about Configured Order

« Choose whether to Show clear this form button in the search results layout.

» Display the Project Status as text, icon, color or both. Select your Project Status setting as Show
Color Label to get the project status bar in your search.

« Allow Changing Attribute Category, where-in the Change Attribute Category will show up in the
actions drop-down.

« Display Labelsin grid layout.
« Setup advanced options like Search Results Dashboard and Show Drilldown using a Saved Search.

Document Search Layout Options

In Document searches, you can configure Individual Result Actions and Display options. To allow an
operation or a display option, keep it enabled.
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Result Layout Options

Search Results General
Search Title

Use 2 custom Search Title

Background Color

#f575f5

Other Display Options
¥ Show "Save this Search’ Burton
¥ Show "Clear this Form' Button
Show Search Buttan )
Show Cart

Results Table
General

¥ Limit cell height (expand on request)

Labels
¥ Show Labels in Grid Layout
Set Labels in Grid Layout in bold

Save Search Results to Excel

¥ Show "Save Search Resulta” Buman
Use following units when exporting:
Metric (mm, cm, dm, m}) -
Use following column order when exparting:
Use Configured Order -

Individual Result Actions
Type

Defzult (frem Menu)

~ W Approve X
v Q¥ comment A
Q¥ View and Annotate L]
3 # pownload =
i [ approval Info a
B O Mail link to L4
B ¥ Llock =+
B ¥ addwocan ]

=+ B Custorn Actions | default

¥ Reject

B Viewin 3D

¥ Dpen in ArticsCAD

¥ Define Document Attributes
Mail Download Link
Upload Mew Version

¥ Rename

¥ Delete

L]

Tagged actians will only show up if the tag is listed here
Example: tag?, tag?". Enter * for all actions.

Layout
Initial Layout

Default (User Preferences) | |2 List 21 Grid = [0 Cards Focus

¥ Allow user to switch to a different layout

Focus Layout
# Enable Focus Layout

Default Dashboard

Drilldown

Show Drilldown using Saved Search ¥

WebCenter

Table Bulk Actions

Q ¥ Show "View and Annatate” action

Show "Compare in Viewer" action

'
= &
%

&

Show "Download” action

&

Show "Add to Cart” action
Show Bulk Edit Actions for fields marked as editable

BN

Allow Changing Attribute Category

+]

Allawe sending Download Mail far Mukiple Documents
== ® Custom Actions | default

Tagged actions will anly show up if the tag is listed here.
Example: “tag1, tag2". Enter * for all actions.

+ Shaw Project Creation Link €3

Thumbnails
Initial Thumbnails
Default (User Praferences) = 44 Shown %5 Hidden
¥ Allow user to "Show/Hide Thumbnails'
Larger Thumbnails an Hover
Only After Buttan Click

Asset Browser

Lists in Left Tree Panel @0
Type  MName Depth  Height

+ Add List

Tree Fanel Width

300 - | px
Image Area Style
Left panel only {no images) -~ O

# Allow Changing Image Area Style via Dropdown

Enable Show Cart to show the cart with the selected documents. You can perform actions such as
create a project or clear from cart.

You can also set up document searches as Asset Browsers.

Search Results

Currently in your Cart

—
=) 01_DisappearinBackz.. © =
<

O GETSET BOTTLEBL. = () GET SET_MULTIVITS_,

GET SETMULTIVITS.... = () casepdf

IR | @ compare in Viewer

+ Create

osted

[ GET SET_MULTIVITS . = [ LUMI-CASE pdf = ) lumi carton.pdf

o W cersereornien. o @ ocvsermunvrs... o [ vorn st onenen

() ALCIS_SHOWER GEL.. =

Qi &=

[ Bollin_Test_Graphic R = [ Bollin_Test_Graphic_R.. = J Bollin_Test Graphicp. = | TAP_DesignRequest_ =

Save This Search | Save Search Results

+ Create Project from Cart b= Remove from Cart | Clear Cart
Sortby | Reversed Modified M
) casepdf ] () GETSET BOTTLE L. =

[ Bollin_Test Graphic.4.. =

. ALCIS SHOWER GEL_TUBE_LABE
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Note: Add to Cart allows you to add documents to the cart.

If the option Show Cart is enabled in a Saved Search, the cart will be displayed in all the locations
where the Saved Search is used.

« Saved Search configured in My work, Document Details and Project Details

ecuments Browse Docaments  Projects in Grou Docurments in Greup asks inGmup  Subprojects. More. -
Currently in your Cart & Create Project from Gart v W Clear Cart
2 DT-OMEUP ORI Bi m 0z Label_Pear i 1 Star Ipecteam Bk
Hama | Deserighion Project

« Cart will not appear in Searches used as Document Source.

Tasks and Approvals Search Result Layout options
Navigate to Search > Tasks and Approvals > Show Result Layout Options.

You can also configure Individual Result Actions .

Result Layout Options

Search Results General Individual Result Actions Table Bulk Actions Results Table
L Type # | B Snow Bulk Edit Actions for fields marked as extable e
Default (from Menu) - 0 Limit cell hei

O Show Search Buron

Layout Thumbnails Save Search Results to Excel
Initial Layout
Elis

Button
Larger Thumbnails an Hover e

Crly Ater Bureen Click -

Focus Layout
O Enatie Focus Leyout

Custom Actions in Search

When you configure custom Action buttons for Searches. You can enable or disable those actions in
specific Saved Searches.

This can be done by defining a Tag for the Action defined in the custom menu.
To have Custom Actions in Saved Searches:

« Create Custom Search Actions
» Specify a Tag for the custom Search Action. Save the menu and apply to the User(s).

« Create a Search. In Result Layout options, enable Custom Actions and specify it with the exact
Tag.
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« Inthe Search Results page, you will be able to see the custom Action that you configured.

Persistent Search Results

Search Results selection is persistent and the selection is kept while you remain on the Search Results
page. You can navigate to another page of the search results, or re-sort, or filter from the design panel,
or use facets, or add available columns,and so on. The selection is available while you remain on the
same WebCenter page and do not execute any other actions on the selection.

The number of items selected is indicated in a counter in the header. You can view the thumbnails of
the selection by clicking the counter. Next to the thumbnail, it is also possible to view either the

« Document Name and Project Name for Document
« Project Name and Project Description for Projects
« Task Name and Project Name for tasks( only available if a search dashboard is configured)

The items are added in the persistent selection section as in the order in which you select the items.
So, when you select a new item to be added to the persistent selection, it is added to the top of the list.
When multiple items are selected, the items are added and ordered the same way as they were on the

page.
Each item can be removed individually from the Selection or you can remove all.

Focus Layout

Focus layout option shows results of Document, Project or Task and Approval Search. Focus layout
provides a better visual representation and an immersive experience of the images in the search
results.

When Focus Layout is used to display the Search Results, the results page displays a single item at
atime. You can select the viewed result with the check box in the top left. In the top right, you can
navigate through the results or can go directly to a result by providing the number. The selected
search results can be viewed when the selection counter in the header is expanded. Read more about
Persistent Search Results on page 125.

When enabling the Focus layout, dashboard can be created newly or can be selected from the existing
dashboards.

Note: When a Task Search results are viewed with Focus layout, the Dashboard existing in the
respective Task Type is shown if it exists or else the dashboard specified for focus layout is
considered.
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8.2.3.

126

WebCenter

Search Results
= [0 Compare imViewsr & Downbssd W AddieCadt  # Cresbe Projest from Selecsed ==

Header | = cerser_sorTie BLuEpd Tofts >

Any Dashboard ) =
7 H

- ENERGY DRINK

Focus layout utilities the full screen for a single search result, allowing you to view the individual search
result items without opening a Document details or the Viewer window.

This can be combined with persistent selection and Viewer dashboard block, to click through a set of
search results and decide which ones to include and which ones to omit for a specific operation.

Focus Layout is enabled by default for Document searches, whereas for the Project and Task and
Approval search, it has to be specifically enabled by the Admin user.

Individual Result Actions

You can configure standard document operations like 5298 =] iy the document or Task

and Approval Search Results page. For example, from this page, you can send download links for the
selected documents.

Note: In Tasks and Approvals Search Result page, the Document actions are only available for
approvals. The actions apply to the document on which the approval is setup.

There are two options to configure namely Default and Custom.

« Admin users can see the check boxes available in the Default (from Menu) like Approve, Reject,
Comment, View and annotate, Define Document Attributes, Lock and so on

You can navigate from go to Search > Documents and click on the Show Result Layout Options link.

Select the option you require to be displayed in your search result.
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Individual Result Actions

Type

Default {(from Menu)

Hi 1 o~ e O QK
< YRV Y Y

o

e f

Approve

Comment

View and Annotate
Download

Approval Info
Upload New Version
Rename

Delete

Custom Actions | default

@ X

o N

T e H

WebCenter

¥ Reject

¥ View in 3D

#| Open in ArtiosCAD

¥| Define Document Attributes
Mail link to

¥ Lock

#| add to Cart

O

Tagged actions will only show up if the tag is listed here.
Example: "tag1, tag2". Enter * for all actions.

By default, the operations selected in the image are enabled for Document search whereas for Task
and Approval search, the options Approve, Reject and Comment are only enabled. You can also add
Custom actions. Read more on configuring custom actions here.

«  When you choose the type as Custom, then you further configure icon and color for each of the
action. You can also select the style as either Icon or Icon and Label.
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8.2.4.

128

Individual Result Actions

Type

Custom... -

Action lean Color

Approval Info - { Actions- @ ~ #5bcOde

Approve - + Actions- @ ~ #d9534f

= Add Action

Style

lcon and Label -

Icon Only

conanlabl

Note: You can configure the search results layout options for:

« Document Search Results
« Saved Searches used in custom project/document menu items
« Saved search based My Work page

These actions will not work in the Saved Searches used as document sources in Project Creation and
Document References.

Show Additional Project Search Criteria

You can use the Show Additional Project Search Criteria option as a advanced search for Documents,
Tasks and Approvals in saved searches.

Project Name 4] 6 o

¥ show Additional Project Search Criteria

After selecting Show Project Search Criteria option, the following options appear:

Using these you can search on project features when searching for Documents or Tasks and
Approvals. Any of the project property or attribute can be used as a search criterion for Document
searching and for Task and Approvals searching.
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8.2.6.

WebCenter

For example, you can search for the tasks in projects of a certain customer and what is the progress
currently going on for a customer. You can also use the Project start date, completed date etc to arrive
at the duration and filter on the other fields.

Configured Order

The order of columns for search results saved to excel files are now configurable by the admin user.

To enable this, choose the Configured Order in the Use following column order when exporting drop-
down.

Use following column order when exporting:
: Use Configured Order F

Use Configured Order
Use Systermn Order

When you choose this option, the order of the columns in the excel file saved is the same, as the order
of the columns in the Search Results page. This configuration is the default for all the new searches.

Note: All the saved searches that were created in WebCenter Versions 16.1 or earlier will have Use
System Order by default and their order can be reconfigured.

Define Search Result Options

You can define which fields needs to be displayed for each search result. By entering numbers, you
can change the sequence of the columns or the sequence of the information in the grid cells. You can
choose to make the view of the field in the results either Available, Visible or Hidden

Note: When you enter an existing number, all others shift to upward numbers. In case of list layout,
this information will be displayed in columns.
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Search Results Options

View Column Order  Editable Sort  Order
Vigible 1 - 1 =
Hidden = b 2w
Hidden - " 4 a
Visible - 2 « 3w
Hidden - {3 o 5 a
Hidden - L}

Note:

Click on any of the Gear icon to Show Time for the date / time fields. For Project Status, Gear icon
gives the configuration options like Automatic or Label and Icon, Only Icon, Only Label, and Color
Label. For Pending Approvers, Gear icon allows you to configure Show assignee details (original

Group /Role).
Search Results Clear this Form Save This Search Save Search Results
Project Name | Drupal6_Library* Due v Project Status ~ Show All v I

Name | Brand Sample Flavor Project Modified

GET SET_BOTTLE_BLUE.pdf Get Set Label Caconut & Berry May 17, 2016
BB e seT_BOTTLE BLUE NOGAD pdf Get Set Label Coconut & Berry May 17,2016
EF  cersET BOTTLE GREENpf Get Set Label Apple+Lime Twist May 17, 2016
BAfSEE  cET SET_BOTTLE GREEN_NOCAD.pdf Get Set Label Apple+Lime Tuist May 17,2016
m GET SET_BOTTLE_ORANGE pdf Get Set Label Tropical Blend May 17, 2016
P cETSET_BOTTLE ORANGE_NOCAD.pdf Get Set Label Tropical Blend May 17, 2016

In case of grid layout, this information will be displayed in each cell either below the thumbnail or to the
right of the thumbnail.
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Search Results Clear this Form Save This Search Save Search Results
Project Name  Drupal6_Library* Due v Project Status | Show All v| T
R LA [E CompareinViewer | & Download = = Add to Cart Sortby | Name v

Name: GET SET_BOTTLE_BLUE pdf Name: GET SET_BOTTLE_BLUE_NOCAD.pdf Name: GET SET_BOTTLE_GREEN pdf
Brand Get Set Brand: Get Set Brand Get Set
Sample: Label Sample: Label Sample: Label
Flavar: Coconut & Berry Flavor: Caconut & Berry o | Flavor: AppletLime Twist

Project Modified: May 17,2016 Project Modified: May 17, 2016 . Project Modified: May 17,2016

Name: GET SET_BOTTLE_GREEN_NOCAD.pdf Name: GET SET_BOTTLE_ORANGE.pdf Name: GET SET_BOTTLE_ORANGE_NOCAD.pdf
Brand Get Set Brand: Get Set Brand Get Set
Sample: Label Sample: Label Sample: Label

l| Flavor: AppletLime Twist u Flavor: Tropical Blend Flavor: Tropical Blend

Project Modified: May 17,2016 Project Modified: May 17, 2016 ~ Project Modified: May 17, 2016

Name: GET SET_WRAPPER_BLUE_NOCAD.pdf Name: GET SET_WRAPPER_GREEN_NOCAD pdf Name: GET SET_WRAPPER_PURPLE_NOCAD.pdf
Brand Brand: Brand

Sample: Sample: Sample:

Flavor: Flavor: - Flavor:

Project Modified: May 18,2016 Project Modified: May 18, 2016 Project Modified: May 18,2016

Name: GET+SET_WRAPPER_BLUE ai Name: GET+SET_WRAPPER_PURPLE ai Name: LUMI_PLUS_CARTON_BLUE pdf
Brand Get Set Brand. Get Set Brand Lumi +

Sample: Energy Bar Sample: Energy Bar Sample: Sports Watch

Flavor:

Project Modified: May 18,2016

Flavor: Berry Mix - Flavar: Blue
Project Modified: May 18, 2016 Project Modified: May 9, 2016

In case of card layout, the information will be displayed on the back of the card, which can be viewed on
clicking the card.

Search Results Clear this Form Save This Search Save Search Results
Project Name  Drupal6_Library* Due v Project Status | Show All v =1
Q View and Annotate [T 3 Download E A Sortby | Name v
) GETSET_BOTTLEBL.. = (£ GET SET_BOTTLEBL.. = £ GET SET_BOTTLE GR.. = [0 GETSET_BOTTLE GR.. = O GET SET_BOTTLE.OR.. = [ GET SET_BOTTLEOR.. =
Name: Name: =
GET SET_BOTTLE_BLUE pdf GET SET_BOTTLE_BLUE_NOCA,
Brand: Brand:
Get Set Get Set
sample: Sample:
Label Label
Flavor: Flavor:
Coconut & Berry Coconut & Berry
Project Modified: Project Modified:
May 17,2016 May 17,2016 T
1 »
) GETSET_WRAPPER_. = () GET SET_WRAPPER.. = ] GET+SET_WRAPPER_.. = =

Link Visibility of Available filters and Columns
In the Result layout options page, Link visibility of Available filters and columns option is available.
When this option is enabled, and both the design panel item and the column are set up as being
Available for a certain field, making one of them visible will make the other one visible as well. Hiding
the field in design panel or column will cause both of them to be hidden. When a column is configured
as visible or hidden instead of available, showing or hiding a filter in the design panel from the search
results page will not affect the columns shown.
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Note:
In List view, a + icon appears on the right side of the table.

In Grid and Card view, a "More..."” link is shown to add or remove information.

8.2.7. Set Attribute Value on a Search Result

The administrator can set the attribute columns to be editable when you run a search. By this, the user
can then select a number of projects or documents (depending on the type of search).

The administrator needs to determine what columns can be edited. This is done in the Search
definition panel.

Fill in ome or mare figlds. Prefer less fields? Ty Keyword Search.
Search for: Al M
Use Advanced Search Characters €3 Seorch Results Options
Search Panel Design Enable SmartMames {3 View{Ligt] Column Order Editable Sort  Order
Document Mame  get sel - 1 # 1 a
Version Author i- z Showr Result Layout Options

Author's Location

Description L 2
Modified *
Attributes..
eskoBrand o+ 4 ¥
Product # 5 ’
Approval Status v = e

Revision | Latest Revision » | Revision Letter;

Characieristics..

Project Mame + <]

Shaw Additional Project Search Criteria

In the above example, the administrator has selected Trademark and Brand attributes to be editable.
When you save and run the search, the attribute columns which are set editable will appear with a
pencilicon.
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Name | Description Project

eskoBrand # Product #

CHILI-DADC GET SET demo for Drupa 2016
TOTA mew

GET SET MULTIVITS variants

- BOTTLE_ORAMGE & Alpro Demo

- FRIDGE PACK.&i AMlpro Demo

- FRIDGE PACK_WOTA.a WOTA_Upgrade_Movies_ATC 16

- FRIDGE PACK_WOTA_Marm,pdf WOTA_Upgrade_Movies_ATC_16

GET SET - FRIDGE PACK_WOTA_std pdf WOTA_Upgrade_Movies_ATC_16
Get Setxm CHET Dema
GET SET_BOTTLE_2LABELS.A3D Callection of ArticsCAD assets that will be w drupa 2016 ArtiosCAD assets

SET_BOTTLE_2LABELS dae drupa 2016 ArtlosCAD aasets

SET_BOTTLE_BLUE Briefing.docx Briefing_ces (01)
GET SET_BOTTLE_ELLE Briefing. docx Drupal&_BO Librany
GET SET_BOTTLE_BLUE Briefing.dacx Briefing.German (01)

GET SET_BOTTLE_BLUE Briefing.docx

riefing_MGEskoWorld (01)

GET SET_BOTTLE_BLUE Briefing.docx

m

riefing_Test PCM 27 june (01)

T SET_BOTTLE_ELUE Briefing.docx

m

riefing_French (01)

SET_BOTTLE_BLUE Briefing docx

23]

riefing_KDCR test (01)

Select a number of projects or documents and click on the Edit button. A dialog box appears asking
for avalue. These values adapts to the type of the attribute. When the value is provided and Start is

clicked, you will see feedback about the progress and success of the operation.

Set Attribute

Set eskoBrand 1o

Advanced

m Cloge

Status Document Comment
CHILI-DA-DC GET SET dema for Drupa 2016 TOTA.mev
GET SET - BOTTLE_ORAMNGE ai

GET SET - FRIDGE PACK ai

Enengy
Dirink

Energy
Drink
Encrgy
Drink
Energy
Drink
Enengy
Drink

Enengy
Dirink

Energy
Drink

Note: When the attribute could not be set on a project or document, the feedback shows a failure icon

and gives the reason (No permission to set attribute, project is non-active, etc).

By clicking on Advanced, the dialog changes to accept different values for each project or document.
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Set Attribute

Set eskoBrand to

Simple

m Close

Stetus  Document eskoBrand Comment
CHIL-DA-DC GET SET dema for Drupa 2016 TOTAmev
GET SET - EDTTLE_ORANGE.a

GET SET - FRIDGE PACHK &

-

Note: Here, failure happens per item. So when selecting 20 items and the first fails, the rest is still
attempted.

8.2.8. Sorting Search Results

You can sort the search results in the List / Grid view based on sort-enabled search columns.

In the List Layout:

You can click on the primary sort field header I/ 1 toswitch between ascending and descending. All
sortable fields will have the sort icon next to their header text.

To change the primary sort field, click on the sort icon next to it.

Up arrow I in the column header indicates that the results are sorted on this field in ascending

order. To sort the results in the reverse order, click l

Downarrow } indicates that results are sorted on this field in descending order. To reverse the

order,click I,

In the Grid Layout:

If the search results are in the grid layout, you will see a drop down with sortable fields instead of the
sorticons.

Project Name v

Name
Reversed Name
Reversed Project Name
Description

Reversed Description
Project Manager
Reversed Project Manager
Modified

Reversed Modified

Due Date

Reversed Due Date
Project Status

Reversed Project Status
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For example, sorting by Name / Reversed Name will make the name field in the ascending or
descending order.

Note:

The configured sort fields will be applicable in both the grid and list layouts.

You can navigate to the page number you want by typing the page number in the footer. If there is only
one page to show the results, then there is no footer shown.

Task and Approval Search

In the Tasks and Approvals search you can

Configure a search for Tasks and / or Approvals by choosing whether you want to search All
Approvals or All Manual Tasks or All Workflow Tasks from the Type drop down. You can also
choose any of the manual tasks or workflow tasks from the drop down or a combination of all the
above.

search for Task Description or Task Type Description in their respective fields. There is also an
option to search on the Status of the Approvals or Tasks or a combination using multi-select.
search for Task Created or Task Estimated or Task Created By or Approvals by Approval Master or
Stage Approval Status or Final Approval Status.

Search on any Specification. Select any of the Specification from the drop-down to refine your
search.

Filter the Specifications based on a Task Type. To filter, select a Task Type and enable Filter task
specifications by selected Task Type option.

search tasks based on the document uploaded within the tasks or search for the document to
approve for approvals.
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Search for Tasks and Approvals @

Fill in one or more fields. Prafer less fields? Try  Keyword Search.

Use Advanced Search Characters 9

Search Panel Design

Name

Task Description

Type

Task Type Description
Seatus

Task Created

Started

Maodified

Due

Completed

Task Estimated

Task Created by
Completed by
Duwration

Time Left

Assigned to
Assignee'’s Location
Approval Master
Kaywords
Specifications...
Dacument{s)

Parents (Document Reference) of
Stage Name

Stage Approval Status
Final Approval Status
Comment/Condition

Reason(s) for Rejection

Project Name

How to find the duration taken and time left for Tasks and Approvals

Enable SmartMames €

Al Approvals X
*Assign &ll roles to Project Manager Soft Points w31 X

All Mot Started X

= - + days
= - + days
2 & W

2 & W

Matches -

Default -

View

-

e BN B N -

1

o

Search Resultz Options

Colurmn Order  Sort

o

1

Order

WebCenter

E3 Clear this Form

M Save Search As...

Be Search Results Dashboard
£} Show Result Layout Options

E Search Reaults Formatting

You can search to find the duration taken for Tasks (both Manual and Workflow) and also for Approvals.

You can choose/ filter the search with the following fields

« Started: Start date of the Task or Approval

« Due: Due date of the Task or Approval
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« Completed: date the task or approval was completed
« Duration: the time (duration) between the start date and the completed date. When the task is still
ongoing, it is the time between the start date and the current time.

« Time Left: the time between the due and the completed. When the task or approval is yet to be
completed, thisis the time between the due date and the completion date.

When the time left is a positive number, then the due date is not reached yet. If it the search yields time
left as a negative number, then the task or the approval is overdue.

Note:

1. Both Duration and the Time Left do not consider weekends(Saturday and Sunday). You can also
switch the weekend days to Friday and Saturday.

2. You can configure to get either the time in days or in hours.

Reporting on Approvals

The main use case for approval search is reporting. In the search, you can find all the pending, and also
all completed approvals. Approvals can be searched for each Approver in an approval stage.

For example, if a user and a group have to approve then two rows are displayed, each with details about
who (of the group) completed the approval, and whether it was rejected or approved, and the duration.
This is very useful information for reporting purposes.

8.3. Projects Calendar View

8.3.1. What is Project Calendar View?

The Calendar View is another feature of project search. Status changes in the project history are
displayed as project stages in a calendar. The picture below shows an example.

This creates a quick dashboard overview of your projects and helps you to prioritise which projects
need your attention.

Why should you use Project Calendar view

« Toshow the Actual Vs Planned status of the project
« View the Project status of the child projects as a drill down
« Due dates are set up as attributes which you can configure at the Project page
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1. i 7. Artwork Creation . Artwo €A |

5 Creation
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1. Briefi| 2. Astwork Creation . 4 ke A |

To view the project feedback, project status history option must be enabled in Admin > Preferences >
Notifications > Include in Project History. Enable Project Status change. Click Save.

Note:

1. Calender View is enabled for Projects in List Mode only
2. To be able to use some of the calendar view functionality, you need the Lifecycle management

license.

You can view the status of the projects along with the labels in the search results. This view also shows
the planned vs actual status of the project status.

How Can you Set Up a Search with the Calendar View?

1. Go to Search > Projects.

2. Select the View check box Project Calendar to view in the Search results page.

3. Click on the gear icon to open the Configuration options for the Project Calendar. You can configure
the Project Calendar options to display your project status in a dynamic way. Configuration options
allow you to choose multiple options, which can provide information on the current status of your
projects and predict the future state. You can set the status based on the task completions or on
the date of the project statuses. Read more on Set up a Search with a Project Calendar on page

138.
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4, Specify the width (in pixels) for the calendar column (minimum is 200px but you get better results
with 500px). Decide whether to also show the project status icon (which will then appear at the left
of the calendar).

5. Click Search to view the Project Calendar.

Note that the calendar is displayed in the column defined for the project status. By changing the
column order for this column, you will move the calendar in the search result. In most cases the best
result is obtained, if the calendar is the last column and if there are not too many preceding columns.

Seanch Parwl Design Enabls SmistNames B Wiew ColumnOrder  Edlable  Serl  Oeder 3 Clear this Fisrm
F"'.'h_]H'! Hame 3 i " I = 28 Cmarrk BGamdte Nechhanrd
Configuwation Options 1)
E Dipticn:
Description = i
Show Calendar Wiew containing
Project Statms | Show A - | = o Higtory -
T e
Peejeel Calendes 4 It
] ared Flanning based an Prajeci Ska e Daiz
Created - r — Predietions bated an Taks ki Bumion
Hertory and Flanning based on Tasks At Butten
Wadfed = = T} Hiabory, Predio "-' d cen [ o whoo rxporting

e g e, ST T

[ - = £k & # Show “Clear this Foem'” Bosion

Set up a Search with a Project Calendar
To set up a Saved search with Project Calendar option, in the search page.

1. Click onthe gearicon in the Project Calendar row to open Configuration Options
2. Choose the options from Show Calendar View Containing drop down options.
Options in the drop down are

- History: shows past statuses (history)

+ History and Planning based on Project Status Due Dates: shows past statuses, planning based
on the milestones that are linked to the project status and the originally planned timeline (in

gray)
- History and Predictions based on Tasks shows past statuses, predictions based on the tasks

« History and Planning based on Tasks shows past statuses, due dates based on the tasks or the
lead time depending on which one is the latest.

» History, Predictions and Planning based on Tasks shows past statuses, due dates based on the
tasks or lead time and the originally planned time line (in gray).

Note: The last three options are available with the task management license only.

3. You can select the Apply Forward Planning to calculate Predictions option, when you choose the
History Predictions and Planning based on Tasks or History Predictions based on Tasks. In such a
case, forward planning is done based on the start date and the next due dates are calculated based
on lead times.
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When this option is not chosen, then backward planning is done where the due date is considered
and the other due dates are calculated backwards based on lead times given.

4. Select Show Project Due Date to display the project due date in the search results.

5. Specify the Calendar Column Width in the box for the calendar column (minimum is 200px but you
get better results with 500px).

6. Labels Shown on Project Status Bars gives options to display the labels in the Project Calendar
view. You can choose the labels to display Label shown on Project Status Bars from the drop down
list as one of the below:

«  Number of Project Status

« Numberin order of Appearance
« Nolabelor

« Status Name configured

7. Select Search to view the search results.

In the Search Results page, Project Statuses of the project is shown over timelines.

MAR 2018
<> @aqQaQ Fri, 23 Sat, 24 Sun, 25 Mon, 26 Tue, 27 Wed, 28
actua 1. Briefing (CalDemo 2. Artwork Creation
plan 1. Beiefing 2. Artwork Creat... 3. Ariwork A HDATSAGHCREID
actua 1. Briefing (CalDemo
plan 1. Briefing

actus

plan

actus

plan

actua 2. Artwork Creation
plan - 2. Artwork Creation

actua 1. Briefing (C.. 2. Artwork Creation 3. Artwork A.. 4. Ariwork R_. |
plan 1. Briefing 2 Artwork Creation 3. Artwork A_. 4. Artwork R__|

actua

. Briefing i 3. Artwork App
plan 1. Brie_. 2. Artwork Creation 3. Ariwork A_. 4. Ariwork R_|

The timeline can contain 2 bars:
« Actual: Displays the actual state of the project now.

For values in the past this bar will always be there and will show the Project Status History.
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For values in the future it can also show predictions based on tasks. Predictions based on tasks show
the due dates of the tasks or the lead time depending on which one is the latest or which one is first
when using forward planning. When calculating the date with lead times, week days are taken into
account.

« Plan: Shows the planned project status of this project.
Planning based on tasks shows the due dates of tasks that have an effect on the project status.

Planning based on milestones shows the values of date attributes in the project that are linked to the
project statuses.

Using the Basic Calendar View

In the basic Show Calendar View only 1line is displayed and it stops at the vertical today’ line.

« Thevertical black line is always on ‘today’. So the current status of the project can be seen from the
color where the black line cuts through the status line.

L Y=Y

« You can zoom the calendar view with the + and - buttons or with the scroll wheel. This changes the
time scale from months to weeks to days or reversely.

+ Youcan pan the calendar view by using the arrows (just before the + and - icons) or by dragging also.

« Clicking the magnifier icon resets the view.

« Thecolors are as defined in the project status setup. (Admin/Project Management/Project
Statuses).

. The number displayed corresponds to the project status index(same statuses have the same
number in all projects).

+ The small red vertical line indicates the project due date (if set).

« The color changes on the date where the project actually changed status.

« You can hover over any of the status blocks to get more information (name of the status, start and
end date, status type, calculated delay).

78 |

Completed

Status E-(78)

Started: Jun 10, 2013 15:26
Completed: Mar 18, 2074 14:31

| |Aprzs. 2014

Using the Calendar View with Predictions

Note: Calendar view with prediction is only available if the user has the task management license.

In order to use this feature, your projects must have Tasks configured to set Project statuses.
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« Thefirst part of the project line (till today) works as in the basic view.

- The second part (after today) shows a prediction of the project based on the project tasks
(rescheduled based on their current status). The estimated due date is based on the task
predecessors, task due date and lead time.

« Alighter version of the project status color is used to draw this part of the bar. For each project
status, it will look for a task completing this project status. Then it will determine from predecessor
logic which tasks need to be completed to complete this task, and how much time this will take in
total. For not started statuses, this will be the length of the block. For started statuses, it will first
subtract what is already consumed and only add the remainder (potentially nothing) to the block.
This way the time line is extended.

8.3.5. Using the Calendar View with Planning

When using this view, you will see 2 lines for each project, a colored line and a grey line.

« Thecolored line behaves identical to the ‘calendar view with predictions’.

« This grey line shows the planned project time line based on the project tasks. For each project
status, it will look for a task which completes this project status and for this task, it will take the
due date. This will determine the end date for the grey block of this project status(the begin date is
simply the end date of the previous status).

Notes:

« Subtasks are left out of the calculation.

- Incase multiple tasks are set the same project status, one (merged) stage is shown only. This
situation is best avoided.

« Incase no project status history is available, nothing is shown.

« ‘Completed’ Project Statuses are not shown in the calendar view. When a project has been put to
completed, and was started again later, there will be a gap in the history bar.

8.3.6. Project Status History Settings

In order to be able to show the project feedback, the project status history option must be turned on.
When loading the page, the following tests are made:

- |fthe global settings for the 'Project status change'include in project history is turned off, a
message box with a clear message is shown.

« If project specific settings for the 'Project status change'include in project history is turned off for
some projects (and the global settings is on), a warning icon with a clear tooltip message is shown
next to the project name.
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8.4. Search on Project Duration

Duration Reporting for a project

You can search for projects based on the Start date, Due date, Completed date, Duration and Time Left
of the project. You can save the searches and add it to the dashboard to have an instant view of the
progress of all the current projects.

Field Name

What it means

Started

The start date of a project is the first time the project was set in an active
status.

Completed

The last date the project was set in a completed status

Due

The due date is shown in the project details.

Duration

The time between the start date and the completed date. Only active statuses
are considered to calculate the duration of the project.

When the project is not completed, the duration is the time between the start
date and the current date/time.

Time Left

This is the time between the actual completion date and the Due Date. When
there is no due date, the time left is not shown as it is not relevant.

When the projectisin progress, the Time Left is the time between the due date
and the current date. When the current date/time is still before the due date, the
project is not overdue.

In this case, the time left is a positive number, indicating that there is still time
remaining before we reach the due date.

When the current time is after the due date, the project is overdue. In this case,
the time left is a negative number, indicating how much the project is overdue.

How to find Project Status Duration

You can also find the Duration metrics on the time spent in a given stage of the project. Projects
statuses can reoccur multiple times and you can compute the duration of time in each of the given

status.

143



ESKO

144

WebCenter
Project Status Started - Select Project Statuses that you want to search on
(®) Prepress Creation Started  this week - i
() Prepress Approval Started  this week h i

You can filter each selected Project Statuses based on the duration criteria

Project Status Duration -
@ Prepress Creation Duration »= - = 2 days 1‘.} [}
(®) Prepress Approval Duration = >= » = 7 days o 7
Field Name What it means

Project Status Started | Th¢ start date of a project Status is the first time the project was set in the
selected status.

Project Status The completed date of a project Status is the last time the project was in
Completed the chosen status before it was changed to a new status.

Project Status The project status duration is the time that the project spent in the selected
Duration status. It is the sum total of all the time the project was in a particular

status. When the project went into the selected status multiple times, the
duration is the accumulated time the project spent in the selected status.

In this field, you can filter on the duration in days of the selected status.

Project Status Time It is the time the project was in the Project Status. When there is no due
left date, the time left is not shown as it is not relevant.

When the project is still ongoing, the Time Left is the time between the
current date with the Project Status Due. When the current time is before
the Project Status Due, the project is not overdue yet.

When the current date is after the Project Status Due, the project is
overdue. In this case, the time left is a negative number, indicating how
many days the project status is overdue.

For example: Let us assume that

Day 1:Jan 01 00:00 till Jan 02 00:00 => Project was in StatusA.

Day 2: Jan 02 00:00 till Jan 03 00:00 => Project was in StatusB.

Day 3: Jan 03 00:00 till Jan 04 00:00 => Project was in StatusA.

Project Status Started of StatusA is Jan 0100:00 (first time project was in StatusA)
Project Status Completed of StatusA is Jan 04 00:00 (last time project was in StatusA)
Duration of StatusA is 2 days and Status B is 1day
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8.5. Asset Browser

Asset browser is a user-friendly feature to search and find assets in a large collection of WebCenter
assets. You can customize the Asset Browser into the WebCenter Menu for easy access. In addition,
you can create more than one Asset Browsers in the same WebCenter with different names for
different sets of users for easy browsing.

For example, a project manager can benefit from an Asset Browser which will collect Project
Templates and a printer will benefit from one that points to finished Projects which are ready to be
printed.

You can create a menu item which can be named “Assets” or "Repository” or simply "Search” or
“Browse”. This menu will be linked to a highly configured Global Saved Search which will function as
your Asset Browser. One Asset Browser can be linked to one Attribute Category as in saved searches.
However, this Attribute Category can have multiple Cascading Dropdowns resulting in multiple
independent trees in the same asset browser. Read more in about Saving Searches as Asset Browser in
Setting Up an Asset Browser on page 147.

A customized graphical Asset Browser will help you to visually browse through projects and graphical
assets previously stored in WebCenter. To achieve this, you need to classify assets using custom
attributes with graphical icons(Attribute Value Images). Read more about graphical labeling of
attributes in Setting Up a Graphical Asset Browser on page 152

You can set up a graphical browser or a tree browser and both. Technically, the Asset Browser has
all the features of Saved searches which is enhanced with Tree and Graphical browsing through
Cascading Attributes. Read more about Cascading Attributes in Lists on page 291

8.5.1. What You Need to Know about Asset Browsing

Concepts Used in this Section

Concept Definition

Asset Any digital file including pictures, graphics (PDF,
lllustrator, ...) and Office documents stored in the
WebCenter. For example a piece of packaging
design that is uploaded to WebCenter.

Asset Browser A user-friendly way to find assetsinalarge
repository. Read more in Asset Browser on page
145

Repository A part of WebCenter which is considered to

contain assets. WebCenter as a whole is a
repository but by filtering you can pin-point to the
specific section of the repository. You can achieve
this by filtering on:

« certain document types
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Concept Definition

« range of projects based on project
characteristics or naming conventions

« both documents and project range.

Saved Search Highly configurable Saved Searches from
WebCenter 12 onwards. Read more in the following
sections from the WebCenter User Guide.
Advanced Searching on page 116

Tree browser This tree is built based on your Cascading
Attributes which you can put in the left panel to
browse through the assets.

Search Parameter Panel A panel appearing at the top of the search results
of Asset Browser which you can use to further

refine your search.

Organizing Assets in WebCenter

You can use the Asset Browser to its full extent by organizing Assets in WebCenter. You can upload the
assets in bulk during the early stage of the WebCenter deployment which will grow with new designs
and documents. For conducting effective search via an asset browser, you need to specify Attributes
(metadata) for your assets while uploading them to WebCenter. You need to:

« define Attributes.
« assign those attributes to Attribute Categories
« assign the right attributes from this Attribute Category to the assets(documents)while uploading.

From WebCenter 12 onwards, you can assign these Attribute categories automatically to uploaded
documents. This is done by:

« using default Attribute Categories using Document Types.

« using document templates with Attribute categories

Read more about this in Autonaming Projects / Documents on page 418
When you store assets in specific projects you should ideally:

« have at least one project template created for projects specifically meant to store assets. This
helps in setting up Security, Roles, Autonames and default Attribute Categories which will aid in
better organization.

« not store too many documents in one WebCenter Project. Since Projects only have one level of
folders, project browsing gets slow when there are too many documents or too many folders in the
project. Asset Browsing will be easier when they are stored with pre-determined metadatain a set
of projects.

Note: You do not have to specifically create “asset projects”. It is possible to design an Asset Browser
for entire WebCenter site.

8.5.2. Creating Asset Browsers
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Setting Up an Asset Browser

1.

Save a Search using your own search settings.

Asset Browser is essentially a highly configured Saved Document Search. Therefore, the features
of Saved Searches are available in the Asset Browser. You can:

Set the Saved search to be Global or Personal as an administrator.

Note: You should use the Global setting for Asset Browsers. Personal searches does not serve
the Asset Browsing function since they can only be used by admins who create them.

Filter on almost any property or attribute of documents in advanced ways.

Define a drill-down (parameter) panel to appear at the top of the search results.
Assign the saved search to a menu item.

Assign which document properties or attributes will be displayed in the search results and in
what sequence.

Set the sorting order of the results.
Set a preference on how many search results will appear per search result page.
Define what operations can be done in the saved search results.

Define layout settings of the search results (grid versus list, number of results, thumbnails or no
thumbnails).

Read more in the following sections from the WebCenter User Guide.

Advanced Searching on page 116

To Save a Search

To Search Content

Add Cascading Attributes to the Saved Search. You need to follow the steps below.

a)
b)

c)

e)

Login as an administrator

Create Cascading Attributes. Read more in Lists on page 291. Create an attribute category with
these Cascading attributes with which you want to customize browsing and displaying.

Go to Search > Saved Searches. Choose and edit the Saved Search from the previous step. If
you did not save the Search, go to Search > Documents and restore the previous settings (within
the same session) or start over.

Click on the Attributes link. Add the Attributes from the Attribute Category that you want to
assign to this search.

Note: Only the Cascading attributes from theAttribute Category are available for tree browsing
in Asset Browser.

: Avoid Using the same Attribute in different lists used in the same Asset Browser as it leads to
unpredictable results.

Enable Search Panel Design. In the Search Panel Design, you should set these attributes to be
Visible/Available
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Tip: The tree view in the Asset Browser requires the attributes to be set to Visible or Available
in the Search Panel Design.

You will have a top panel with Visible/Available Attributes to refine the search. Selecting a value for
one Attribute will limit the values for other Attributes.

Note: If the Attributes appear but not as dropdowns, check whether the Attribute Category is
correctly configured. Assign it to a document to test whether the cascading effect works.

3. Create a Browsing Tree using Cascading Dropdowns.

A cascading attribute can be shown as a tree or as a set of mutually dependant attribute dropdowns
where choice of one from a dropdown limits the choice available in other dropdowns.

Attributes in Category BO_ltem ,* [ =
Meta Data
Category Beverage v
Brand Get Set v
Product Energy Drink v
£l - Advanced...
ement fype Energy Drink

File Type
Values requiring changes to other selections:

Energy Bar

m Export to JOF Import fron Energy Gel
Hand Cream

Perfume
o "
Shower Gel
Sports Watch
Vitamins
Search Results
Current Selection: FileType | 3D Mockup v Market
(@ BO_Master Data ~ Beverage ~ Get Set ~ Energy
Drink
More...v
¥ BO_Master Data
¥ (] Beverage
¥ (et et GET SET_BOTTLE BL.. = VIEW_GET SET_BOTT.. = VIEW_GET SET_BOTT.. =
» (@ Energy Drink =\ -
» (] Energy Gel -
» [ Food »
» [ Health Care -
» [ Personal Care | GET| GET
P (] Sportswear = s T
a5
=
VIEW_GET SET_BOTT.. = VIEW_GET SET_BOTT.. = VIEW_GET SET_POUC.. =
(=) (=]
4]
_— | —= |
I gl
SET, /i I =
e L - |
el s

Found: & items. Page1of 1

You can choose from any of these two options or both views together. Read below some remarks
about these options.
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« Thetree view takes more space and loads slower
« The tree view allows multiple selection
« Thetree view can be restricted using the depth parameter

« Dropdownsin the top panel can also be restricted

« Thetree view can be shown in a graphic way (using thumbnails). This takes even more
space on the screen but creates a beautiful user experience provided you have good image
representations.

a) Goto Search > Saved Searches. Choose and edit the Saved Search from Step 1. If you did not
save the Search, go to Search > Documents and restore the previous settings (within the same
session) or start with a new Search.

b) Click on Show Result Layout Options. This opens a panel with additional options.
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Docurment operations:
0 View
) Open in ArtiosCAD

Download

Define Attributes
Approval Info

Mail Link To

Upload Mew Version
) More actions

Other display options:

) Show "Save this Search” Button

) Show "Save Search Results" Button

) Show "Hide Thumbnail® Button

# Show "Show as Grid/List/Cards” Button
# Show Labels in Grid/Card Layout

) Set Labels in Grid Layout in bold

Initial Results Display:

Advanced Functions:
) Allow Changing Attribute Category
) Custom Actions
) Show Search Button €3

# Show Cart €
# Show Project Creation Link €

® Mo Template Specified
2 Fixed Template
Flease select or start typing... -

2 Template from Characteristics Path

€» Liststo be shown in left tree panel:

Type Mame Depth  Height

E [Demo_Sheet Brand | | | | | px

EIE [Demo_Sheet Packaging | | | | | pxx

E [Demo_Sheet Product | | | | | px

[Add List

Tree panel width: px

Image Area Style: | Left panel and image panel i ]

# Allow Changing Image Area Style via Dropdown

c) Enterthe list names that you have configured in the Listmanager project.

Note: You can add lists to the tree panel by clicking on Add List or remove them by clicking on
the =icon. Use the arrows in the second column to move the lists up or down.

d) Setthe properties for each list. These properties are applicable when a left tree panel is
selected.

Depth If you leave it empty, all the columns
from lists.xml will be available.

If you need four columns out of five
columns from your lists.xml, enter 4
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Height You can set a maximum height for the
tree here.

If you leave it empty, the tree will take as
much space as it requires.

If the tree height is bigger than your
entry in this setting, a scroll bar will
appear.

Note: You canenter 1000 pixels or less
for the best user experience. However,
it can vary depending on the size of the
user monitor.

e) Set the browsing style for Tree browsing and Image browsing by modifying the following fields.

Tree panel width Default Tree panel width is 300 pixels
which you can increase or decrease
depending on your requirements.

Image Area Style For a browsing tree at the left hand side,
choose Left panel only (no images)

If you want to browse through an image
panel at the top, choose Top panel only
(no tree to the left)

If you want both tree browsing and
image browsing, choose Left panel and

image panel
Allow Changing Image Area Style via If you want the user to change the
Dropdown browsing style, enable this option.

4. Save/Run this search.

If you have save it as a global saved search, all WebCenter users can run this asset browser from
their saved search lists or from the menu if you have customized a menu item for this Asset
Browser.

Note:
You canrestrict access to the Asset Browser by:

« deleting Saved Searches item from the Search menu for the restricted Users.

+ deleting the menu item assigned for the Asset Browser.

When you run the search, you will get a tree in the search results. This tree will have branches
according to the columns in the lists (Cascading Attributes). You can see in the screenshot below:

« 1. The user can choose from three options. This is only available when you have enabled Allow
Changing Image Area Style via Dropdown. See the explanation above.

+ Show left Panel
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« Show Image Panel
» Show left and image(top) panel
« 2.Tree Panel. This shows the information from the lists

« 3.Search Parameter Panel where you can refine your search using Attributes or document
properties.

» 4.Ilmage Panel
« b5.Search Results

Search Results Show Left and Top (Image) P!e r Clear this Form
Show Left Panel

Current Selection: Show Top (Image) Panel —
Show Left and Top (Image) Panel

¥ Demo_Sheet Brand

== Select criterion - v
= ) Enfocus Vall
P 1Esko Value
¥ Demo_Sheet Packaging a ®
» 1 Displ 1 P Y Y
ey 14 o e o ESKOS
> QPrimary enfocus
P 1 Secondary I e,
) Tertiary Demo_Shest O O
¥ Demo_Shest Product Brand Enfocus Value Esko Value
B O Lubricants
- O Speciality Your Cart is empty
i Q, View and Annotate @ Compare in Viewer 4 Download Sortby | Name v

More...- a

O Eco_Speed_back-wer...

O Eco_Speed_front-wer.. = O ErrorReduction.pdf =

Setting Up a Graphical Asset Browser

As already mentioned, the tree panel to the left can be replaced with a panel of images at the top.
Alternatively, you can choose to have both at the same time which will give you synchronized results.

These images are a representation of the attributes and you can also configure an image label for an
attribute.

1. Create images for each value of Attributes and lists.
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Note:

« Forthe best user experience, use .jpg images. It does recognize .gif,.jpeg and .png.
« The name of the Attribute (or lists) and the image should be entirely the same including the
case of the letters. Extensions should be specified in lower case.

« Theimages appear as 100x100 pixels. If you add images exactly of this size, best performance is
assured. If the sizes vary, it will be adjusted to fit into 100x100 appearance. Therefore, the image
appearance will vary depending on your browser's capacity to scale images.

(] AttribureLabellmages

3 »
20l custom Els
EJ (1] AttributesHelp ’
; } Macintosh HD . B AttributeValuelmages >
=

(1] Characteri.. Thumbnails

() Network b [ excel

Blister.gif
Brand.gif
Carton.gif
Color.gif
Display.gif
Enfocus Value.png
Error.gif

Esko Value.jpeg
Expert.gif

Flex Bag.gif
Green.gif
Innovation.gif
Label.gif
Lubricants.gif
Packaging Type.gif
packaging.png
POS.jpeg
Primary.gif
Product Type.gif
Profit.gif
Secondary.gif
Shrink.gif
Speed.gif

(EICEIE T NEN S

|3/ |5 o [be (<2 (3 1 [=

&[5 [2

(1 [ =] o] e [

[ ]
3
g
2
Q

= Trust.gif

2. AddtheseimagestoWebCenter\WebServer\tomcat\webapps\WebCenter Inst\custom
\AttributeValueImages.

If more than one WebCenter instance is used, you have to copy this setup to each instance.

AssetDemo Show Top (Image) Panel (=]
Brand: "Esko Valug" Document Name: [ |  Sub Brand: |:|

variant: [ ]
Search | --- Select criterion --- IZ'

Current

Selection: h I -
. e*n_-ma“'. _- é!)"; L These images correspond to the lists
T M"W (cascading dropdown lists).
Y S

Brand Packaging Product

Your cart is empty
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AssetDemo Show Top (Image) Panel [=]
Brand: 'Esko Value" Document Name: [ Sub Brand: l:l

Vardant: [ ]
Search ——- Select criterion -— :

Current

Selection:
Esko Walue

Attribute label images

Note:

Make sure that you have an image for each list used. In the above example screenshots above, this is
Brand.jpg, Packaging.jpg and no image attached with Product.

Use a .jpg for the lists since list images will be frequently used. As mentioned earlier, WebCenter is
optimized for .jpg. When some attribute value has no fitting image, the list image will be shown instead.

Removing the Search Button from the Asset Browser

If you keep the Search in the asset browser, for every search modification in the Asset Browser, you
have to click it to refresh the results. You can remove this button from the Asset Browser to improve
the user experience.

By removing the Search button, you can:

« saveonscreen space in the Asset Browser
« anychange in the search criteria from the browsing tree or the search panel will update the results.

You can accomplish this by editing the Saved Search created for the Asset Browser:

1. Go to Search > Saved Searches > Edit Search
2. Onthe right hand side of the page, click on Show Result Layout Options
3. Disable the Show Search Button option.
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Docurment operations:
O View

) Open in ArtiosCAD
) Download

) Define Attributes

) Approval Info

) Mail Link To

) Upload New Version
) Mare actions

Other display options:
[ Show "Sawve this Search” Button
) Show "Save Search Results" Button
[ Show "Hide Thumbnail” Button
# Show "Show as Grid/List/Cards” Button
# Show Labels in Grid/Card Layout
) Set Labels in Grid Layout in bold

Initial Results Display:

Advanced Functions:
) Allow Changing Attribute Category
[ Custom Actions
[ Show Search Button €3

# Show Cart €3
¥ Show Project Creation Link

® Mo Temnplate Specified
2 Fixed Template
Please select or start typing... -

2 Template from Characteristics Path

€ Lists to be shown in left tree panel:

Type MName Depth  Height

% 7 list [Demc_Sheet Brand | | | | | px

%) st [Demo_Sheet Packaging | | | | | pxx

% 7 list [Demc_Sheet Product | | | | | px

Add List

Tree panel width: px

Image Area Style: | Left panel and image panel i ]

# Allow Changing Image Area Style via Dropdown

8.5.3. Customizing the User Menu with the Asset Browser

Assigning a Menu Item for the Asset Browser

You can create and assign a Menu Item for easy access to your Asset Browser. The procedure is
similiar to assigning a menu item for Saved Searches. Read Add Custom Menu Items from WebCenter
Customization Guide for details
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1. Go to Admin > Preferences > Menus. Download the XML file or create a new XML file and add the
following code under the NON_ADMIN.

<menuitem>

<name>AssetDemo</name>

<labeltag>Asset Browser</labeltag>
<url>dosavedsearch.jsp?searchName=AssetDemo</url>
</menuitem>

2. Assign the scope of this menu to the (set of) users or to a Company/Location. Read more in Add
Custom Menu Items

3. Save this XML and upload as a new menu.

This results in the following Menu Item named Asset Browser. The search results are directly avaiable

by clicking on this item. The name of the page is the same as the name of the Saved Search. In this
example, the page appears as AssetDemo instead of “Search Results”

|Juest | Projects v | Asset Browser ¥ | Search v | My WebCenter v | upload | Projects [=]

ear this form

Brand: ["Esko value” (NOT vALID)[*] Document Name: [ ] Sub Brand: ---Please Select-—- | ¥ |
Packaging: ---Please Select-—- [« ] Packaging Sub Type: ---Please Select--- [« | Product Type: ---Please Select-—- [« ]

Variant: ——-Please Select—  [+]
Search --- Select criterion --- [ ¥ |

Your cart is empty

Found: 13 items. Show as List Page 1 of 1

[] | Name Actions Description  Project Brand SubBrand Size Packaging Packaging SubType ProductType Variant

O il 2 Green disploy 12 026 IMAS Prinales Demo ESK®  Green 3Nos  Display POS Lubricants  Petrol
header.ai value

O il 2 Green displov Asset Library Esko  croen 3Nos  Display POS Lubricants  Petrol
header.ai = value

Assigning Submenus to Dedicated Asset Browsers

You can customize your Asset Browser further by creating submenus for different asset browsers with
a more dedicated and simplified user interface. This will help you to navigate easily between the asset
browsers( saved searches. You do this by adding a submenu to the asset browser’s menu item which is
explained in Assigning a Menu Item for the Asset Browser on page 155.

1. Setup dedicated Asset Browsers for your assets. These are Saved Searches called Brands and
Packaging in this example.

2. Update the XML file with the similiar fragment as in the example below. You can see that there are
submenus for the set of Asset Browsers created in the previous step.

<menuitem>

<name>Asset Browser</name>
<url>dosavedsearch.jsp?searchName=AssetDemo&amp;actionMenu=Asset Browser</url>
<labeltag>Assets</labeltag>

<menuitem>

<name>Brands</name>

<labeltag>Brands</labeltag>

<url>dosavedsearch. jsp?searchName=Brands&amp; actionMenu=Asset Browser</url>
</menuitem>

<menuitem>
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<name>Packaging Types</name>

<labeltag>Packaging Types</labeltag>
<url>dosavedsearch.jsp?searchName=Packaging&amp;actionMenu=Asset Browser</url>
</menuitem>

</menuitem>

Note:

« This will result in submenu which folds out and permanent links on the top left below the main
menu bar. The second one is caused by &amp; actionMenu=Asset Browser.

« Check the spelling as every character is important.

« This code addition is not necessary if you use one menu item for a single Asset Browser alone.
Example in Assigning a Menu Item for the Asset Browser on page 155.

3. Upload this XML to a new menu or update a previous menu in Admin > Preferences > Menus
4. Assign this menuto a set of Users or a User. You can also assign a menu itemto a
Company/Location. This versatility helps you to restrict the access to specific Groups and Users.

Clicking on Brands under Assets will bring you to the saved search called Brands. You can save this
with simpler settings or with a graphical asset browser according to your preference. It is possible to
give different names to the Saved Searches and the submenu items.

8.5.4. Advanced Options in Asset Browser

Configuring the Cart in the Asset browser

You can configure the Cart in the Asset Browser which can assemble the assets selected from the
Asset Browser. From the Cart, you can:

« startthe viewer

« download the assets

« startanew project with these assets
« modify the assets.

You can do several rounds of searching and browsing to add documents one by one to the Cart and
then proceed with the actions listed above. The Cart has to be configured by the administrator while
determining the settings of the Asset Browser (the Saved Search).

1. Inthe Search Settings, click on Show Result Layout Options which will open the Advanced
Functions.

2. Enable Show Cart.
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Advanced Functions:

! Allow Changing Attribute Category

! Allow sending Download Mail for Multiple Documents
| Custom Actions

| Show Search Button €3

¥ Show Cart €
¥ Show Project Creation Link €

' Mo Template Specified
'® Fixed Template
BO_Packaging v

') Template from Characteristics Path

3. Save the search.

The next time you access the Asset Browser, the Cart will appear within a few seconds. You can now
add your selections to the cart.

Search Results Shows Left and Top (Image) Panel ¥ Clear this Form

Current Selection: Document Name

Name

Read more about using the Cart in Using the Cart from the Asset Browser .
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Configure Project Creation from the Asset Browser

Your Packaging Projects often involve modification of existing packaging or creation of new packaging
with recurring elements. You can use a project template for these recurring elements. Asset Browser
will help you to browse for these templates and existing packaging projects while setting up new
Projects. You can either collect the relevant items to the Cart and start a new Project directly or start
Project creation from the action list menu. Follow the steps below to configure this feature.

1. Inthe Search Settings, click onShow Result Layout Options which will open the Advanced
Functions.

2. Enable Show Project Creation Link.

Advanced Functions
Allow Changing Attribute Category
Allow sending Download Mail for Multiple Documents
Custom Actions
Show Search Button

¥l Show Cart
| show Project Creation Link

No Template Specified
® Fixed Template
DEKE_test_this is a template -

Template from Characteristics Path

This will add a link to the search results action buttons (Create project from selected) and to the
Cart CartCreate project from cart.

3. You can choose the template for the project creation from Asset Browser. For this, enable the Fixed
Template option and select the template from the dropdown list.

Option Result
Fixed Template Select the template from the dropdown list.
Template from Characteristics Path You have to specify the path. For example,

projects\modificationTemplates.

Note: Follow the correct spelling and letter
case.

Note: Projects can have multiple
characteristics. The same template can
appear in multiple asset browsers together
with other sets of templates.

No Template Specified This will result in the standard project
creation user interface.

4. Save the search under the same name.

You can either use Create Project from Selected link or Create Project from Cart to create projects
from your selected assets(either from the selection or from the Cart. This will lead to project creation
user interface depending on the template choice made in the steps above. When creating the project,
the selected assets will be copied to the new project.
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Search Results Show Left and Top (Image) Panel ¥ Clear this Form
Current Selection: Document Name
¥ ESmeeiesiinns —Selectererion—  *
» [ Enfocus Value
» 0 Esko Value
¥ Demo.Shest Packaging 0\ b
W (] Display < fanat” 4 ESKO&
o Prmay g enfocus
¥ (I Secondary %, e, ']
» (I Tertiary Demo._Sheet
- Band
Currently in your Cart # Clear Cart
- @& car:
‘g Eco_Speed_back-wor. _‘E Eco_Speed_back-wor. B Final_Collar_Orange_d. B Final_Collar_Orange_d_. O | | Final_Collar_Pear_dist.
Sortby | Name

Final_330ml Label Or.. = Final_330ml Label_Pe.. = Final_330ml Lsbel Ra... =

8.5.5. Tips and Tricks
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Tip:

In certain cases you might want to have your assets attached with different Attribute Categories to be
shown in your Asset Browser. For instance, when you have graphical designs attached to one Attribute
Category and photographs attached to another Attribute Category. If you want your Asset Browser

to show these two types of assets, you can create a third Attribute Category combining these two
Attribute Categories. You can create your Asset Browser attached with this Attribute Category. You
can refine your Search Results from the Browsing Tree or using Search Panel.

It is a good practise to name this combined Attribute Category with the name of the Asset Browser for
future reference. However, this is not mandatory.

Remarks

« You can use any quicker browsers like Google Chrome, Edge and Firefox on Windows PC and Safari
or Firefox on Mac.

- If the same value for an attribute exists in different Attribute Categories, the image label will be the
same in the Asset Browser. For example if you have attribute named "lemon flavor” for Brand A and
Brand B, you cannot have two different images for Brand A and Brand B.

« You cannot search for empty attributes. If you are doing a complex search with multiple
checkboxes from the browsing tree with one of them without a value, the Asset browser does not
give intuitive results.

« Attribute values or list names should not contain disallowed characters for the Windows Operating
system file names when setting up a Graphical Asset Browsing. Avoid the double quote as well.
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8.5.6. Troubleshooting

Problem: The asset browser works fine on on WebCenter Instance but not on another
WebCenter Instance

« Youneed to copy all of the setup to each WebCenter Instance:

« Migrate the ListManager Project or Template.
« copytheimagestowebinstance\custom\AttributeValueImages

Problem: You get a message box with “No Search Panel Exists for attribute xxx”

The chosen attribute is not set to Available or Visible in the Search Panel Design.

8.6. How to Search for Document Reference Attributes

1. To search for document references, click on:

- the attributes link from the Search Projects /Search Documents page.
« the task specifications link from the Search Tasks and Approvals page.

You will get the Search Attributes / Search Specifications page.
2. Choose your Attribute Category with the reference to the document you are looking for.
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Search Attributes

Show Attributes in Category
PACKSHOT_CAD_REFEREMCE_PROPERTIES -

Available Attributes Selection
Filter available Attributes Filter selected Attributes
CAD_DRIENTATION CAD_PRINTAREA
CAD_ALIGNMENT
CAD_DFFSET_X
CAD_OFFSET_Y
PACKSHOT_ARTWORKBOX
PACKSHOT_ARTWORKAMCHOR
PACKSHOT_FROMTBACK
PACKSHOT_USERFRIENDLYMNAME

PACKSHOT_PRINTAREAID

€ »

Clear All Cancel m

3. Foreach of your Document Reference Attributes, you can specify the search criteria as:

Options Description

Empty to search for projects / documents where the
document reference attribute has no document
attached to it.

Attributes...

CAD_REFERENCE is Empty

Matches to search for a specific document by its name.

Note: supports wild cards and special
characters
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Options

Description

Select

to select a specific Document from a specific
Project folder.

This option gives you a Select Document
Reference pop-up where you can specify:

a Project

the Folder

the Document

a single Version or a Revision. If you specify
arevision, all the versions of this revision
will become selected. The default is Any
version.

Note: You can select the Project and Folder
to specify the location of the document.

But the search will locate all the versions

of the same document located in different
projects as well.

Search for Reference Documents

Use Reference field to search on all document reference attributes or specifications in the Project /

Task and Approval searches.

You cannot make it viewable or sort on this field. If you want to make the referenced documents visible
you will need to do this by making specific document reference attributes visible.

Note: It is not possible to search with Empty option.

It is recommended to use the SmartName Document Version ID rather than the SmartName Document
Name. The Document Version ID SmartName uniquely identifies the document version, when it is

searched in the Matched mode.

8.6.1. Searching for Reference and Reference By

Use Reference field to search on all document reference attributes in the Document search.

When using the Referenced by, the resulting Documents will only contain a specific Document if the
latest version of said Document is referenced by the selected Document (Version).

You cannot make it viewable or sort on this field. If you want to make the referenced documents visible
you will need to do this by making specific document reference attributes visible.

Note: It is not possible to search with Empty option.
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It is recommended to use the SmartName Document Version ID rather than the SmartName Document
Name. The Document Version ID SmartName uniquely identifies the document version, when it is
searched in the Matched mode.

You can search or create saved searches for Documents with reference attributes. You can search for a
specific document used as a reference either by name or its project and location.

In both the Reference and Referenced by options, you can use

» Select/Matches: to search for the documents that are referencing a given document (version)

« Select/Matches (any level): to search for the documents that are referenced by a given
document(version)

Find an example below where both options are explained.

o,

f/ \‘n

L Docd J

’/h <
o P
( Dioc2 ) ( Dioech )

L / \ /
o T
Ao Y
( Doci V([ Doc3 \ ( Doch )

! PR / \ /
A N M

e e M

The arrows show the relation between the documents(E.g. Doc4 has a document reference to Doc2)
Reference

» Select“Doc1”in this field and it will return Doc2.
« Select(any level)"Doc1”and it will return Doc2 and Doc4.

Reference by

« Select“Doc4” this will return: Doc2 and Docb.
« Select(any level)"Doc4” this will return: Docl, Doc2, Doc3 and Docb.

Both the Reference and Referenced by support “Any level” searching for Document References. It is
possible to turn the "Any level” searching off in the search crawler settings.

When using the Referenced by, the resulting Documents will only contain a specific Document if the
latest version of said Document is referenced by the selected Document (Version).

E.g. Document A references both Document B (version 1)and Document C (version 1whilst latest
version is version 2)=>when searching for “Referenced by” Documents of Document A only Document
B will be found.
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8.7. Searching Documents

In Search for Documents page, you can filter the search to a specific document type. When a
document type is selected from the drop down, all additional parameters configured for the selected
document type becomes visible.

8.7.1. Search Documents by Version Count and Approval Version Count

As a Project Manager or Admin user, you may want to find the number of versions of a Document
existing in WebCenter (Version Count) or want to filter for certain count of Document versions on which
approval cycle has started at least once ( Approval Version Count).

To search the Version Count or Approval Version Count in the Document Search,

» checkthe field in the view and specify the column order

« enterthe criteriain the respective field along with filtering conditions like greater than, equal to or
lesser than for Version Count and with filtering conditions like greater than, equal to, and variance
for Approval Version Count.

Search results shows the Documents along with the number of versions and number of approval cycles.

8.7.2. Searching on Documents

Search by Document Size
Users can search for documents which are of a certain size range using Version Size.

Version size will only show the size of the version of the document shown in the results. The size of the
previous version of the document is not shown.

The Version Size criterion is available for all document types. You can search, sort and facet on the size
of the document version (in bytes).

Search by Document Created Date

You can search the documents based on the creation date in arange or in the specified previous
number of days and make it hidden or visible or available in the results.

Folder Search

You can search for the folders and it is described in detail here.

Live Text in Document

You can search for a text within a pdf document or a Al file using this Live Text in Document. This field
is available for search, based on the setting in the Search Crawler configuration set by the Admin user.
This search does not find results for the text present within an Image or outlined text.

When the search results are shown as a Focus layout with a viewer block, the matches for the searched
text are highlighted in the document. You can navigate through the matches to see where the searched
text occurs. The number of instances of the text occurring in the document are shown in the header.
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Note: This field does not support right to left text used in languages like Hebrew, Arabic.
Live Text in Document | tropical
[0 GET SET - Bottle Label - Coconut&Berry.ai 1ofgl < >

Text matches: 1/2 > Erl @ {D

ENERGY DRINK

TROPICAL BLEND

You can navigate through the matches to see where the searched text occurs.

Search Results Save Search As... Save Results to Excel
3]
0 01_Green_Hanger_MP.pdf 50f714 | € >

Text matches: 1/11 % &1 @t @ 1|E|f2 Pages

1. Navigate through the text matches within the document
2. Navigate through the pages within the same document
3. Navigate to the next document in the search results

The number of instances of the text occurring in the document are shown in the header. When multiple
pages contain a match for the searched text, it is indicated with an asterisk and navigating through the

matches will also navigate through the different pages. By hovering over an arrow, you can also see the
number of pages containing a match.
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Search for Live Text in Document only works on left to right text. For example, text in Arabic or Hebrew
are not supported yet.

8.7.3. Search Document by Reasons for Rejection

You can search on documents for Reasons for Rejection. You can either search for the current version
of a document or search for all versions of the document.

Both the fields has 3 modes and a text field where you can enter any text. You can search for:

» Both Category and Reason (default)

« Only Category
« Only Reason

When searching in Both Category and Reason, this specific reason can be found by using the same
format as shown in the search results: “reason (category)’ or “reason”(if there is no category).

Note: The results are sorted on the Category and then on Reason. Reasons without a category are

displayed after all the reasons that have a category.

8.7.4. Document Duration

Duration Metrics for a document are related to the Approval cycle(s) on the document.

Search Results

Clesr i Foom

'

5 2 2 1

Keizer, Debbie (PEKE)  Gilbert, Randy (RGILBERT)  Plank, Paul (PAPL)  Iefr lefr (LEFR_D)

1 1 1

Khurana, Ishu {ISKH) Sutrick, Neal (NESU) Moonen, Katleen (KAMO)

1 1 1

Matté, Bart (BAMTT) Mattéz, Bart (BaMTZ) Letort, Frantz (FRLE}

Some of the fields you can use to know the metrics of a document approval are

« Start date which is the start date of the approval cycle of the document
« Due date which is the due date of the approval cycle of the document

. Completion date which is the date and time the document reached an approved status

- Approval Duration is the time between the start date and the completion date when the documents
are already approved. When the document is not approved yet, it is the time from the start date

until the current date and time.
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« Time Left is the time in days that is still left until the due date. When the documents are approved
before the due date, the Time Left is positive and shows the number of days it is ahead of schedule,
whereas when the document is approved after the due date, the Time Left is the number of days
the approval was overdue. When the document is not yet approved, this is the time between the
current date and the due date.

8.7.5. Searching for Text Content Document

Search and Select Text Content in Search Menu
To search for Text Content, go to Search > Documents > Search for > Text Content.

Search for Documents

Fill in one or more fields. Prefer less fields? Try Keyword Search.

Search for: | Text Content v|

[J Use Advanced Search Characters €

[ Search Panel Design (] Enable SmartNames €

TEXT CONTENT INFORMATION

Element Type -
Document Status -
Statement
Language  Danish -
Translation -
Text TR 3
Modified -~ | -+
Document Name
yesterday

before today
Version Author = & | ¢ | this week

last week
Author's Location this month
last month
this year
Description last year

maore options...

You can search based on the Text Content Criteria such as:
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« Element Type: To search for a document based on its Element Type, select it in this field. Smart
Names are available when Enable SmartNames is selected. Read more in: Element Types.

« Document Status: To search documents based on its status, select the status (Draft / Signed Off)
from the drop-down.
« Statements' criteria: These fields allow you to select and search based on:
+ Language of the Text Element. For example, select English - United Statestosearch
for Master statements in English (US).
« Whether the Element is a Translation or Master. It can be specified in the Translation drop-
down.

« Thedirectionality of the text will be based on the language selected. You can search both
Master and Translation languages for right to left languages like Arabic or Hebrew.

Note: You can also leave these fields blank. If the language field is blank, all languages (both
Master and Translated) are searched for.

« Actual Text from statements: Type the word you want to search in the Text field.

« Text Element Status: Click ... and select the status from the drop- down. For example, you can
search for Signed-off statements with a particular text piece.

+ Modified: Specify the time line you wish to search for like today, yesterday or last month etc .

« Acombination of Text Statements'criteria
You can add new rows for additional search criteria by clicking +. When you have multiple rows,

you can use either AND or OR operation to refine the Search.

You can also ignore the search criteria mentioned and only display the results by choosing ™"
icon or you can choose the Any option to show results of text documents in any of the status.

Language | English-Ir Translation | Master - W

Text  Mutrients T m

Language French - Frar - I b4
Text Draft R
Pending Signof
+" Signed Of
¥ Signott Reject

* 2
In the example screen shot, the Search will find all Master Statements with Nutrientsinits

content AND with French- France as Translation.

Configuring Text Content Documents Search Results

The Search Results page shows all Text Content Documents that match the specified criteria. Each
statement row selected to View is represented as a single column in the Results.
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Search Results Save This Search  Zave Search Resulls

Hama | Dascription  Project Elamant Typs  Documssat Status  Master English - Unnad Statas Ve ko Mthor

L] P - WITH 26
A : e LR NUTRIENTS
Gam  claimow clakn

A Content WITH 24
Kal#  Content MUTRIENTS

ABE i e Fuad i} ink
anm I W Bl (f claim

] R . . WITH 24
. trupa NUTRIENTS

claim

' WITH 24

ke ¢ HUTRIENTS

claim

Page1 of 1 %o

Note: You can save Text Document Searches in Excel. The document statuses are not included in the
Excel export.

Search Results Options
To customize the Search Results, select your criteria in the Search Result Options fields. The

Document Nameis selected by default but can also be removed by unchecking the box. Read in:Search
Result Options.

Search Panel Design
As an Admin, you can setup a Text Content Search with a Design Panel just like other document saved

searches. The users can select individual text statement criteria in the Panel to filter the search
results.

Note: When smartname is selected for the language field, to view each resolved language in a
separate column in the Search Results page, select the view as visible.

Search Results Clear this Form  Save This Search  Save Search Resuhts

Eemenn Type

Note:

- |f no Statement language is selected from the language drop down, you will not be able to view it as
a separate column. The results will then match Text statements of any language.

« If thelanguage chosen for the text has the directionality right to left or a custom font, then the text

is also rendered right to left or in the custom font in the search results.

Saved Search for Text Content Search

Text Document Searches
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To view My Saved Searches, go to Search > Saved Searches, you can view the saved search in the table
under Text Document Searches. Saved Search for Text Content Document behaves exactly like any
other document saved in the WebCenter.

Note: Only an Admin can modify the visibility of a Global Search.

8.7.6. Search Document by Folder

You can now search and display the folder where a document resides. Folder Search is useful to set
up searches, to find certain types of assets. For example, when you have to search for pack shotsin a
certain folder in the project. You can either select the root folder, or search with the name of the sub-
folder.

There is a new filter on the document search where you can specify the folder to look for. You can
either search in the root folder or the name specified.

Foldler W E3

You can facet the search results for folders in three ways namely:

« Grouped by Folder Name

When searching the system for documents, you can group all the folders by name when you facet on
the results.

Search for Documents in Folders

O 31 23 23 e
BN ok shepes  structure = (3 compsreinviewer & Download T AddtoCan Sortby | Doeument amo g

Document Name: _GETSETMAX_NUTRITION_MAIMN jpg
Folder: Keyshot Visuals
Project Name: DEKE_Demo

Document Name: _INSERT.pdi
Folder: Artwork - Lumi Plus

16 15 15

artwork - alcis  artwork - whisky  3d collada Project Name: DEKE_Componants Demo

Folder (Project)

Document Name: _MAX_BLUE_BACK. jpg Document Name: _MAX_BLUE_TOPjpg
Artwaork (DEKE_Demo) Folder: Keyshot Visuals Folder: Keyshot Visuals
Root Folder (DEKE_Demo_Upload Files) L 25 Project Name: DEKE_Demo Project Name: DEKE_Demo
Shapes (DEKE_Components Dama)

Structure (DEKE_Dema)
Document Name: _MAX_BLUE_TOP_DOWN jpa Document Name: _MAX_RED_BACK jpg

rl I

a

a
Folder: Keyshot Visuals Folder: Keyshot Visuals
Project Name: DEKE_Demo Project Name: DEKE.Dema

D I

D -

Artwork - Alcis (DEKE_Companents Dema)

Artwork - Whisky (DEKE_Components Demoa)
Artwork - Get Set May (DEKE_Compenents Demao)
Packehots (DEKE_Companents Demo)

a Document Name: _MAX_RED_TOFjpg Document Name: _TAG pdf

Folder: Artwork - Lumi Plus
ProjectMame:  DEKE_Components Demo

30 Collada (DEKE_Damo) Folds Keyshot Visualk
er: eyshot Visuals

Root Folder (DEKE_Components Dema) L 11 ProjectName:  DEKE_Demo
Artwaork - Gin (DEKE_Companents Demo)
Artwork - Lumi Plus (DEKE_Components Demo)

Root Folder (DEKE_demo_reasons for rejection) L2 ] - ment Name: | ALCIS BOTTLE SLEEVED 22
Folder: Shapes
Keyshol Visuals (DEKE_Dema) Project Name:

Document Name: ALCIS FRAGRANCE FOR_HER_BOTTL
Folder: Artwork - Aleis

DEKE_Components Demo Project Mame:  DEKE_Components Demo

Roat Folder (DEKE_Demo_Show Document Thumbnails i @

Artwork - Get Sel Sweets (DEKE_Components Demo)

« Individual Folders

When searching the system for documents, you can have the folders shown individually when you facet
on the results. In this case, the project name will be appended because you can have multiple folders
with the same name in different projects.
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« Project Context

When searching for documents and faceting on the folders within a project context, this facet option
will mimic the folder structure of the project, meaning all folders are listed, even when they are empty,
and the ordering is the same as on the project documents page.

8.7.7. Search on non Latest version of the document

In WebCenter 18.1.1, we added a new option to search index documents which are referenced to earlier
versions.

To enable this feature, Admin users must select Index all currently referenced Document Versions in
the Search Crawler Setup page. The index is rebuilt wherever the option selection is changed in the
setup.

This option is only useful, when you have the older versions of the documents which are referenced
and it would occur when a document reference with the "Selected Version" option is used.

When this option is turned on, the Document search setup page has a new field, Version Used In.

Version Used in | Project -

Document Reference only
Document Reference or Project

Following are the options that can be chosen when you search for a document based on the version
used.

« Projectis the default option selected and the search returns versions of the documents that are
linked into a project or are the latest version of a document revision.

« Document Reference only option limits the search to referenced document versions that are not
the latest in any Project or Revision.

- Document Reference or Project returns any version in a project or referenced by any other
document.

Note: Only versions referenced from a document reference in Documents are taken into account
and not if a version is referenced from a document reference in a project.

8.7.8. Search on Approval Status

172

You can search for more than one Approval Status by selecting multiple statuses in the Approval
Status field and you can also search on Approval status completed field.

With the Approval Status field you can also search for documents where the approval is stopped or not
set up yet.
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Pending x o~
Approval Status | All Rejected X
Approved with a Condition ¢

Appraval Status Completed | today - 4

Approval Started

yesterday
before today
this week

last week
Approval Completed | this month
last month

this year

last year

more options...

Approval Due

oo 3 O

Approval Duration

8.8. Search on Pending Approvers

Pending Approvers
You can make the Pending Approvers column visible. This column shows all the approvers who still
need to approve. You can also sort, facet, and filter on Pending Approver. There is a configurable
option to show the assignee details of the Pending Approver.

Pending Approvers | & | 28 T

Display User

To enable the navigation and filtering for specified approver(s) easier, you can choose to configure this
fields results. You can choose to show the pending approver(s) field in the Search results page either as
Name or Avatar and Name or Avatar only.

8.9. Searching for Parent or Child Projects

It is possible to search for Projects which are related in a Campaign or Program. This is very useful in
creating Saved Searches that can be used in the context of a Program or Campaign.
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It is also possible to use these Project criteria in the Document and Task searches.

You can use the fields: Parent Projects or Child Projects to specify a name criterion.

Tip: Use SmartNames to use Saved Searches in the context of a Program or Project. If you set the
Parent Project as the [ Project id], your results will list all the Child projects of the current project. See
more in: SmartNames in Search on page 174

Note:

« Thesearchresults depend on the view permissions of the user.

« |tis possible to save the Parent and/or Child Projects in Search results to Excel if that option is
selected.

If you specify the Parent Projects field as campaign , the search will look for Projects with a
Parent Project with “campaign_".

Searching in Parent Projects
When you are searching for Projects who has a certain Parent, you have three options:

« Search only in Direct Parent Projects: Use this option if you want to search in Projects that are one
level higher in the Program structure.

. Searchin all Parent Projects: This option lets you search in all Parent Projects directly above and in
all higher levels in the Program structure

« No Parent Projects: Use this when you have to search in Projects that are at the top of the Program
structure, or the Projects which do not have parents.

Searching in Child Projects
When you are searching for Projects with certain child Projects, you have three options:

- Search only in Direct Child Projects to search in Projects that are one level below in the Program
structure. The second(and deeper) level Projects will not be considered in this search.

« Searchin all Child Projects lets you search in all Child Projects from all levels.

« No Child Projects: Use this when you have to search for Projects that do not have Child Projects.

SmartNames in Search

174

Administrators can create Saved Searches with SmartNames. SmartNames are variables that will
refer to a value when placed in the right context.

Read about the SmartName here.

Note: These searches will resolve only in the context of the Project / Document and will not be useful
as a general search.

When you plug in these searches into a project / document, these SmartNames will resolve with

values retrieved from that context. For example, if you create a saved search for finding the related
projects, your users will be able to view the search results within a project tab. Read more in: Use Case:
SmartName Search to find Related Projects.
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You can also use SmartName searches as the document sources in Document Reference Attributes and
Project Creation.

These SmartName searches will display different results in different projects/documents as the
context of the SmartName changes.

8.10.1. Using SmartNames in Saved Searches
A SmartName is a variable that will refer to a value when placed in the right context (For example,
within a project or in the context of a document).
To create a SmartName powered search:

1. Go to Search > Documents or Search > Projects or Search > Tasks.
2. Enable SmartName.

Use Advanced Search Characters

Search Panel Design ¥/ Enable SmartNames

Project Name []1

All your search fields will display the SmartNames *[1icon.

3. Click on the *[Ticon in the field where you want the SmartName configured.

For example, Project Name can indicate the group of projects it belongs to. In this case click +[1in
the Project Name field.

4. Inthe SmartName dialog, choose the SmartName.

Insert a SmartName...

Sections Sub-Brand| Q
User Existing Program Sub-Brand (Project)
Document Sub-Brand (Project)

Document Attributes
Project

Project Attributes

5. Save the search. Your SmartName search will appear in the list of Saved Searches.

Note: SmartName enabled searches can be saved only as global searches. These searches will be
visible only to the ADMINS group. You can change the visibility of the search by clicking the Edit
visibility button. Read more in Creating Advanced Saved Searches on page 117.
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Global
Project Searches

My Smart Search+[] @ 7

You can plug these searches into the relevant projects where the SmartName will get resolved. Your
search results will then list the results based on the context.

Note: If a SmartName gets resolved into multiple values (a multi-value Project Attribute), your
search criteria will be all of those separated by the OR separator.

Remember: |f you execute a SmartName search from the saved searches page, you will not get
valid results.

Save as Global when SmartName Context is enabled

Note: SmartName enabled searches can be saved only as global searches. These searches will be
visible only to the ADMINS group. You can change the visibility of the search by clicking the Edit
visibility button. Read more in Creating Advanced Saved Searches on page 117.

8.10.2. Use Case: SmartName Search to find Related Projects

176

When you have a group of Projects under a Packaging Project / Program, your projects share
attributes. You can use these common parameters (in the search)to display the related projects /
documents. This is also useful when you have derived-projects created using the Create Project node.

Depending on your business needs, you can customize a SmartName powered search and plug thisas a
tab in the projects details page. For example, you can display all the derived-projects in one tab and all
the related projects in another by plugging in SmartName saved searches in these custom tabs.

Tip: You can configure this as a dedicated menu item for the Project Details / Document Details page.

SmartName Searches in Project Details / Document Details

To use your SmartName powered searches as a dedicated tab of the Project / Document details page,
create a custom menu item.

You can link this custom tab to a saved search with SmartNames.The SmartNames will resolve to
values derived from the current Project (for Project Details Menu Items) or Project and Document (for
Document Details Menu ltems) context.
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The user / group / company with this menu will have a custom tab displaying the search results based
on the SmartName criteria.

8.10.3. Use a SmartName Saved Search as a Document Source
You can create custom Document Sources using dedicated SmartName searches. You can use these
as sourcesiin:

« Project Templates with Document Creation Settings on page 98.

« Documents or Projects assigned with Document Reference Attributes

When the user uses this source during Project creation or to add documents to a task within the
Project, the Saved Search configured as the document source is executed from the current Project /
Document context.

Setting up a SmartName Saved Search as a Document Source
1. Go to Search > Documents.
2. Enable SmartName.
Allyour search fields will have a SmartNames +*[Ticon next toit.
3. Click on the attributes link.

4. Click the *[Ticon next to the attribute from your attribute category.

As an example, if you want to setup a document source for a Customer, from the library of your CAD
files:

« specify the customer related attributes as the SmartName search criteria.

Insert a SmartName...

Sections box Q
User box (Document)

Document Box Brands (Document)

Document Attributes Box Count {Document)

Project Box Name (Document)

Project Attributes BoxCAD {Document)

checkbox (Document)
checkbox1 (Document)

chkbox (Document)

Tip: Configure Search Layout options to get an advanced layout.

The selected attribute(s) will appear in the search form.
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Attributes...

DSR_Customer equals "[DSR_Customer (Project)]”

Tip: The above example will work only in a document assigned with a document reference attribute
(category). If you would use this as a document source in project creation, use the [Box Brands
(Project) ] as the SmartName.

5. Save the search.

Tip: If you want to limit the scope of the search within a library of documents(a repository project),
specify the project name as another criteria.

You can add this search as a document source in:

» Document Creation Settings on page 98 of Projects / Templates.

« Document sources in Document References on page 306

When the user clicks a custom link to add a document as a document reference, the result will be a pop-
up with the saved search results. You can configure the search result layout settings to configure the
features in the document source pop-up.

Please select document

Sortby = Name v

BOXCO_00001.ard = BOXCO0_00003.ard =

vV %

Found: 2 items Page 1of 1

Cancel Copy Move Use By Reference

8.11. Drilldown Searches

You can use Project search based drilldowns to set up a:

« Drill-down into all levels of Projects. This feature allows the Program Manager to explore project
data beyond the overview. If you have a nested structure (Project / Grouping / SKU / Components)in
your Program, an expand button lets you access the next level.

« Drill-down into Components (documents) or Tasks

Use Case: Program Search
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1. The parent Search with Programs. This example shows a Search Results Dashboard on page 180
with counters.

2. The second level of Drilldown which executes the Saved Search specified in the parent search. This
search contains a Dashboard with a Facet Graph.Configuring a Drill down Search on page 179

The third level of Saved Search with a Document Search.

4. The expand button to execute the drilldown.

o

8.11.1. Configuring a Drill down Search

To create a drill down view, you need a Project Search or Document Search with the Drill down option
turned on. As a result, the parent search will have an expand button in every row of the results table.

When you click on the expand, it will execute the Saved Search or display the associated child Projects
or Documents in the Search Results page.

Note: Drilldown expand buttons are only shown in the List view of the Search results.

1. Tosetupa Search to show adrilldown of child Projects or related documents:
a) Search for your Programs (Parent Projects) or Documents.
b) Enable Show Drilldown using Saved Search in the Show Results Layout Options.
c) Save the search with all the advanced settings you want. Read more in:Creating Advanced Saved
Searches on page 117
2. Tocreate multiple levels of Drilldown searches:
a) Create Searches for all your sub-levels and save them. Optionally, configure Dashboards.
b) Specify the Search Criteria for your parent search.
c) Enable Show Drilldown using Saved Search and specify a Saved Search from the drop-down.
d) Create further levels using the same steps.

To configure the layout of the drilldown in the search results, choose any of the three options for
the Layout, Selection and Actions. Read more about it here.
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Note:

« The Dashboard Facets will display the data based on the specified Saved Search. Clicking on a
Facet(Graph/List/Counter) section will refine the search results of child search.

« Itisrecommended to use Document Version ID SmartName than the Document Name
SmartName, since Document id is unique.

8.12. Search Results Dashboard

WebCenter search dashboard organizes and create a visual representation of your data along with
tables. It is built using a set of smaller components (blocks) with specific information. The admin has to
configure each of these blocks in a Saved Search.

You can decide the layout and configure it with the components that suit your user's interest. To
configure a Search Results Dashboard, you can simply drag each component into your canvas from a
gallery. You will have live editable preview as you configure each of the dashboard component. Each of
these components can accommodate specific settings and search criteria.

All the search-specific blocks like facets, results table, asset browser, cart, design panel will show a
preview with real data instead of just a placeholder. When editing the configuration or dragging in new
blocks, the search will rerun to load the new data and the preview will be updated.

You can configure Dashboards with Project/Document/Task and Approvals searches.
Once setup, you can use Dashboards on your user pages such as:

« My Work

+ Menu

« Project Details with context aware SmartNames
« Drill-down overviews of Projects/Programs

- Asset Browsers
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Assignedto £ 2 T Status  All Completed Q- Type  All Approvals X o~
Assigned to Completed - past weeks
Botterman (ABOT) 120
. 1o 109
Deuninck, Ewoud (EWDE) 100
Deuninck, Normal User 1 (EWDE_USER1) 20
80
Botterman USERS (ABOT_USERS) 70
0
ADMIN (ADMIN) £ !
40
Dummy, Jami (JAMI_DUMMY) 20
Botterman (ABOT_USER3) f‘; i . -
Botterman (ABOT_USERT) a — I -
g 3 F 3 3 3 g 3 z E
User2, Jami (JAMI_USER2) £ 2 2 2 [ 2 2 [ H H
] T W 2 = n Gl = 2 H
LEFRAPPROVERSGROUP 2 2 H g 8 8 8 ]
- H s E ) E
Name Status Assigned to Completed |  Project Name +
01_Collar_Orange.ai (1) - Design £5)1L_ROLE1 (One of) . E
H@“ Approval - IL_ROLE1 X 28 IL_GROUP3 Apr12,2019t17:07 il test 440 wf
— 21‘;;:\;?%33;83;(11) esion X 2RIL_GROUP1 (One of) Apr12,2019at17:05 il test 440 wf
= g;;fs‘y:‘rjﬁraggzzfn ~Design + 2l 855 user1 (IL_USER_1) Apr12,2019 at17:04 il test 440 wf
01_Collar_oi 1)-Di
Ap;rsv:‘rjlfaggg&: )-Design IL_GROUP1 (One of) Apr12,2019at17:02 il test 440 wf
W Approved M Canceled M Rejected
M Force Approved [ Approved with a Cond... _— 01_Collar_Orange.ai (1) - Design V. 25)IL_ROLE1 (One of) Apr12,2019:8t17:01 il test 440 wf
B Force Rejected M Force Approved with Approval-IL_ROLE1 : 20 ILGROUP3 '
Type g;;fs‘y:‘rjﬁraggzzfn ~Design + 2l 555 user 1 (IL_USER_1) Apr12,2019 at16:59 il test 440 wf
Approval -
_m oxygen.jpg (1) - IL_GROUP1 + 2IL_GROUP1 (One of) Apr 12,2019 at 13:39 il test permissions

Note: Live preview is not available when the dashboard is configured with SmartNames in it.

8.12.1. Types of Dashboard Blocks

Dashboard Blocks

A Dashboard consists of several building blocks that can show information as graphs, counters or
tables. These are interactive and you can use it to refine the displayed data. You can configure several
such Blocks in a Dashboard.
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General - Rich Text Block
+ Selection Panel
« Counter
Layout . Collapsible Section
« Column Layout
« Left Side Panel Layout
« List Layout
Search - Facet Bar Chart
Facets
» Facet Counter Bar
» Facet Donuts Chart
+ Facet Horizontal Bar Chart
+ FacetList
+ Facet Pie Chart
Search « Search Details
General

« Search Design Panel

. Cart
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- Asset Browser Side Panel

+ Asset Browser Image Panel

8.12.2. Configuring the Search Dashboard Layout and Blocks

To configure a Dashboard, you can utilize any of the building blocks depending on your requirements.
You can make a visual representation of your search results using various faceting blocks. You can see
how your configuration will look like when you start building your Dashboard live.

From the Project/Document/Task and Approvals Search page, click on Search Results Dashboard.
It opens up a canvas with a gallery on the left hand side. The qgallery displays all the available blocks.

Tip: Search Result Dashboard now supports Internationalization. You can define translations for
Block titles, Counter Labels and Rich Text fields.

Arrange your Layout blocks.

a) Drag Layout blocks into your canvas. You can use combinations of list, left side panel, column
layouts and collapsible section to present your blocks.

« Select List Layout for a vertical list of blocks and Column Layout for a horizontal
arrangement.

« Select Left Side Panel Layout to present information in a left side Column Layout. This pre-
defined layout can be modified to suit your needs.

« Select Collapsible Section to present info which can also be hidden and expand one or more
blocks based on the requirements.

« Select Column Layout to display blocks in configurable columns. When the user adds a
Column Layout to the dashboard, the layout is preconfigured with 2 columns.

b) Add Rich Text Blocks to add any Text message/ information to your users.

Determine the dimensions of your Layout blocks

a) Specify Spacing to define space between Layouts. This is optional and use it if you want to
separate the layout blocks.

b) To style your Column Layout, you define the width, minimum width and maximum width of
individual columns. If you leave the Width as empty, the columns will fill according to the
available space.

c) Fill each of these Layout blocks with the Search and Facet type of blocks.

Configure the Facet blocks. To configure a Facet Graph, List or Counter Bar, specify the Facet field
(Search criterion) to facet on and the maximum number of facets to be displayed.

Read more about Facet fields in: Facet Settings.
a) Drag your Facets into the Layout block.
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b) Forany Facet block, you can select the Type from Bar Chart, Horizontal Bar Chart, List, Donut
Chart, Counter Bar and Pie Chart (default).

c) Use Customize Value Order and ColorsCustomize Labels and Colors on page 185 to configure
custom labels and color definitions for Facet Graphs, Facet Lists, and Facet Counter Bars.

d) Specify the dimensions of your graph or chart (width and height). This is an optional step and if
the sizes are not specified the graph fits to the available space.

e) For Facet Counter Bars ( Facet and Search Based Counters ), you can specify the Style to adjust
the display size.

f) Optionally, specify a Block Title and enable Show Block Title and Border. This will enable a color
picker from which you can specify the Border color.

You can add Search Results, Search Panel, Cart Asset Browser Side Panel and Image Panel to your
Dashboard layouts.

Building a Search Based Counter
You can use a Counter block to display the total count of a Saved search.
To configure counters for your dashboard follow the steps below:

« Specify a Global Saved Search. In the counter display, the dashboard will show the count of this
particular search.

You can use a SmartName based search in a counter. If the SmartName cannot be resolved, the
counter will show a -.

- AddaLabel. If you did not specify a label, the counter displays the Saved Search's name.

« Specify a Background Color.
The default color is green and you can change the color by typing a hex value or picking a color using
the color-picker.

« Select aStyle from the drop-down: Extra small, Small, Small Left Aligned, Default, Default Left
Aligned, Large, Large Left Aligned and Large No Label.
You can configure several of these counters in a column layout to create an interesting overview.
Read more in: Program Dashboard with a Drill-down View on page 434.
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Note: Enable or disable the Run Search on Click. This option is enabled by default. If this option is
on, you can click the counter to view the search results in the current window.

Customize Labels and Colors

How to Customize Labels and Value in Search Results

This option enables to configure the labels and color definitions for the Facet Counter Bars, Facet
Graphs and Facet Lists.

When any facet block is configured, there is an option to Customize Labels and Colors to modify the
labels and colors for the values selected. This can be used for string and status fields.

Note: Date and user fields cannot have custom values. For example, if you are configuring Roles in a
facet list, then this option is not visible.

If this option is enabled, a new section appears in the configuration panel. A table is displayed in which
custom labels and color definitions can be configured. Click Add Value and a new row is added to this
configuration table.

To Add Value

To customize the labels and colors for the facet values, you can either select the values from the drop-
down list, input fields or even a range of values based on the facet chosen. For each value, a custom
label and color can be defined in the row. You can reorder rows by drag and drop. To delete the row, you
can click delete button at the end of the row.

Faceted fields like project status, approval status that have predefined colors that denotes a status, do
not allow color customization.

Enable Only display currently defined custom values and order to restrict the display of only the
customized values. In that case, the option Maximum number of facet values is ignored and Number
of values field and the corresponding drop down becomes invisible.

8.12.3. Facet Settings

Facet blocks (see Types of Dashboard Blocks on page 181) allow you to visually represent your
specified search field (Facet). You can use the cascading drop-downs of available fields to specify the
Facet.

The Number of Facets (Number of Values)field determines the maximum number of facet values
displayed in the graph/ chart/counter bar/list. The facets with the most number of results get priority
in the chart/graph/list/counter bar display.

Facet Settings- Project Search Fields
1. Project Information has the following fields in the drop-down:

» Attribute Category

« Completed

- Created(date)

« Customer/Location(company/location)
« Due(date)
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« Manager Location(company/location)
« Modified (date)

+ Project Creator

+ Project Manager

+ Project Template

+ Project Status

« Salesperson

« Started
« Time Left
To facet on a Role, select it from the Roles drop-down.

To facet on an Attribute, specify it from the Attributes drop-down (Text attributes, Text restricted
set attributes, Numeric and Date Attributes).

You can facet on the Project Status Duration, Project Status Started, Project Status Completed,
Project Status Due Date and Project Status Time Left. You can read about it here.

Facet Settings- Document Search Fields
Document Information Facet has the following criteria:

« Approval Completed

« Approval Due

« Approval Duration

+ Approval Started

- Approval Status (status only)

« Approval Status Completed

« Approval Time Left

« Approval Version Count

« Attribute Category

« Author’s Location (company/location)

+ Created
« Current Approval Stage
« Folder

« Modified(date)

« Pending Approvers
« Version author

« Version Count

« Version Size

Note: When you select Version Count, you can specify the range of the values and customize
the label names and the display colors.

Document Attributes: You can specify the attribute from the Attributes drop-down with Text
attributes, Text restricted set attributes, Numeric attributes and Date attributes.

When you choose numeric attributes, range of values has to specified and labels can be customized
for display. The range and the label are displayed in the same order.

Specific Document Information You can also add specific document meta data based on the
document type searched for and display in the search dashboard. When you search for text content
documents, you can show for Document Status and Element Type.

Facet Settings- Task and Approval Search Fields

Task Information Facet can be of the following criteria:
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Approval Master
Assigned To
Assignee’s Location (company/location)
Completed (date)
Completed by

Due

Duration

Final Approval Status
Modified (date)
Reason(s) for Rejection
Stage Approval Status
Started

Status

Task Created (date)
Task Created by

Task Estimated

Time Left

Type

WebCenter

2. You can also Facet on Task Specifications. The Specifications(Numeric, Text, Text restricted set

and Date) are listed in the adjacent drop-down.

Note:

«  Whenyou select a Date criterion, you can specify the time in the past or future days, weeks and
months when applicable.

8.12.4. Facet Search: Viewing Search Results

Facet List

A Facet List presents the search information in a List. All possible values for the faceted field ( the
search criterion specified) are presented in a list form in the descending order of the number of
occurrences (displayed in the list as a badge).
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Wait for Files

Mon-active

Mightcrawler

CalDemo Completed
Completed

PRMA_Initial

PRMATest
SAH_STATUS_ACTIVE 1@

SAH_STATUS_ACTIVE_2

Facet Graphs
Facet Graphs present the data based on the Facet Field as a graph like bar or vertical bar chart or as
donut chart or pie chart. All possible values will be presented as separate sections in the graph. There
is priority for the values with the number of occurrences if there is a specified value for the Facet Field.
Read in Facet Settings on page 185.

Sub Category @ [/AnD |

quad foil 2 X | depower 22 X trainer 16 X

B quad foil M quad B deita B depower B trainer
W handle B airfoil B single skin foil
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Facet Counter Bar

The Facet Counter Bar lists the number of occurrences of the faceted field in a horizontal bar and
similar to the Facet List, the counters appear in the descending order.

You can specify the Style to adjust the alignment and size of the counter bar.

Note: The number of values of the faceted field is restricted by the maximum values set in the
Dashboard Facet settings.

Refining Search Results using AND/OR Operations

To refine the search results to one particular value (of the Field/Criterion), simply click on the item (or
section)in the List. The results will be refined and you will see X' icon to deselect. You can either use 'X’
or click on the value again to deselect it.

By default, this is an OR operation. To display a results of all the selected 'values' of a particular Field,
you can simply click on all of them and switch the operation to AND.

When you click on a list/counter/graph item or section, by default, search uses an OR operation to
refine the results. For Facet Fields (Attributes/Specifications/Roles), you can switch to the AND
operation to combine these sections.

Note:

« The Information Fields (Project, Task and Document information) do not show an operator.

« The Date and Time Fields show only OR operator.

Important: Clicking on a section would automatically update your search results if the Show Search
Button option is turned off. If this option is on, you have to select a section and then click Search.

Default Colors

If you are faceting on project statuses or document approval statuses, the appropriate colors are used
for the count badges, graph sections and counters.

8.12.5. Image Spinner

Image Spinner allows you to display selected images in a Dashboard. This can be a display of your
relevant artworks or any relevant images.

See the settings of this block below:

- Saved Search: Select a global saved search of graphical documents (pdf, ai, png, jpg, jpeg). The
first 26 images will be displayed in the image spinner.

Note: Itis possible to use a SmartName based Search. However, make sure that these
SmartNames are resolvable to prevent an empty image spinner block.

« Horizontal & Vertical resolution of the images: Specify a resolution value for the image. The value
can range from 1 pixel to 5000 pixels.

« Scale image to width of block (Default option): When this option is on, the images are always
completely visible. If the option is off, the images are shown according to their size.

« Seconds: Specify the duration of display for each image in seconds in this field.
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8.13. Search Results Formatting

Search Result Formatting framework makes it simple to present result data in an attractive and clearly
communicating form.
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Admin users can setup Search Results Formatting by navigating from the Search setup page for
Projects or Documents or Task and Approval Searches.

This opens a pop-up with two tabs, namely Fields and Row/Card. The default selected tab is Fields.

Choose the Row/Card to set up a styling rule in the Search results or you can set up the rules specific
to each field by using the Field tab.

1. Select Add Rule to add a new rule to the field chosen with a defined condition.

This adds a row to the table and allows selecting:

« ACondition
« AnOperator
« AValue
« AStyle

« Apply to Fields (only for Fields tab)
The first three columns determine when the rule for styling should be applied.

Rules created can be reordered by drag and drop and the order determines the required sequence.

2. Select afield based on which you want to create the rule for styling from the Condition drop down.
The list displayed may vary based on whether it is a Project or Task and Approval or Document
Search.
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Document search will have fields related to Document Information like Approval Completion Date,
Document Name, Description, Last version Comments along with Document Attributes, Project
Information related fields, Roles and so on.

3. Based on the field chosen for the Condition, relevant operators are available in the Operator drop
down. For example if any date related field is chosen for Condition, then the operator will have
options like Is after, Is empty, Is Before and so on.

4. Again based on the operator used, only the relevant fields are shown. If the Condition field is a date
and if the operator chosen is Is after, then the relevant date fields are shown in the drop down with
an offset option.

5. Inthe Style field, you can either Create New Style or Import an existing style with the saved
searches. If you want to create a new style, click on Create New Style to open the pop up window.
Styles can also be imported from another saved search for consistency and efficiency.

You can edit an existing style by clicking on the edit icon and click OK to make the changes to the
same style or you can Save as New Style.

Create New Style

Preview
Style Name* | Style 1

I Briefing Concept Art Production Art )  Separations Files Released >I

Colors
Background #d9534f - v
Color
@ Use Background Color Label

Text Color l:l v

Border Style No Border -

Content

Display Style Both Icon and Value -

Fixed Text Red

lcon Briefing Concept Art Production Art ) Separations FlesReleased @ T

07 - Child Briefing (at risk).png

Cancel n

6. Choose the field from the drop down for which you want to set up a Style chosen or created in
the Apply to Fields. You can choose more than one field per row or can create multiple rows for
different conditions or operators.

7. For the Row/Card, follow the steps from 1to 5 to set up a style for the search results.

Styles thus created are available per saved search.

8.13.1. Create New Style

You can create new styles to apply it on either selected fields or the complete row in the search results.
Click on Create New Style to open a pop up window.
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Style New Style
Mame*
Colors
Background | #e377c2 v
Color
Use Background Coler Labe
Text Calor #1f77bd4 - ¥
Border Right Border -
Style
Border #5heolde I:I v
Calar
Content
Display Both lcon and Yalue -
Style
Fixed Text Test Text
leon I icon-WCR_AE-min o -
con Calor #00B0FF - -
lcon Size Large -

Cancel m

Style Name is a required field by default. You can provide a unique name to the style you are
creating.

. Select the background color for the style from the color picker tool.

. Select Use Background Color Label in the check box to use a background color only for the label.
This optionis only available for field styles.

4. Choose atext color for the style from the color picker tool.
5. You can either choose No border or Right or Left border for the field or the rows of search results.

6. Specify whether you want to have Both Icon and Value or Only Icon or Only Value to be displayed
for the fields in the search result. If you choose any of the icon options then another drop down in
displayed with the available icons. When anicon is chosen, you get additional options to choose
the color and the Icon Size also. In case you choose Value Only or Icon and Value option, you get an
additional field for entering a Fixed Text which will be displayed in the field.

8.13.2. Import Styles

You can select the Import Styles to reuse any existing style in the saved searches.



ESKOS

WebCenter
Import Styles
Saved Search
DEKE_Demo_Duration_nographs -
Styles to Import
Belect Style -

Import All Styles

1-2 days
2-4 days

1. Onselecting this option, you get a drop down of all the available saved searches with styles. Choose
the saved search which has the requisite style.

2. You will get an additional drop down to choose from all the styles already created in this Saved
Search. Styles available for field is displayed when you choose this option in the Fields tab and
styles available for rows are displayed when you choose this option in the Row/ Card tab.

—
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8.14. Setting Up Project Operations in Saved Searches

8.14.1. Updating Due date, Manager or Status

194

The Project Manager, Due date and Project status properties can be modified from Project search
results or a saved Project search results.

Note:

All actions are restricted to current permissions on the individual projects involved.

Search For Projects

Fill in one or more fields. Prefer less fields? Try  Kevword Search.

#| Use Advanced Search Characters ¥ Search Panel Design Search Results Options

View(List) Column Order Editable Sort Order Clear this form

Project Name: | | ) L=
Description: | | ]

Project Status: [Show an ] v

Created: I:l

Modified: l:l G

Due: L ] z E_] ’

Customer/Location: | |

Salesperson: [ |

Project Manager: ® User U Group U Me L L4

Manager’s location: |

Add Role Search Criterion
© TEMA DESIGN @ User U Group O Me v v

Attributes...:

Characteristics...:

Bill of Materials: | Show All v

1. Inthe main menu, go to Search > Projects.
2. Type the parameters you would like to use to filter the search results.
3. Enable the Editable check-boxes for Project Status, Due and/or Project Manager.

Use the Editable column to enable bulk operations on projects. You can modify the following
parameters of several projects at once:

+ Duedate
+ Project Manager

« Project Status
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« Attribute Category or Project members/permissions

« Project Role assignments

The bulk operations can be done from the Search Results page or from Saved Search Results page.

Note: These bulk operations are always limited to current permissions on the projects involved.

When you enable the Editable items, you get an Edit %! button next to the selected items in the
View List.

4. Now Save the Search or click Search.

Due Date -*| Manager -* TEMA_DESIGN |-#

Note: For each Editable item, a corresponding option will be created in the table actions bar.

8.14.2. Updating Attribute Category or Project Member / Permissions

You can setup Project Search Results to allow bulk updating of:

« the Project Attribute Category
« Project Members
Project Permissions

In the main menu, go to Search > Projects.

Type the parameters you would like to use to filter the search results.

Click Show Result Layout Options to see advanced search options.

Enable Allow Changing Attribute Category and / or Allow Changing Project Members.

S

Now Save the Search as Global.

8.14.3. Updating Roles

In the main menu, go to Search > Projects.
Type the parameters you would like to use to filter the search results.
Add one or more Role Search Criteria by clicking the Add Role Search Criterion link.

soon -

Enable the Editable check-boxes for the role or roles that you want to make editable.
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5. Save the Search as Global.

8.14.4. Detach Child Projects

You can configure Detach Child Project(s) operation in a Saved Search. Program Managers can use
this in a contextual Saved Search configured in the Parent Project's details. The use case is that the
Project or Program Manager can select existing Child Projects displayed in the search tab and detach
them from the Parent Project.

Note: The action is only available to the users with Change Permissions of the parent and child
project.

« Create aglobal Saved Search to search on child Projects. Enable the Search Result Layout option
Allow Detaching Child Projects.

« Apply the Saved Search into the Project Details menu of the Parent Project Manager.

« Todetach child Projects, go to the Child Projects tab with the saved search, select child Projects
and click Detach Child Project(s).
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9. Inline Editing

Inline Editing allows you to directly edit a Project or a Document or a Task in Search Results page or
Dashboards for editable fields. Editable fields have a pencil icon next to it on hover, indicating that it is
possible to edit that field.

When a field in Search or in Dashboard is set as editable and if you have the necessary rights, you can
edit the field. The changes are applied to the corresponding Project, Document, or Task.

List of editable Fields in Search Results page or in Dashboards for Project, Documents and Tasks can
be checked here.

For example, to re-assign a task in your Search Result page, there is no need to go to the Task
execution page to change the assignee and go back to your search, you can just directly edit it.

Assignedto »

°._I-_“"m JOHM)

James (JAMES
bob, bot (BOE)
Jahn (JOHN)

Mot (TOM)

Conditional Formatting for Editable fields

You can edit a field inline in Search Results page or in the Dashboard which has some conditional
formatting set. If the field is a Restricted set or Project Status or Task status or a dropdown that is
connected to a list, the values in the drop down are shown with the conditional formatting applied on it.

For example, there is conditional formatting set to show the values as progress bar.
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Live Preview

Preview of any editing done to is shown both for editable and non-editable information. When editing
avalue, preview of changes is shown in all the instances of the field within the same Dashboard and
across all locations in WebCenter.

For example, when the Project status is edited in a list, all other instances of project status (of the
same project)is also updated simultaneously in the Dashboard.

Similarly, when a Project name is changed, then it has a cascading effect on the child projects or
parents' projects. The same applies to Document Name changes, where the change is also affected
across all versions of the document and wherever the document may reside like a Document reference
or a Task.

When the Conditional formatting rules are edited, the changes are visible in the Dashboard
simultaneously. This could be helpful for Project status and Task Status based Dashboards.

Some of the fields where the live preview do not reflect immediately are

« Project Calendar or Project or Task Approval due date which reflects in milestones
« Auto naming of the Project or Document
« Rulestriggered based on events

Rich Text fields

Rich Text fields are also editable inline. Select the text in a rich text field to open the rich text panel.

LLE is a rich text field

B I U = £ x x M| T« |
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9.1. Configuring Editable Fields

Configuration of Editable Fields in Search Results

To make a field editable, enable the editable option in the Search Results Options for a Search.
Editable fields for Projects or Documents or Tasks and Approvals varies as per the context.

#| search Fanel Design Enable Smartdames (B Labal Visibility Rew  Columa Vikw c;:'.‘ Edaabls fsan  Order [ Clear this Form
Fraject Hame - Viskle | = 1 1 Viskle = 1 v & - I save search As
Caserignion Bl - 2 =k -
Froject Stanss - @ viskle | = 3 visbls v 3 3

Configuration of Editable Fields and Required fields in Dashoard

When you configure any type of Dashboard ( Project, Task or Document), in the Configuration panel,
select the Editable option.

Project Information Fleld

Description -

Custom label

| Editable

Enabling Mandatory fields in the Dashboard forms

As Dashboards can be used to create input forms and some fields can be made as required fields while
designing the form itself. For example, Project Manager field in a Project Creation form or an attribute
value in an attribute-based form.Inputs for the required fields are validated on save.

You can select Required option to make the dashboard block as a mandatory field. An error message is
shown when any of the mandatory field is not filled along with the fields not filled in.
Configuration of Bulk Editing

Admin user has to select the Show Bulk Edit Actions for fields marked as Editable option in the Table
Bulk Actions in Search Result Layout Options.

199



ESKO

WebCenter

Tahle Bulk Actions

] Show "Delete” action

& Show "GeneratesDelete View Files™ actions for Admins

ra Show Bulk Edit Actions for fields marked as editable

E——
& [ Allow Changing Attribute Category
i O allow Changing Project Members
lz [ allow Detaching Child Projects €3
" Custom Actions | default 2

agged actions will only show up if the tag is listed here

Example: “tagl, tag2”. Enter * for all actions

Note: Pencil icon in the header to bulk edit is available for whichever field has been chosen as Editable
irrespective of the above option selection.

9.2. Inline and Form Editing for Projects, Tasks and
Documents

200

Inline Editing in Projects

Project fields that are editable are Project Name, Description, Attributes, Role, Due, Sales Person,
Project Manager, Project Status.

Inline Editing in Documents

Document fields that are editable are Document Name, Description, and Attributes.

Note: Editing Attributes in both Projects and Documents has two preconditions. Firstly the user
must have the editing permission for the Attribute values and the Attributes should be present in the
Attribute Category of the Project or Document respectively. Document References are editable in Edit
form Dashboards only.

Inline Editing in Tasks

Task fields that are enabled for inline editing in Dashboard and Search Results are Name, Description,
Due, Task Estimated, Task Status, Task Specifications, Assigned to (not applicable for Approvals and
only to Project members with permissions), Documents (in Edit form Dashboards only).

Note: Specifications are only editable, if they are in the Task Type of the Task and if the user has the
right to edit the specification values.
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9.3. Shortcuts in Inline Editing

Inline editing can be performed by using shortcut keys easily. Click on the first field that you want to
edit and after that you can continue editing using only the keyboard.

When you are not inline editing and the mouse points to one of the things you could potentially edit, you
can use the following:

Arrow Key Right: To navigate to the next inline editing input in the same Dashboard or same Search
results row.

Arrow Key Left: Navigate back to the previous inline editing input in the same Sashboard or Search
results row.

Arrow Key Down: For list layout, cursor moves to the next inline editing input in the same column
(inside the same table) and for non-list layout (Grid layout, dashboard...), does the same as Arrow
Key Right.

Arrow Key Up: For list layout, cursor moves to the previous inline editing input in the same column
(inside the same table) and for non-list layout,does the same as arrow key left.

ENTER: Enter inline editing mode for the selected field.

While you are actually inline editing, you can use :

Tab : To Save and go to the next input

Enter: Save and do the same as Arrow Key Down afterward and Ctrl+Enter Only for multiline fields
(Description, Rich text attributes)

Escape: Cancel and keep the focus on the current item.

When you are in a dropdown:

Arrow Key Down : Go to the next element in the dropdown.
Arrow Key Up: Go to the previous element in the dropdown.
Enter: Select the element and close the dropdown if only one value can be selected for this field.

Escape: Close the dropdown.

Note: Tab is a general shortcut in browsers, that is used in Search Results or Dashboard page to go to
the next input or link.
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Managing Companies

Entering Company and Location information lets you further refine projects and users when they are
created.

System History Logs
All Companies related events like

. Companies Created
« Companies Deleted and

« Companies Changed

are recorded and stored in System History. Read this page on how to access the records

Create a New Company

10.2.

1. Click Admin > Companies > New Company.

2. Enter the information about the new company (Company Short Name, Company Legal Name,
Phone...).
Fields with asterisks next to them are required to have information in them.

3. Doyou want the users of this company to see custom menus instead of the default WebCenter
menus?

Custom menus allow you for example to simplify the user interface, so the users only see the menus
they need to use. See Menus on page 38.

Note: Users linked to a company will always see the menu assigned to the company, when the
Default menu is assigned to them as a user.

« Ifyes, choose the menu to assign to the company in Menu.
+ Ifno, leave Default in Menu.

4. Click Create.

A status message saying the company was created successfully appears at the bottom of the page.
You can create an additional company by filling out the form again and pressing Create.

Edit a Company

202

1. Click Admin > Companies.
2. Either type in aFilter or click Go to see the list of companies.
3. Click the name of the company to change.
This opens the Edit Company page.
4. Inthe Name and Menu tab, you can change:
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+ the Company Short Name,

« the Company Legal Name,

« the Menu that the users of this company will see (see Menus on page 38 for information about
menus).

Click Save to save your changes before switching to another tab.
In the Locations tab, you can edit the company's location(s):
« clickalocation to edit its details (Location Name, City, Country...),

- todelete alocation, select it and click Delete Location(s) in the actions menu,
- toaddalocation, click the New Location link and fill in the new location's details.

In the My Work Setup tab, you can change what the company users will see on their My Work
page. Click on Setup Custom My Work to customize the My Work page displayed for the selected
company's users. Else the default My Work page is displayed for the users.

Read more on how to set up My Work page for Companies here Set up My Work page on page 205.

10.3. Merge Companies

10.4.

You can merge two or more companies using the Merge Companies option in Admin > Companies.

1.

2.
3.

Select the source company / companies which has to be merged.
Choose the Merge Companies field, to open the Merge Selected Companies pop-up window.
Choose the target the company from theMerge to Company drop down.

A warning message will be displayed when the source company / companies has one or more
locations in common with the target Company. The source company locations will be renamed to
<location_name>_<company_legal_name>.

Click OK to merge the companies.

Delete a Company

If the company you delete has users assigned to any of its locations, WebCenter issues a dependencies
warning.

You must reassign the users to another location or delete the users before you can delete the company.
There is no dependency check if there are no users assigned to any location.

If the company is only assigned as a customer, it will be deleted when you confirm the deletion.

Note: Attempting to delete multiple companies will stop on the first company that has dependencies.
To delete the rest of the companies, reselect them and delete them.

o orowN

Click Admin > Companies.

Either type in a Filter or click Go to see the list of companies.
Select the checkbox of the company to delete.

Click Delete Company in the actions menu.

Click OK to confirm the deletion. The company is deleted.
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10.5. Add Locations New

Context for the current task

Click Admin > Companies.
. Either type in a Filter or click Go to see the list of companies.
. Click the name of the company for which you want to add a location.

1.
2
3
4. Click the Locations tab. The current locations for the company are displayed.
5. Click New Location at right.

6

. Enter the appropriate information and click Add Location. The new location is created.
All Location related events like

« Location created
« Location merged
« Location deleted and

« Location changed

are recorded and stored in System History. Read this page on how to access the records.

10.6. Edit a Location

1. Click Admin > Companies.

2. Either typein aFilter or click Go to see the list of companies. Click the name of the company for
which you want to edit a location.

3. Click Locations on the menu. The current locations are displayed.

In the location list, you can merge the two or more locations of the same company. Read how to
Merge Locations on page 204 here.

4. Click the name of the location to edit.

5. Change the information as desired and click Change. The information is changed and a
confirmation message appears.

10.7. Merge Locations

You can merge two or more locations of a company using the Merge Locations option.
Navigate to Locations tab in Company details page, to view the locations of a company.
In the location list, select the source location(s) that you want to merge.

Choose Merge Locations to merge the selected location(s) to a target location.

N

In the Merge Selected Locations pop up window, choose the target location from the Merge to
Location drop down and select OK to merge.
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10.8. Set up My Work page

10.9.

Admin users can set up customized My Work page for all users in a company.

s oo

Navigate to Companies and select the company for which you want to set up My Work page.
In the company details page, open My Work Setup tab.

Click on Setup My work to open the My Work page in edit mode. If it is al

Follow the steps given here Edit the Default My Work Page on page 59 and Save.

Delete a Location

If the location you delete still has users assigned to it, WebCenter issues a dependencies warning. You
must reassign the users to another location or delete the users before you can delete the location.

Attempting to delete multiple locations will stop on the first location that has dependencies. To delete
the rest of the locations, reselect them and delete them.

1.

2.

oo r oo

Click Admin > Companies.

Either type in a Filter or click Go to see the list of companies. Click the name of the company for
which you want to edit a location.

Click Locations on the menu. The current locations are displayed.

Select the location(s) to delete by selecting the checkbox next to the name.
Click Delete Location(s) in the actions menu.

Click OK to confirm the deletion.
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11. Managing Users

11.1. Licensing and Users

WebCenter supports two types of licensing models. You can have counted licenses in the Named User
License Model on page 208 or Concurrent License Model on page 206 where you can have licenses
that are taken up during a log-in sessions.

11.1.1. Concurrent License Model

206

In this model, you can create as many users as you want. The number of users who may use the system
at the same time is determined by your Concurrent Licenses. The licensing model distinguishes
between three types of users: guaranteed users, concurrent users, and editor users.

Types of Users in Concurrent License Model
Guaranteed users

A guaranteed user can always access WebCenter, regardless of how many concurrent users are
logged on at the time.

Concurrent users

Any other user who does not have guaranteed access can log on to WebCenter as long as the
maximum number of concurrent users are not exceeded.

You can assign guaranteed sessions to users, even without having the WebCenter Integration User
licenses and all guaranteed sessions are taken from the pool of concurrent licenses.

Note:
For every three guaranteed users you create, one concurrent user license is blocked permanently.

For example, if you have 25 concurrent licenses for 100 non-guaranteed (concurrent) users, 25
concurrent users can login at any time.

If you give 25 users guaranteed access, these users will take up 8 concurrent licenses. This means
that only 17 concurrent users (out of 100) can log in simultaneously, because 8 concurrent licenses
would be permanently blocked by those 25 guaranteed users (25 x 0.333 = 8.333).

Editor users

These are ArtiosCAD Enterprise users. They have guaranteed access but do not take away concurrent
licenses.

You will have a fixed number of editor users, determined by the license you have purchased. When that
number is reached, you cannot set more users to be editor users.

Generally, your system will either have guaranteed and concurrent users, or editor users.
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If you have editor and concurrent users, and all your concurrent access licenses are in use, a
concurrent user will not be able to access WebCenter, even if you have editor licenses left (a
concurrent user cannot use an editor license to log in).

Integration Sessions

For your integration sessions (e.g. for the SDK or Automation Engine), you can allow Multiple Open
Sessions (for SDK or Automation Engine) for a User.

Each of your workflow connections connected through tunnel clients will block one integration
session license.

When all the Integration Licenses are utilized for integration sessions ( for SDK or Automation Engine),
then the concurrent license pool is used to allow further integration sessions. In such a case, one
concurrent license is blocked for every three integration sessions.

Advance SSO

The Advanced Single SIGN ON is also a license for the concurrent license model. From WebCenter 18.1,
license file received will have the Advanced SSO feature by default.

Mutiple Guaranteed Sessions

You can allow multiple open sessions (such as the SDK user or Automation Engine user) as guaranteed
sessions for a User. However, every three such sessions will block a concurrent license reducing the
number of available concurrent access.

Workflow Connections

Your workflow connections connected through tunnel clients will block one concurrent license each.

What if the user limit is exceeded?

When the limit of users with concurrent access is reached, no concurrent user may log in until another
user logs out.

To prevent users from blocking access for others, there is a configurable time limit of 30 minutes of
inactivity. After any users (guaranteed or not) have been inactive for that amount of time, they are
logged out automatically, thereby allowing other users to log in.

Note: The Admin user can always log in, even if the user limit is reached.

Check the Licensing Status

1. Click Admin and navigate to Users. To see the users who are currently logged in, click on the eye
icon.

You can filter on the Active users or currently logged in users.

Users who simply close browser windows do not actually log off until their sessions expire due to
inactivity (usually after 30 minutes). Users should always click Log Off when they are done using
WebCenter.

Note: To forcibly log off a non-guaranteed user to make more concurrent licenses available, click
Log user off next to that user’s licensing status. Use this with caution as it may result in data loss. It
would be prudent to try contacting the user in question before using this command.

2. The Users page also shows this table, where the utilization of different licenses are detailed.
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« Concurrent Users: all users logged in currently apart from Guaranteed access users.
- Editor Users: the sum of Guaranteed Access (GA) users on the system.

« Integration user sessions: sum of all the reserved integration sessions and the number of
workflow connections made.

Note: When the Guaranteed Access users and integration sessions and workflow connections
licenses are exceeded then, they utlilize concurrent licenses in a factor of three items using one
concurrent license.

If the number of available licenses reaches a specific threshold, it is displayed in red to indicate the
license pool is depleted. The following threshold is effective per license type:

« Concurrent Licenses: b

« Editor Users: N/A

+ Integration Sessions: N/A

If alicense violation is effective, (no more free license to allow log in) a warning icon appears next to
the appropriate license type and the Remaining count value are shown in the next column.

11.1.2. Named User License Model

208

A Named User License is an exclusive licensure of rights assigned to a single software user. This
License model lets you pay for the number of users you want to create in WebCenter. This means that
the purchased number of licenses (per type of users) limit the number of users that can be created.

You can view the number of licenses per user type on the Admin > Users page.

Types of Users (Named User Licensing Model)

Regular Users

These are the users who use the non-admin pages of WebCenter. The WebCenter Regular user limit
determines how many reqular users can be created in the system.

Project Creator

These are regular users but can also additionally create projects. They have no other rights on the
project after creation. When the licenses of regular users are exhausted, the project creator licenses
can be used for regular licenses.
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Example:

When you have to create reqular users and the number of regular users licenses has been used up, you
can use the remaining Project creator license for these extra users.

License Type €2 # Purchased Assigned Remaining
Admin/Project Manager Users 250 86 164
- . 116

Project Creator Users 300 a1 103
Regular Users 100 181 :\} 0
Integration Sessions 5 ? 5

Note: You can hover over the warning symbol to see the number of Project Creator Licenses used for
Reqular Users.

When there is no license for Regular Users, the licenses for Project Creator and Regular users are
combined in the overview page.

Admin or Project Manager Users

These are users who will function as Administrators or Project Managers. The WebCenter Admin/PM
user limit (as per your license pack) determines the maximum number of Admin and Project Manager
users in the system.

Integration Users

For your integration use cases (e.qg. for the SDK or Automation Engine), you can allow Multiple Open
Sessions for a user. The maximum allowed guaranteed sessions is determined by the WebCenter SDK
session limit module.

Named users have guaranteed sessions and is determined by the WebCenter SDK session limit
module. You can allow Multiple Open Sessions (for SOK or Automation Engine) for such a user.

The session limit licenses can be split over multiple users (without an upper limit), but the total number
of guaranteed sessions cannot exceed the WebCenter SDK session limit.

Each of your workflow connections connected through tunnel clients will block one integration session
license.

Note: There is an upper limit for the number of simultaneous sessions (maximum 5) for Admin /
Project Managers and Reqular Users.

What if the user limit is exceeded?

When adding more sessions to an Integration user, the system checks your session limit to see if this is
feasible.

When the number of licenses available reaches a specific threshold, then it is indicated in red color.
Threshold for concurrent users are fixed at five whereas for Editor Users or Integration sessions the
threshold is not applicable.

You cannot create a new User of a Type when the limit has been reached. The limit also applies when
you try to change a Reqular User to Admin or Project Manager. You will get a License Violation error if
the limit has been reached.
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Note:

« Checkthe Troubleshooting Tool if you run into License limit related errors. This page has a License
Check[ WCR121_TST_700] test with more details about the current status.

« The System Administrator (ADMIN) can always login to verify and correct licensing issues.

Check the Named User Licensing Status

1. Click Admin to open the Users page.To see the users who are currently logged in, click on the eye
icon. You can filter on the Active Users or the current users logged in.

2. ysers page lists the number of Purchased, Assigned and Remaining license per user type. You can
expand the Assigned column to view the details of the available licenses vs used at the moment.

License Type # Purchased Assigned (Hide Details) Remaining

Admin/Project Manager Users 1001 Total: 329 672

Total: 358

Project Creator/Regular Users 2500 274/324 2142

34/34

Total: 146

P ; 3 357
Integration Sessions 503 138/138 .

8/8

- Admin/Project Manager Users (Assigned) is the number of Admin Users and Project Managers
licenses utilized from the license type.

- Project Creator Users/Regular Users (Assigned) is the number of Project Creator Users and
Regular Users licenses utilized from the license type.

Note: In case the regular users licenses are exhausted, then Project Creator Users licenses are
used instead of regular users.

- Integration Sessions (Assigned)is the sum of all the guaranteed sessions and workflow
connections licenses utilized from the license type.

If the number of available licenses reaches a specific threshold, it is displayed in red to indicate the
license pool is depleted. The following threshold is effective per license type:

« Admin/Project Manager Users: 1
« Project Creator Users and Regular Users: 10
+ Integration Sessions: N/A

If alicense violation is effective (no more free license to allow log in). appears next to the
appropriate license type and the Remaining is shown in the Remaining column.
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The following default users are not counted against the Purchased licenses.

ADMIN - the admin user, user with user name "ADMIN"
CADX user

CLEANUP user

WORKFLOW USER

N

Users, Groups and Roles

1.3.

Basic concepts
Access to projects and documents is controlled by user and group permissions.
User

Everyone who logs in to WebCenter is a user. Users log in using a username and password assigned to
them by an Administrator.

Group

A Group is alogical set of users connected by a common element of your choosing, such as function
or location. You can assign tasks to groups, you can set up groups as approvers or even as project
managers.

Role

A Role is a placeholder object that project managers can use in their projects or templates to set

up approvals, assign tasks to, use in workflows, etc., without being forced to use specific users and
groups just yet. Upon project creation, or even later in the process, the project manager can assign
the role(s) to the actual user(s)and/or group(s). This provides more flexbility in setting up templates/
projects.

Default users

One user, admin, and two groups, Admins and Users, are created by default in WebCenter. Members of
the Admins group are WebCenter system administrators and can perform any function.

Create a User

1. Click Admin > Users > New User.

Step 1: User Info in the Create New User wizard appears.
2. Type the basic user information into the appropriate fields (Username, First Name, Last Name...).

Note: Required fields are indicated with an asterisk *.

3. Do you want to use LDAP authentication (single sign-on)for this user?

» Ifyes, enable the Use LDAP to Authenticate User option. This will allow the user to use his
regular Windows network user name and password to log on to WebCenter.
« If no, provide the user’s initial Password and confirm it.

Enable the option Require the user to change the password at first login to force the user to
choose a new password when they first log on to the system.
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4. Do you want this user to see custom menus instead of the default WebCenter menus?
Custom menus allow you for example to simplify the user interface, so the users only see the menus
they need to use. See Menus on page 38.
« Ifyes, choose the menu to assign to the user in User Menu.
+ If no, leave Default in User Menu.
5. Doesthe user need guaranteed access?

« Ifyes, enable the option User Has Guaranteed Access or is an ArtiosCAD Enterprise User.

Note: You can also use this option to make editor users, if you license allows it (see Licensing
and Users on page 2086).

« If no, leave the option disabled and proceed to the next step.

For more information on guaranteed access and its licensing implications, see Licensing and Users
on page 206.

6. Doesthe user need multiple open sessions with guaranteed access?

« If yes, enable the option Allow Multiple Guaranteed Sessions.

Note: You can allow multiple open sessions(such as the SDK user or Automation Engine user)
as guaranteed sessions for a User. However, every three such sessions will block a concurrent
license reducing the number of available concurrent access.(see Licensing and Users on page
208).

7. Does the user need special permissions in WebCenter?

If the user needs... Select the option...

no special permissions Normal User

Project Manager permissions, but only for
projects and users belonging to his or her own
company

Project Manager with Limited Visibility of
Companies and Groups

Project Manager permissions on the complete
system

Project Manager with Full Visibility

Project Creator with permission on the
complete system

Project Creator with Full Visibility

Project Creator permissions in restricted
mode

Project Creator with Limited Visibility

Manager)

8. Does the user need the ability to create new task types in WebCenter? (only if the user is a Project

« Ifyes, enable the option User Can Create Task Type.
» If no, leave the option disabled and proceed to the next step.

9. Does the user need the ability to create new users? (only if the user is a Project Manager)

« If yes, enable the option User Can Create User, then click Continue.
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Note: A Project Manager creating users will have less options than an Admin: for example he /
she will not be able to give the new user LDAP (network) sign-on or guaranteed access.

« If no, click Continue.

Tip: You can keep track of users created by other users: the Owner column of the Users page
shows who created each user.

In Step 2: Assign to a Company, optionally select a company to which you want to assign the user.
Note that this can be very important to filter the content and users the new user will be able to see.

If you:

« are creating a Normal User or a Project Manager with Full Visibility, the wizard is complete.
Click Finish to create the user.

- are creating a Project Manager with Limited Visibility, click Continue and proceed to the next
step.

In Step 3: Assign Visible Companies, select the companies that this user should be able to see,

then click Continue.

The selection you make here filters the list of users in the next step so that this Project Manager
can never see users from the companies you did not select in this step. By default, only the
company of the Project Manager himself (the one you selected in the previous step) will be selected.

In Step 4: Assign Visible Groups, select the groups the user should be able to see, then click Finish.
Only groups containing members that belong to one of the companies you assigned in the previous

step will show up in the list. In addition, some groups may be set to be visible to all users(such as
the ADMINS group).

11.4. Editing Users and their Preferences

11.4.1. Edit a User

Click Admin.
On the Users page, filter the list of users if desired, and click the User Name of the user to edit.

The Profile page appears.

Make the required changes:
To edit the user's... You should...
User info (including edit the fields on the Profile Page.

authentication details) Read also Edit User Authentication Settings on page 215.

Menu choose a different menu in the User Menu list.

User Type select the appropriate role from the options:

« Normal User
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To edit the user's...

You should...

« Project Creator

« Project Manager

Visibility Select the visibility for the user from the options:
- Limited Visibility of Companies and Groups
- Full Visibility

Privileges Also specify if:

« User Can create Task Type

User Can Create User

« User Has Guaranteed Access or is an ArtiosCAD Enterprise User

Company or Location

1. Click the Company/Location link at the bottom of the Profile
page.
2. Select a new company and click Finish.

Visible Companies or
Locations (only applies
to Project Managers and
Project Creators with
Limited Visibility)

1. Click the Visible Companies or Visible Locations links.

2. Make a selection of visible locations and/or companies and click
Finish.

Allow Multiple Sessions

The licensing and users
overview page will
explicitly show the
number of guaranteed
sessions and the number
of licenses blocked.

Enable this option to allow the user to login concurrently multiple
times.

Tip: Use this if you have heavy SDK integration with simultaneous
tasks. This is also useful if you have a lot of shared users(e.g. for an
external company).

« Specify the Maximum Open Sessions allowed for the user.

Note: This has animpact on your concurrent licenses. Every three
such sessions take up one concurrent license. For example, if your
integration user has 30 sessions, this will take up 10 concurrent
licenses. Do not use this option for normal users.

The admin users have the same number of multiple sessions as any
other user. You can change this by setting a different Maximum Open
Sessions.

4. Click Change to confirm.
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An Administrator or a Project manager with rights can manage the SSO authentication details at the

user profile page.

Go to Admin > Users. Select the User and go to the Profile page.

Users Mew User Login Tracking Frofile Preerenrer My Work Setup Groups
User Details
Username * JLO
First Name Jenny
Last Mame* Lo
E-Mail * Jenny.Lo@esko.com

FPhone Number
Maobile Number
Funetion

Picture

Mew Password *

Confirm New Password *

Authentication:

Authentication

@ Basic password authentication | Default (Allowed) »

[0 Require the User to change the password at first login.

@tcken | Default {Allowed) +

This section lists the available and disabled authentication types. You can allow / deny the User
authenticating with any of the Single Sign-On Instances.

Read also Single Sign-On Settings on page 391.

Link Authentication:

To allow a User to authenticate via a link, configure Token Authentication on page 394 and allow this
type of authentication in the User profile page.

Note: You need to disable all the other types of authentication to make the link authentication active.

Click Mail Login Link to send this link to the user.
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Whenever the token-authenticated user receives a notification with a link, the link contains a token
to authenticate without user credentials. This permits the users added to the approval cycle to login
using the approval links from the notification mails.

11.4.2. Change the Password for a User

1. Click Admin.

The Users page appears.

On the Users page, filter the list of users if desired, and click the User Name of the user to edit.
Click the Password tab.

Type a new Password and Confirmit.

oos N

Click Change to save the changes.

11.4.3. Change a User’s License Status

1. Click Admin.

The Users page appears.
2. Onthe Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Select or deselect the User has guaranteed access option and click Change.

Note: Changing users'licensing is effective immediately.

Alternatively, to change many users'licensing status in a single operation:

1. Select the users on the User page.
2. Inthe actions menu, click Grant Guaranteed Access or Remove Guaranteed Access as desired.

11.4.4. Set the Preferences for a User

1. Click Admin.

The Users page appears.
2. Onthe Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Preferences tab.

4. Configure the Preferences as needed. For more information on the settings and options, see
General Preferences on page 19.

11.4.5. Copy Preferences to Users

Use this to quickly copy previously defined preferences to one or several users.
1. Click Admin.

The Users page appears.
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2. Select the user(s)whose preferences you want to change and select Apply Preferences in the
actions menu.

3. Inthe Apply Preferences popup, select the preferences to change, and deselect the preferences to
keep.
Other Preferences are the user preferences not mentioned above (for example: show thumbnails or
not, search results layout, etc.).

4, Select who you want to copy the preferences from: in Take Preferences From, select another user,
or select Default to use the default settings for the preferences you selected.

5. Click OK.

11.4.6. Edit a User's Group Memberships

1. Click Admin.

2. Onthe Users page, filter the list of users if desired, and click the User Name of the user to edit.
The Profile page appears.

3. Click the Groups tab.

4. Toadd the user to one or more groups, select those groups (use Ctrl+click to multiple-select)in the
Available Groups list and click the >> button.

5. Toremove the user from one or more groups, select those groups in the Current Groups list (use
Ctrl+click to multiple-select) and click the << button.

The changes are effective immediately.

11.4.7. Set Available Download Formats for a User

1. Click Admin.
The Users page appears.
2. Onthe Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Download tab.
4. Select or deselect the download formats you want to enable.

Note: User permissions for download formats take precedence over group permissions for
download formats.

5. Click Change.

Note:

Alternatively, you can click Use Group Permissions to make the user inherit the download formats from
his or her group membership(s).
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11.5.

Deactivating Users

1n.5.1.

218

An administrator user or a project manager with create user rights user can deactivate users. You
may want to use this feature when you no longer need a user in the system or when you are inviting an
external collaborator to an approval cycle temporarily. You can also do this when you need to free up
named user licenses.

Deactivated users cannot log in, become project members or stay as task assignees. This means that
you cannot start a task or an approval cycle that has a deactivated user as its assignee or approver
respectively.

The deactivated users are still in the Users list with a clearly marked Deactivated label. This allows
you to keep track of what they did or reactivate them if there is a need. Click Deactivate User(s) after
selecting the users you may want to delete.

Note:

« Aproject manager with create user rights can only deactivate the users he created.
« The user deactivation and activation events are logged in the User Management History.

« Admin User or PM users with Create User rights can deactivate users in bulk in the Users overview
page, by selecting the users and clicking Deactivate user(s).

The deactivated users will not receive notification or overdue e-mails even if they are included among
the expected recipients of a Notification message (for example, deactivated Project members).

Deactivate Users

You can deactivate users either manually or automatically after a specified duration.

« To deactivate a user manually:
a) Goto Admin > Users > User > Profile page.
b) Disable the Active User option.

You will see a message warning you about pending approvals or tasks or if the user is currently
logged in. To know more details about the pending work, click on the displayed message.

c) Save.
As soon as you save, the deactivation happens even if the user is logged in or has pending work.

Note: It is not possible to deactivate:

+ the built-in users (ADMIN, CADX, WORKFLOW, CLEANUP) that don't take up any licenses.
« thecurrently logged in user.

ﬁ Warning: The manually deactivated users can be reactivated only after 24 hours.

« To set up automatic deactivation,

a) Go to Admin > Users > User > Profile page.
b) Select from the following options and save.
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Options Description

Deactivate after X working days Specify the number of working days from the
current date.

You will see a message with the predicted date
of deactivation.

Deactivate at a specified date Pick a date using the date picker.

Note: You can only set this up for active users.

No automatic deactivation The default option.

The automatic deactivation happens on the calculated/specified date after 23:59:59 server time.

- Tocreate deactivated users, disable the Active User option in the user creation form. For example,
you could create a deactivated user as a Template user.

Tip: You can create deactivated users with different deactivation dates as template users. Use
these as template users to create different types of approver users(with varying deactivation
periods).

11.5.2. Reactivate Users

To reactivate users, use any of the two ways listed below.

« From the User Profile page, enable the Active User option.
« Select deactivated user(s)in the Admin > Users page and click the Activate User(s) action button.

ﬂ Warning: The manually deactivated users can be reactivated only after 24 hours.

11.6. Delete a User

When deleting a user, WebCenter checks for dependencies, such as being a Project Manager or being
an Approval User on an ongoing Approval Cycle, before deleting the user.

If there are dependencies, WebCenter asks you whether you want to view them (with links so you can
remedy the dependencies)or cancel the deletion.

Note: Attempting to delete multiple users will stop on the first user that has dependencies. To delete
the rest of the users, reselect them and delete them.

1. Click Admin.

2. Select the checkbox next to the name of the user to be deleted. To delete more than one user at a
time, select additional checkboxes of users to delete.

3. Click Delete User(s) in the actions menu.
4. Click OK to confirm the deletion.
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5. If there is a Delete Dependency confirmation, choose the desired option and click OK.

Users cannot be deleted until any dependency issues have been resolved.

11.7. Create and Invite a User from the Approval Page

Project Managers can create and invite users in the context of an approval page. This allows you(as a
Project Manager) to add an external reviewer to the Approval cycle. If the user is not in the system, you
can add a new user and invite him or her from the approval page. It is possible to create and add users
from any approval page(document's, project's or folder's).

Note: These users will be created as Regular Users. The only exception is when an Administrator user
creates a user using an Admin User as the Approval User Template.

If you have used up all your Regular User licenses, you will not be able to Create and Invite User from
the approval page. Read about Named User License model in Licensing and Users on page 206.

« Click Add Approver > Create and Invite New User.

User Info in the Create and Invite New User wizard appears.
« Type the user's e-mail address. The fields (Username, First Name and Last Name will be filled in
automatically from the e-mail address. You can change these fields, if necessary.

« Usernameis filled with the part before @ of the e-mail address.
« First Name is taken as the part before the last dot.
- Last name s filled with all characters after the last dot (or all the characters before @ if no dots
are present).
« Optionally, assign to a Company and Location. Note that this can be very important to filter the
content and users the new user will be able to see.
« |fyouwant the usertologin with alink sent from the approval page, follow the process below:
a) Setup a Token based single sign-on instance and keep it active.

b) Specify a User as Approval User Template. Also remember to allow link authentication in the
user profile.

To allow a User to authenticate via a link, configure Token Authentication on page 394 and allow
this type of authentication in the User profile page.

Note: You need to disable all the other types of authentication to make the link authentication
active.

Whenever the token-authenticated user receives a notification with a link, the link contains a
token to authenticate without user credentials. This permits the users added to the approval
cycle tologin using the approval links from the notification mails.

« If your default approval user template has no Token Authentication setup or you have not defined
a user as the template, you need to specify and confirm a password in the Create and Invite User
wizard.

« Ifthere are Roles as members of the Project(with view rights to the folder or document where the
approval is being set up), it is mandatory to assign the user to a role. Select the Role in the Assign to
aRole field.

« Click Create and Invite User.
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A new user is created and invited to the Project. You will be able to see this user in the Approvers list as
well asin the Users list.

» If you enabled link authentication, the user will log on to the system using a link from the
notification e-mail. The user will be able to see and approve the document/folder or project.

« If you specified a password, the user would need to know the password to be able to log in.

11.8. Managing User Memberships in Projects

11.8.1. View a User’s Project Memberships

1. Click Admin.
2. Onthe Users page, filter the list of users if desired, and click the User Name of the user to edit.
3. Click the Projects User is in tab.

The list of project for the user is displayed. You can filter the list of projects if needed, using the

Show Projects, Manager Last Name, and Manager Group Name fields and the Modified list. Fill in the
filter criteria and click Go.

Note: This does not show Projects for which the user is the Project Manager or those Projects in
which the user is a member by means of belonging to an invited Group.

4. You may uninvite the user from any of the Projects shown in this list by selecting the Project(s), and
clicking Uninvite in the actions menu. The user must not be an Approver in an active Approval Cycle.

11.8.2. Invite a User to Multiple Projects

Click Admin.
On the Users page, filter the list of users if desired, and click the User Name of the user to edit.

Click the Projects User is in tab.

1.

2,

3.

4. Click Invite to Projects.

5. Select the projects you want to invite the user to, and click Continue.
6.

Select the permissions the user needs in the project and click Finish.

11.8.3. Uninvite Users from Multiple Projects

Note: If the useris an Approverin an ongoing Approval Cycle in a selected Project, the entire removal
action is canceled. You must stop the Approval Cycle and then perform the removal.

1. Click Admin.
2. Onthe Users page, filter the list of users if desired, and click the User Name of the user to edit.

3. Click the Projects User is in tab.

221



ESKO

1.9.

WebCenter

The list of project for the user is displayed. You can filter the list of projects if needed, using the
Show Projects, Manager Last Name, and Manager Group Name fields and the Modified list. Fill in the
filter criteria and click Go.

4, Select the Projects you want to uninvite the user from.
5. Click Uninvite in the actions menu.
6. Click OK to confirm.

Login Tracking

1n.9.1.

1.9.2.

11.9.3.
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To get a simple overview of User Logins for a specified time period, click the Admin > Users > Login
Tracking option.

» Specify the time units ( Detail Overview in days / hours / weeks).

The overview table will display the time in the units you specified here.
« Select the View as graph / table.

« Select the time period by specifying the dates.
» Click Search.

You can use Save to Excel to export the login overview. You can view more details by clicking on Switch
to Advanced View. Read in Advanced Login Tracking on page 222.

Read also Failed Logins on page 222 and License Usage on page 222

Failed Logins

Failed Logins column gives the count of the number of login attempts that were denied because of
insufficient licenses. This count is measured during the period you specified.

License Usage

In the Login Tracking page, you can see the statistics regarding:

« usedand free editor licenses
- usedand free concurrent licenses

for the specified time period. You will see a warning next to the progress bar if there was at least one
Failed Login due to shortage of licenses.

Advanced Login Tracking

The advanced page shows a list of individual User sessions (or Failed login attempts) that were active
during the specified time period.

To view the successful login details, select Show Login Sessions. You can view the failed logins by
opting to Show Failed Logins.
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Use the custom filtering to limit the information to what you are looking for. For successful login
sessions you can filter on:

- Single Sign-0On Instance
+ Login Method

« Logout Method

« User: You cantype the

« UserName

« First Name

« Last Name

of the target User.
« Company

« Location: Use this filter to view the login statistics associated with one Company and in a specific
location

Note: To show the system user sessions (("SYSTEM" and “CADX"), enable the option Show sessions
from system users. This option is turned off by default.

If you are viewing Failed Logins, you can filter on:
« Single Sign-0On Instance

« Login Method

« Login Failure Cause

« User Type any of the following:

+ User Name
« First Name
« Last Name

To see login attempts from unregistered users, enable Show anonymous login attempts.

Tip:
Use Sort by to sort the table based on the selected column.

To export the table as a .XLS file, click Export to Excel link.

11.10. Delegation

Delegation is the assignment of responsibility or privileges to another user to complete his / her work.

For example, when a Project Manager (P1) has planned a personal time off and wants to delegate his
user account to another Project Manger (P2). In this case, the P1is the delegator and P2 acts as a
delegate of P1. P2 can perform and manage the work on behalf of P1.

You can configure a delegate for a specified time period or permanently. Actions performed by the
delegate P2 will be tracked in the respective project history.

Delegation can be done only to users who are in the same hierarchy or above. An admin user can
delegate only to another admin user and not to a normal user. Potential Delegates as per the User
Access Level are
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User Access Level Can delegate to

Admin User Admin only

Project Manager (with Limited and full visibility)  |Project Manager or Admin User

Normal User Normal User or Project Manager or Admin User

Delegation Restrictions

To ensure that your user(s) delegate to a limited list of users, you can use the Delegation Restrictions
either as a system wide settings Delegation Preferences- System Wide on page 31or per user.

The Administrators can specify the user level setting which overrides the system wide settings in that
case. Admin users can place restrictions on delegation for a specific user based on various factors like

« System Default

« No Delegation is possible if you choose this option. This prevents your users from delegating their
work.

« All Visible Users allows to delegate any user who are visible in his or her list.

« Only Users in the same allows you to restrict the choice to delegate, within the same company or
location or group.

For example, you can specify that delegation is restricted within the members of a Company. This
would mean that you cannot pick a user who is not part of the same Company as your delegate.

+ Any of the following Users or Groups allows you to choose the delegates from a group(s) or any
users with the Add button.

Note: All the delegation restrictions are copied when the option Delegation Restrictions is
selected in Apply Preferences.

Your user's Delegation

As an Admin user or as a Project Manager who has a set of users, you can view, create or modify the
delegation setup of your users. To do that, use the Users > Profile > Delegation page.

When a user assigns a delegate, the delegate can perform all the work actions. The delegate has to log-
in on behalf of the delegator, to perform the tasks, approvals and permission settings.

Note:

1. You cannot delegate a deactivated user's work or delegate to a deactivated user.

2. Auser can be the delegate to more than one user but cannot be logged in as more than one
delegate at the same time.

3. Delegation works only in one level. The work delegated to a user cannot be delegated to his
delegates.

11.10.1. Setting up Delegation for your Users

As an Admin user or as a Project Manager who has a set of users, you can view, create or modify the
delegation setup of your users. To do that, use the Users > Profile > Delegation page.
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If you are an owner of users, go to My WebCenter > My Users > *Name* > Delegation page. As an
administrator, you can use the Admin > Users > *Name* > Profile > Delegation page.

To add one or more delegates for your user, select a user from the drop-down and click Add
Delegate.

Optionally, if you an admin and like to configure a specific restriction for a user or to add a custom
list of users and group as potential delegates, you can edit the Delegation Restrictions. If you do
not edit this field, the global Delegation Restrictions setting will apply.

You canrevert to the global setting by selecting System Default.

The My Delegates section of your user will list the delegates authorized to act on his or her behalf. You
can add new delegates here.

Add Delegate

You can delegate your work to a specific user or users. Follow the steps below to add delegates.

1.

2.

To add one or more delegates, go to My WebCenter > My Delegates.
Select a user from the drop-down and click Add Delegate.
To inform your colleague about the delegation, enable the Notify new/modified delegates option.

If this is a temporary delegation until your return to work, specify a Start Date and an End Date.
There is also a comment field to leave your notes.

If you leave the End Date empty, the colleague can act as your permanent delegate.

My WebCenter > My Delegates page lists all your delegates and the respective time periods for which
the delegations remain active.

Note: You can modify the delegation fields or delete a delegate from My WebCenter > My Delegates
page.
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12. Managing Groups

12.1. Create a New Group

1. Click Admin > Groups > New Group.
2. Enter the name of the group.

3. Choose who will be able to see this group: All Project Managers, Administrators Only, or Selected
Project Managers.

4. Click Continue.

5. In Step 2: Select Group Members, select the members of the group by checking the checkboxes to
the left of their names.

6. Isthis new group visible to every Project Manager or only to Administrators:
« Ifyes, click Finish. The group is created.
« If no, click Continue. The, in Step 3: Assign group visibility to project manager(s), select the
Project Managers that can see this group and click Finish.

Project Managers with Full Visibility are unavailable, as they can see all groups. By default, group
members can see the group but you can still de-select the group members so that they don't
know this group exists.

12.2. Add Usersto a Group

1. Click Admin > Groups.
2. Click the name of the group to edit. Click Add Users.

When adding new members to a Group, you can filter on First Name, Last Name, User Name, Email
of the User, Name or the legal name or the Company of the user or the Location of the User. You can

add all active members in one go using Select All Active Users ( ) option.

1 Attention: Members of the Admins group can perform any task and are not bound by any
security restrictions and hence it is important to cautious when adding users to groups.
Deactivated Users can be activated and added to the group by the admin users.

The list of users who are currently not members of the group is displayed.
3. Select the user(s)to add to the group.
4. Click Finish.
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12.4.

o orowN

Click Admin > Groups.

Click the group to edit.

Select the user(s) to remove from the group.
Click Remove in the actions menu.

Click OK.

Copy or Move Users Between Groups

12.5.

s oo o

Click Admin > Groups.

Click the group to edit.

Select the users to copy from the group.
In the actions menu, click:

« Copy users if you want to copy users from one group to another.
+ Move users if you want to move users from one group to another.

. Either filter or click Go to show the list of groups.
. Select the new group(s) into which the users will be copied or moved.

Click Finish.

Rename a Group

12.6.

Click Admin > Groups.
Click the group to edit.

The ADMINS and USERS groups cannot be renamed.

Enter the new name of the group in the Group Name field and click anywhere else on the page.

Click OK.

Change the Group Visibility

N

Click Admin > Groups.
Click the group to edit.
Click the Visibility tab.

Select the desired visibility choice: All Project Managers/Creators, Administrators Only, or

Selected Project Managers/Creators.
Depending on your visibility choice, proceed as follows:
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» If you chose Selected Project Managers/Creators, you will be prompted to select the individual
Project Managers who should be able to see this group. Click Change when you have made your
selection.

« Ifyou chose one of the other options, go directly to the next step in this procedure.
6. Click OK.

12.7. Set Group Download Formats

Configure the available download formats in WebCenter Preferences (Admin > Preferences >
Download Formats) before setting group download permissions.

Click Admin > Groups.

Click the group to edit.

Click the Download tab.

Select or deselect the download formats you want to enable.

N

Note: User permissions for download formats take precedence over group permissions for
download formats.

5. Select or deselect checkboxes to grant or deny permissions as desired.
6. Click Change.

12.8. View Group History

Actions performed in the group including its creation, are recorded in the History tab of the group. You
can access this from Admin > Groups. Now, select and open the Group for which you want to view the
history and navigate to the History tab.

You can view the following actions in the History tab.

« Group Created
« Group Information changed ( Renaming of the group/ changes to visibility setting of the Group)
« Useradded or removed from the group

- Group View Rights changed (changes to the list of Project Manager’s/ Project Creators who can
view the Group)

« Group Manager Changed

Note: When the Group is deleted, you can view the event history in Admin > Group > View History.
This page lists the events of all the groups and it can be filtered on date and users.

12.9. Setting Group Notifications

As an administrator or a Group manager, you can set up notifications individually for every group
member or to a single group e-mail address.

1. Click Admin > Groups.
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2. Click the group to edit.
3. Click the General tab.
4. Select your preferred way of sending notifications or disable them altogether.

« Send notifications to everyone in the group: When this option is selected, a group event will
trigger notifications to all of the group members' e-mail addresses according to the individual
language settings.

+ Send notifications to a group e-mail address. Specify the following info:

« Group e-mail address

« Group-email language

If this option is chosen, a single e-mail notification is sent to the specified Group e-mail address.
- Do not send notifications to this group: Select this to deactivate email notifications altogether.

5. Click Save.

12.10. Managing Group Memberships in Projects

12.10.1. View a Group's Project Memberships

1. Click Admin > Groups.
2. Click the group to edit.
3. Click Projects.

12.10.2. Invite a Group to Multiple Projects

Click Admin > Groups.

Click the name of the desired group.

Click Projects.

Click Invite to projects.

Either filter or click Go to show the list of all projects to which this group is not invited.
Select the projects to which the group is being invited.

Click Continue.

® N o rw N

Set the project permissions that this group will have in the projects to which it is being invited. The
same permissions will apply to each project.

9. Click Finish.

12.10.3. Uninvite Groups from Multiple Projects

If auserinthe group is an Approverin an ongoing Approval Cycle in a selected Project, the entire
removal action is cancelled. You must stop the Approval Cycle first, and then perform the removal.
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Click Admin > Groups.
Click the name of the desired group.
Click Projects.

Select those Projects from which the group is to be uninvited.

1.
2.
3.
4. Either filter or click Go to show the list of all Projects to which this group is invited.
5.
6. Click Uninvite in the actions menu.

7.

Click OK to confirm the removal.

12.11. Overview of My Group's Tasks

My Group's Tasks lets the Group Manager quickly view the tasks assigned to their group or group
members. It also allows to assign, re-assign, or distribute the tasks among the group members.

If a group memberisill or not available, the Group Manager can re-assign the task to an other group
member. A Group Manager can also monitor the progress on a selected Group or Group Member. Using
the filter options, the Group Manager can have a quick overview of the workload.

12.11.1. Group Task Manager

Every department has a Department Manager. In WebCenter Department Manager are referrred to as
Group Manager. A group can have any number of Group Managers including 0. Group Manager is always
part of a group.

A Group Manager likes to view the tasks assigned to a selected group or group members, which will
assist himin distributing the tasks and also get a quick view on the current status of a task.

The My Group's Tasks feature allows Group Managers to:

- View task assignments for a selected group and the workload overview.
« View tasks assigned to a group member and the workload overview.

« Re-assign any task assigned to a group member.

« Review the task overview filtering on status and due date.

12.11.2. Assigning a Group Manager

The My Group's Task page can only be accessed by a Group Manager. Only a member of ADMINS can
turn a group member into a Group Manager.

Login to WebCenter as an Admin user.
Click Admin > Groups > Groups.
Search for the required Group Name or click the Group Name from the list available.

R N

Select the Group Manager check box for the desired group member.
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You can assign multiple Group Managers to one group. The same user can also be Group Manager to
multiple groups.

12.11.3. Using My Group's Tasks

To access My Group's Tasks feature, log in as Group Manager. Click My WebCenter > My Group's Tasks
to view the Group Tasks for Group page.

Viewing Task Assignments
You can view the tasks assigned to a selected group and also for a group member within the group.

1. Thetask list for assigned group appears.

Note: If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of
managed groups. You can only view the tasks for one group at a time.

2. In the Tasks assigned to drop-down list box, select the group or group member for whom you want
view the task assigned.

3. Atasklist assigned to the selected group or group member appears. Also in the list are:
» Task Name

+ Project Name
« Assignedto

. Status
« LeadTime
« Due Date

+ Created Date

« Started Date

« Estimated Date
« Task Documents

Viewing a Workload Overview

During editing/re-assigning, the Group Manager can have an overview of number of tasks assigned and
how many are overdue. The Task Count is the number of assignments assigned to a group member. The
Task Count displayed is based on the filtering criteria and tasks with past due-date always appears.
The non-active projects do not appear and are not counted.

1. Thetask list for assigned group appears.

Note: If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of
managed groups. You can only view the tasks for one group at a time.

2. The workload overview appears for the selected group.
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Search Tasks Sortby = Due Date v Status All but completed

Members Task Count

_ S Before1(1 overdue)
DEKE_DEPENDENCIES N !
o - ! After: [1(1 overdue)
At AT A - . - Before:0(0 overdue)
ArtiosCAD, ArtiosCAD (ARTIOSCAD) :
e oseA . After: 0(0 overdue)
P Before:0(0 overdue)
deke_user2 (DEKE_USERZ) : !
exe_userz{ - After: 0(0 overdug)

om (IL_PM) Before: NG 1(61 overdue)
e After  EEEEENG1(67 overdue)

Keizer Debbie (DEKE) Before: I 1 35 (138 overdue)
e After: I 35 (138 overdue)
Before:0(0 overdug)

prma (PRMA_USERZ)
APRMA- After: 0(0 overdug)

If the task is past the due date, it appearsinred.

Reassigning a Task

A Group Manager can re-assign a task to a group or a group member. A task can be re-assigned only to
a group member within the same Group. In addition to this when the task is reassigned, the WebCenter
Ul displays the previous assignee in Previous column.

1 Note: Ensure tologin as Group Manager.

1. Thetask list for assigned group appears.

Note: If a Group Manager manages or is assigned to multiple groups, WebCenter displays the list of
managed groups. You can only view the tasks for one group at a time.

2. Select the new assignee in the Assigned to drop-down list box. This list contains group and group
members name.

3. WebCenter shows changed tasks with a yellow background indicating the change.

Note: Even if a task is not initially assigned to a group, the Group Manager has all the rights to re-
assign the task to a group member.

4. Click Save to commit the changes.

Filtering Based on Task Status and Due Date

A Group Manager manages multiple tasks at a time and this might lead to delay. Using the Search
Tasks Status, one can see tasks in a more specific status.

For example, you can filter the tasks which are in Completed or In Progress status. By filtering the
task, a Group Manager need not re-assign completed tasks or tasks which cannot start because a
predecessor is not complete.

Similarly the tasks can also be filtered by Due Date. This gives a Group Manager a quick view of the task
for the required time line. Using this information Group Manager can view what is due this week or this
month to make the required planning.

1 Note: Ensure tologin as Group Manager.

1. Thetask list for assigned group appears.
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Note: If a Group Manager manages multiple groups, WebCenter displays the list of managed
groups. You can only view the tasks for one group at a time.

In the Search Tasks Status drop-down list, select the desired task status.
In Due Date, select the required due date and then click Go.

Note: To set the Due Date filtering, setting a task status filter is not necessary. The Due Date
changes to completion date, if the task status is filtered to completed.

The following are the default due dates settings available:

« All

« Today

+ Next 3 days

+ Nextweek

+  Next 2 weeks

» Next month

+ Next3months

» Overdue

«  Week overdue, all the tasks which are overdue for less than five days.

Filtering Based on Column

By clicking a column header, the Group Manager can view tasks for a selected group in ascending or
descending order.

For example, if Due Date is selected then the tasks for the selected group appears with the earliest
due date. Similarly if Due Date is clicked again, then the tasks for the selected group appears with the
latest due date.

1.

2.

Log in as Group Manager.
The task list for assigned group appears.

Note: If a Group Manager manages multiple groups, WebCenter displays the list of managed
groups. You can only view the tasks for one group at a time.

Click a column header, for example Due Date, to sort on this column.
The sorting is indicated by an arrow. For example, if Due Date is selected then it would appear as:

Due Date 1

Jan 29, 2013
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13. Managing Roles

13.1. Roles

234

A Role is an assignment that you can create in WebCenter to be used later on in Projects. You
can assign a Role to Project Templates, Projects, Tasks and Approvals. You can set up project
permissions, approval settings and tasks for a Role within a project or template.

You can assign these Roles to real users and groups when needed. When you assign a Role to a real
User or Group, you are assigning the Role's settings.

You can create versatile Project Templates using Roles which will help you to reduce the number of
Project Templates.

Roles are created as global. This helps the Project Managers (or Selected Project Managers)to use
the Roles effectively in individual projects and templates. You can invite these Roles as in the case of
Users and Groups.

Roles are effective after real members (Groups, Users) are assigned into each of the Roles. A project
Role assignee will be treated like a standard project member. Once you assign the Role to a project,
these take over the role's security setup, approval setup and task assignments.

« the notifications will be sent out correctly
« the task will be shown in the respective members' to-do list

+ the necessary access rights will be assigned to the members to perform the task (depending on the
Role)
« the approval notifications will be sent out correctly.

You can employ multiple assignments of a single Role. For example, you can invite a "Designer” Role
to all the Projects requiring a designer either after creating a Project or via the Project Template with
assigned Roles.

You can use Roles:
« To combine with Workflows:

The tasks assigned to Roles will be picked up by the users or groups who are assigned to these
Roles either at the beginning or later during the project execution. The project manager can decide
who will get assigned to the Roles. Since WebCenter keeps track of Role assignments:

« thenotifications will be sent out correctly

« the task will be shown in the respective members'to-do list

« the necessary access rights will be assigned to the members to perform the task (depending on
the Role)
« the approval notifications will be sent out correctly.

+ InProject Templates:
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Features associated with Roles will be inherited from Project Templates during project creation.
Adding Roles (instead of user Groups or individual Users) to your Project templates makes them
more versatile.

Note: Although the Roles are defined for entire WebCenter, the assignment of Roles is done per
project and is independent of the User. Therefore, you can assign the same user or group to a
"Designer” Role in one project and restrict the access for the same User/Group in other projects.

Read more in Creating a Role on page 235

13.2. Creating a Role

1. Click Admin > Roles > New Role.
2. Specify the name of the Role

3. Determine the visibility of the Role by selecting from All Project Managers, Administrators, or
Selected Project Managers. Click Continue

Subsequent step depends on whether you selected Selected Project Managers visibility in this

step.
Choice Steps
Selected Project Managers You should select which Project Mangers are
allowed to see the Role
All other The New Role is created.

You can view these roles in the list of Project Members even after being resolved.

4. Assign a Viewer Workspace from one of the existing workspace available in the drop down or you
can create a new workspace for the role created.

13.3. Editing Role details

1. Go to Admin > Roles. You can see the list of available Roles, where the Role names are visible as
links in this tab. To edit any Role details, click on the Role Name and this will lead you to the tab
named General of Role Management page.

2. You can change the name of the Role in the General tab. Edit the name of the role in the Role Name
field and click anywhere else on the page to save the change or click on Save.

3. You can also assign a new workspace from the drop down available in the Viewer Workspace field
or change the workspace present. It is also possible to edit or delete the workspace present by
selecting the gear icon.Click on save for the changes to be effected.
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1. Go to Admin > Roles . This will lead you to the tab named General of Role Management page. You

can see the list of available Roles in this tab.

2. Click on the name of the Role (visible as a link) for which you want to change the Visibility.

3. Go to the Visibility tab and change the visibility.

You will have to choose from three Visibility choices: All Project Managers, Administrators Only

and Selected Project Managers.

Options

Description

Selected Project Managers / Creators

You will be prompted to select the individual
Project Managers or Project Creators. Click
Change when you have made your selection.

All Project Managers/ Creators and
Administrators Only

You will be asked to confirm the selection.
Click OK.

13.5. Deleting Roles

1. Go to Admin > Roles. This will lead you to the tab named General of Role Management page. You can

see the list of available Roles in this tab.

2. Select the Roles from the list of Roles by toggling the respective check boxes.

3. Click on Actions > Delete Role(s) from the list header.

Note: You will be warned if this Role is associated with an existing Project or Approval cycle.

13.6. Converting Empty Groups to Roles
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Previous versions of WebCenter made use of empty Groups to create roles. From WebCenter 12
onwards this is replaced by Roles. However, you can also convert any empty Group that serves as Role
into a full fledged Role. This will ensure that any reference to such empty Groups will be retained and
shifted to the new Role that is created during this process.

To convert an empty group to a role you need to follow these steps:

1. Go to Admin > Groups.

2. Select those Groups which you need to convert into Roles.

You can use Show filter to filter out all the non-empty groups.

3. Go to Actions menu. Select Convert Group to Role action link in to execute the conversioninto a

Role.
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You will be re-directed to a page detailing how many of the selected empty groups were converted
and how many were not.

Note: The conversion can fail when:

« anon-empty group is selected for conversion. Only empty groups can be converted into roles.

« arole with the same name as the selected empty group exists. Role names must be unique.

13.7. Delegating Roles: Setting up Roles to Assign Roles

Project Managers and Project members (with permissions) can assign a Role within their Projects. The
Project Manager or Member can do this from the Manage Roles page.

1. Click Admin > Roles.
2. Select the Role you want to assign permissions to.
3. Click the General tab.

Role: CSR

Rolez | Mew Role | General | Visibility

Role CSR

Tip: indicates required field

Role Name: CSR

Role is Visible by : =All Project Managers=

Role can invite following roles : Sales; CSR; Printer

Save

4. Click on the Roles can invite following roles link. This will open Manageable Roles page.

Role can invite the following roles drop down will contain all the Roles present in the system.
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Role: MANAGEMENT

Rolez | New Role | General | Visibility | Manageahle Roles

Roles Managed by Role MANAGEMENT

Role can invite the following roles: |Please zelect or start typing... El

© pEsIGN
(=) FINANCE
(2 MARKETING

Role can invite the following roles list depends on the visibility rules. See below.

Admin and PM with PM with limited visibility Normal user
full visibility
All Users and Groups Visible Users and Groups - Users from his own

company (all locations).

« Usersand Groups present
in the same Project
(through individual or role
assignments).

« Groupstheuseris
member of.

5. Save.
After setting up this configuration, the Project Member in that specific Role can invite other Roles.

The same Project Member in different Roles can have individual configurations in Role can invite
the following roles list. In this scenario, the list of Roles that this Member can assign will be the sum
of these individual lists.

13.8. View Roles History

You can view the changes that are made to the Roles in the History tab. You can access this in the.
Admin > Roles. Now, select and open the Role for which you want to view the history and navigate to
the History tab.

« Role Created

» Role Information Changed (renaming of the Role/ changes to visibility setting of the Role)

+ Role View Rights changed (changes to the list of PM's/ Project Creators who can view the Role

« Group Converted to Role. History of the group is transferred here and all details can be viewed now
in the Role History
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Note: When the Role itself is deleted, you can view the event history in Admin > Roles > View History.
This page lists the events of all the roles and it can be filtered on date and users.
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Discussions

Discussions helps users to communicate with each other better and enables to seamlessly interact at
various levels like project, document or at task level. Discussions facilitates WebCenter users to have
conversations, which facilitates collaboration and faster decision making.

You can start a discussions in WebCenter, in a Project, Task or at a Document level.

You can view the conversations in the Project or Task or at the Document level in the Discussions
Tab. Discussions can be with all the members or private conversations with few or one member of the
project.

Admin users have permission to view, edit the members, and delete the messages or the discussions
itself in any of the project, or task or document. Admin Users, Project Managers of the Project where
the discussion is in and the owners of the Discussion can make the discussion read only.

All members of the Project can start a new discussion. Read more on how to start a discussion or post
amessage in a discussion Start a New Discussion.

Global Discussions

14.2.

Admin users can communicate to all the users in the WebCenter using Global discussions. It is an one-
way communication and can also be made read-only. By default, global discussions are for everyone
but admin users can also restrict the audience by selecting the targeted users, roles or groups.

You can start a global discussion on either My Discussions page or in the Discussions widget on My
Work page. Based on the setup of notifications, a notification is sent when a discussion is started or a
message is posted.

Note: You canuse the ﬁ read-only toggle button, to make an existing discussion read only.

Enabling Discussions in Task Type
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To start Discussion in a Task, Task Type chosen for the task should have the field Allow Discussions
enabled. Either Admin users or Project Managers with Create Task Type permission can do so. Refer
to the steps here to create a task type Create a Task Type.

To Enable Discussions in a Task:

1. Open any Task Type and enable Allow Discussions in the Discussions tab.
2. You can choose the Discussion contexts from the drop down list.

« Current Task : Discussions are created in the current task and are visible in the task.

« Parent Workflow: Discussions created on the tasks of the parent workflow are visible in all the
tasks of the parent and the child workflows.
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- Root Workflow: Discussions created on the task of the root workflow are visible in all the tasks
of the related workflows or the workflow with this setting.

» Project: Discussions created in the task are Project Discussions and are visible in the task.

3. Choose Show Discussions of Documents linked to the Task to view the discussions that happen at
the document linked to this task.

Note: Once the task is completed, discussions are in read-only mode.

Copying Discussions from Project / Template

As an Admin user, you can create default templates of discussions and messages which are inherited
to projects that are created from the template.

The discussions can be copied optionally, when a new project is created from another project.

Note: Notifications are not sent for discussion events triggered on a project template level.

Copying Discussions from the Project Template

When you create a Project based on a template, the new project is created with the discussions that
were defined in the template. This will also include the users and messages in every discussion that is
copied.

All Project, Document and Task Discussions from the source Template/Project are included in the
target project.

Copying Discussions from another Project

Project Manager users can specify to Copy Discussions, when a new project is created from Copy
Project from another Project option.
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Copy setup from an Existing Project

# Copy Project Manager
# Copy Members
# Copy Approval Settings
# Copy Folders
Including Docurnents
Including Bill of Materials
# Copy Attributes
# Copy Characteristics
# Copy Tasks | From Scurce Project v

# Copy Security Settings

# Copy Motifications

Note: When Copy Discussions is enabled, Project discussions will be copied to the newly created
project. Document and Task discussion will be copied, if the Including Documents and Copy Tasks
options are also selected.

14.4

Deleting a Discussion or message

Admin users have the option to delete some of the discussions and messages that may not be required
or redundant. For security reasons, this option is available only for Admin users and Project Managers.

1. To delete, open the discussion and click the delete button in the Action bar.

2. To delete a message, hover over the message and click the delete button.

Tip: Depending on the notifications set up for discussions, an email notification is sent when a
message or a discussion is deleted. You can set up notifications when a member is added or deleted
from a discussion. Project history is updated when any changes are made to an existing Discussion
or a message in the Discussion.
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Project and Document Characteristics

Characteristics are descriptive tags that can be assigned to projects or documents to make them
easier to find.

Characteristics are hierarchical. This means there can be different levels of characteristics for various
product lines so that you can drill down through the information to find the exact characteristic desired
when searching the database.

For example, you could create a master characteristic for Electronics, and then various sub-
characteristics for types of appliances, entertainment equipment, or computers, and so forth. They
are presented in a tree format - main categories with expandable branches. The characteristics tree
configures the available characteristic names as well as how they are organized.

System History Logs
All Characteristics related events like
« Characteristics Created
+ Characteristics Deleted and
« Characteristics Changed

are recorded and stored in System History. Read this page on how to access the recordsSystem History
on page 386

Create a Characteristic

15.2.

1. Click Admin > Characteristics
2. Do you want to add a primary characteristic (a main category) or a secondary characteristic?

- Toadd aprimary characteristic, select the option button next to Root at the top of the tree and
then click New Characteristic.

« Toadd a secondary characteristic, select the option button for the characteristic under which to
add the new one, and then click New Characteristic.

There can be up to 17 levels of characteristics or at most 256 characters for the entire
characteristics path from the root characteristic to the deepest-level characteristic.
3. Enter the name of the characteristic in the Name field.

4. Click Create. The new characteristic appears in the list.

Edit or Delete a Characteristic

When deleting a characteristic, WebCenter checks if the characteristic or any of its child
characteristics are assigned to any Projects or documents. If such a dependency is found, you are
prompted to remove the dependency and delete anyway, or cancel the deletion.

1. Click Admin > Characteristics
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2. Do one of the following:

« Toedit acharacteristic, click its name in the tree structure. Type a new name in the Edit
Characteristic page and click Change to confirm.
« Todelete a characteristic, select it in the tree and click the Delete Characteristic link.

If there are no dependencies, it is deleted immediately. Note that any sub-characteristics of the
selected characteristic will also be deleted.

15.3. Export/Import Characteristics

When exporting a project or project template, the project characteristics are exported along with
other project information. Upon import, the characteristics are restored on the target system. When
the characteristic does not exist on the target system, it gets created automatically.

« Inthe source location, to Export Characteristics, go to Admin > Projects.

Select the Projects that you would like to export. Click Exportto start a download of a XML fie
containing the characteristics.

Save this on your computer

« Inthetarget location, to import Characteristics, go to Admin > Projects >.

Select Import from File and choose the XML file which was downloaded earlier.
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16. Project and Document Attributes

Basic concepts

Attributes are a way to assign user-configurable fields and their values to documents and projects.
They can be:

- Prompted so that the user has to set a value each time it is used,
« Calculated from an ArtiosCAD formula,

« restricted to a group of preset values (a Restricted Set).
The Restricted Sets must exist before you can use them when creating an attribute.

Attribute Categories group attributes together for convenience. An attribute must be put into an
attribute category before it can be used; however, the same attribute can be in multiple categories.

You must create an Attribute Category before adding attributes to it.

16.1. Restricted Sets

16.1.1. Create a Restricted Set

1. Click Admin > Attributes > Restricted Sets > New Restricted Set.
2. Enterinformationinthe fields as appropriate:

« Name: the name of the Restricted Set, up to 35 characters.

« Type: the data type of the Restricted Set. There are eight allowed types: Area, Date and Time,
Distance, Float, Integer, Text, Text (Right to Left), Volume, and Weight.

A Float is a number containing a decimal point and an Integer is a whole number.

The labels in parentheses after the name of the type indicate the units of measurement used in
Imperial and Metric systems.

« Value: an entry for the restricted set. Text values can be up to 255 characters long.

Click Add to add the value to the set and clear the Value field. Enter as many values as desired,
clicking Add after each one.

Tip:

You can sort the Values list using. ® 'and ® |, or click the Sort button to sort it alphabetically
(for Text Type Restricted Sets).

You can also select one or more values and click Remove to remove them.
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3. Click Create to create the Restricted Set.

16.1.2. Edit a Restricted Set

Click Admin > Attributes > Restricted Sets.
Either filter or click Go to show the restricted sets.

Click the name of the restricted set to edit.

N

Change the name, or add and remove values as desired. You cannot change the type.

Note: If you remove a value, the next time you access a project using the deleted value, you will be
prompted to change it.

5. Click Change to make the changes.

16.1.3. Delete a Restricted Set

WebCenter checks if a Restricted Set is being used before deleting it. If it is in use, you will be

prompted to either clear the restricted set from the attribute using it, or to cancel the deletion.

1. Click Admin > Attributes > Restricted Sets.

2. Eitherfilter or click Go to show the restricted sets.

3. Select the checkbox of the restricted set to delete and click Delete Restricted Set(s) in the actions
menu.

4. Click OK when asked to confirm the deletion.

5. If the restricted setis not being used, it is deleted immediately.

16.1.4. Export / Import Restricted Sets

You can Export and Import restricted sets .

« To export, go toAdmin > Attributes > Restricted Sets:
a) Click on the Import link.
b) Browse to a previously saved XML file.

c) Select Actions > Export.
This will start a download of an XML containing the Restricted Set.

d) Save this on your computer.

« Toimport, go toAdmin > Attributes > Restricted Sets:
a) Select the Restricted Set to export.
b) Select Actions > Export.

c) Click the Import button.
If the restricted set exists, it will be overwritten with the new values. If it does not exist, it will be
created.
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Note: This is similar to exporting / importing attribute categories and task types. The exported
category will contain the exported restricted sets in the same XML file. While Importing this in a new
system, the restricted sets and attribute categories will be created.

System History Logs
All Restricted Set related events like

« Restricted Set created
« Restricted Set deleted and

« Restricted Set changed

are recorded and stored in System History. Read this page on how to access the records.

16.2. Attributes

16.2.1. Create an Attribute

1. Click Admin > Attributes > New Attribute.
2. Enterinformationinthe fields as appropriate:

In the field... Fillin the...
Name name of the attribute (for example, Billable).
Label text of the label which has to be displayed. To get the translated

text of the label in the other languages chosen, select the blue
icon to open Find or Create Translated labels on page 249.

Description description of the attribute contents (for example, Indicates
whether work on this project should be billed
by finance).

Type the type of the attribute. You can select from the drop down.
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In the field... Fillin the...

- Select Attribute Type —

- Select Attribute Type —
Area(sq in.sqcm)
Area(sq in.,.sq mm)
Area(sq ft,sgm)
Date and Time
Distance({in. mm}
Distance(in.,m)
Document Reference
Float

Integer

Text

Text (Right to left)
Volume(cu in.,cu cm)
Volume(cu in.cu dm)
Volume(cu ftocu m)
Weight{lbs,gr)
Weight(lbs kg)

Document References are attribute-links pointing to different
document sources. When you select this option, you will have
more options. Read more in Create a Document Reference
Attribute on page 307.

Floats are numbers containing a decimal point(e.g. 3.1415)
and integers are whole numbers(e.qg. 42).

Date and Time attribute added in the project attribute category
allows to link a date/time to the project status.

Text ( Right to Left) attribute allows text to be written right to
left always and this feature is available in 18.0.1 onwards.

Rich Text attribute type allows you in entering long and/or rich
text. You can:

« add set of least 16 different colors.

« setthetext bold and italic.

« use bulleted and numbered lists.

« Heading up to four levels and also add tables.

In the Preview you will see the Rich Text editor. Click the Show
Rich Text Controls link to view the broad pallet of text options.
The Project Managers with change properties rights can add
content from a document to the Rich text editor window.

Here, the text (also Chinese, special characters), font types,
bullet types, color, tables and headings are preserved. From
WebCenter 18.0.1, there is also an option to change the text
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In the field...

Fillin the...

T T

direction using the buttons (right to left or left to

right).

Values

choose either:
« Prompted if you want to allow the user to enter any value.
« Calculated if you want to use an ArtiosCAD formula to

calculate the attribute value (enter the ArtiosCAD formula in
the field).

Note: You should set Calculated attributes to read-only

as their values are automatically updated from ArtiosCAD
and should not be changed by WebCenter users. To set the
value of the calculated attributes during upload, ensure that
you have a default attribute category with the calculated
attributes for the ArtiosCAD documents.

+ Restricted Set to limit the possible values.

Note:

To choose a Restricted Set, it must be created before defining
the attribute (see Create a Restricted Set on page 245).

Make sure that the Type of the Restricted Set is the same as the
attribute type.

Note: For Document Reference attributes, you will have only
Prompted as the value.

3. Select Attribute is also a task specification if you want to be able to use the attribute as a task

specification.

For more information about task specifications, see Basic Concepts of Task Management".
4. Click Create.

Find or Create Translated labels

This option may be found, when you

Where will you find this option

Create an Attribute or a document reference
Create or edit a Search using Search Panel Design

How to Create new translated label
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Find or Create Translated Labels

Q orR | | o

You can either search for translations or create a new label in the language you require.

16.2.2. Edit an Attribute

1. Click Admin > Attributes
2. Click the attribute to edit.
3. Edit the attribute as desired (change the Name, Description...).

Note: You cannot change the attribute type.

4. Click Change to make the changes.

16.2.3. Copy and Paste Attributes

250

Attributes can be easily copied between attribute categories between two views in the same
categories or between attribute categories and task type specifications. This can be done within the
same WebCenter system or between different WebCenter systems.

To copy your selection of attributes in any view to the clipboard by either using keyboard shortcuts like
Ctrl/Cmd+C, Ctrl/Cmd+X, Ctrl/Cmd+V, or by using a context menu (right click).

Note: Copy and paste of attributes is possible only in Grid Layout and this feature is not supported in
the Header view of the Attribute Category.

When pasting the content in a cell, all settings including labels, rules, styles, document reference
rendering configurations and lists are copied.

There can be conflicts detected when you paste the copied cells into another location. Following are
the possibilities that may arise:

Conflict Detected Action that can be performed

Target cells are already occupied Choose to overwrite or cancel the operation
Copied cells are already existing in the new Choose to replace the existing one or skip the
location conflicting cells or cancel the operation

When the copied attribute has rules / styles that Choose to

are already existing in the new location . overwrite the rule/ style

» keep both the rules/ styles. Copied rules/styles
gets anumber added to its name

« Use the existing rules/Styles or
« cancel the operation
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Conflict Detected Action that can be performed
When a list entry is already assigned to a Choose to
different set of attributes in the destination

overwrite the list
« keep both thelists
+ merge values or
« cancel the operation

category

When the copied Form property (Task execution Choose to

or project creation view) already exists in the overwrite the selection

destination . .
« Skip the action
Note: When a form property is placed in a view
where it cannot be placed, it will be ignored
System History Logs

All Attribute related events like
+ Attribute Created

+ Attribute Deleted and

« Attribute Changed

are recorded and stored in the System History. Read this page on how to access the records System
History on page 386

16.2.4. Delete an Attribute

When deleting an attribute, WebCenter checks if the attribute or any of its child attributes are used in
any projects. If it is, you are prompted to remove it from the project and delete anyway, or cancel the
deletion.

1. Click Admin > Attributes
2. Select the attribute to delete and click Delete Attribute(s) in the actions menu.

If the attribute is not being used, it is deleted immediately.

16.3. Attribute Categories

An attribute category is a set of attributes which are used together and is a way to apply attributesto a
project or a document.

Attribute categories contain:

« attributes you selected
« lay-out elements(ruler, table, spacer, title)
« styling
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custom labels

« rules

buttons (potentially automatically executed on events)

System History Logs
All Attribute Category related events like
« Attribute Category Created

« Attribute Category Deleted and

« Attribute Category Changed

are recorded and stored in the System History. Read this page on how to access the recordsSystem
History on page 386

16.3.1. Create an Attribute Category

1. Click Admin > Attributes > Attribute Categories > New Category.

2. Enter the name of the Attribute Category to create, for example Shipping Instructions.
3. Click Create.

Once you have created the attribute category, you can add attributes to it, define views, etc.

To do this, click the Attribute category was created successfully. Edit ... link (see Add Attributes to an
Attribute Category on page 252 for details).

16.3.2. Rename an Attribute Category

Click Admin > Attributes > Attribute Categories.
Click the attribute category to rename.

Type the new name in the Edit Category page.
Click Save.

N s

Note: Click Save As Copy if you want to duplicate the attribute category under the new name, while
keeping the original category as it was.

16.3.3. Add Attributes to an Attribute Category

1. Click Admin > Attributes > Attribute Categories.

The Edit Category page shows two columns: the available attributes (that you can add to the
category)at left, and the attributes that are already in the category at right.

2. To add attributes to a category or remove them from it, use the chevron (<< or >>) buttons to move
them between the two columns.
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Note:
Moving attributes between columns takes effect immediately.

Attributes you have added to the category have an * in the left column.

Tip: Use the search field to filter the available attributes list, and the . ® |and ¥ |buttons to
change the order of the attributes in the category.

You can see a Preview of your attributes under the columns.
3. Click Save when you are done.

16.3.4. Attributes Views

You can use different layouts for the same Attribute Category in different locations or pages by
creating custom Attribute Views. A View created for a particular context can have custom layout for
that context. This way, different places in the user interface can show different levels of details of the
attributes.

For example, you can choose to show very few attributes during Document upload using a Creation
View. See more examples below.

You can use special Attribute Views such as Project Creation Form view to create request formsin
WebCenter. You can completely customize these forms with your business terms without any default
terminology from the application.

You can have multiple views for an Attribute Category. Essentially, these are subsets of the category
with different layouts (if you have configured it that way).

You can configure the following views:

« Default view: used in project attribute details page and document attribute details page. You
cannot delete this view.

« Creation view: used in the project creation and upload document pages.
« Headerview: used in the headers of project details pages and document details pages
« BOMyview: usedin the Bill of Materials tab of projects

« Task Type views: For each task type you can define a view which will be used in the task execution
page for documents attached to this task.

«  Viewer Views
« Project Creation Form View
« Task Execution View (for Task Specifications)

Default View

When adding attributes to a category, only the Default View of the category exists at first (you can add
other views). The Default View is the view that will be shown in the project or document details (on the
Attributes page).
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Documents (3} | Tasks (0) | Discussiens (0) | Characteristics | Attributes | Project Information | Approval | Motifications | Members | Security

Show Attributes in Category Package Information Change Categor

Name Value Type

Product name |Cr|oc' Ice Cream Text

Country Belgium b Countrles

Length In Inches or mm |220 mm

Number of Spot Colors |2 Integer

Save

Export to JOF file: Export...

Import from JOF file: ’ Browse. .. \ Import
Note:

« Users can edit attributes in the default view if they have Change Properties right on the project (for
project attributes) or on the folder containing the document (for document attributes).

- When editing attributes, they must fill in attributes that are required (they have a red *).

« They cannot edit attributes that the Admin made Read Only.

Creation View
If you have added a Creation View of the attributes, users see it when they:

« create aproject with attributes,
« create adocument placeholder from a document template with attributes,
« upload one or multiple documents with attributes.
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Create Project
Create: |use a Project Template j
Template: |Packag|ng j Show Detalls
¥ Details
Name: |Choc' Ice Cream packaging @
Project Manager: | Me - Status: Active - .i;.—(-q
Customer: No Customer i Location: No Location ~ Thumbnail: Cfﬁ Lhangs
‘13.' l‘
Description:
Due Date: [ [ -]
» Documents
» Members
¥ Attributes
Name Value Type
Product name |C10c' Ice Cream Text
Country Belglum - Countrles
Length In Inches or mm |22El mm
Number of Spot Colors |2 Integer

Note:

« Ifyou haven't added a creation view, users will see the default view instead when performing those
tasks.

« When editing attributes, users must fill in attributes that are required (they have a red *). They will
not be able to create the project / document placeholder if they don't!

Users cannot edit attributes that the Admin made Read Only.

Header View

If you have added a Header View of the attributes, users see it in the header of the project or document
details page.

Project: Choc' Ice Cream packaging Status: Active
Mail link to Manager: Berg, Brune Product name: Choc' Ice Cream
Soaihice ¥ w Customer: Country: Belgium
A = Due On: Length in inches or mm: 220 mm
More actions... L W -
> = Modified: Sep 22, 2010 Number of Spot Colors: 2

&~ Upload Description:
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Note:

» Ifyouhaven't added a header view, users will not see attributes in the project or document header.

« Users cannot edit attributes in the header view.

Task Type View

If you have added a Task Type View of the attributes, users see it on the task details page for
documents attached to a task of that specific task type.

Viewer View

You can create dedicated views to allow your users to view the active document's attribute category in
the Viewer.

If you have configured your attribute category with such Views, your users can view this in the
Attributes widget.

For example, you can create attribute category based checklists for different roles / groups. When a
user from that role or group views the documents with that category, this attribute checklist will be
visible in the viewer. Read more about this use case in: https://wiki.esko.com/pages/viewpage.action?
pageld=170047115.

As an another example, you can use this to view your document references in the Viewer. If you have
more than one CAD document references associated with your graphics file, you can create a Viewer
view for these attributes with specific source and rendering configurations. Your user will then be able
to change areference from the Viewer and save this configuration.

Note: Only the users with Project / Folder level Change Properties permissions can change and save
attributes from the attributes widget.

Read also: Add Viewer Views on page 257.

Add Attributes Views

« Toaddacreation view:
a) Click Add Creation View in the Edit Category page.

The attributes in the category are copied from the default view to the creation view.
b) Use <<toremove any attributes you don't want to show in the creation view.

Note:
You cannot add attributes to the creation view if they are not already in the default view.

To add more attributes to the creation view, switch the Current View to Default, add the
attributes, then switch it back to Creation.

c) Useagrid layout if desired (see Use a Grid Layout on page 265 for more information).
« Toadd aheader view:

a) Click Add Header View in the Edit Category page.

The attributes in the category are not copied from the default view to the header view.
b) Use>>to add attributes to the header view.
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Note:
You cannot add attributes to the header view if they are not already in the default view.

To add more attributes to the header view, switch the Current View to Default, add the
attributes, then switch it back to Header.

Note: You cannot use a grid layout for the header view.

c) Click Save to save all your views.

Add Viewer Views

You can create dedicated views to allow your users to view the active document's attribute category in
the Viewer.

If you have configured your attribute category with such Views, your users can view this in the
Attributes widget.

For example, you can create attribute category based checklists for different roles / groups. When a
user from that role or group views the documents with that category, this attribute checklist will be
visible in the viewer. Read more about this use case in: https://wiki.esko.com/pages/viewpage.action?
pageld=170047115.

As an another example, you can use this to view your document references in the Viewer. If you have
more than one CAD document references associated with your graphics file, you can create a Viewer
view for these attributes with specific source and rendering configurations. Your user will then be able
to change areference from the Viewer and save this configuration.

Note: Only the users with Project / Folder level Change Properties permissions can change and save
attributes from the attributes widget.

To create a Viewer View:

« Click Add View in the Edit Category page.
You will get a pop-up to type in the view name.

« Type the name of the View. You can create a general Viewer view for all users or views dedicated to
a particular role / group.

You can create the following views:
+ Viewer forageneral Viewer view of the attributes.

+ Viewer [Role] withthe specificrole name as a suffix. This view will be visible in the
Attributes widget of the Viewer when a member of that role opens the document.

+ Viewer [Group] withthe specific group name as a suffix. This view will be visible when a
member of that group opens the document.

Note: Itisimportant that you name your views exactly as above

You will be switched to the newly created view. All your attributes from the default view will be
copied into the new one.
« Use<<toremove any attributes you don't want to show in the Viewer view.
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Note:

You cannot add attributes to these views if they are not already in the default view. If you need more
attributes in the Viewer view:

1. Select the Default view in the Current View drop down.
2. Add attributes.
3. Switch to the Viewer view in the Current View drop down.

The attributes added to Viewer, Viewer [Role] orViewer [Group] will bevisibleinthe
Viewer.

« Ifyour Viewer view is for document reference attributes, create specific source and rendering
configurations.

- Save.

If your Attribute Category View(s) and your User Role / Group is...  The Viewer will have...

are...

Only Default Any No widget

Viewer None Viewer View

Viewer, Viewer Designer None Viewer View

Viewer, Viewer Designer Designer Viewer Designer View

Viewer, Viewer Designer, Viewer Legal Viewer Legal View

Legal

Viewer, Viewer Designer, Viewer Designer and Legal Viewer Designer View / Viewer

Legal Legal View + selector to switch
between the Views

Viewer, Viewer Designer, Viewer Marketing Viewer View

Legal

Viewing Attributes

Edit the Terminology for Project Creation

It is possible to change the terminology used for project creation so that the Project Creation page
talks about "Designs" instead of "Documents”, or "Roles" instead of "Placeholder Groups", for example...

You can achieve this by customizing the terminology in the attribute category of the project or
template used as a basis for project creation.

You need to:
Click the attribute category to use on the Attribute Categories page.

Add a Creation or Header view to your attribute category and click Save.
Click Edit Terminology.

s oo

In the Edit Terminology pop-up; fill in the custom terms you want use instead of the default project
creation terms.

For example, fillin Designs in the Documents field if you want to show "Designs" instead of
"Documents" on the project creation page.
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Any field left blank will still use the default term.

Edit Terminology

Change terms in all Project Creation Forms where this Attribute Category is used

Default Term  Mew Term
Detalls | set project Details
Nama
Requestor
Project Manager  projact owner
Status
Cuslomer  pivision
Loeation
Description
Due Date
Bill Of Materials
Documents | attachments
Document Template
Members
Role
Invite Members
Attributes | enter Request Detalls

Section Sequence

Attention: Your custom terms will not be automatically translated, and will show as you
enter them for all languages in which you run WebCenter.

A

Optionally, you can specify Section Sequence if you want to alter the order of the sections. To
do that alter the sequence of the GABDM (General Details, Attributes, Bill Of Materials, Docs,
Members)in the way you want.

« The system does not accept wrong combinations such as other letters, too many letters or
repetitions.

« Iflessletters are given, the system will order these sections first and then put the othersin the
normal sequence.

« Section sequence is not applicable to project creation view since it displays the attribute
category

In the Task Specifications of a Task Type, it's also possible to edit terminology, though more limited;

itis not possible to change the section sequence. The edit terminology link is available in the
Default view and the task execution view

If you configure the Project Creation form to have less sections than GABDM, these are simply
taken out. For example, if you specify GABDM, but have configured the Project creation with no
Documents section, you will have the following in that order:
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+ General details
« Attributes

- Bill of Materials
+ Members

Project Creation Form View

You can fully customize your Project Creation form in WebCenter. This way you can have a uniform
customized look for the entire project creation form. You can combine attributes with project
properties in an Attribute Category with a Project Creation Form View.

When you add this special view, this category will load default Project Creation Properties just like
attributes in their default order( as in a default Project Form).

See the example screenshot to see the default Project Form.

Create Project
Create | start from a Blank Project

w Details

Customer | Please select or start typing
Loeation | Mo Location

Description

Due Date =] - @

Thumbnail ) Change

w Documents

w Members

Invite Members | Please select or start typing.

Create Project

The following Project Properties are available in this view and you can customize all of them. The
fields from all sections are included in this view but without section titles (Members, Bill of Materials,
Documents).

« Template selector on top of the Project Creation form
« ProjectName

« Requestor

« Project Manager

«  Thumbnail

« Customer

« Planning (backward or forward)

« LastTaskEnds (Date for Planning)
- Status

« Description

« Location
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Members

Bill of Materials

Documents

sttribute Category has changed since last
save

Other Properties ¥

Template Selection

Marme(*)
Requestor
Project Manager(
St
Customer
Location
Thumbnaif
Description(*)

Due Date(*)
Planning

Last Task Ends(*)
Members

Bill OF Materials
Dacuments(*)

Preview

Des

Own

What is it abo

Due D

AH»FroJ(_act
Rroperties,

=
< |

ign
ner
ut?

ate

Last Task Ends

Languages

Documel

nts

Theselector |,

Remove Grid Layout
e [-=] [+l @

2]

Insert:
+

[Name]

[Project Manager]

[Description]

RrojectiRroperties

[Due Date]

[Last Task Ends]

[Button Click]

Additional TaskDesc  Alltributes]

[pocuments]

LAREIRE INI 2

Details for selected cell

Property Documents

v

Label
Text Documents
[|caber:  Label
Image:
Position:| Left v
Span [a~
Comns: =~
- |‘.'-'l2:(5('ni?'ﬁnr'bl.1ﬂ v
Y Add Style €
e |Editable ¥
SR ladd rule @

EditiRrojects
Rropertyihere

WebCenter

In the attribute selector pane, you will see both the attributes and the project properties. You can use
the selector to toggle between Attributes and Project Properties.

When the Attribute Category (with Project Creation View)is assigned to the Template or the Project,
the new custom form fields will appear during project creation.

Use caution when customizing Project Property fields:

Notes

When you remove ProjectName from the Attribute Category View, make sure that you have

configured Autonaming in the Project Template.

Make sure that Project Details > Configuration > Project Creation page is in line with your Project

Creation view:
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Show Required
Fealure

Cdl Set |’ff.JPCT MEI‘IR!}IE‘I
+ Set Status
#  Set Customer s
o Set Description
i Set Due Date
o+ Upload Documents
4  Assign Roles
o+ Invite other Members
¥ Sel Altributes
o+ Select Thumbnail
¥ Set Planning (Tasks)
Default Planning Method | Backward v

Change Bill of Materials

« Therequired fields should be configured as Visible. Read more in: Project Creation Settings on
page 97

» Make sure that the Set Attributes is enabled. If this field is disabled, the Project Creation Form
will not load (when using Project Creation Form view).

» If some fields are disabled in this page, but added to the Project Creation Form view, they are not
available during project creation.

« Planning fields are available only when the Project / Template has tasks. Also if the label of the field
LastTaskEnds is not custom, the value will change to “First Task Starts” when planning is set to
Forward.

« The Requestor field is available when there is a REQUESTOR role.

Add Project Creation Form View

Create the Attribute Category that you want to assign to the Project or Template from which your users
will create Projects.

To modify the Project Creation Form, you have to Add Project Creation View to this Attribute Category.
To add a Project Creation Form view:
« Click Add Project Creation View in the Edit Category page.

The existing attributes (if any) and all default Project Properties are added to this view.
« Use <<toremove any Project Properties or Attributes you don't want to show in the Project
Creation Form. Read the notes in: Project Creation Form View on page 260 before you do this step.

You can also drag these Project properties and place them between the Attributes in the Attribute
Category. When you remove properties, they don't appear in the Project Creation Form.
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Mame
DEKE_DSR_Form

Attributes r

J=l

DEKE.Contact.DocRef(*)

DSR_Customen*)
DSR_Description*)

Current Wiew: | Project Creation ¥

Alternating background

WebCenter

Delete View Add Creation View  Add Header View AddView € Edit Terminology @9

Show also Attribute types and Restricted Set types

#|Keep session alive (avoid that people get logged off due to time out)

Use Alternative Rendering (Gives more control over column width)

Grid Layout

" +F | ~=

= +[|| +3

[Project Manager]

=0 | nsert:|mme| = || — | =8|
I I SR_D
[Location] [Thumbnail] ga't— bue

DSR_Dec(") DSR_Sales Rep DSR_Service Rep DSR_Location
DSR_Due Datel*) -
DSR_Location]*) DSR_MNotes
DSR_Motes |Space]
3 DSR.D0C L)
DSR_Service Rep(*) T b8R_Customer | DERL "
DSR_Task Due Date - | | [spacer] | DSR_Customer | DSR_Descript r:'|| ® | batails for selected cell
DSR_Task Qty << | | DEKE_Contact DocRef 4 | o cellis selected or the selected cell is empty]
DSR_Task Type —
[Button Fill in seme Customer »
datal d
m Save As Copy Cancel
Note:

You cannot add attributes to this creation view if they are not already in the default view.

To add more attributes to the creation view, switch to the Default view, add the attributes and
switch back to Project Creation Form View.

Use a grid layout if desired (see Use a Grid Layout on page 265 for more information). Grid layout
gives you the possibility to customize your Project Properties with advanced features.

Keep the following in mind when customizing Properties:

« You can show and hide fields or sections based on attribute values

+ You cannot specify them as Read-Only or Required
« Youcan customize the label or image including their position (left or top).

» You can add Style to these Properties

« You can define the Column Span for them.

Save.

When Project Creation Form View is defined in a Project's or Template's Attribute Category, the custom
view is loaded when a user creates a Project (based on that Project or Template). When this view is
loaded, the whole page will look like one continuous form. See the result of the example configuration:
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@) nvashboard Textlibraryw  ArtworkLibrary~  Template Library v More

Create Project

General Information

Project | v|  Location v Thumbnail o o Due Date
anager -

Document(s)

+ Upload Box 4+ Add Box from Library

Contact Information

+ select Contact  + Add New Contact to Library

WebCenter by Esko - Version 16.0+ Bulld 16

16.3.5. Configuring Preview for Attribute Category

Preview the Attributes in the document
You can view the preview of any documents in the Preview tab of the document, which is enabled by
default to all users.

When you navigate to the Preview tab of the document, a dashboard is loaded with two blocks
displayed side by side, namely

1. Attributes block on the left side and
2. Preview block on the right side

Configure Preview Block

To configure the preview block to render, following attributes have to be created and configured:

Create Attributes For

PREVIEW_TYPE This text type attribute is to specify which type of preview user wants
to see. It can hold value from a restricted set, which contains values
CHILIPreview and StaticPreview.

PREVIEW_DOCUMENT | This document reference type of the attribute can hold a single HTML or
Chili document to create preview.

LOCALE_# Attributes to specify the locale index to prepare locale mapping for
the languages. Create as many Locale attributes as per the number of
languages you require.

In the Preview > Attributes , choose either of the following:

« CHILI Preview: This preview is applicable for Chili documents. When you enable this option, Chili
viewer loads in the Preview block.
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Note: You can view the Attributes and the Chili document in the preview mode, only if the option is
enabled in the Chili set up. Read about Chili Setup here. Admin user has to add the menu option for
the required user groups.

. Static Preview: When this type is selected then the Preview block loads a HTML file and the values
can be simultaneously updated.

Update Preview Block with Attribute values change

When any update is made to the attributes, the matching text/image placeholders in the preview block
are updatedin real time.

You can update the values for the Chili document along with the attributes and save either as new
version of the document or retain it as a draft.

16.3.6. Delete an Attribute Category

WebCenter checks if an Attribute Category is being used before deleting it. If it is in use, you will be
prompted to either clear the category from the projects or documents using it and delete the category,
or to cancel the deletion.

1. Click Admin > Attributes > Attribute Categories.
2. Select the attribute category to delete and click Delete Category in the actions menu.

If the attribute category is not being used, it is deleted immediately.

16.3.7. Use a Grid Layout

Adding a grid layout to your attribute category allows you to customize the way your attributes will be
shown to users.

It also provides more advanced features, like making an attribute required (users have to fill it in) or
read only.

1. Click Use Grid Layout in the Edit Category page.

This shows extra options and buttons on top of your attributes column, and a Details table at right,
containing information and extra options for the selected attribute.
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Select Alternating background if you want your rows to have an alternating background color.

Select Show also Attribute types and Restricted Set Types if you want the types of the attributes /
attributes restricted sets to be displayed after each attribute (like Business Unit inthe example

above).

When checked, pages having this attribute category or task specification layout will not keep the
session alive. This allows you to fill out long forms without having to log in repeatedly.

Optionally enable Keep Session Alive when user is inactive to avoid getting timed out when there

are signs of inactivity.

As long as the user is working on the form, the session will be kept alive. However, if the browser
detects that the userin inactive, it stops keeping the session alive. When this flag is turned on, the
session will be kept alive even if the user is inactive.

Add or remove columns and rows as desired:

Click == to add arow at the bottom of the table.

Select arow and click ™

Selectarowand click '

" to remove it.

Click * I toadda column at the right of the table.

Select a column and click |~ 0 to remove it.

" to insert another row before it.

Select a column and click " O to insert another column before it.

Note:

If you want an attribute to be displayed across several columns, select it and enter the desired

number of columns in Span Columns in the Details table.




ESKO®

Edit C. y

Name

ge Infor

[Package Taformation

Attributes:

Current View: |Defaut =

) Azernating Background

# Show aiso attribute types and restricted set types

Remov
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A][-=] [+50] [+@] [0

Insert: |™

3| [— | [mm

132456
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& In build 19
atandspec
attribute_text

Brand

Brune's Attribute 1
Brune's Attribute 2
Comments
ComponentiD
Country(=)
DateTimeRs

dekel

deke2

deke3

DLMS_Codel

[save |

Preview

IP\denctname

Country

Length in inches or mm

Number of Spot Colors

Detals for selected call:

Attribute

Product name

Label:

& | [Awribute Type: [TEXT

[Froduct name

Row Size

Soan c:xu.—rns:n_[g i

Soyle

[webcenter Antrlbute =]
Add Style

visibilicy:

|Prcduc: name |

Country ---Please Select--—- =

Countries Length In inches or mm

MNurmber of Spoet Colors

WebCenter

7. You have the option to have a cell to span over multiple rows. You can increase or decrease the row
in the Row Span. You can increase or decrease the row span for cells to have better layout.
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Attribute Category has changed since |agt Save

m Save As Copy Cancel

Preview

Product

Preduct Description

8. Format your grid as desired:

° TIm

To add a Title row, click then fill in the Title, choose the number of Columns to span and the
title Style in the pop-up that opens.

To add a Spacer bar, click ~  then fill in the bar's Height and Color in the pop-up that opens.

Note:

« You can use color names or hexadecimal codes.
« If you don't enter a Height, the bar will have a default height.

« Ifyou don't enter a Color, the bar will be white.

To add a Ruler, click then choose the number of Columns to span and fill in the Height and
Color in the pop-up that opens.

268



ESKO

10.

n

12.
13.

14.

WebCenter

To add a Header Bar, click " .

The example below has a Header Bar on top (showing Name, Value and Type), then a Title
(Packaging information), ablue Spacer bar, and a black Ruler after two attributes.

Preview

Nama Valug Type

Packaging Information

Product name

Country ---Please Select--- = | Countries

Length In Inches ar mm [

Number of Spat Colors |

Note: You can edit the formatting(color, height...)in the Details table at right when you select th
cell.

e

You can change how an attribute will appear to the user by giving it a Label (in the Details table).

For example, you could use a label to show Manufactured in: instead of Country. Thisis
particularly useful if the users are not familiar with your attributes, or if you are using generic
attributes for different purposes.

If you set the labels on top for at least an entire column, you will have a nice form layout.

Select the Position of the Label as either Left or Top.

By default, the Label will be placed on the left side in the grid. But you can place it on top of the
value to modify the form appearance.

A single cell will contain both the Label and the Value. Within this cell, you can manage alignment
via the style options.

Component Type

If you are using Date time Attribute, then you have an option to hide the time and display only the
date by checking the box Hide Time.

You can also format individual attribute cells using Styles (see Define Styles on page 270).

If you are using Date time Attribute, then you have an option to hide the time and display only the
date by checking the box Hide Time.

If desired, change the visibility of individual attributes: select a cell and choose the Visibility
parameter to use:

- Choose Editable if you want the users (with the right permissions) to be able to edit this
attribute.

« Choose Required if you want to make it mandatory for users (with the right permissions)to fill
this attribute.

in
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If auser doesn't fill in a Required attribute during project creation for example, he / she will not
be able to save the project.

« Choose Read Only if you don't want any user to be able to edit this attribute.

« Choose Hidden if you don't want to show this attribute to users. The values will be deleted in this
case.

« Choose Hidden (Keep Values) if you don't want to show this attribute to users but keep the
value.

Note: You can also use visibility Rules to determine when an attribute will be hidden / required /
read only... See Set Visibility on page 271.

15. Click Save when you are done.

Define Styles
Define styles to further customize your attributes layout.
1. Select the cell of the attribute to customize.

This show the Details table at right.
2. Click Add Style to define a custom style.

Note: You can also use one of the predefined styles (WebCenter Attribute or WebCenter Title) if
you want your attributes to have the default WebCenter look.

3. Define your style: enter a Style Name, a Background Color (use the color name or the hexadecimal
code), choose a Font Family, Font Style, Font Weight, Font Size, Font Color.

.| Edit Style x

Background Color: |:|

Alignment: Left r
Font Family: [verdana v
Font Style: MNormal ¥

Font Weight:

Font Size: l:lpt

Font Color: l:l

wickh, —
Height: I:lpx
Column Width: l:l

Label and value have different styling

=0
You can fix the Column width of the first column to keep the titles aligned.

Set the Column width lower than what you want as there is some margin for the columns. The total
table takes the full width of the allowed/available space (depending on the browser). Therefore
fixing the width of one column has an effect on the other columns.
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Tip: Do not fix the width of all columns as it will lead to unpredictable results.

Click OK to update the style for the attribute..
You can see your style applied to the attribute cell in the Preview.
To apply it to another attribute cell, select the cell then select the style in the Details table.
You can edit or delete the style using the links in the Details table.
Set Style based on Rules
You can define styles for Attributes based on the rules set up.

This allows flexibility to display different styles based on the parameters defined in the rule. Rules can
be set up with JavaScript or an Attribute value for both Styles and Visibility Rules. Style rules can be
set up in the same way as visibility rules, except for the then and else section, where styles should be
selected instead of visibility.

For example,

if (return att["Attributel"] + att["current"] + att["Attribute3"] < 100) then the cell
is green, else, the cell is red.

Note: You can create arule based on the value of the Current Attribute. In a style rule, Current
Attribute is used to actually execute.

Note: Once you have defined a style in the Default view, you can use it in the Creation view, and vice-
versa.

Set Visibility
If you want an attribute to be hidden or required or read only, depending on a condition, you should

define a visibility rule for this attribute.

A rule makes the visibility of an attribute depend on one or more other attributes or a JavaScript
snippet.

1. Select the cell of the attribute for which you need a visibility rule.

This show the Details table at right.
2. Click Add Rule to define a new visibility rule.

3. Inthe Edit Rule pop-up that opens, give your rule a name (choose a name that indicates what the
rule does).

Edit Rule

Rule Name: |

If Tne value of attrioute| -—-Select Attribute-— = || = - A

The cell is : Editable -
Else, the cell is| Editable -

) el
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4. Define yourrule.

For example, you want the attribute Number of samples to only be visible (and filled in)if the
Sample Needed attributeissetto Yes.

a) You need to first define the condition: If The value of attribute Samples Needed=Yes.
b) Then define what happens when this condition is fulfilled: The cellis: Required.
c) Then define what happens when it is not fulfilled: Else, the cell is Hidden.

Areainsqftorsgm Length in in

Edit Rule x
Brand Country

Rule Name: |1‘ samples needed
due date Comments
Samples Needed If The value of attribute| samples Needed ~|[= = ][ves And

Number of samples

The cell is : Required =
Else, the cell is| Hidden pl

5. You can edit the Visibility rules and Styles rules based on Java Script rules. Instead of choosing an
attribute value, you can add a JavaScript code snippet to create a rule for visibility or styles. This
allows more flexibility and can have customized rules apart from the attribute values. Read more on
how to set Edit Styles / Visibility based on Java Script rules You can also add chain rules for styles,
where the conditions can be linked based on rules. Read more about Chained rules.

6. Click OK when you are done defining your rule.

The Preview is updated to reflect the result of your rule.

Note:

The Preview is interactive: in the example above, you can choose Yes for the Samples Needed
attributes in the Preview, and see the Number of samples attribute displayed.

You can choose No (or nothing at all) and have that attribute hidden.

To apply the rule to another attribute cell, select the cell then select the rule in the Details table.

You can edit or delete the rule using the links in the Details table.

Note: Once you have defined a rule in the Default view, you can use it in the Creation view, and vice-
versa.
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Note:
You can create more complex rules by clicking the And link to add more conditions.

Choose AND if both conditions should be fulfilled, or OR if at least one of them should.

Edit Rula x

Rule Name: If samples needed

If The value of att’u:nute|<_.;,5mp|g:, Neaded j| = jl‘r'ES and E3
The value of att'n:uute|(_.;rapq,cg j| = jl‘r‘es and ES
Required =~

Else, the cell is| Hidden -

You can define very complex rules if necessary.

In the example below, a warning message is made visible (but read only) when somebody requests more
than 10000 samples or asks for more than 4 spot colors.

The warning message itself can be a title or an attribute (that you can use in several attribute
categories).

Edit Rula 3
Rule Mame: |DI'SD|E',' Wwarning
If The value of attrlt:ute| Samples Needed j| = jl‘-{es And B3
AND = |The value of attnt:ute| Number of samples j| - j|1g|}gg And [EX

01

If The value of attnt:ute| Graohics J| = Jl""ﬁs

AND +|The value of attribute| Number of Spot Colors || > s

The cell is : Read Only -
Else, the cell is Hidden -

T
l':;

£l E

Note: You can add styles to based on the result of your rules set. Read for detailed explanationRules for
Style and Visibility

Style Rule based on Attribute Value

For example, If <Attribute Value (choose from the drop down) = X > then the style =(Style Name A, else
Style Name B) where Style Name A and Style Name B are predefined
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Change Cell Details for Multiple Cells

In the grid layout, when you click on a non-empty cell, details are shown to the right of the grid. You
can change the details of multiple attributes by choosing the cells using CTRL /CMD and SHIFT keys or
selecting individual attributes holding the CTRL key.

When multiple attributes are selected, only the details that are relevant for the selected cells are
shown.

When the values of all the selected attributes are the same for an option, it is displayed in the details. A
blank value is shown if the selected cells have different values. When selecting a value, and it is applied
to all the selected cells.

16.3.8. Enhancing Attributes with Advanced Features from Grid Layout

274

You can enhance the attributes from the Grid layout view. You can restrict values to available
cascading attributes, create multi-value attributes, add label images and add HTML help to the
attributes.

« Click Use Grid Layout in the Edit Category page.

» You canadd LookUp Attributes on page 275 button next to your Attributes in your form.

« Click onany of the attributes. Its details will appear on the right side.

Insert:

@

« Labellmage: You can add a representative image as a label image. Read more in Create Image Label
for an Attribute on page 281.

« Restrict Values: You can restrict values to list containing Cascading Dropdowns as columns and
select their rendering.
You can also create check boxes, radio buttons and image selectors for text type list attributes.

« Allow Multiple Values: You can allow more than one value to an attribute. Read more in Create a
Multi-Value Attribute on page 283.

- InfoPage: You can provide additional information in an HTML page. Read more in Create HTML
Information for an Attribute on page 284.
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You can use LookUpattributes button to fill multiple attribute fields based on one or more input

WebCenter

attributes without a cascading dropdown. You can configure the list in the details of this button. You do
not have to restrict individual attribute values to a list when using this button.

You can create a better user experience with this feature if a lot of properties must be loaded for

something already well-known / unique. The typical example is loading product details or component
details when you enter the product code. In this case, when you type the code and click the button, you
will get all its details filled.

When you have partial / non-unique information, use Cascading Dropdowns.

1. Create and add attributes to an Attribute Category.

2. Select your attribute in the Grid Layout.

3.

=
Click on the LookUpAttributes ' == | button to add it next to the selected attribute.

You will see the Button details in the Details of selected cell table.

Button:
Remove

Label Click
Style buttonprimary v
Execute [ 0n Load

On Save

#| On Change of Attribute (X)| NAPR_ATT4
Add Attribute

Function| LookUpAttributes v

List ALL_LANGUAGES_1 v

I

A

d Input Attribute

A

Add Qutput Attribute

4. Modify the button's details.

« You can specify the Label text you want to display next to your button.
« Pick a Style for the button to change its look.

Note: If you choose Hidden, you can Execute the button :

On Change of Attribute where you need to specify the attribute

« Selectalist.
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Note: You can use the lists created on the WebCenter database. Cascading dropdowns placed on
Web Server are not supported.

Set Function to LookUpAttributes.

Add one or more Input Attributes. Select the attribute from a list of attributes in your category
and match it to the right list Column. Click on Add Input Attribute to add more.

Enable Exact to only allow exact matches. For example, if the input attribute is country name
and if you type Belg, you can get Belgium if the Exact is off. If this is on, you will find country
details only if you type Belgium entirely.

Add all the Output Attributes. Select the attribute from a list of attributes in your category and
match it to the right list Column. Click on Add Output Attribute to add more. This will correct
your (typed) input attributes to the official value. If you type Belg and click the button, the entry
value will be Belgium. This will also add the other details associated with this attribute.

5. You can now test the button and save.

Check Unique Values

This feature allows you to create a unique name for a component. It helps to create names which are
different from existing names.

However, this is not useful if you are creating pure numbers (where you expect auto-numbering). Use
auto-numbering in such cases.

Note:

This function does not guarantee that the values are unique throughout the system.

1.

Create and add attributes to an Attribute Category.

2. Select your attribute cell in the Grid Layout.

Note: This function does not work for date attributes or rich text attributes. You will be warned if
you use any of these types.

3.
&=
Click on the Add button! ™~ |icon to add it next to the selected attribute.
You will see the Button details in the Details of selected cell table.
Button: Label Check if Unique
Remove
Style buttonprimary v
Execute [ 0On Load
On Save

On Change of Attribute

Function | CheckUniqueValue ¥

Info HTML page (name+extension)

Info Page: <WeblnstanceRoot=/custom/AttributesHelp/
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4. Modify the button's details.

« You can specify the Label text you want to display next to your attribute.
« Pick a Style for the button to change its look.
« Set Function to CheckUniqueValue.

5. Now save.

Note: This function is difficult to test via the preview because the checks are done based on the
current project, document or task. In the preview, you have no document, project or task.

In a project attribute category, it checks whether the filled out value already exists for another project
in the system. If yes, you will be warned that it is not unique. The function will force you to choose
another value before you can save the attributes or create the project (during project creation).

In a document attribute category, it checks whether the filled out value already exists for another
document in the system.

Note: This function does not check the versions of the current document. So multiple versions of the
same document may share the same attribute value.

In a task type, it checks whether the filled out value already exists for another task of any task type.

Note:

This verification happens when you click the button or when you save the checked attribute. This
check will not happen if you change the attribute in any of following ways:

« viaasystem integration(WebCenter SDK)

« via Automation Engine

« when changing a group of attribute values via the project saved search operations
« when setting the attribute via a workflow

« when setting the attribute via ArtiosCAD

The check button must be in the visible view. This way you can have a check which only happens during
creation or in a task type view.

Note: A unique value for a task does not guarantee that this value does not exist for a project. So this
function is not of use while using automatically set project attribute values from task specifications.

Create JavaScript Button

A JavaScript button allows you to create a powerful additional functionality within a WebCenter form.

ﬁ Warning: This is an advanced feature and we recommend that only Esko solution architects
and advanced administrators use this.

Use this to:

« execute a calculation within the form
« copy information from a project to a document created in the project
» automatically fill out values for attributes (which are specified as read-only)
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Note:

The JavaScript operation is done within the form. However, this may not be automatic in all cases. For
example, when you copy project attribute values to documents, the JavaScript execution happens
once. When the project attribute is changed, the document attribute will not be synchronized until the
button is clicked again. This avoids issues related to full synchronization.

Read JavaScript examples in the Esko Knowledge Base Article.

Button: Label Brand
Remove

Style buttonprimary v

Execute On Load

On Save
#| On Change of Attribute (X)| Brand v
Add Attribute
Function | JavaScript ¥

if ( att[BrandValue]!="XYZ")
att[Marketing] = "No";
JavaScript
Code

In the screen shot, you can see a simple script in the JavaScript Code field.

docref[“Document Reference Attribute Name”] could be used to access the attributes of a referenced
Document.

- Do not return a value but set the value of att['MyAttribute’]

« Allattribute names must be surrounded by single quotes

« All attribute names are case sensitive

« Use the attribute name. This can be different from the attribute label visible in the form
« The property att is case sensitive.

« Technical info: att is an associative JavaScript array containing a copy of the current values for all
placed attributes. At the end of the execution, (only) the changed values are copied back into the
form.

Note:

« Use this only if you know JavaScript and its use. Consult your Esko Solution Architect in case you
need JavaScript operations.

« The functionis protected against misuse by only allowing to change attributes contained in the
current attribute category. This also shows message boxes. The function cannot change any other
data in WebCenter (for example it cannot execute web calls).
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Advanced JS Button features
JavaScript Buttons can be programmed to access attributes of the referenced Document.

. docref["Document Reference Attribute Name"] could be used to access the attributes of the
Attribute Category of areferenced Document.

This operator returns a JavaScript object with following properties:

count

Number of documents referenced by the selected Document Reference

docbyname (“Name of the Document”) or docbypos (Position of the
document)

Returns a JavaScript object representing the Attribute Category of the selected Document.

Properties of the Attribute Category object of the selected Document:

Property Description

att[“attribute name”] Get the value of the specified attribute.
setatt("attribute name”, “value”) Set the value of the specified attribute
propl‘reference property name”] Get the value of the referenced property
setpro;)(”reference property name”, Set the value of the referenced property
“value”

For example, the sample scripts below, shows how to push an attribute value to an attribute in the
attribute category of all the referenced documents.

Button:

Labe Click
Remove
Style buttonprimary ¥
Execute ¥ On Load
#| 0n Save
0On Change of Attribute
Function JavaScript T

var boxes = docref["docRef";
var price = att["Price™;
i for(var i=0; i < boxes.count;i++)
JavaScript Code { var box = boxes.docbypos(i+1);
box. setatt("Price” price); hd

} y,

All the documents being referenced, are gathered using docref{ "docRef"] and stored in the boxes
variable.

The for loop iterates over all these documents and for every document it updates the "Price" attribute in
the attribute category.
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« Another operator that was introduced for this functionality is “parent”. It allows you to work with the
parent Attribute Category (Category from where current Document is being referenced).

It returns a similar JavaScript object as "docref" with the following properties:

Property Description

att[“attribute name”] Get the value of the specified attribute.
setatt("attribute name”, "value”) Set the value of the specified attribute
docref[“Document Reference Attribute allows to go to the Attribute Category of a referenced
Name” Document

parent allows to go to the parent Attribute Category (Category

from where current Document is being referenced

For example, the sample script below shows how to push an attribute value to a parent attribute

category.
Butten: Labe Click
Remove
Style buttonprimary ¥
Execute #| On Load
#|0n Save

On Change of Attribute
Function JavaScript ¥

var newVal ="My new value”;
parent.setatt("text" newVal);

JavaScript Code

Using both operators in combination makes it possible to iterate over the whole tree of Attribute
Categories of referenced Documents.

Note:

1. Itis not possible to change the value of Document reference attributes

2. Itisnot possible to access/ change attributes that are not loaded on the page at the time the
JavaScript Button is executed.

3. The expected result of the JavaScript logic should not be dependent on the order in which the
JavaScript Buttons are executed.

You can access some basic information about the Referenced Document as follows

Property Retuns the referenced document'’s
docRef.docposition Document position
docRef.docname Document name

docRef.docid Document id
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Property Retuns the referenced document'’s
docRef.docdescription Description of the document
docRef.docversion Number/index of the document version, not its ID (1st version -> 1, 2nd
version->2, ...)
docRef.projectid ID of the project, where the referenced document resides. (Helpful to
find if the referenced document is linked to more projects)
docRef.projectname Name of the project with docRef.projectid ID. Note this information
might not be available in some cases and can return an empty String.

You cannot change the properties of a referenced document by assigning it a new value within
JavaScript button script. They are read-only values.

Create Image Label for an Attribute

You can create Project request forms or Order forms with graphical labels by setting image labels

for specific Attributes in an Attribute Category. You can use this feature to make the form visually
attractive and user friendly. In addition, you can add graphical (packaging) symbols and warnings to aid
the user while filling in the forms.

1. Add the label images to the following folder on the WebServer: WebCenter\WebServer\tomcat
\webapps\WebCenter Inst\custom\AttributeLabelImages.

Create a new folder customiif it does not exist yet and create a folder named
AttributeLabellmages under this folder.

Note:

« Forthe best user experience, use .jpg images. It does recognize .qgif,.jpeg and .png.

2. Open your Attribute Category and select the Attribute for which you want to give an image label.

3. Inthe cell details, enter the correct image name including the extension in the Label Image field
and save your attribute category.
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Remove Grid Layout
L A== A N =2 R £ = Insert; |vms| | -I-| — || 2| [+
NAPR_TASK_ATT1 NAPR_TEXTATT_2 . Attribute NAPR_TASK_ATT1
vira_res_B155 MAKE PROJECT THUMBNAIL Attribute Type: Text
napr_yes_no napr_richl Label Text NAPR_TASK_ATT1
napr_docref_latest_version MAPR_TEXTATT_3 [Button Click] Label: Label Image: Dangerjpg
NAPR_ATT4 Text Position: Left ¥
NAPR_ATTG Custom Unit Label
Span Columns: 1
A  SpanRows: 1
v Stle: WebCenter Attribute *
e Add Style €3
4
Style Rule: No RU[Q '
» Add Style Rule
il Editable M
Visibility Add Rule €3
Restricted Set: NAPR_RES1
Restrict Values: € Rendering: Dropdown MK i
Allow Multiple Values:
Info HTML page (name-+extension)
Info Page: <WeblnstanceRoot=/custom/ AttributesHelp/
Note: The image name is case sensitive.
You can see image labels appearing instead of attribute names in the forms.
Regulatory Input / Briefing
Packaging Symbols
O O O
Packaging Code Barcode type Barcode Approved for Use?
l:l ---Flease Select--- (=] l:l ---Pleaze Select--- [ ]

Required Legal Disclaimers / Warnings

Show Rich Text Controls

Tip: In case you wish to display a check box for the attribute, make sure you use an attribute with a
restricted set containing only the values Yes and No.

Note: You can either have a text label or an image label, but not both.
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Create a Multi-Value Attribute

There are situations when you are creating a new Project or filling in a Form, more than one value
needs to be added as an attribute. For example, if you are producing a packaging that is intended for
more than one market, you need to specify those markets as values in the respective attribute field.
You can use a multi-value attribute for this purpose.

« Open your Attribute Category and select the Attribute for which you want to give more than one
values.
+ Inthe Details for the selected cell table (in the Grid layout ), enable Allow Multiple values.

wove Grid Layout

L #EE || == + ] || +H] | Ingert: || -3 | — | BB (&
PR_TASK_ATT NMAPR_TEXTATT_Z - Attribute NAPR_TASK_ATT1
_res_8155 MAKE PROJECT THUMBNAIL Attribute Type: Text
_yes_no napr_rich1 Label Text: HAPR_TASK_ATT1
r_docraf_latest_version MAPR_TEXTATT_3 [Button Click] Labal: Label Image: Danger.jpg
PR_ATTA Text Position: Left v
“R ATTG Customn Unit Label
Span Columns: 1
r Span Rows: .1
- WebCenter Attribute ¥
Style: -
Add Style 'ﬂ
«
Style Rule: .NID_ F{ule ’
> Add Style Rule
il Editable v
YWisi itwr
Visibility: Add Rule ﬂ
. Val Restricted Set: MAPR_RES
estrict Values:
Rendering: Dropdown I i

Allow Multiple ‘u’alues

Info HTML page (name+extension)
Info Page: <WeblnstanceRoot>/custom/AttributesHelp/

In your Project (as a form), you will have the particular attribute with an option to select more than one
(or all)values inits response field. See an example below.
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Marketing Input

Note:

Simple text attributes were limited to 255 characters until WebCenter 14. There is no character
limitation from WebCenter 14 onwards. This allows for unlimited attribute values for a single multi-
value attribute.

Create HTML Information for an Attribute

When you design Project request forms or new Order forms, you might want to provide additional
information to the user who is filling in the information.

From WebCenter 12 onwards you can provide additional information as HTML help or information. This
is especially useful when technical fields need to be supported with extended HTML help.

There will be an information "+ icon that is added next to the attribute name or attribute image label.
When the user clicks on this icon, a pop-up HTML page with the information will appear.

1. Create an HTML file with the additional information you want to provide along with the attribute.
You can create textual information as well as images to explain the attribute.

2. Place this HTML file in the AttributeHelp folder (WebCenter\WebServer\tomcat\webapps
\WebCenter Inst\custom\AttributesHelp).

3. Open the Attribute category and select the attribute for which you want to provide HTML help or
information.

4. Inthe cell details, enter the correct file name (of the HTML file) in the Info Page field and save your
Attribute Category.
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Detailz for zelected cell:

Attribute w2p-Finishing
Attribute Type: Tewxt
Label: |Fir|i5hir|g |

Label Image: | |

Span Columns: [1]~]

Style: | WebCenter Attribute EI
Add Stvle
Visibility: [wisibilityRule [+ ]

Add Rule Edit Rule Delete Rule
Allow Multiple values:| []

Info HTML page (name+extension)
Info Page: =WeblnstanceRoot=/custom/AttributesHelp/

|5heet-and-roll.html |

If you have an HTML information page linked to an attribute, you can see an information icon next to

the attribute in the form that you created. When you click on the information 6 you can see a pop-up
window with the information to help the User.

Y oOrder Information

Is this an Order? Approval Required Before Print?
¥

Label Shape ——Please Select— | ¥ | Quantity | |

Varnish [---Please Select--- =] Specialties  [_please Select—- (7]

Finishing® ¥ ---Please Select--- [ v |

Add More Information?

[No E2

Create Project
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@ 1031.140.85/WebCenter_Inst/custom/AttributesHel...| = | (=) [I@S

[ 10.31.140.85/WebCenter_Inst/custom/Attribu tesHelp/sheet-and-roll.html

The picture below show the examples of labels printed on sheet and
roll.

eolele
el
| 2D

e

Check box, Radio button and Image selector in your Attribute Category

You can decide the rendering of choices for a restricted set (text) and for list attributes (text). The
default rendering is a drop down with the options. You can show the optionsas:

« simple radio buttons or check boxes
« radio buttons or check boxes with images

This allows your users to see the options more clearly than in the case of a drop down.

Create Radio buttons and Check boxes

When you have a few options as the value for an attribute, you can present the options via radio
buttons or check boxes instead of a drop down.

Note: Avoid doing this when you have a lot of options to select from. The form will load slow.

1. Create and add attributes to an Attribute Category.

2. Select your attribute in the Grid Layout.
An item Restrict Values will be visible in the Details section.

3. Select the Rendering as Radio / Checkboxes.
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Details for selected cell:

Attribute 00 Business Unit
Attribute Type: Text

Label Text: |Bu5ine55 Unit

Label: Label |
Image:

Position: Top

Span Columns: TE

WebCenter Attribute |Z|

Style:

Visibility: lﬁ =
A ule
| List |ZH BO Brands lz‘ Copy List

Column: Segment : Reorder Columns
Rendering: Radio/Checkboxes :

Restrict Values:

Columns: 6
Alignment: | Distribute over Width |Z|
Labels: Below :
|
Info HTML page (name+extension)
Info Page: =WeblnstanceRoot=/custom/AttributesHelp/

In the Attribute Category Preview, you will see a set of checkboxes or radio buttons depending on
the items in the restricted set or valid items in the list column.

You will get Radio buttons for a single-value attribute.

Product Details

Business Unit Deselect

Air Autc  Beauty Health Home

You will have check boxes for a multi-value attribute. Select the Allow Multiple Values option for

this.
Product Details
Business Unit Select All Deselect All Show All (remove cascading filter)
O O O O O
Air Auto Beauty Health Home
Note:

This is optimized for non-cascading type of restricted sets. You may also use them for cascading
dropdowns with limited values. Avoid using it when more than two attributes cascade.

Do not use this option for lists with thousands of rows.

4. Select the Column numbers, Alignment and the Label position.

You get the best user experience when the number of columns equals the number of allowed values
or one of its dividers. If you restrict it to one column, you will get a vertical array.
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By default the columns will be aligned as per the Distribute over Width option. You can choose to

Product Details

Business Unit Select All

De=zelect All

] Air

] Auto
[[] Beauty
[ Health

[] Home

align to the left or right depending on the appearance you prefer.

Create Image Selectors

You can use images just like Radio/Check boxes.

1. Create and add attributes to an Attribute Category.

2. Select your attribute in the Grid Layout.

An item Restrict Values will be visible in the Details section.

Restrict Values:

Restricted Set: FC_Sizes

Rendering: | Images El
Columns: ’6—

Alignment: | Distribute over Width El
Labels: IWEI

Height of Images: ’T pix

Height of Cell: ’— pix

Image Type: ipg

3. Select the Rendering as Images.

« Theimages must be placed on webinstance\custom\AttributeValueImages. You can

use the same images used in the Asset Browser as selectors.

Note: The image names are case sensitive.

Tip: You can create Push Through Configurations to access the AttributeValuelmages,
AttributeLabellmages and AttributesHelp on the Web Server. This way your users do not have to

access the web server to customize the attributes.

« Height of Images:

You can resize the images by adjusting the height. By default, resizing is always done
proportionally and to 100 pixels. You can get high quality images when you create images with

the sizing specified here.

« Height of Cell:

288
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The grid of images can take a lot of screen space. If you want to limit the space use and use
a scroll bar, limit the height of the cell. In this setting, the cell will have a fixed height and a
scrollbar when the needed size to show all images extends to given height.

Image Type:

You can choose the Image Type as automatic to display any of the image types. However, we
recommend that you select an Image Type in this field.

Region Select All Deselect All Show All

4OROIOION

MiddleEast Europe Africa Pacific Latin-America North-America Asia

Troubleshooting

When you do not see any images at all : Verify the path where the images are located. If you have
multiple web server instances, you must have the images on each instance (or at least on the
instance where you try).

Note: Do not put your images for image selectorsinthe AttributeLabelImages folder.

Check the extension of the images.

Note: The name and the extension are case sensitive.

When some images are missing:

Verify if there are any special characters. Avoid all the special characters (comma, %, ...etc) except
space.

Check leading and trailing spaces and number of spaces in the names.

16.3.9. Restrict Attribute Values to Previously Selected Values

To setup a practical way to make a final selection from a previously made/calculated list of candidates,
a new function has been introduced.

It applies to attribute categories or task specifications with a grid-layout having a first multi-value
attribute (attribute A)and a second simple text, non-restricted set attribute (attribute B).

The result is Attribute B is restricted to the selected values of attribute A

This can be set up only by administrators and used by all users who can edit attributes.

Usage:

Select Attribute B in the grid layout. In the cell details, set the Restrict Values selector on Attribute.
This will display a dropdown with candidates for attribute B (this list is all plain-text multi-value
attributes).
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Restrict Values: |Attr‘i|:+ute ¥ || -- Pleaze Select - | ¥
Allow Multiple Values:| |+
P Board
Country

Select one of the candidates. This results in a behavior as shown in the below example: Final Country
(which is attribute B)is restricted to the selected values for Possible Country.

Poszible Country  |Denmark il Final Country ---Please Select---
France
Germany Denmark
Ireland France
Eermany
Ireland

Details/Limitations:

290

This function only works in grid layout

Attribute A and B must both be plain text attributes. Attribute A can be a restricted set or a plain
text attribute (typically linked to a cascading dropdown).

Attribute A must be multi-select
Attribute B cannot be a restricted set or linked to a cascading dropdown

Attribute B can still be multi-value, so you can select multiple values from the selected values of
attribute A

In search, attribute B is NOT shown as a dropdown, so it behaves as a simple text

The dropdown only appears when the attribute is editable, else the selected value(s)is/are simply
displayed as for a plain text attribute

Auto-select: When attribute A has only 1value selected, this value is automatically selected for
attribute B.

Auto-deselect: When attribute B has a value and attribute A’s values are changed so that the value
for attribute B is no longer a selected value for attribute A, the value for attribute B will be de-
selected. In case attribute B is multi-value, this logic is applied to each value separately.

It is allowed that attribute A is itself restricted by yet another attribute.

This function works identically for task specifications

It is allowed to set visibility rules on both attribute A and attribute B

When attribute A is taken away from the attribute category or if it is deleted from the system,
attribute B becomes a plain text attribute. All set values are however remembered (even if they are
multi-value, they will be displayed in their base form “value 1| value 2").

When no values are selected for attribute A, nothing is displayed for attribute B (no empty dropdown
either).
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Lists

16.4.1.

Cascading Dropdowns contain a set of dependent attributes. The choice of one attribute limits the
choice of other attributes in these Dropdowns.

These attributes will be visible as a drop down while building your forms and projects. This allows you to
customize and build intelligent forms. Using these, you can:

« retrieve relationships among values (for example, brand-sub brand roles).

« auto-fill the values depending on the relationship (if you select a brand, a brand description will be
filled in).

- do smart filtering (if you select a brand, you can filter the products that are available under the
brand).

- useinadvanced searching (Asset Browsing). Read more in Asset Browser on page 145.

« Look Up attribute values buttons in attribute categories and task type specification forms.

You can create Cascading dropdowns as:

« Listson page 291 based on WebCenter Database.
« Cascading Dropdowns based on Excel sheets placed on the web server.

Note: We recommend that you reconfigure the attribute categories and task types to use the
database lists. The Excel sheet based cascading dropdowns will become obsolete eventually.

Lists

Lists contain a set of dependent attributes imported into WebCenter. The Lists data is added to the
WebCenter database and maintained in a WebCenter Project or Template. Therefore, you can modify
this data from WebCenter interface.

Also, you can control the access to this data by setting project permissions.

Note: This works in the same way as the List Data imported from Excel sheets. However, you can use
larger data sets with these Database Lists. Read more about Lists from Excel sheets in Cascading
Dropdowns from Excel Sheet on page 298

Adding a new List
» Upload your Excel(either .xls or .xIsx) or XML document to a project or template named
ListManager. If this project does not exist yet, create a new project named ListManager.

In this project, you can create folders for different departments, setup approval cycles to approve
your lists before it is fully configured.

Note: If you are uploading your lists to the ListManager template, only your administrators can see
the lists.

« Gotothe Admin > Attributes > Lists page.
« Click New List.
You will see the New List configuration page.
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« General List Information: Specify the List Name and a Description
« Input Source Properties:

« Specify the Input Source Type. It can be either Excel or XML document. The Select Document
drop down will list the Excel or XML files uploaded to the ListManager project.

« Excel: Select the input Excel file from the Input Source Type drop down. Specify the Sheet
Name of the Excel sheet containing the List data.

« XML : Select the input XML from the drop down and specify the XML Main Node.

a) You may enable the Flush existing list data before updating the list option to clear the old data
from the List before updating with new data.
With this option on, whenever you upload a new version of the Excel / XML input document, the
data from the List will get deleted before the List data gets updated.

b) You can enable the Database user name and password are required when deleting data from
list as a security measure.
If you have enabled this, you have to specify a database user who has the permission to change
the database schema. The database SA (System Administrator) user can also change the
schema.

Important: We recommend that you enable this option to avoid accidental deletion of Lists and
List Data.

« LogFile Folder: Select this from the drop down listing the folders in the ListManager project.

This folder will contain the log files associated with individual Lists. The respective log files gets
updated when you add or modify List data. You can also set permissions for this folder so that only
your administrators can access the logs.

» Database info:

» Create new database table for storing the data: Select this when you want a new database
table for your list.

When this is selected, a WebCenter database table is created whenever you create a new List.
You need to specify the database user credentials to be able create new database tables.

Note:

If you check the Use the built-in 'webcenter' database user account to create the database
table, the SA user has to give the database Create Table rights to the default 'webcenter' user
account. In this case, you do not have to specify the database SA user credentials for creating
new list tables.

» Use an existing database table for storing the data:

Specify an existing table in the WebCenter database for storing the List data. The columns
in this database table and your List need to match. You do not have to specify database user
credentials to use an existing table for creating lists.

» List Properties: You can configure your Input Columns in the List Properties table.
« Specify the columns relevant for the List here by selecting or deselecting.

By default, the column names of the database table will be the same as the input column names.
You may also change the Column names.
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Note: The List column names should be unique.

» You can select a particular column as Unique Identifier. When you enable this, each value in this
List column has to be unique (for example, Product Names). It is possible to select more columns
as Unique Identifiers ( for example, Product Name-Product Variant combination).

Tip:

If you have selected more than one Unique Identifier columns, the combination of the values in
these columns have to be unique. For example, in the case of Product-Variant combinations, you
can have the same Product name repeated for each of its Variants.

Note: When you are updating the list, make sure that the new data matches the Unique
Identifier column. If the new data does not match the identifier values, new rows will be created.
This does not apply if you have enabled the Flush existing list data before updating the list
option.

« Click Create List.

The Lists are displayed in the Lists overview page. Clicking on a specific List will lead to the List Details
page. You can inspect your List data here.

Note: If you update the source XML or Excel document, the List Data will get updated.

Purging Lists

The document linked to a list can have newer versions created. When there are more than thirty
thousand (30000) new versions of the document that is linked to the list, the older versions of the list
up-to 20000 ( that is 1to 20000 ) are purged. This is to make space for the newer versions to be stored.

Note: Document versions can be linked into different projects. When purging, WebCenter will check if
any of the purged versions of the document is linked into a project. Documents versions that are linked
into a project are not purged.

Inspecting List Data

« (o tothe Admin > Attributes > Lists page.
The Lists overview page displays all the existing Lists. The source document and the creator's name
is also listed in this page.

« Click on the name of the List you want to inspect.
« Inthe List Details on page 293 page, click Show List Data to see all of your list data.

You can filter on a list column with a specific value to make the inspection easier.
« Click Return to List Overview to return to the general Lists overview page.

List Details
The List Details page contains an overview of the following :

« General List information
« Input source properties:
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Use the Excel/XML Document link is to view the document’s action history.
You can also access the Log file from the respective link.

« List properties

You can:

« inspect alist's data by clicking on Show List Data

« deletealist orits data

Unique Identifier

You can select a particular column as Unique Identifier. When you enable this, each value in this List
column has to be unique (for example, Product Names). It is possible to select more columns as Unique
Identifiers ( for example, Product Name-Product Variant combination).

Tip:

If you have selected more than one Unique Identifier columns, the combination of the values in these
columns have to be unique. For example, in the case of Product-Variant combinations, you can have
the same Product name repeated for each of its Variants.

Note: When you are updating the list, make sure that the new data matches the Unique Identifier
column. If the new data does not match the identifier values, new rows will be created. This does not
apply if you have enabled the Flush existing list data before updating the list option.

Deleting a List or List Data
You can remove an existing List completely from the system or remove only the List data.

1. Go to the Admin > Attributes > Lists page.

2. Click on the List Name from the Lists table.
This will lead you to the List configuration page.

3. Choose either the Delete List Data option or Delete List option.
4. Enter the Database User name and Password if required.
If you are deleting one of the Lists, you always have to enter the database user credentials.

Note: If you are deleting the List Data, you have to enter the credentials only if the Database user
name and password are required when deleting data from list option was enabled while creating
the List.

5. Click Delete List or Delete List Data to confirm.

Note:

The deletion does not check if the List being deleted is in use by any of the attribute categories. This
will result in malfunctioning of the features using that attribute category.

To restore the affected attribute category, create a List with the same name as the deleted List.

To restore your deleted List Data, update the corresponding input file in the Listmanager project with a
new version.
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Using Lists as Cascading Dropdowns

You can use Lists in the same way as the cascading dropdowns from Excel sheets.

1.

Add and configure your List.
Go to Attributes > Attribute Categories or Task type specification form and click on any text
attribute field.

Note:

» Make sure you are in Grid Layout.
« Bring a text attribute into one of the cells.

« Make sure that it is not a restricted set. You cannot view the lists of cascading attributes in the
restricted sets category.

An item Restrict Values will be visible in the Details section. You can see the cascading attribute
lists based on the web server (if any) and the database lists as lists. These are now available for use
in your Projects and Forms

Note: You cannot re-use a column of alist in more than one attributes belonging to one attribute
category. You can replicate the list temporarily to add the same column to another attribute of the
same attribute category.

Do this for multiple attributes that are required and you will see the cascading behavior.
When you select a value for one attribute, the other attribute values are restricted to what is
allowed according to the List data.

Replicate List Data in an Attribute Category

If you have to use the same list data multiple times for multiple attributes, you can copy the list to these
attributes. If you need two bar code selectors for your packaging component, you will need two fields in
the form with the same drop down.

1.

2.

Add and configure your List.

In the Admin mode, go to Attributes > Attribute Categories or Task type specification form and
click on any text attribute field.

An item Restrict Values will be visible in the Details section. You can see the cascading attribute
lists based on the web server (if any) and the database lists as lists. These are now available for use
in your Projects and Forms

Select the List from the Lists drop down. Click Copy List.
This way, you will get a second cascading drop down configuration without duplicating the data

on the database. You will get a new entry in the list drop down with the same list name with (2) as
suffix. You can do this multiple times and the suffix changes accordingly.

Add more attributes to the category and select values from the replicated Lists.

Note: These copies are only available in the attribute categories where the List was replicated.
If you save the attribute category without linking any attributes to the copied Lists, they will be
removed.

295



ESKO

296

Configuring List Columns in an Attribute Category

WebCenter

You can customize the list columns in an attribute without changing the database list. You can:

« change the order of the columns in the cascading drop down. You can create cascading drop downs
with different column ordering using the same database lists.

« allow other values in the list.

1. Addand configure your List.

Go to Attributes > Attribute Categories or Task type specification form and click on any text

attribute field.

Note:

« Make sure you are in Grid Layout.

« Bring atext attribute into one of the cells.

« Make sure that it is not a restricted set. You cannot view the lists of cascading attributes in the

restricted sets category.

An item Restrict Values will be visible in the Details section. You can see the cascading attribute

lists here.

Details for selected cell:

Attribute CountryCode
Attribute Type: Text

Label Text. |CountryCode
Label: Label Image: |

Position: Left ¥

Span Columns: 1r

|
WebGCenter Attribute ¥ |

Style:
Style Add Style
T Editable v |
Visibility :
Add Rule
[ List || Country list v | Copy List
Restrict Values: Column: | Country Code ¥ |Configure List
Rendering: | Dropdown
Allow Multiple “/alues:
Infe HTML page (name+extension)
Info Page: =WebinstanceRoot=/t ustomiAttributes Help!

2. Click on the Configure List link.
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Configure List

order of the columns
¢t on the tree view in search results (asset browser

Use the arrows to changet

Column ordering only has

Column Attribute

Region Region

Country Country

| Cormrect the previous entries when a selection is not val d

Allow Other Values

3. Intheresulting dialog, you can use the arrows to change the order of the columns in the cascading
drop downs.

Tip: You can configure the list column order to create a cascading tree in search results for your
asset browser. In the example above, you can change the Region to a higher level using the arrow
to move up.

4, By default, the cascading attribute values are corrected when one of the corresponding values
change. Disable the Correct the previous entries when a selection is not valid option if you do not
want your cascade to correct entries automatically.

This allows you to select combinations that are not present in the referenced list.

5. You can also specify whether the attribute values restricted to a list column should be allowed to
have non-list values. Enable Allow Other Values to do so.

» If you have turned the Allow Other Values option off, only the list column values can be selected
as a value. This means that if you have an empty field, you cannot type anything there.

« If the Allow Other Values option is on, you can type in an attribute value. The other attributes in
the same cascade will not be filtered to the new value until you save the attributes.

Note: This configuration is attribute category specific. So the column in the database list
remain the same.

» If the Allow Other Values option is on for a multi-value attribute, you can click on the Other Value
link on the top to enter a non-list value. As a result, you will get an additional row to enter the
new value. You can create multiple rows this way.
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6. Optionally, enable Autoselect matching values when other values are filled out outside of
attributes page (e.g. workflow). This checkbox is off by default.

When this optionis on, if one value was filled out by a workflow or elsewhere, the entire cascading
will be executed in the attribute page.

If the option is off, cascading will only occur when changes are done by a user in the attributes
page.

16.4.2. Cascading Dropdowns from Excel Sheet

Installing Cascading Dropdowns from Excel Sheet

You can create Cascading Dropdowns by following the steps below.

Note: We recommend that you reconfigure the attribute categories and task types to use the
database lists. The Excel sheet based cascading dropdowns will become obsolete eventually.

1. GotoWebCenter\WebServer\tomcat\webapps\WebCenter Inst\custom.Createa
folder named excel under the custom folder if it is not present.

Only for WebCenter 10.2 users: go to webapp\javascript\cascading dropdowns and copy the two
javascript files to webapp\javascript. We recommend that these two files are backed up.

2. You need to place an XML file named 1ists.xml and the excel file (with your attributes to be
imported)in the excel folder.
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You will find an example XML file called 1ists.xml and excel sheets in the excel folder under
webapp\custom example.

Adapt 1ists.xml according to your requirements, within the structure given in the example file.
See an example below:

<lists> <list> <name>Countries and
Managers</name> <file>CountryList.xls</file>
<type>Excel</type> <sheet>Country</sheet>
<column><columnName>CountryName</columnName></column>
<column><columnName>CountryCode</columnName></column>
<column><columnName>Region</columnName></column>
<column><columnName>CountryManager</columnName></column>
<column><columnName>RegionManager</columnName></column>
</list> <list> <name>Countries</name>
<file>CountryList.xls</file>
<type>Excel</type> <sheet>Country</sheet>
<column><columnName>CountryName</columnName></column>
<column><columnName>CountryCode</columnName></column>
</list> </lists>

Note:

« <lists>:Thistagisobligatoryinthis code. You can specify the rest of the details regarding
the importing attribute list under <1ist> tag. In the above example, two attribute lists are
being imported.

+ <name>: You can specify the name of the list which should appear among the WebCenter
attribute lists after this tag. There are two lists in the above example. The lists are named
Countries and Managers and Countries. These names appearin as List namesin the
Restrict Values option.

« <file>: Youshould indicate the file name (including the .xls extension) after this tag. In the
above example, itis CountryList.x1s and thisfileis placed along with 1ists.xml inthe
custom folder.

« <type>: Thisshould be Excel.
+ <sheet>: Here you should specify the name of the work sheet in the excel file. Please avoid

special characters and spaces in the sheet name. The sheet name in the above example is
Country. You can make more than one lists from one sheet.

Remember:
You cannot make one list from the columns placed in different sheets.

As shown in the example, you can make two lists from the same excel sheet or from different
sheets in the same excel file.

+ <column>: Each columnin the excel sheet should be specified separately under the <column>
tag for each of the lists. In the example, five columns are specified under the list named
Countries and Managers and two columns under the list named Countries. The data
from the specified columns will be imported into WebCenter attribute categories.

« <columnName>: You should indicate name of the column here. Excel files get column names
from the values placed in the first row. Please avoid special characters in the column names.
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4, Save andclose the 1ists.xml file.
Make sure that your XML is XML-compliant and in the right folder (excel).

5. Loginto WebCenter as an admin. In the attribute category definition (Attributes > Attribute
Categories and in Grid Layout) click on a text attribute (not on a restricted set).

A Restrict Values item will be visible in the Details section. This shows a dropdown with the lists you
have configuredin 1ists.xml.

Restrict Values:|List: | -- Please Select -- | |

[PY7YY - Please Select - -
<L1.-"r_=b| Countries and Managers

Info Page: =2 Countries tesHelp/

These lists will have the values from the columns of the excel sheet.

Note: If you are uninstalling WebCenter, the custom folder should be backed up and placed
back in the same location as before to restore the Cascading Dropdown functionality in the
new installation. If this folder or one of the files is missing, you will lose the installed Cascading
Dropdowns.

Using Excel based Cascading Dropdowns

The cascading attributes that have been imported will be visible in the attribute category definition.
You can see a dropdown with the lists you have configured in lists.xml here. These dropdowns are
filtered to the row combinations from Excel worksheets.

An example use case is when you want to you use all your brands and sub-brands and the respective
managers to be filled in to the project or for when you choose a product. If you have an excel file with
the information that needs to be imported into WebCenter, you can import this by following the steps
described in Installing Cascading Dropdowns from Excel Sheet on page 298

1. Create an Excel file with Column Names in the first row and fill the columns with your brand
related information that needs to be in the WebCenter Cascading Attributes.

Note:

« Please note that the columns that should be part of one list should be placed in one Excel Sheet.
It is not possible to make one list out of the data placed in different sheets.

« The Cascading Dropdowns are filtered to the row combinations from the specified worksheet.
The linking of row combinations is currently only possible for the columns placed in one Excel
sheet.

«  Werecommend you delete the first empty lines at the bottom of the Excel sheet to avoid the
Excel driver picking up completely empty lines and producing them as valid combinations.

« Make sure you save the Excel fileasa .x1sandnotasa .x1sxfile.

« Thecurrentdriver for Excel sheets does not support Asian characters. Installing another driver
can help solving this problem, but Esko does not have an out-of-the-box recommendation at this
time.
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Brand gj Category ProductManageg Director B SeniorVP g Group
- ESRO VVeBCEenter Bl(smElehiinig Fans Dewne BETHaTd ZWaeNepoer [VVeD soumons |
3 ESKO WebCenter Jijo Dominic Hans Dewitte Bernard Zwaenepoel |Web Solutions
4 ESKO WebCenter Jijo Dominic Hans Dewitte Bernard Zwaenepoel |Web Solutions
5 ESKO WebCenter Jijo Dominic Hans Dewitte Bernard Zwaenepoel Web Solutions
6 ESKO WebCenter Jijo Dominic Hans Dewitte Bernard Zwaenepoel [Web Solutions
7 ESKO Automation Enginfcandida.hart Geert De Proost |Bernard Zwaenepoel |Engines Cow
8 ESKO ArtPro Bjorn Willems Frank Adegeest |Bernard Zwaenepoel |Editors Brar
9 ESKO PackEdge Bjorn Willems Frank Adegeest |Bernard Zwaenepoel |Editors Cow
10 ESKO Studio Kris Van Bael Frank Adegeest |Bernard Zwaenepoel |Editors Sch
11 ESKO Dynamic Content|Jijo Dominic john.chatterton  |Bernard Zwaenepoel |Web Solutions Pac
12 ESKO Dynamic Content|Jijo Dominic john.chatterton  |Bernard Zwaenepoel |Web Solutions Brar
13 ESKO Dynamic Content|Bjorn Willems Frank Adegeest |Bernard Zwaenepoel |Editors CO\Av
RN AN fomhatin Mmees S 14l B I %]

Adapt lists.xml according to the information from the Excel file. Save and close the file.

The Excel file and the XML file should be placed in the folder named excel. See the location of the

folder below.

Esko ~ Artios = WebCenter - WebServer = tomcat = webapps = WebCenter_Inst - custom - excel

hd m I Search excel

-

4

Include in library «

. Program

B JJ tomcat

2 bin

. cert

. conf

J lib

2 logs

. temp

. webapps

J ROOT

. MiewServer
J ‘WebAPI

J ‘WwebCenker_Inst

1 config

0B BB e e e o o &

Bl custom

Share with =

Mew Folder

LI Iame =

|| ESko_Records.xds

Date modified I Type

¥LS File
ML Docurmen

9f6(2012 11:37 AM

2| lisks. il 9f&f2012 11:40 AM

<lists> <list> <name>Esko Brands and

Managers</name>

<file>ESKO Records.xls</file>

<type>Excel</type> <sheet>Esko</sheet>
<column><columnName>Brand</columnName></column>
<column><columnName>Category</columnName></column>
<column><columnName>ProductManager</columnName></column>
<column><columnName>Director</columnName></column>
<column><columnName>SeniorVP</columnName></column>
</list> <list> <name>Esko Group</name>

<file>ESKO Records.xls</file>

<type>Excel</type> <sheet>Esko</sheet>
<column><columnName>Group</columnName></column>
<column><columnName>Ecosystem</columnName></column>
</list> </lists>

See more on installation of this feature in Installing Cascading Dropdowns from Excel Sheet on page
298

Note: You can define more than one lists using columns from a single Excel sheet.

In the Admin mode, go to Attributes > Attribute Categories and click on any text attribute field.
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Note:

« Make sure you are in Grid Layout.
« Bring a text attribute into one of the cells.

« Make sure that it is not a restricted set. You cannot view the lists of cascading attributes in the
restricted sets category.

An item Restrict Values will be visible in the Details section. You can see the cascading attribute
lists Esko Brands and Managers and Esko Group as lists. These are now available for use in your

Projects and Fo.rms

Astributes:

T —[=
\backslasht, - HeaderBar tails i i il
|_CC_Nomber_of_Boxes = 1 Details for selected call:
_CC_Number_cf_samples = Product 1 Attribute Product
_CC_Request_Type I attribute Type: [Text
_CC_Substrate_Type Label: Product
_Request type !
<encoding> “quete™da? \L a\ Label Image: [
--»<seript>alent("--o--"); </script> i
azaasasa [Span Colurnns: EEI
AE_OrderiD  Size:
AE_SubOrderiD == @ | |Row Size: .
Agency =] ® | [styte: I
(agent A agdd Srvle
AGE T
AGI brigfing Visability
AGI Customer
AGI job type Restrict Values fLst: | -- Please Select - =2
AGI lead time e ||
41 New Customer o o Brands and Hanogers
aG1 Packaging Type Info Page:  [EWRH el Greup -
AGI Production Site L a
AGE LA bl
Astribute Categor
[Sove] [sav

3. Create attribute categories which contains the product and brand specific information and save it.

a) Create specific attributes. Select the type as text if you want to have Cascading Dropdowns in
the Details. Read more about creating attributes in Create an Attribute on page 247

Attribute Details

Define Attribute's Name, Description, Type then click Finish.

MName
[Esko Group

*

Description

Type
Text | *

Area(sq in.,sq cm)
Arealsqg in.,sg mm)
Area(sq ft,sq m)
Date and Time
Distance(in.,mm)
Distance(in.,m)
Float

Integer pecification
Rich Text

Text

Volumelcu in.,cu cm)
Volumelcu in.,cu dm)
Volumelcu ft,cu m)
Weight{lbs,ar)
Weight{lbs,kg)
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b) Create/edit attribute category. Bring these attributes to this category in the Grid layout. In

this example, an attribute category is created with Esko brand related attributes. See the

screenshot below.

=0 | insert: v
—

mj »

CategoryEsko

Esko Ecosystem

BrandEsks
Esko Product Managers

- Details for selected cell:

Attribute

CategoryEsko

Attribute Type:

Text

Esko Senior Vice Presid

Labal;

fcategoryEske

Esko Group

wripts

Esko Directors

Label Image:

Span Columns:

T
L=

# | |style:

‘WebCenter Attribute [¥ ]

add Stele

B[

---Flease Select---
|— ArtiosCAD
ArtiosCAD Enterprise
—1 ArtPro

Automation Engine
Color Engine

| DeskPack

Dynamic Content

- '—— Dynarmic Content Engine

HD Flexo

-Cut Automate
Imaging Engine
PackEdge
PitStop Connect
PitStop Pro
PitStap Server
Plato

Studio

Hame Switch
WebCenter
WebCenter

CategoryEsko

Editable ¥

1
-

! |Restrict Valuas:

List: Esko Brands and Managers[ ¥ |

con: [Cowegary 7]

Allow Multiple Values:|T

- info Page:

Type

Eska Ecosystem [

| Text

Esko Group [

| Text

(2]
—

info HTML page (name+extension)
<WeblnstanceRoot>/custom/AttributesHelp/|

BrandEsko
Esko Product Managers
Esko Sensor Vice Presidents

Esko Diractors

Type

Text

] Test

] Text

] Test

Select the List and Column in the Restrict Values Section for each of the attributes that needs

to contain Cascading Dropdowns. List indicates the list names given in the lists.xml file and

Column indicates the column names in the Excel sheets associated with that list.
You can have more than one values in the attribute fields by enabling Allow Multiple Values. In

d

-

the above example when a product has to be associated with more thane one Ecosystems, you
can enable Allow Multiple Values with more than one Ecosystems.

When you have defined attribute category with lists and columns, you will have Dropdowns available
in each of the fields and it will respect the row combinations of Excel values. Therefore, when you
select one value in a specific attribute field, the related information will be smartly filtered and

automatically filled in if there is only one possible value left for those attribute fields.

The dropdowns interact in such a way that only those values are shown which are linked to the
already chosen values for other columns. This will be a very handy feature when complicated forms

have to be filled in.

In the example here, you can see that when WebCenter is selected, all the associated information is
filled in from the same list. The associated data come from the columns of the list Esko Brands

and Managers.

Note:

If you would like smart filtering and automatic fill in, the columns have to be specified in the same

list in lists.xml.

If you want independent columns with all values irrespective of the selection, define separate lists.
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Studio
Name Type Name Value
CategoryEsko e Text BrandEsko ESKO

Esko Ecosystem [~-Please select— [ ~] Text Esko Product Managers
Esko Group ——Please Select-— | ¥ | Text Esko Senior Vice Presidents [Bernard Zwaenepoel [*]

Esko Directors

[Hans Dewitte [ ]

Note:

You can apply rules to these lists to induce advanced customization. For example. you can set
one attribute (Brand description) to be read-only. As a consequence when you select the attribute
Brand(editable), the brand description (read-only) will be automatically filled in.

4. Apply the attribute category with embedded lists containing imported information to any related

project or documents. You can also use these attributes to build Asset Browsers. Read more in Lists
on page 291

Project: ACON - 00001 Status: Active

Manager: Dominic, Jie
* Upload
Customer:

o o
Upload Multiple Documents C‘Lﬁz‘% et
Mail link to. | ‘M Modified: Sep 7, 2012
Mare actions... Description: test
aments (0) | Tasks (0) | Discussions (0) | Characteristics [ Attributes [Jproject information | Approval | Notifications | Members | Security | Configure

Show Attributes in Category Esko Brands and Managers

Hame Value Type

WebCenter =] =

Text

Web Solions [~ Text

Note: Cascading dropdowns are used in setting up an Asset Browser. Read more in

Troubleshooting

When a column contains lots of numbers, non-numbers are no longer appears in the
dropdown and the numbers are displayed with .0 after them

This is caused by the excel reader (which is a piece of Microsoft code) trying to figure out the data type
in the column. It does not work according to the formatting type and therefore changing the formatting
would not solve the problem. So if half (approximately) of the values are numbers, it interprets them

as numbers and dumps all the rest. We are looking for a solution by enforcing the numbers to be
interpreted as text.

To work around this problem, you can do add space to each value to make it pure text. The procedure to
do this automatically is detailed below.

1. Make a new column.

2. Copy the header from the original column to this new column.

3. Change the original column name.

4, Inthe new column, set the value for the first (non-header) row to CONCATENATE("“,X2). Here, X is
the new column with the original data.

Copy this to all rows (select the cells from the just entered cell all the way down and do a Ctrl-D.
Save your file and close it
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The Restrict values choice does not appear in the cell details while selecting a cell in
the Attribute Category layout

You need to make sure that you:

« arein the Grid layout
« choose the right Attribute Type for the selected cell. It should be text (simple, not rich text) type.

« did not choose a Restricted Set.

If all the above settings are correct and you do not have the Restrict Values option, you have to check
the configuration of the lists.xml. If WebCenter fails to find a lists.xml, it assumes that there are no lists
and therefore does not show the Restrict Values option. The most likely cause is that lists.xml is not at
the right location.

It should be placed under WebCenter\WebServer\tomcat\webapps\WebCenter Inst
\custom|custom.

Check also the access rights to see if the access to read the xml is given.

The problem could arise if your lists.xml is not well-formed (not a valid xml). To check this, open the file
in your browser. If you get a message "The XML page cannot be displayed”, it indicates that your XML is
not valid.

I get an error message in the Attribute Category layout

You will get an indication about what is going wrong by reading the error message. Most errors look
like:

« Cannotread list Project Code
. error:

« java.sql.SQLException: [Microsoft ] ODBC Excel Driver] Cannot open database (unknown). It may
not be a database that your application recognizes, or the file may be corrupt. xxx\custom\excel
\Products.xls

Check whether:

« the Excelfile is open. You can check it by opening it yourself . If it is opened by someone else, Excel
warns you about it.

Note: You need to close it after you open the Excel file. If you leave it open, it might result in the
error described above.

« Check the location of the Excel file.

» Cross check the name of the Excel file with the one from the error message.
« Checkforany typingerrorsin lists.xml.

I get an error message “List xxx is no longer configured”.

This means that the attribute category points to a list which is no longer configured correctly in XML
filec(lists.xml). In this situation, all dropdowns will be replaced by simple text fields.

The dropdowns do not appear during project creation, document upload or attribute
editing

Open the Attribute category layout as admin and see whether you get an error message. This situation
points to the removal of lists.xml or one of its items.
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After are-install my Cascading dropdowns no longer appear.

If you are uninstalling WebCenter, the custom folder should be backed up and placed back in the same
location as before to restore the Cascading Dropdown functionality in the new installation. If this folder

or one of the files is missing, you will lose the installed Cascading Dropdowns.

16.4.3. Why Use Database Lists instead of Web Server Lists?

16.5.

Database Lists

Web Server Lists

Higher Security : These are maintained in the
protected WebCenter database.

You need advanced setup through IIS
configuration to prevent security breach.

Reliability : Existing database drivers are reliable.

The Excel reading driver is system dependent.
This limits access to one reader at a time.

Scalable

The scalability is poor.

Easy Update

Difficult to update configurations. When you
update, you have to save your custom Lists folder
separately

Easy administration:You can manage these

via the WebCenter interface. Even non-
administrators can update the master data if the
administrators allow this.

Administration only via the web server.

Faster dataloading: The attribute category
loads information bit by bit ensuring a better user
experience.

Excel based lists are loaded entirely when the
form is loaded. This slows down the form data
loading.

Unlimited List Size:We have tested the Lists with
up to 200,000 rows of data.

There is also a limitation to the size of the data
(maximum of 15000 rows in the Excel sheet). The
driver used is limited to 64K rows which would
make a product list with 100,000 products non-
practical.

Support for .xlsx files

Only .xls files are supported.

Important:

WebCenter 14 is a 64-bit system using only 64-bit drivers. In order to continue using the web server
based cascading dropdowns, you have to install this 64-bit driver. Read more info on Esko Knowledge

Base.

Document References
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You can make use of Document References to specify product and its components or master-child
relationships. Using this feature, you can create an attribute link to refer to a document that is located

within another project or a document library.
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The document reference attribute behaves like a normal attribute which can be added into any
attribute categories. However, you can configure them to provide document sources for your projects.
For example, when you are re-using your existing marketing statements or claims for individual
packaging projects, you can store them in a library and use document references in your future
projects to link to them.

Both Projects and Documents can have document references. You can also create and use document
reference task specifications.

You can:

« configure the document reference links to access specific projects designed as document libraries,
or to access saved searches or asset browsers.

« storeyour text statementsin alibrary project. Using document references, you can link to relevant
text statements from each of your individual packaging artwork.

« configure the file types of documents for these links. You can link a 3D file to one or more CAD files
as document references where the reference links are configured to add only . ARD files.

« configure a document reference attribute to point to multiple documents.

« refertoa CAD overlay from the Graphic file for 3D viewing. Read more in https://wiki.esko.com/
pages/viewpage.action?pageld=170043393.

Create Project

Create: [Use a Project Template v

Project: | JANH S&T DocRef template w | show Details

¥ DSR Information

General Information @

Customer* Description Due Date

[rhis is 2 new Project for Custome] [ |

Sales Rep Service Rep Location

CAD Design(s)* lDocumemReferenceAltr\bute I

Upload CAD Add CAD from Librar

Contact Information Customized label

Add Contact + New Contact

¥ Details

Mote: The name of this Project will be created automatically.

Create Project

It is possible to specify attributes specific to the document reference attribute links. For example,
your packaging project for a box can have a document reference link to an artwork PDF. The specific
barcode can be linked to this document reference via a reference category.

Note: You will see warnings when deleting a document that is referenced elsewhere in WebCenter.

16.5.1. Create a Document Reference Attribute

Creating a document reference attribute is similar to creating an attribute.
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1. Click Admin > Attributes > New Attribute.
2. Enterinformationin the fields as appropriate:
In the field... Fillin the...
Name name of the document reference attribute
Label text of the label which has to be displayed. To get the translated

text of the label in the other languages chosen, select the blue
icon to open Find or Create Translated labels on page 249

Description description of the attribute contents (for example, 1ink to
the CAD shape document).

Type select document reference as the type.

—- Select Attribute Type —

-—-- Select Attribute Type —
Area(sqin.,sqcm)
Area(sq in.sq mm)
Area(sq ft,sqgm)
Date and Time
Distance(in.,mm)
Distance(in.,m)
Document Reference
Float

Integer

Text

Text (Right to left)
Volume(cu in.,cu cm)
Volume(cu in.,cu dm)
Volume(cu ft,cu m)
Weight(lbs,gr)
Weight(lbs kg)

Document References are attribute-links pointing to different
document sources. When you select this option, you will have
additional options.
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In the field...

Fillin the...

Values

will be set to Prompted by default.

Versions and Revisions

Use this field to point to the exact version of the document you
need as the document reference link. This is especially useful
when you want to point to an approved version. By default, it
points to the latest version, but you can set this to:

- Latest Version: When you select this, the document
reference link will be updated to the latest version of the
document.

Note: When you update the referred document, the
document link will point to the latest version regardless of
the Change Properties permissions in the Project > Security
tab.

» Selected Version: Use this setting if your document
reference link should point to a certain version always. In this
case, the document reference will not be updated to point
to the latest version when a new version of the reference
document is uploaded.

« Selected Revision: When you choose this, the document
reference will always point to the latest version of the
selected revision.

Note: When you update the referred document, the link will
source the latest version of the selected revision regardless
of the Change Properties permissions in the Security tab.

Reference Category

To apply a reference category to the document reference,
select from the drop down listing all the attribute categories.

Note: Rich text attributes and document reference attributes
cannot be used as reference attributes.

You can use a reference category (which is an attribute
category) to assign certain attributes to the document
reference link. This is very useful when the property is not
linked to the product or the component specifically. You can
use reference categories to specify properties of the reference
links.

Select Attribute is also a task specification if you want to be able to use the attribute as a task

specification.

For more information about task specifications, see Basic Concepts of Task Management".

Click Create.
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Document Versions and Revisions

Use this field to point to the exact version of the document you need as the document reference link.
This is especially useful when you want to point to an approved version. By default, it points to the
latest version, but you can set this to:

- Latest Version: When you select this, the document reference link will be updated to the latest
version of the document.

WebCenter

Note: When you update the referred document, the document link will point to the latest version
regardless of the Change Properties permissions in the Project > Security tab.

« Selected Version: Use this setting if your document reference link should point to a certain version
always. In this case, the document reference will not be updated to point to the latest version when
a new version of the reference document is uploaded.

« Selected Revision: When you choose this, the document reference will always point to the latest
version of the selected revision.

Note: When you update the referred document, the link will source the latest version of the
selected revision regardless of the Change Properties permissions in the Security tab.

Note:

When you upload a new version or revision of the reference document, your Preferences > Security
settings will over-write the above settings.

« When the Allow changing attributes of approved documents option is turned off, the document
references (as project attributes or task specifications) will not be updated to point to the latest
versions.

« If the setting Allow changing attributes of inactive projects is turned off, the document references

of such projects will not get updated to the latest revision / version.

Reference Category

You can use areference category (which is an attribute category) to assign certain attributes to
the document reference link. This is very useful when the property is not linked to the product or the
component specifically. You can use reference categories to specify properties of the reference links.

For example, you can:

» define the position of a text fragment (document reference link) in an artwork.

- size of abarcode on abox. The barcode is the document referenced in the box and the size of the
barcode is an attribute of the document reference link.

Note: This feature is only available with the Lifecycle Management License.

To apply a reference category to the document reference, select from the drop down listing all the
attribute categories.

Note: Rich text attributes and document reference attributes cannot be used as reference
attributes.
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Deleting Documents used as Document References

When you try to delete documents (or document versions) being used as references elsewhere, you
will get a warning message with a list of projects / documents / tasks where it is being used as a
reference.

When you confirm the deletion, the documents / version will be deleted.

Note: However, you cannot delete documents when the Preferences > Security settings are turned
off:

« When the Allow changing attributes of approved documents option is turned off as a security
setting, the documents / versions referenced as project attributes or task specifications cannot
be deleted.

You will get an error message and a list of projects / documents / tasks where the document or
version is being used.
« If the setting Allow changing attributes of inactive projects is turned off as a security measure,

the documents / versions referenced in those projects cannot be deleted.

You will get an error message listing the occurrences where the document is being referenced.

16.5.2. Edit a Document Reference Attribute

Click Admin > Attributes
Click the attribute to edit.

Edit the attribute as desired. You can change the Name, Description, Versions and Revisions,
Reference Category and Attribute is also a task specification.

Edit Attribute properties and click Change.

Name }ACAD - Referenced ARDs

Tip: Enter a name with a prefix to find it back more easily.
Description
Type Document Reference

Value ® prompted
Calculated

Restricted Set
Versions and Revisions Selected Revision r ¥
Reference Category | --- Select Category --- v P
#| pttribute is also a Task Specification

Attribute Categories ACAD Test, ACAD Test Exported, ACAD Test
Exported 2

Task Types test deletion of task specification

Change Return
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4. Click Change to make the changes.

Attention: When you edit the versions and revisions settings, the changes will not be
A reflected in the existing document references. The changes are updated for the future uses of
the edited attribute.

16.5.3. Copying Document Reference Attributes from source Project or
Template

When a project is created from an existing project or a template, the Document Reference Attributes
that are copied from the template or the source project are copied into the documents in the newly
created project. Documents that are local to the source project or template is local to the newly
created project as well.

When a project is copied or created along with the documents,

« Thedocuments are copied to the new project and the document reference attribute values of the
documents point to the original documents.

« Forall document reference project attributes, the referenced document is copied to the new
project and attribute points to the new document, which is local to the new project.

« Remote documents in the template/source project remain remote in the new project with no
change to corresponding document reference.
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Project: demo_source

% Upload Manager: BLSA_DOCREF: "'napr_custlog_1.
1 :
ity Upload Multiple Documents Customer
o Due On:

i Mail link to Modified: Jun 18, 2018
More...r Description:
4
Documents @)  Bill Of Materialz i) Tasks () Discussions )  Characteristics | Attributes | More._.~

Aftributes in Category Demo_Cat 4 [ = [

BLSA_DOCREF Dasajrme
<+ Upload + Search ] ]
Location of the documant in
the source
& [= Thumbnail Mame Project Mame Location
Mnapr_custlog_1.xmil napr_app_1 9. Reference @
Em test . xlsx demo_source Local "
Prﬂ]EEt demo ta rg E ew Project created as a copy of
'EI'I'IO source
% Upload Manager: BLSA_DOCREF: "'/napr_custlog_1.
Cust
i Upload Multiple Documents ustomer:
Due On:
i Mail link to Modified: Jun 18, 2018
More...» Description:
Documents g Bill Of Materials ) Tasks (1) Discussions (1) Characteristics Attributes Maore.,. =
Attributes in Category Demo_Cat & H & P
BLSA_DOCREF Dacum
4 Upload <+ Search

Location of the dotument in
the new project

[# = Thumbnail Mame Project Name Location
[+ | Mnapr_custlog_1.xml napr_taskmanagement %, Reference &
testl .xlsx demo_target Local ]

Any document reference attributes which are referenced to documents when copied to the target
project while creating a new project from a source project are remapped to the new project as local.
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Documents added to the document references through the Link in the current project document
source, will be also remapped to the document references to the new project created.

Note: When you copy a project without the documents, all the document references point to the
source project or its referenced project.

Upload a New Version

You can upload a new version to an existing document only once. This restriction helps to ensure
multiple versions of the same documents are not uploaded accidentally.

16.5.4. Delete a Document Reference Attribute

1. Click Admin > Attributes
2. Select the attribute to delete and click Delete Attribute(s)in the actions menu.

If the attribute is not being used, it is deleted immediately.
3. If the document reference is being used elsewhere, you will be asked to confirm the deletion.
Choose from:

« clear the attribute from the Project(s), Document(s), Document Reference Attribute(s) or
Category(s): When you select this option, your document reference attributes and its values are
deleted from the projects / documents / where it is being used. However, the original document
or its attributes are not deleted.

« Cancel deletion.

16.5.5. Document References in an Attribute Category

You can set up the document references with advanced options in the attribute category grid layout
page.
Document reference attributes appear just like the other attributes in this page.

Read Configure a Document Reference Attribute in a Category on page 315.

Document References in One Column

Note: You need the Life cycle management license to place and edit the document references with its
advanced features. If you do not have this, the list layout is the only available option. In the list layout,
you will have a simple preview:

« multiple values are always supported

« default style

- drop down rendering when multiple values are added (when editable)

« document references are always rendered as a set of hyperlink read-only.
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Configure a Document Reference Attribute in a Category

You need to use the Grid Layout for the advanced features associated with the document reference
attributes within the cell of an attribute category.

« Toadd document reference attributes to a category or remove them from it, use the chevron (<< or
>>) buttons to move them between the two columns.

You can see a Preview of your attributes under the columns.
«  Whenyou add a document reference attribute, you can setup advanced options in the details table:

REFE"EH_C_E Mo Reference Category selected
Category:
Version Mode: Latest Version
Document Components_Default ‘¥
Source(s): Edit Configuration

_ ¥
Rendering: Components_Default

Edit Render Configuration

« Check Allow Multiple values to allow the reference to multiple documents. This feature is detailed
in Create a Multi-Value Attribute on page 283

« Reference Category is a read only field which refers to properties specific to this document
reference link.

This field is set during the creation of the document reference attribute. You can specify an
attribute category for each document reference attribute to define the properties of the reference /
link. Read more in Reference Category on page 310.

- Version Mode refers to the document version you are referencing to. This field is also set during the
creation of the document reference attribute. Read Document Versions and Revisions on page 310.
« Document Source: You can configure different types of document sources for a customized
document reference link.
a) Click Edit Configuration.
You can configure your document sources in the Edit Document Source Configuration pop-up.

b) Click Add document source to add more document sources for this Document Reference
Attribute.

c) If you have different attribute views, you can setup different source configurations.

Read more in:
« Adding Document Sources for a Document Reference Attribute on page 316.

« Document Sources for Different Attribute Views on page 318.

« Rendering: You can setup a Simple or advanced Table display of the document reference links in a
Project / Template / Forms.

If you select your rendering as: The result will be...

Simple

Upload CAD Add CAD from Libran

P
- } Add CAD from Library (Reference): ball.ard ®

‘ Add CAD from Library (Reference): BOXCO_00001.ard ¥
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If you select your rendering as: The result will be...

« The document references will have:

« the document name as a hyperlink. Click
this link to open the document in a new
tab.

« athumbnail. Click on the thumbnail to
open the document in the Viewer.

« adelete button

« up/down arrow to re-order the document
list.

Table An advanced table depending on your
configuration. For example, you can configure
editable attributes into your table.

Read more details in: Create an Advanced Table
Rendering on page 319

« Save the attribute category.
A user with attribute update permissions can:

« delete adocument from the list of document references.

« addadocument. The document sources as configured will be available as a header to the simple /
table rendering.

Note:

1. If allow multiple values is turned off, document source links will appear next to the added
document in the same row.

2. Without the necessary upload rights to the folders of the project, a user cannot add documents
to them.

« change the order of the referenced document.

Adding Document Sources for a Document Reference Attribute

You can configure your document sources (such as a Project/template which serves as a library of
assets, a Saved search of your assets, or your document templates)in the Grid layout. Your configured
sources will appear in the places(such as templates or forms you have designed) where you set the
document reference categories.
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Copy Operation

Add Document Source

You can configure:

Copy with all References - D

th Local References

Copy with All References

« asimple Browse link for the user to upload a document.

[0 Create Assembly

WebCenter
Edit Document Sources Configuration
DocRef1_Default
Source Label Details Operation Target Target Folder
Standard Allowed Extensions add
[x] Brawse - Upload
v I " . Boct Temnla red Replace
Upload Document Template selector  Any Document Template configured -
Document Template selector  Fixed Document Template -
Standard - add
Document Templates - Template(s) = VV_Template from a Project.vvvi Copy Repla
Browse - eplace
Copy Operation | Basic Copy - @
Standard - Add
Current Project - Link Renlac
Link - eplace
Search Name | TL_WCR_16922 Bulk Operations - Find Docume « Copy
Standard - OJ Link Add
Saved Search - Document Template selector  Any Document Template configured + | ] Move Repl.
eplace
Search - Use by Reference P

Note: You can also drag and drop multiple files to the upload button.

« Document Templates from the template library. This will serve as a place holder with pre-
configured settings such as attribute categories. Read more about templates in Document

Templates on page 95.

« Current Project

« Saved Search: Use this option to allow the user to select a file from a saved search. When the user
clicks the document reference as a link (with a custom label), saved search results will appear in a

pop-up with all the configured options.

« Asset Management System: Use this to allow selecting a file from the configured Asset
Management Systems. Read more in Configure Asset Management Connections on page 372

You can specify settings for your users:

« theLabel

« the Details such as:

« the document template library
« the name of the saved search

- allowed file extensions
« copy operation

« the type of operation depending on the document source. You can allow the users to:

- copy
o link
- move
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+ use byreference
+ Create Assembly

« Target folder: Every document source must have at least one target location selected.
Add and Replace options as targets are available for all the document sources.
+ Addtargetis used when you are uploading a new document or moving or copying or referencing

an existing document with a Document source and adding it to a Documents table.

- Replace target is used when an existing document is replaced by a new document (uploaded or
already existing) within a Documents table.

Options are similar to the Project / Template document creation settings.

Tip: You can setup different configurations for different attribute views.

Document Sources for Different Attribute Views

There is always one document source configuration assigned to a document reference attribute
in a category depending upon the view. In the default view, the name of this configuration will be
"AttributeName" Default.

You can create dedicated document sources for custom attribute views. When you are in a custom
view, click Create Configuration for the Current View to create a custom document source.

You will get an Edit Document Sources Configuration pop-up with a copy of the default setup.

Create a new setup for the current view and click OK. To revert to the default, click Return to Default
View Configuration.

Note: Return to Default View Configuration will delete the current configuration and restore the
default.
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ibals_Default

Nt Templates

earch

urce

WebCenter
Label Details Operation Target
Standard = Document Template selector  Any Document Template configured - Add
Copy i
Mew - Copy Operation Basic Copy - i Repla
Search Name | - Select Search - - Copy
Standard - L Link Add
Document Template selector  Any Document Template configured » || Move R
: Epia
Search - i Use by Reference
Copy Operation | Basic Copy ~ £

Create Assembly

In other views, the configuration name can be:

+ "AttributeName" Default if the configurationin the current view is inherited from the
default view.

+ "AttributeName" ViewName if the view hasits own configuration. If the configuration is
shared with another view, ViewName can be from the other view.

Asset Management Connection as a Document Source for Document Reference

You can select Asset Management System as a Document Source. You can further add specific details
from what has to be fetched from the asset management system by selecting Configure which opens
the Asset Management Configuration window.

Following information has to be specified for the Configuration

« Choose either a Workspace that should be opened or workflow that should be called in the Asset
Management.

«  When Workspace is selected: Choose the Name Space and Parameter from the drop down and
value can be keyed in or filled using SmartNames

« When Workflow is selected: Parameters should be added to the request, and values can be
keyed in or filled using SmartNames

Note: This setup can be exported for reuse or another setup can be imported from file.

Create an Advanced Table Rendering

Adding an advanced table of document references allows you to customize the way your document will
be shown to users when they are applied (For example, in a template).

It also allows you to configure advanced features such as making an attribute of the document
required or read only.
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Note: The document reference attributes will inherit the style specified in the attribute category.
This style is further expanded to the individual document's attributes as well.

« Click Use Grid Layout in the Edit Category page. Add your document reference attributes.

REFE"E”_C_E Mo Reference Category selected
Category:
Version Mode: Latest Version
Document Components_Default ‘¥
Source(s): Edit Configuration

¥
Rendering: Components_Default

Edit Render Configura

« Select the Rendering as Table in the grid layout.

In the Edit Render Configuration dialog, you can set up the advanced rendering.

Note: You can create custom tables for your different views.

« Enable Hide Header if you do not want a header row in the document references table. The labels
will be displayed in line for each document.

« Enable Allow Bulk Operations when any action performed on the document reference is also
cascaded to all the references which are made to that particular document reference. Actions
performed on the document reference could be to

+ Remove a Referenced document which removes all the document references in the tree
structure

+ Replace and Undo
« Getting document to Local and Undo action
« Upload anew version and/or edit a text statement
« Update to the latest version

« Enable Limit Bulk Operations to Document References with matching Operations configured,
when you want to perform bulk operations on document rows which are filtered based on document
sources and actions configured for them. Read more about bulk operations.

User is informed about the number of rows the bulk operation will be really performed (after
filtering) in the specific bulk operation modal dialog.

. EIIE Name color2 (prop) City Project 2
A /\1:& Report test.pdf [ | iy DocRef project
= . e Name color? (prop) City Project @
mpp.txt |pitch black | |L0nd0n |ﬁ DocRef project

« Enable Open Links in new Tab , to open any link in the document reference in a new tab.
« Click Add Column to add more columns to the table.

The rows in the Edit Render Configuration pop-up correspond to your document reference
columns.
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Edit Render Configuration

Name: DocRef3_Default

Hide Header
¥ Open Links in new Tab
#| Allow Bulk Operations

Limit Bulk Operations to Document References with matching Operations configured

Type

Reference Property
Up/Down

Document Property

Document Name

Document Actions

Document Property

Local/Remote Project

Replace Button

Delete Button

4

-

Details Label
INSTANCE_SEQUENCE - INSTAMCE_SEQUENCE
Thumbnail « 50 v px Thumbnail

« Show Document Source
# Show Document Description

Na
@ Show Folder ame
# Show Document Template

Open 3D View - ©

View - B9

Open in ArtiosCAD v ©

Download ~ B

Add Action

Version -
¥ Allow uploading a new version Version

¥ Allow updating to |atest version

Copy Text Content Status

Add Column Revert to default configuration

Visibility
Editable
Read Only

Read Only

Read Only

Read Only

Read Only

Editable

Read Only

Read Only

WebCenter

Width

auto

auto

auto

auto

auto

auto

auto

auto

auto

Collapse

Select Type as Document Name which is a mandatory field. In the Details section, you can disable:

« Show Document Source

« Show Document Description
« Show Folder
« Show Document Template

Your rendering will have a hyperlink to the document depending on the user permissions. These
options are additional details added to the document and can be viewed only when a new document

is added.

box sprint2.ard

The name will not be a hyperlink for users without document view permissions.

Depending on how your document properties should be rendered, configure the table columns. You

can create custom Labels for your selections. The properties will be displayed as read-only.
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Choose Document
PropertyDetails as...

The result in the rendering table will be...

- Description

+ VersionRevision
» VersionAuthor

+ Project

- ApprovalStatus
« ApprovalStage

+ ModifiedDate

o Thumbnail

+ Create custom labels

« Specify the pixels for
your thumbnail.

» Check the box Allow
uploading a new Version
button

The selected document properties will appear in the table
header with the custom label. For example:

« thecurrent Approval Stage of the document. The user can
click to access the approval pop-up.

» Clickable thumbnail of the document with the default
(50x50) or specified pixels.

estado de  etapa de

Version . .
aprobacion aprobacion

1 (%) (= Stage2

1 (%) WV Etapa 3

* Upload New Version'®  if you have the rights to upload will
be available in theVersion column.

« You can configure document actions in the table rendering of the document references.

The actions will appear next to the documents listed in the table only when it is relevant.

® =+ |Document Actions v |

Open 30 View v |0 |-'-‘-.|:ti|:||'|5
View r E,J
Open in ArtiosCAD ¥ E,J
Download v (%)
Upload Mew Version ¥ EJ

[ Add Achion ]

Choose Document Actions as...

The result in the rendering table will be...

+ View
- Openin3D
« Openin ArtiosCAD

« Download

« Upload New Version

322

A 3D .3 button will be available only when
there is an existing 3D perspective.

« Openin ArtiosCAD option will be available
for CAD files. Clicking on it will open the CAD
document as set up in the preferences
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Choose Document Actions as... The result in the rendering table will be...
« Update to Latest Version « Download option will be available when the

user has download permission.

« Upload New Version: This is available when
the user has the rights to upload new version.

Note: The Upload New Version * button
can also be placed in the Version column by
checking the Allow uploading a new version
check box.

« Update to Latest Version: Allows user to
update to the latest version

Note:

« If you change the attribute values during the upload of a new version, these are only applied on
the new version of the document. The previous version will have the old attribute values.

- |fadocument version is linked in multiple projects, all linked projects will get the new document
version.

« If the configured columns do not fit in the table, the table will assign each column its minimum
width and show a horizontal scroll bar.

« Configure how your Document attributes should be displayed. Select the relevant attribute from
the drop down as a specific column (with a custom Label) in your table.

lCu:urr.pcunents hi |

Component Code -
Component Mame

Component Number

Concepts

Configuration

ConnectArea(sg ft,sq m)
Construction of Pack Efficient?
Consumer Insight

Contact Name

Specify the Visibility of the The result in the rendering table will be...

attribute as...
- Editable if you want the « The selected document attributes will be displayed in the
users (with the right table header and its values in the respective columns.

permissions) to be able
to edit this attribute.
width *  Length
+ Required if you want
to make it mandatory
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Specify the Visibility of the The result in the rendering table will be...
attribute as...
for users (with the right « Theusers cantype in the values for the editable attributes.
permissions)to fill in this
attribute. Weight Date
+ Read Only if you don't T | [May 26, 2015 =

want any user to be able
to edit this attribute.

Note: You can configure the Visibility also at the attribute
level. If your settings differ, the most restrictive setting will be
applied.

Tip: Click add column and select another attribute to have more attributes listed in your table.

Tip:

You can configure a project's document reference attributes to be non-editable and still allow the
user to edit the attributes of the documents referenced.

Your user can do this from the project's attribute category tab.

Tip:

Optionally, you can setup the Project > Notifications > Project Attribute/Category change to
receive notifications about document references.

Reference category changes will be notified according to the Project > Notifications > Document
Attribute/Category change settings.

Configure Expand Attributes Iy Collapse Attributes — button for your document references.
This allows you to expand or collapse the document attributes of your references.

Tip: You can configure different expand attributes settings for different views. Specify the view
name here.

Note:

The check box Use Creation View for new Documents is switched on by default. As a result, you will
get the creation view whenever you use Upload/ Browse, Copy or New regardless of the view you
are creating the rendering for. If this option is disabled, you will see the specific view or the default
view.

When you save the view will change to the specified or default view depending on the configuration.
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Edit the Visibility as...

The result in the rendering table will be...

« read-only

. editable

Note: The user needs Change
properties right to edit attribute
values.

Click * to expand the document attributes (which
may also be document references):

Tip: Keep this editable, if your users have to edit
the document reference's attributes.

When the document attributes are expanded, you

canuse ' tocollapse them.

E1E] Thumbnail Name

= N BOXCO 00001.ard

Customer Box Brands
Description CAD Number

[Blue box for Bax&Ca. | [t |
Display Style Length

Select the relevant reference properties and specify if you want it to be Read-only / Editable /

Required / Hidden.

Reference properties are attributes (reference category )of the document reference link. You can
select one of them from the attribute drop down in the Details cell.

[ Reference Proparty

r | | DEKE_Ingredient Quantity (loat) v ]

| Reference Property

v | | DEKE_Ingrediant Unit v |

Note: Reference Property field is only available when a reference category is specified for the

document reference.

Specify the Visibility of the
reference category attribute as...

The result in the rendering table will be...

- Editable if you want the users
(with the right permissions)to be
able to edit this attribute.

+ Required if you want to make it
mandatory for users (with the
right permissions)to fill in this

attribute.

« Thereference attributes will be displayed in the
table header and its values in the respective
columns.

« Theusers can type in the values for the editable
attributes.
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Specify the Visibility of the The result in the rendering table will be...
reference category attribute as...

+ Read Only if you do not want
any user to be able to edit this
attribute.

Hidden if you want to specify a « Novisible reference attributes in the table
Reference Property, but do not want

to show it in the table. « The values (of the reference attributes) are
retained when you duplicate or replace a
document reference.

Note: This option is specific to
Reference Properties.

Note:

Choose Collapse check box when you choose Document Property, Reference Property, Reference
Property Filter, Document Attribute, Project Property, Project Attribute, Master Text, Translation
Text, Text Language Flags fields for Type, to expand or collapse the column while rendering in the
table.

+ = Pphoto Ingredient Quantity

You can allow the users to move a referenced document into the current project. To set this up,
create a column with Local / Remote setting. Specify the visibility as editable or read-only. You
can move all the referenced documents into the local project by hovering on the Location in the
header and selecting the option Copy All References into Current Project.
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-+ Upload < Link -+ Search -+ Search
[=] Location = Thumbnail Name Version
opy All References into Current Project
S Refer Reference M Allergen statement Q s 1 =

0002 _TextDoc_00000814_PCM.wce

Reference Best before date
123Best before date.wecc

Reference M Dosage instructions
123Dosage instructions.wcc

NCarrotl1.pdf Q & 1t (]

000000002_Mutritional Facts_C.wce

You can move any of the referenced document to the local by clicking on the Referenced field of the
required document and selecting the option Copy to Current Project.

[=] Location = Th

z.5 Copy to Current Project

sl
“1
-
"

<908

----------- I e WA 8
= L= = LB QIm. ¥ve-n-10o50

The users need to Change Properties and Add permissions to move a document to local folder. The
document reference will point to the local copies.

The user will be able to specify:

« anewname and description
- document template
« target folder

If the setting is Read-only, the user will see indicating remote project.

When you are creating a Copy Sheet using Text Document References, you can configure text
related data to the table. Read more in: Create a Table Rendering for Text Documents on page 334
To configure the rendering with Project related parameters, choose from
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+ Project Property
« Project Attribute

Read more details in: Project Properties in Advanced Table Rendering on page 331
« Optionally, add:
a) aNumbering column.
b) Up/ Down arrows to let the users change the sequence.
c) Duplicate button which allows the user to duplicate a reference along with its properties. Read
more in: Duplicate a Document Reference on page 330.
d) Replace button which allows the user to replace a document reference. Read more: Replace a
Document Reference on page 331.
e) aDelete Button to let the users delete the document references from the table.
f) Row Selector to let the users select single or multiple documents. Using this, user can select
multiple documents from the document table and perform document actions on them.
« Save the configuration by clicking OK. To revert from this configuration, click Revert to WebCenter
Default Configuration.
. Save the Attribute Category.

If the logged in user does not have permissions to view the document, the document table will have
(based on the configuration):

1. Document name with !. The user will see a warning message.
Editable reference properties displayed in the specified columns
Up /Down arrows

Delete button

Numbering ("#")

LIPS

Note: If the settings are not editable, the document table will have the document name and its
sequence number.
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Note:

You can create dedicated table (of document references) for custom attribute views. When you are in a

custom view, click Create Configuration for the Current View to create a custom table.

You will get an Edit Render Configuration pop-up with a copy of the default setup.

Edit Render Configuration

Name: DocRef3_Default
Hide Header

# Open Links in new Tab

# Allow Bulk Operations

Limit Bulk Operations to Document References with matching Operations configured

Type

Reference Property
Up/Down

Document Property

Document Name

Document Actions

Document Property

Local/Remote Project

Replace Bution

Delete Button

-

Details Label
INSTANCE_SEQUENCE - INSTANCE_SEQUENCE
Thumbnail -~ 50 v | px Thumbnail

# Show Document Source
# Show Document Description

2 Show Folder Name
# Show Document Template

Open 3D View - 9

View ~ B

Open in ArtiosCAD -~ ©

Download - O

Add Action

Version -
#| Allow uploading a new version ‘Version

#| Allow updating to latest version

Copy Text Content Status

Add Column Revert to default configuration

Visibility
Editable
Read Only

Read Only

Read Only

Read Only

Read Only

Editable

Read Only

Read Only

Width

auto

auto

auto

auto

auto

auto

auto

auto

auto

Create a new setup for the current view and click OK. To revert to the default, click Return to
WebCenter Default Configuration.

Collapse

Note: Return to WebCenter Default Configuration will delete the current configuration and restore

the default.

In other views, the configuration name can be:

+ "AttributeName"-Drfamlhinehie gantiewaient dhe eornaglvien s intrer tedficurathmdetmatadew.

with another view, ViewName can be from the other view.
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Duplicate a Document Reference

You can configure a Duplicate option in your document reference table. When the user duplicates a
reference, a new row of document reference will be created. The duplicated document will have the
same content, document attributes and reference category as the previous one.

In the case of Text Document, Content file, then each element status in the file will be reset to draft.

Note: Only users who are Project managers, Administrators or with Change Properties rights can
replace the document reference.

Technical:

m Fram Library
:r:;:;me v v Version
| SO step 1
L By Decumentisource. @ ~ ] —
ASSEMBLY Sanding T s . - 5 ?ﬂ
INSTRUCTIO, @
[ ] step 1

32 Buplicated|row,

u
e

ASSEMBLY
INSTRUCTIO..

INGREDIENTS
§ " v mMagnesium Hydroxide Prep. i 3 ]
INGREDIENT 2 'Y E
DECLARAT IU;[ ‘g;" (Magnesium Hydroxide, Starch), -

Dicalcium Phosphate, Vitamin G Prep. -

®

0
IN]
L]

C]

When you configure a Duplicate button, it will allow the users:

to duplicate a document row with Copy and New as document sources.

The duplicate documents are created in the current Project where the copied or newly created
documents are stored.

Tip:

« Thedocument willbe namedas [FileName] [Duplicate] [1], [FileName]
[Duplicate] [2],etc.

« Use the Rename document action to change the document name.

You cannot duplicate a document reference if the document source is:

» Browse/ Link/ Use by Reference / Remote.

Behavior while duplicating document and its reference properties:

If Allow multiple values is turned off in the attribute category, the duplicate will replace the original
instead of adding a new document reference.

The duplicated document will have the same Attribute category including the child document
references. The Reference categories and its settings are copied at parent and child levels.

The duplicated row inherits the entire hierarchy (if any) of the parent row including the attribute
values.

It is possible to duplicate a newly created document row.
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Replace a Document Reference

You can configure a Replace option in your document reference table. When you replace the old
reference, the new document reference will have the same reference category as the old one.

Note: Project managers, Administrators or users with Change Properties rights can replace the
document reference.

Translation Text |Dutch - Metherlands ¥ | INSTANCE_SEQUENCE

o [sF

v
Signed Link
=H @ Browse
MNew
Search
T =T ]

When you configure a Replace button, it allow the you to

- replace the document via any of the configured document sources (upload, browse, etc.). If you do
not select any option, the first source is taken as the default.

« Undo the action before saving the new document reference.

This document has its own Attribute Category but will keep the same Reference Category as the old
reference.

You can also select compact rendering option for this button.

Project Properties in Advanced Table Rendering

You can configure the document's Project related details in the document reference rendering.

Project Property

If you select Project Property as the Type, you can specify the following parameters of the document's
host Project in the document rendering.

« Project Property

« Project Name
« Project Due Date
« Project Status. You can choose to:

+ Show Labeland Icon
« Show Only Label

« Show Color Label

+ Show Onlylcon

« Project Attribute: Specify the attribute that you want to show from the drop-down.
Bulk Operations on Document references

A single document can be referenced multiple-times from various Projects /Document Attribute
Details, Project Creation Form or Task Execution Page.
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To speed up and improve working in such a situation, you can perform the bulk operations on the
documents referenced by a document reference attributes.

When you perform the following actions on a document references,

« Remove a document from a document reference attribute

» Replace a document referenced by a document reference attribute

« Make adocument referenced by a document reference attribute local to the current project

- Update the reference of a document to refer to the latest version of the document (available only for
“Selected version/revision” document reference types)

you can choose to perform only on the selected document or on all the documents it is referenced
to. By all documents it is referenced, means a search is performed in the document reference tree
structure for affected documents including the document references with bulk operations turned off.

Note: Bulk operations are not performed in

« BOM Documents
» Read-only and hidden document references

You can also enable the option Limit Bulk Operations to Document References with matching
Operations configured in the Edit Render Configuration in Attributes Category page. When the option
is chosen, document rows to be modified by any of supported bulk operations are in addition filtered
based on document sources and actions configured for them. Only document rows where the bulk
operation can be performed directly are filtered and are modified by the bulk operation.

Creating a Copy Sheet

Copy sheet is aterm used to describe all the content together which are attached to a particular
artwork or printed item. A copy sheet containing aggregated content helps you to:

- validate the copy sheet templates for consistency, accuracy and compliance with the established
content management process.
« review, proof-read and approve copy sheet in one place.

You can create a copy sheet using Text Content Document References in an Attribute Category. This
gives the option to attach this copy sheet to your Projects or artwork documents.

The copy sheet categories allow you to:

« track the content on anartwork.
« easily reuse existing approved content
« configure separate permissions and approval system for each text document.

Tip:

By configuring Document Rendering for Text documents, you can attach copy sheets to Tasks. When
you configure Workflows with manual tasks for editing or approving, the users can work on the copy
sheet directly from their task.

An Attribute Category based copy sheet offers the following advantages:

« thelanguages. To view a particular translation corresponding to a master, just select that language
in the filter drop down.
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the Instance Sequence. See more in: Dynamic Content documentation

« theoptionto replace a text document with another

the button to duplicate a document with the same reference attributes

« advanced document reference options

You can Edit, Start Approval, Approve and Reject actions from the copy sheet depending on your
content permission.

Note:

The text document references are used when you import Dynamic Content into WebCenter. Read about
thisin: Import Dynamic Text.

See the example screen shot below. The configuration explained here is only an example. You can
configure your document references according to your needs.

Tip: You can configure the copy sheet with different Attribute Views to provide custom views to
your users. For example, a content collator and Translation Language Editors can have different
custom views of the same text document reference category.

Note: You can also add the languages by clicking on the + displayed in the text statement. On

deletion of a language, the * iconis again displayed to enable adding back the language. You can
configure the corresponding attribute category to display the languages one by one in a table.

o Hew b Madeding Sonterd Ribrary

= Text Widgets -
ame Assier Teat £ wégratonad Tronlsmos fer freach Lot L] ol Languages
Language Flags
QT — - e = ®l.
! o * B’ o! ® LT I
HFRES: i o RAFRAIH ST MENT AT L
= s copy =] [ i ! T e i mEN=is |
T @
EXCELLENT 3008 L= X CEE L]
ey gy a- o P¥deaeersn H &5 P MRl an
@ @
) =] L
s ' Resycle stmenent [ " =i i L= oo
B 5 & "'\3'_15'-'\." (=11 n-‘ * ElIIEGS [
B Pactagag i 5. u [Geere ot M= ! BT ?oa

Adding or removing Master or Translation languages from a Project Attribute Category page or
Project Creation page or Document Attributes, or in a Task execution pages behaves differently now.

Adding any of the available languages is possible based on permissions on all text content in the
page including documents that are from other than current project.

Similarly, it is possible to remove the language when it is added recently but not saved

« Evenwhen text content document is referenced from other than the current project
« Evenifitisnotempty

« Evenifyoudo not have permission to remove languages
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Create a Table Rendering for Text Documents

You can configure a Text statement as document references and add them to a Project or Document
Attribute category. The configuration and rendering are similar for Task Specifications.

For each Copy Sheet (Product Content Sheet), which has Text Content documents as reference, you
can make different configurations to show text related data using advance table rendering option."

1. Create a Table Rendering.
2. Inthe Edit Rendering Configuration pop-up:

Configure The result in the rendering table will be...
Master Text or Translation Master Text Statement or the Translation Text is shown in
Text a text widget along with its content in the edit field and all

related text content actions.

Note: The Visibility should be specified as Editable if you
want your users to edit the text. One or more columns can be
configured for the Master or Translations of the Master Text.

Master and Translation languages will either appear in a drop
down or you can choose Show Side by Side view.

You can also restrict the languages that will appear in the
drop down, by mentioning the languages ( pipe separated)
specifically in the details tab.

Text Language Flags The language drop downs for Master and Translation Text
columns.

Note: The master and translation languages are populated
from the project attributes MASTER_TEXT_LANGUAGE and
TRANSLATION_TEXT_LANGUAGE respectively.

Tip:

You can specify a default language code for Text statements. The selected language will be the
default in the document reference table. If default language is not specified, the first language from
the language drop down is selected as the default. WebCenter also supports right to left languages
like Arabic and Hebrew for text content.

3. Specify the width for Master Text and Translation Text.By default, the width of every column is set
to Auto. However, you can configure the width for the Document Name, Master Text, Translation
Text and the Translation Languages.
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Tip:

To change the width of the columns, specify pixels or a percentage (of the width of the table).

If the label of the column is too big for the width specified, the column width will be bigger to
accommodate this.

Edit Render Configuration

Name: PCM Text Reference_Default

) Hide Header

Open Links in new Tab
O Allow Bulk Operations
Limit Bulk Operations to Document References with matching Operations configured

1. You can also enable the Display Options in the Edit Render Configurations. You have four icons

Type

Document Property

ocument Name

Replace Buiton

Reference Property

Reference Property

Translation Text

Master Text

Delete Button

-

Details
Thumbnail
B Show Document Source
[ Show Document Description
L] Show Folder
[ Snow Document Template
Compact Rendering
ARTWORK_VARIABLE

INSTANCE_SEQUENCE

O Show Side by Side

DisplayOptions & &£ Q @

O Show Side by Side

DisplayOptions @& & @ @

Add Column Revert to default configuration

v (50 v px

Label

Thumbnail

Name

ARTWORK_VARIABLE

Instance Seq.

Translation Text

Mastar Text

Visibility

Read Only

Read Only

Read Only

Editable

Editable

Editable

Editable

Read Only

Width

auto

100px

auto

auto

75px

600px

E00px

auto

Collapse
O

buttons and are active by default.

« Status Button Show status column in default manner like basic view page when active. When
the button is inactive it shows status in the form of a colored strip based on the status of the

content. Green for approved, red for rejected, blue for pending approval and grey for draft.

« Inheritance Button Shows the inheritance icon when active.

« Comments Button Shows the comments icon button when active.

« Approval Info Button Shows the approval info button when active.

While Rendering of Master and Translation Language, if all the button options are disabled and
there is no message to show then more options “Ellipsis” button will also not be visible.

Configure the display of Text Language Flags. You can configure the Display as Show only Flags or
Show Flags and Languages.
These flags will be based on the Project Language Attributes.

335



ESKOS —

« Inthe copy sheet view, all the newly created text documents will have the current Project's
Language attributes as flags. You can read about how to customize flags for languages here.

- Allthe sourced content (referenced from other Projects) will have the flags based on the source
Project's language attributes. To add the current project's languages, select them from the
available flags.You can add or delete flags in this view.

5. You can allow the users to move areferenced document into the current project. To set this up,
create a column with Local / Remote setting. Specify the visibility as editable or read-only. You
can move all the referenced documents into the local project by hovering on the Location in the
header and selecting the option Copy All References into Current Project.

-+ Upload + Link -+ Search + Search

[=] Location = Thumbnail Name Version

opy All References into Current Project

Reference M Allergen statement

[r] ‘
RS ¢ TN (000 Textboc 00000814 PCMwee & & !
. __ Reference | | Best before date Q 3 8(F)
il © "SI 123Best before date.wce —
Reference M Dosage instructions
s :
N 123Dosage instructions.wcc Q2 !
eference JiH NCarrot11.p = =
R f s — IIC tl 1 df q " 1 t
= A
E=
e 1 LL
- 000000002 _Mutritional Facts_C.wcc Q i T
——

You can move any of the referenced document to the local by clicking on the Referenced field of the
required document and selecting the option Copy to Current Project.

[=] Location = Th

£ Copy to Current Project
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The users need to Change Properties and Add permissions to move a document to local folder. The
document reference will point to the local copies.

The user will be able to specify:

« anewname and description
« document template
« target folder

If the setting is Read-only, the user will see E'E indicating remote project.

If you are configuring Local / Remote button to allow copying of documents, ensure that you have
enabled or disabled Retain text document status.

When this option is turned off, if you copy to Local, the approval status of the Text Document is
reset to Draft.

If Retain text document status option is turned on when you copy the document, the document's
approval statusisretained as it is.

Define adequate permissions to view and edit Text Statements.

Whether or not your user can edit or perform approval actions on a Text Element is determined by
the following settings and permissions:

+ Visibility should be specified as Editable.

« If your Text Document Reference is a child of another document (for example an artwork), the
Expand Attributes (+) column of the Parent document should be configured as Editable.

« Theuser should have appropriate Content Permissions. Read more in: Managing Text
Permissions on page 456.

Tip:

Check these Project level permissions (Project Details > Security) to troubleshoot editing
problems:

« Change Properties

« Start/Stop Approval
« Upload new version
« Change Task

- Download

+ View

- Add
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Note: The Text widgets, related languages and statuses are rendered only for Text Document
References.

16.5.6. How to Create a Functioning Document Reference System

338

You can make use of Document References to specify product and its components or master-child
relationships. Using this feature, you can create an attribute link to refer to a document that is located
within another project or a document library.

This advanced feature allows you to create a system of references (like a "hanger" for your related
assets)to keep a product and its parts together even when they are not located together. For example,
the CAD file, the artwork, the die and its leaflet. For a display, its language variants, parts and artwork
together.

Artwork

)

)

To create such document reference system, you need:

« Reusable components stored in the form of libraries

« Document Templates

« Version/ Revision aware Document Reference Attributes and other Attributes

« Attribute Categories with your document reference attributes and other types of attributes

Follow the steps below to create an advanced document reference system.

1. Create WebCenter Projects as Libraries and organize your assets in them.

Examples for your libraries

« Structural design files for your packaging shapes
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Project: DEKE_DSR_Box_Library

Manager: Keizer, Debbie (DEKE)
Customer:
Due On:
Modified: May 13, 2015

Description:

ks (0) | Discussions (0) | Characteristics | Attributes | Project Information

Documents (15) Actions v

~&L (L

BOXCO_00001.ard (28KB)

BOXCO_00002.ard (28KB)

BOXCO_00003.ard (28KB)

BOXCO_00004.ard (28K8)

Boxes002.ard (28KB)

Graphical design files from the creative agency

Standard design elements such as your brand logo, company logo etc.
Symbols such as recycle symbols, warning symbols, Quality Symbols etc.

Text Content Documents

Project: DEKE_Icon Library

Manager: Keizer, Debbie (DEKE)
Customer:
Due On:
Modified: Mar 27, 2015

Description:

5 (0) | Discussions (0) | Characteristics | Attributes | Project Informa

Documents (18) Actions »

C€

7

Agel-3.png (167.1KB)

CE.png (52.6KB)

Dishwasher.png (58.4kB)

Fairtrade.png (86.4KB)

Flammable.png (28.5kB)
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- Barcodes

To organize further, you can create advanced saved searches or SmartName searches.
2. Create your Attributes and Attribute Categories for the specification / packaging request.

For example, Production quantities, count, budget, material type, ink coverage, color, language
variants, Barcode etc. Read:

+ Create a Document Reference Attribute on page 307

+ Reference Category on page 310
3. Create Document Templates with Attributes.

Your Project Managers can use Document Templates on page 95 as document placeholders for
future project documents.

Document Templates

Please select the Template or Project that will serve as a Document Library:

Select: O po not use a Document Library
Template
® Project DEKE_DSR_Standards_Library -

When the Document library contains ARD files, how do you want to use these ARD files when creating a new Document?
* plways run the ARD as a standard
Run the ARD as a standard when the IsStandard Attribute is set to 'yes'

Mever run the ARD as a standard

Save

Note: Link to the document templates in document creation settings of the Project Template.

4. Create your document reference attributes and enable advanced features in grid layout.

a) Select document reference as the attribute type. reference category attribute (such as count)
of the link. Read: Create a Document Reference Attribute on page 307.

Examples:
« Specify the version / revision of the document it should refer to.
« Specify areference category if you have properties that are specific to a document

reference link. For example, count.
b) Add the document reference attribute to an attribute category.

« You can make the attribute read-only / editable / required by setting the visibility.

« You can create a document reference where the user can add multiple documents by
enabling allow multiple values.

« You can use all the advanced features available in the grid layout.
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Edit Category DEKE_Artwork
Name
DEKE_Artwork
Current View: | Default v] Add Creation View Add Header View Add View @ Edit Te
| Alternating background
) Show also Attribute types and Restricted Set types
|l Keep session alive (avoid that people get logged off due to time out)
. Remove Grid Layout
Attributes: . e . = i = m (&
- = : ][ —
2 | TR [T 7= |TE|[TEH || TH | Insert:|TE|TE | 7T || == || ]
$dl$Dicline ) - [Title]Contact Information -
$dl$DocumentLink1 |:|
$dl$DocumentLinkRich DEKE_Contact_DocRef | |
sdlsMaterial
5
sdIsPOA [Spacer]
sdlsSearch [Title]CAD
*tema_Rich_Text
00 Change Category CAD_REFERENCE | |
00 Change Order Number [Spacer] ‘J
00 Change Type )
00 Description s [Title]Color h
00 Description of Changes << DEKE_Ink DEKE_ICC Profile @
00 Initiator = | = | =%
00 Ttem Category [Spacer] » |
00 Item Number [Title]Icons
00 Reason
00 Workflow DEKE_Icons
1 [Spacer]

1 Admin per design

1 Correct delivered AP
1 Courier charges TRN

1 Analog flexo clichee / colour

Save As Copy

[Title]Text Content

PEKE Tawk Cantant

Details for selected cell:

Attribute CAD_REFERENCE
Attribute Type: DocumentReference
Label Text:
Label: Label Image:
Position: Top ¥
Span Columns: 17|
Bold v |
Style: -
Y Add Stvle Edit Stvle Delete Style
o Editable M
Visibility : |
v 2dd Rule

Allow Multiple Values:

Reference Category:

CAD_ALIGNMENT_ATTRIBUTES

Version Mode:

Selected Revision

Document Source(s):

CAD_REFEREMCE_Default Q’
Edit Configuration

[Table v]®

Rendering: CAD_REFEREMNCE_Default
Edit Render Configuration
Info HTML page (name+extension)
Info Page: < WebInstanceRoot=/custom/AttributesHelp/

c) Configure the document sources for the references. Choose the operation(copy, link, move, or
use by reference). Read more in: Adding Document Sources for a Document Reference Attribute

on page 316

The document references will be shown as links in the final rendering as per the document
sources settings you configure here.
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CAD

Select CAD from Library Upload CAD file Reuse from Current Project

Color

Add Ink(s)

Icons

Add Icon(s)

+ Createacustomlabel suchas Select CAD from Library.

« Specify the source of the document. For example, a saved search.

Edit Document Sources Configuration

DSR_Doc_Default

Source Label Details. Operation Target Folder
®  [Browse ] [Simple ¥ ][Upload Box ] Allowed Extensians: Upload
Document template selector: [ No document template selector v]
® + [Saved search v] [Simple ¥ |[add Box from Library | search Name: * DEKE_DSR_Box_Library v] @ copy caD
Document template selector: [No document template selector v] Link
¥ Move

¥l Use By Reference

® ~ [Document Templates ¥] [Simple ¥ |[New Box from Standard | Document template selector: [ Limited options for document template ¥ Copy
Template(s): [Box1.ard,Box2.ard,Box3.ard,Box
Add Document Source

« Specify the type of operation you would like your user to do. You can configure copy, link,
move or use by reference.

Configure how the documents should be listed and whether the users can modify some of the

document properties. To do this, create an advanced table rendering.

o
—

5. Create Project Templates and apply the document reference attributes and other attributes in an
attribute category.
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4= | Source

Upload Artwork:

Contact Information

Add Contact from Library

CAD

Select CAD from Library

Document Template

Choose Fie | FireWors_wi_vr_clip2.pdf | Pantons CMYK Coatsd

Praview CAD fil

Select CAD from

Board Version

Approval
Status

v

pload CAD file Reuse from Current Project B

Library _
& 1 @
| T [ —
fire.ard
Color
(s)
Add Ink(s
#= Ik | InknName Hex Ink Coverage (%)  Opaque?
+ - . Pantone Process Cyan C zoofff [ ]
# . Pantone Process Magenta C
. Pantone Process Yellow C 1
E . Pantone Process Black C zooooo0 [ ]
Icons
- Add Icon(s) (Reference): CE.png ®

Recvcle2.png

PRV PN
e JaEhA

Add Icon(s) (Reference): Dishwasher.png (X

®

Folder

Name

WebCenter

Description

Default (template) ¥ | |FireWors_window_elip2.pd ®

Offset X OffsetY  Orientation

Select 1CC Profile for Proof
Standard
printing
condition

Profile

. 150 DIS
CGATS21 CRPCh.ict 153395

Separation

TAC: 320%
GCR: Medium+
Max K: 100%
TVI: CMY 16%,
K19%

+ 1.CADdocuments are rendered in a Table configuration. The header contains custom labeled
document sources. You have editable reference properties such as offsets configured in the

table.

« 2.Thecustomized add ink link will take you to the inks library to choose your inks for the

current project.

+ 3.The configured Add icons link will take you to a saved search. This document reference
attribute is rendered as Simple. Therefore, the references appear as a list.

You can have documents stored in the local folder or referred in document reference links.
However, the user gets the view of both the local and referenced documents together.

16.5.7. Referenced Property Filter

Reference Property Filter (RPF)is a restricted view of the reference property attribute category. It
filters the attributes that are both part of the Reference property Attribute Category and the Project
Attribute Category. For example,
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RFF 2
_ RPF1 |
el
Symbaol 1 Earr{‘ode
RFF 2

image 1 ,

URPF1} IRPE1 RPF2 | RPF2 mege 2
/ SRS EESEEEN

Text 1 Text 2 Text 3 Table 1

Multiple products or artworks can reuse the same content like text, recipes, images and so on. To
specify the context of using the content as reference, you have to filter the context, in which the
content sheet can be used in the artwork. To know more about Product Content Sheet, read Product

Content Sheet.
Configuring Reference Property Filter

Reference Property Filter is available only, when a reference property attribute category is defined
for the Document Reference Attribute. It will show the attributes in the reference property attribute
category which are also present in the Project Attribute Category of the document or in a Bocument
Attribute Category and have values.
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This configuration is used to display the column of the reference
properties which defines the reference property filter of the document

+ Upload + New =+ Link =+ Search

Thumbnail Name Scope Flavour I Scop

Chocolate % ML
B Variant

Variant_1 . wce

Apple + Lime Twist 3
Tropical Blend 3

B Marketing copy Apple + Lime Twist X ML
Marketing copy_3.wcc

Tropical Blend ¥ ML
B Marketing copy Coconut & Berry X

. ry

Marketing copy_4.wcc
B Recycle statement Apple + Lime Twist X Sin
Recycle statement_1.wee

Strawberry X ML

B Marketing copy
Marketing copy_3.wcc

reference.

Note:

Itis important add the values as attributes in the Project or Document to render the same in the
Reference Property Filter.

In the above image Scope Flavor and Scope Outputs are the Reference property Filters and the values
Chocolate, Apple+ Lime Twist or multipack are the attributes defined in the attribute category of the
project.

Reference property is allowed to have the values only from the project attribute category.

Viewing Reference Property Filter
Reference Property Filter can be viewed in the Attributes tab of a Project or Document.
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=+ Upload =+ New

Thumbnail Name

W Variant

Variant_1.

== Link =+ Search

Scope Flavour

Chocelate 3 Apple + Lime Twist X
Tropical Blend M

B Marketing copy Apple + Lime Twist X

Marketing copy_3.woe

WebCenter

Scope Output

Multi Pack %

Multi Pack ¥  Single Pack X

In the render configuration for the header row, the details and the label are not applicable and the width
is always set to auto. You can collapse or expand the columns to view.

16.5.8. Copy Document References
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You can create new projects from the template projects with an option to copy all the document
references along with them. You have both the option to copy only the local references or copy all the
references in multiple levels.

You can use this also in Task Specifications, "Documents" section of Project Creation page and Task

Execution page.

While copying, along with the documents all the attributes including their values are also copied.

To enable copying of the Document Reference Attributes, the Document sources in the Attribute
Category of the document has to be configured.

Edit Document Sources Configuration

ANKR_ATTR_DOCREF2_Default

Source

[x] Saved Search
v
a

o Saved Search
R
a

] Document Templates
v
a

[x] Current Project

Add Document Source

Label Details

Search Mame = SOBK_Image Search -
Simple -
Document Template selector  Any Document Template configured -

Basic Copy
Copy Operation | Basic Copy - 9
SearchName = SOBK_Graphics & ArtiosCAD Library Search  »
Simple -
Document Template selector  Any Document Template configured -
Deep Copy
Copy Operation | Copy with Local References - D
Simple = Document Template selector  Any Document Template configured -
Deep copy All Copy Operation | Copy with All References - 0
Basic Copy
Standard Copy with Local References
Copy with All References
Link -

Operation

¥ Copy
Link
Maove

Use By
Reference

4 Copy
Link
Maove

Use By
Reference

Copy

Link

Target Folder

Folder2

Folder1

Only the following document sources can be configured for Copy Action:

« Document Template (New)

« Saved Search
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« Copy from Project
There are three options to copy that you can configure namely:

« Basic Copy - Only the selected document is copied to the destination project. Document references
of the newly created (copied) documents are set to reference the same documents as the original/
source document(s).

- Copy with Local References- Selected document and all documents referenced by it that are from
the same source project are copied to the destination project.

«Copy with All References Selected document with all document it references are copied to the
destination project, irrespective of the project it is located.

Note: Copy Actions are not supported in BOM documents tables/sections and also when copying a
document from Documents page in Project Details.
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17. Create Assembly documents using
Document References

348

Assembly document is a component document that consists of a bunch of document references
namely a structured document (a 3D model of a product with defined printable parts as attribute values
to that document)and graphical references to the artworks required, that can be viewed and edited

in the WebCenter Viewer.This is one of the critical and most important step in the process of creating
and viewing pack shots in WebCenter.

Follow the steps below to Create Assembly:

1. Create a Saved Search for collada files( structured documents). Collada files should contain the
printable parts referenced ( added to it).

2. Create an attribute category representing the assembly called DEFAULT ASSEMBLY CATEGORY.
3. DEFAULT ASSEMBLY CATEGORY should have two Document reference attributes namely

a. CAD_REFERENCE attribute that can contain only one document.

b. GRAPHICS_REFERENCE should have areference Category, e.g CAD_REFERENCE_PROPERTIES,
that contains the following attributes. These attributes should also be added in the rendering
configuration.

CAD_PRINTABLE_PART
CAD_PRINTABLE_PART_SIDE
CAD_PRINTABLE_PART_NAME
CAD_FINISHING_PROFILE

GRAPHICS_REFERENCE should be configured to accept more than one document as it can
contain references to the multiple labels ( like front, back, top) required for the structured
document.

U

Using the specified Attributes and Attribute Categories, users with Add and Change Properties
permissions can create an assembly file from a structural file. Upon selecting the Structure
document, an Assembly document is created, containing the selected Structure Document in the
CAD_REFERENCE attribute, and placeholders for graphics documents in the GRAPHICS_REFERENCE
attribute, based on the printable parts of the Structure document. Before submitting the form, you are
already able to replace these placeholders with the actual artwork.



ESKO

WebCenter

Value
+ Upload =+ Link + Create Assembly

B Thumbnail Name Versicn

Azssembly
g : Asser 1ANS_EDIPAL Deseription 1
Aot -

CAD REFERENCE

+ Link + Select Collada
# = Thumbnail Name Version Location =

Use by Reference

CANS_SIXPACK zae = JR=3F 3 1 S, Reference

GRAPHICS REFERENCE
+ Search + Link
¥ = Thumbnail Name CAD_PRINTABLE_PART PRINTABLE_PART_NAME PRINTABLE_PART_SIDE CAD_FINISHING_PROFILE

Placeholosr W@ Resoulces Objeci_Can_z50ml-pr Print area back
+ = (] esouces OBjeeI0_Can_250ml-pri firv area e
Placeholder =
+ PiInt area L] Resources Object0_Can_Z50ml-pri Print area front

Placeholder _
+ Sleeve L] Resources_Object3_Object3-Sleeve Sleeve front

}

CAD_OFFSET_ANGLE

Default Assembly Category has a Saved Search configured as a Document source with Create
Assembly as an operation.

Create Assembly document operation can be used in all places, where Saved Search is used as

a document source within a Documents table. You can set a different default target folder for
Placeholder documents and Graphic documents when you are configuring the document source of the
(document reference) attribute.

Operation Target Target Folder
_1 Copy
] Link
Add
] Move
Replace

"] Use by Reference
Create Assembly
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18. CAD Options

Use the CAD menu to set options related to working with ArtiosCAD.
WebCenter allows you to:
« create a CAD document from a standard directly WebCenter

« view the CAD documents with folding angles in 3D

« view CAD documentsin the Viewer
« search for CAD documents

18.1. CAD Download Format

Synchronize with Defaults

WebCenter administrators can download ArtiosCAD files in different formats as specified in Defaults
of the ArtiosCAD instance running on the Application Server.

On the CAD > CAD Download Formats page, you can enable or disable download formats for all users.

Click the Synchronize button to import the settings from ArtiosCAD Defaults. A successful status
message should appear after a few moments, and the list of formats is populated. Select the formats
you want to make available for the users.

Note: The three native ArtiosCAD formats (ARD, MFG and ACD) do not require any configuration.

Download formats and users

User and group permissions for the download formats are set in Users > select user > Download and
Groups > select group > Download, respectively. You must set permissions on the formats before
users can download documents.

Note: Members of the Admins group are granted all download format permissions by default, and the
Change and Use Group Permissions buttons are unavailable when attempting to change permissions
for those users.

Non-cached ArtiosCAD Download formats

The WebCenter configuration has been extended with an option to not cache specific download
formats to support dynamic ArtiosCAD download formats.

Currently, the CAD Download Formats for a given document version are by default generated and
cached in the system when first downloaded by a user. Subsequent users downloading the same
download format get the same cached file. The caching behavior is controlled for every CAD document
type and download format.

Examples of dynamic download formats where turning caching off could be needed are Bill of Materials
reports and reports that are based on meta-data that can be edited directly in WebCenter.

To turn off the caching for a given document type and download format:

1. Goto Admin > CAD > CAD Download Formats.
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2. Gototherespective document type and download format and unselect the respective check box.
3. Save the changes to disable the caching and delete any cached data for the selected download type
and document format system wide.

There is no Cache option for the ArtiosCAD format (native document) as this format is always available.

Boards

18.2.1.

The CAD > Boards page shows the types of boards that can be used for CAD designs (paper, corrugated
board, folding carton...).

These boards are defined in ArtiosCAD. They cannot be edited, created or deleted from WebCenter.
However, you can set the boards' default location(s) and use them in a Restricted Set.

Assigning a Board to a Company or Location

You can assign a specific board to a Company, or a Location of that company.

1. Inthe CAD > Boards page, browse the Boards tree to find the board you are interested in.
2. Click that board to show the Edit Default Locations for board ... page.

Note: You can only assign boards to companies/locations, not boards folders.

3. Onthat page, select the companies/locations to associate with this board, and click Finish.

Tip: If you want to assign this board to all companies/locations, select the checkbox next to
Company at the top.

The users in these companies/locations will see the board as default.

18.2.2. Creating a Boards Restricted Set

18.3.

You can create a Restricted Set of boards, so that users can pick from a short list of relevant boards
when creating a design.

To do this, click Create Boards in Restricted Set, then add boards to the Restricted Set as explained in
Create a Restricted Set on page 24b.

Note: The data Type is always Text in a boards Restricted Set.

Run a CAD Standard from WebCenter

A CAD standard is a default ArtiosCAD document, to be customized with parameters supplied by
the user to make a design. This will be a 2D design, that can be made 3D if the standard has fold
information.
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In WebCenter, an ARD document template is used as the CAD standard, and attributes are used as the
parameters needed to make the design.

In practice, you create a new document from the ARD document template, filling in the template's
attributes' values to give your parameters.

CAD Standard Configuration

You need to:

1. Setup an attribute category containing the attributes necessary to create the design, and their
default values.

2. Setupadocument template with this attribute category.

Create an Attribute Category

You will need to create attributes that match the CAD standard's parameters in ArtiosCAD. They must
have the same name as the corresponding parameters, and any parameter required in ArtiosCAD must
translate into a Required attribute in WebCenter.

Generally, you will use at least BOARD (this is always Required), and mostly L (length), W(width)and D
(depth).

BOARD parameter: Creating different board attributes will allow the usage of different board restricted
sets. Attributes will be selected by WebCenter, if the name of the attribute starts with "BOARD".

Other parameters are less standardized. You need the person who built the standard to clearly indicate
which parameters are needed.

Here is an overview table of the attributes you will probably need the most:
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template should be used to run CAD
standards or not.

« ARDdocument templates to be
used for CAD standards should
have YES as ISSTANDARD value.

« ARDdocument templates NOT to
be used for CAD standards should
have NO as ISSTANDARD value.

Attribute Use case Values
BOARD The type of board to use for the A Restricted Set of Text type.
design. Set your desired values in the
Used for every CAD standard (thisisa |Restricted Set.
Required attribute).
L WandD Length, Width and Depth. Prompted values (the user
Used for most CAD standards. C?n set what he/sh(.e Wants).of
Distance(in,mm), Distance(in,m) or
Float type.
ISSTANDARD Toindicate if an ARD document A Restricted Set of Text type.

The values in the Restricted Set must
be YES and NO.
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Attribute Use case Values
This should be a Hidden attribute.
UNITS To set units other than the user's A Restricted Set of Text type.

default units. The values in the Restricted Set must

If no unit is set, the standard will be be mmand in.
runin the units set in My WebCenter >
My Preferences by the user. Note: Value of the Units attribute is
not considered when using distance
attributes for L,W and D.

ISCORRUGATED To indicate whether the resulting A Restricted Set of Text type.

design should be corrugated. The values in the Restricted Set must

If this attribute is not present, the be true and false.
design is understood NOT to be
corrugated.

GRAIN Toindicate the direction of the flute/ |A Restricted Set of Text type. The
grain of the design being created by  |supported values for this attribute are
running the standard. Horizontal, Vertical and Standard.

If the value chosen is Standard, then
the created design will have the same
flute/grain direction as the Standard
that is being used.

If no value is mentioned, then vertical
is taken as default.

SIDE To indicate the print side of the A Restricted Set of Text type. The
design thatis created by running the |supported values for this attribute
standard. are Inside, OQutside and Standard. If

the value chosen is Standard, then
the design created will have the same
print side as the standard that is being
used.

If no value is mentioned, then the print
side will be Outside.

1. Create the Restricted Sets needed by your attributes as listed in the table above.
See Create a Restricted Set on page 245 for details.

2. Create your attributes(the ones listed in the table above as applicable, and any other attribute you
may need to run your particular CAD standards).

Assign the relevant Restricted Sets to your attributes. See Create an Attribute on page 247 for
details.

3. Create an attribute category containing all the attributes you have just created.
4. Adda Creation View to your attribute category and click Use Grid Layout.

a) Make the BOARD attribute Required.
b) If you are using the ISSTANDARD attribute, make it Hidden.
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c) Change the Visibility of your other attributes as desired.

Tip: You can add use a Label to change how your attributes appear to the user (for example, you
can show the L attribute as Length).

Note:

If you want to work with several CAD standards, you can either reuse this attribute category for more
designs, or create more attribute categories.

Create an ARD Document Template
You now need to set up an ARD document template using the attribute category you just created.

For this, you need to use an ARD document corresponding to the CAD standard in ArtiosCAD (same
default design).

Set up your Document Library as explained in Create Document Templates on page 95.
Upload your ARD file into the Document Library.
Link the attribute category you just created to this ARD file.

R N

Point to the Document Library in:

« existing projects in which you want to create a design from a CAD standard,
« project templates that will be used to create projects with designs from CAD standards.

See Create Document Templates on page 95 for details.

18.3.2. Run a Standard in an Existing Project

To create a design from a CAD standard in an existing project:

1. If your project isn't already linked to the Document Library:

a) Inthe Project Details page, click Configure then Document Templates.
b) Select Template, then select your document library in the list.
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Documents asks Attributes Project Information Approva Members Security Configure
Workflow Connection Document Templates  Project Creation ~ Document Types  Document Creation Project Statuses
Please select the Template or Project that will serve as a Document Library
Do not use a Document Library
Template
® Project | PCM Text Templates -
When the Document library contains ARD files, how do you want to use these ARD files when creating a new Document?
® Always run the ARD as a standard

Run the ARD as a standard when the IsStandard Attribute is set to 'yes'

Never run the ARD as a standard

c) Under When the document library contains ARD files..., select either:

Note: Run a Standard option for CAD documents is available with WebCenter Life cycle
Management license.

« Always run the ARD as a standard if you want to be able to use any ARD document template
in the document library to run a CAD standard

« Runthe ARD as a standard when the IsStandard attribute is set to 1if you only want to use
some ARD document templates to run CAD standards.

These ARD document templates must have the ISSTANDARD attribute assigned, with the
default value set to YES (see Create an Attribute Category on page 352).

d) Click Save.

2. Create adesign from your ARD document template:

a) Click the Upload button.

b) Select New in the Source list and select your ARD document template.

c) Fillin the Attributes as desired.

For example, specify the BOARD to use, and the L (length), W (width) and D (depth) of the design.
d) Click Upload.

Note: This is only possible through the normal WebCenter upload (see Uploading a Document
via Upload and Copy / Create Multiple Documents), not the Java applet upload or when uploading
documents from other applications like Automation Engine and ArtiosCAD.

Your design is created. You can click its thumbnail to view it in the Viewer.

18.3.3. Run a Standard at Project Creation

To create a design from a CAD standard when creating a project from a project template:

1. If your project template isn't already linked to the Document Library:

355



ESKO

WebCenter

a) Inthe Project Details page, click Configure then Document Templates.
b) Select Template, then select your document library in the list.
c) Under When the document library contains ARD files..., select either:

Note: Run a Standard option for CAD documents is available with WebCenter Life cycle
Management license.

« Always run the ARD as a standard if you want to be able to use any ARD document template
in the document library to run a CAD standard

« Runthe ARD as a standard when the IsStandard attribute is set to 1if you only want to use
some ARD document templates to run CAD standards.

These ARD document templates must have the ISSTANDARD attribute assigned, with the
default value set to YES (see Create an Attribute Category on page 352).
d) Click Save.

2. When creating a project from your project template:
a) Click New in the Documents section of the Create Project page.
b) Select your ARD document template from the pop-up and click OK.

Please Select a Document Template

Filter Total Documents: 4

C v Box1.ard
-
' Box2.ard
—
' Box3.ard
J Box4.ard

Cancel m

Tip:

If you have many ARD document templates, use the Filter field to filter them alphabetically on
the file name.

You can also filter them based on document characteristics if you have created a custom project
creation page to do so(see Create a Project and Run a CAD Standard in the Customization Guide).

c) Fillin the attributes to use in the Documents section.

For example, specify the BOARD to use, and the L (length), W (width) and D (depth) of the design.
d) Fillinthe rest of the project settings as desired and click Create Project.

Your project containing your design is created.
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18.4. Canvas related Attribute Categories

A document reference attribute and two attribute categories are created by default in WebCenter
during the installation or upgrade.

These will create a document reference system to contain different Canvas parts saved to WebCenter:
« The default document reference attribute named as CANVAS PARTS.

« This default empty CANVAS REFERENCE CATEGORY. This category will contain the reference
attributes associated with the CANVAS PARTS attribute.

« The default DEFAULT CANVAS CATEGORY will contain the the CANVAS PARTS. This allows the
ArtiosCAD Enterprise client to save managed parts as individual document reference values.

Note:

During an update, these attributes will get created if they do not exist yet.
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19. WebCenter Configuration

The Configuration menu contains entries for configuring e-mail notifications, LDAP authentication,
push-through folders, BackStage / Automation Engine Approval clients, the System Info page, etc.

19.1. Configure E-Mail

You can set up e-mail configuration using the Admin module. All changes to the setup are effective
immediately.

1. Click Admin > Configuration > E-Mail Environment Setup.

E-Mail Notifications

E-Mail Service Protocol ~ SMTP
@ EMail functionality enabled
@ E-Mail debugging output in log
E-Mail Service Host* | smtpmail.esko.com
E-Mail Service Port Number* | 25

Outgoing E-Mail Notifications' "FROM’ | webcenter@esko.com
Address *

ssssssss

E-Mail messages queued/submitted  0/0

m Send Testing E-Mail

2. Provide the required e-mail settings:

Configuration Option Description

E-Mail Service Protocol Set to the SMTP protocol.

E-Mail functionality To enable/disable e-mail functionality.
enabled

E-Mail debugging output | To enable/disable e-mail debugging output in log files.

inlog

E-Mail Service Host Address for the preferred mail server that will act as the server for
dispatching e-mail notifications.

E-Mail Service Port Port number on which the e-mail server is listening for incoming e-

Number mails.

Outgoing E-Mail Supply a valid e-mail address. This will be used as the "From" e-

Notifications "FROM" mail header for every e-mail sent by the system. This information

Address is important for returning undelivered mail (the filled-in address

should belong to the administrator, since he will most likely be
addressed with undelivered mail for troubleshooting).
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Configuration Option Description
E-Mail Session Select this option if the mail server connection session should be
Authentication authenticated using a username and password.

E-Mail Service Username | Mail account user name when authentication is required.

E-Mail Service Password Mail account password when authentication is required. The
password is stored in encrypted format.

Click Send Testing E-Mail.

4. Edit the contents of the test e-mail if required.

Click Send E-Mail.

A response will appear stating whether or not the e-mail could be sent successfully. There are 3
possible outcomes of the e-mail environment testing page:

+ Test E-Mail Sent: The environment is set up correctly.

« JMS System Error: Communication with the JBoss proprietary messaging framework failed. An
administrator should check the JBoss server configuration and/or log files for possible causes.

- Mail Server Connection Error: The connection to the specified mail server did not succeed.
Either the data the administrator supplied on the e-mail environment setup page was
incorrect, or the mail server is currently down. An administrator should either check the e-mail
environment settings for possible misspellings or contact the mail provider as to the status of
the mail server.

If necessary, return to the configuration page and correct the settings.

Note: System History Logs All changes/events in this page are recorded and stored in the System
History page for Administrator users. Read this page on how to access the records.

Configure Search Crawler Setup

You can change the Search Crawler Setup from Admin > Configuration > Search Crawler Setup. All
the below mentioned actions can only be performed by the Admin users.

1.

2.

Enable Rebuild Index on Restart option to allow or disallow rebuilding the index upon search
crawler restart (default is enabled).

Enable Index Document Revisions to index all the Document Revisions. If this is not enabled, only
the Latest Version for every Document is indexed. If this option is enabled, users can search for the
revisions on the Document Search page.

To skip the indexing of Workflow Tasks, you can disable Index Workflow Tasks. Changing this
option will trigger re-indexing. When this option is disabled, you cannot search for workflows in the
Task Search.

Enable Index Any level Document Reference to search the entire Document referenced within
WebCenter and return in the search result when the document search is executed.

Enable Index all currently referenced Document Versions to add the earlier versions of the
referenced document to the search index. The index will be rebuilt once this option has been
changed in the setup.
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6. Enable Index all currently referenced Document Versions to add the earlier versions of the
referenced document to the search index. The index will be rebuilt once this option has been
changed in the setup.

Status

Last crawl activity shows the date and time of the last search crawl activity and Crawl Tasks
Waiting shows the pending crawl tasks.

Note: System History Logs All changes/events in this page are recorded and stored in the System
History page for Administrator users. Read this page on how to access the records.

Index Live Text in Documents

Search Crawler Setup in the configuration menu has an option choose whether to Index Live Text in
Documents or not. This allows enabling or disabling of Document Content indexing which is disabled
by default.

Changing the state of the option, results in a full re-indexing of the document content. In such a case,
Documents are not re-indexed but only the document content is re-indexed which means Document
Search will find all results while the document content indexing is ongoing.

Note: When the option is turned off, the search index with document content is cleared to save space.

Configure External Web Connections

19.3.1.

360

An external web connection is a connection to some data in an external system (usually a MIS
system). The MIS system calculates the data (for example the cost/price information for an order) and
WebCenter retrieves this data through the external web connection and displays it on a WebCenter

page.

After configuring the external web connection, you can choose to add a link to it in a WebCenter top-
level menu, project menu or a My Work section. See the Customization Guide for more details.

System History Logs
All External Web Connection events like
- External Web Connection Created
+ External Web Connection Deleted and
« External Web Connections Changed

are recorded and stored in System History. Read this page on how to access the recordsSystem History
on page 386

Create an External Web Connection

1. Go to Admin > Configuration > External Web Connections.
2. Click the New External Web Connection link in the External Web Connections page.
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3. Enter the Name to give your external web connection.

4. Enter the URL of the data you want to retrieve in your external system. This needs to be accessible

by either the WebCenter Application Server or Web Server.

You can use SmartNames in the URL. The supported SmartNames are:

- all basic project properties(see List of Available SmartNames on page 404),

» all project attributes,

« Requestor SmartNames ([ Requestor UserName], [Requestor Location], etc...). Here,
Requestor indicates the user who is logged in.

These SmartNames will be resolved when activating the connection, depending on the context.
This means that for example:

« ifyouareusingthe [Requestor UserName] SmartName, it will be resolved to the name
of the user currently logged in to WebCenter (the one clicking the link to the external web
connection).

« ifyouareusingthe [Project Name] SmartName, it will be resolved to the name of the
current project.

So if you are using an order ID as project name and you want to connect to an external system
containing information about that order ID, whose URL ishttp://ExternalSystem/
OrderInformation.jsp,thenyoucanuse http://ExternalSystem/
OrderInformation.jsp?orderID=[Project Name] as URL here.

This will be resolved to for example: http://ExternalSystem/OrderInformation. jsp?
orderID=Order 832809.

Note: When using SmartNames, you should take into account where the connection will be used
from (where in WebCenter it will be integrated).

« You can use user-related SmartNames (such as [Requestor UserName])if the connection is
to be added to a top-level menu or a My Work section.

« You can use user-related and project-related SmartNames(such as [Project Name])if the
connectionis to be added to a project menu.

See the Customization Guide for information about integrating a link to an external web connection
into the WebCenter user interface.

In Type, select if your external system outputs HTML or XML.

Note: If your external system outputs XML, you will need an XSL (eXtensible Stylesheet Language)
file to transform this to HTML and display it in WebCenter. Your WebCenter installation comes with
an example XSL file, that you can customize.

See the Customization Guide for more details.

Click the Test button to test the connection to your external system.
You should see a green check mark if the connection is successful.
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Note: The test button will only check whether or not the main URL is reachable. It will not take into
account any SmartName used to pass on parameters, as SmartNames have to be resolved from a
specific context in WebCenter.

In the example above, the test will try to connecttohttp://ExternalSystem/
OrderInformation.jsp,andnottohttp://ExternalSystem/

OrderInformation.jsp?orderID=[Project Name].

19.3.2. Edit an External Web Connection

« To edit an external web connection, click its name in the External Web Connections page.

1 Attention: If you change the name of a connection here, you will also need to change it in
the customization files used to integrate a link to this connection into the WebCenter user

interface!

See the Customization Guide for more details.

Make Direct External Web Calls

You can directly call to a service instead of adding the External web calls to the menu or Homepage
Sections. This can be done with the call:

GetExternalWebInfo.jsp

The call takes the same parameters as the previously mentioned calls. For example, this call can be

used in a javascript button in the Attribute Category (using CustomFormExtensions).

Example: A SOAP call made out of JavaScript .This function could be added in

CustomFormExtensions.js

soap:

var
var
var

var

var

function (att) {
extWebConn = ”“SOAPService”; // name of connection
attrl = att[‘attrl’];
attr2 = att[‘attr2’];
attr3 = att[‘attr3’];
body = "<?xml version=\"1.0\" encoding=\"utf-8\" standalone=\"no\"?>"

+ "<soap:Envelope schema params>

+ " <soap:Body>"

+ " <Operation xmlns=\"http://tempuri.org/\">"

F W <Request>"

+ " <data>"

+ " <attrl>"+ attrl+"</ attrl>"

+ " <attr2>"+ attr2+"</ attr2>"

+ " <attr3>"+ attr3+"</ attr3>"

+ " </data>"

+ " </Request>"

+ " </ Operation >"

+ " </soap:Body>"

+ "</soap:Envelope>";

var formData = new FormData();
formData.append ("externalwebconfigname", extWebConn);
formData.append ("requestbody", body) ;
formData.append ("requestmethod"”, "POST");
(

formData.append ("requestheader",
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"Content-type:text/xml; charset=utf-8");
formData.append ("requestheader",
"SOAPAction:http://tempuri.org/CalculateNewQuote") ;

formData.append ("responsetype", "application/xml") ;
formData.append ("callfromwebserver”", "1");

S.ajax ({

url: "GetExternalWebInfo.jsp",

dataType : "xml",

type: 'POST',

enctype: 'multipart/form-data',
cache: false,

processData: false,
contentType: false,

data: formData,

async: false

})

.done (_.bind(function (data) {

// Read and handle data

}, this))

.fail(_ .bind(function(err, status, errStr) {
alert ("Request failed: " + errStr);

}, this));

}

Add Parameters to a direct call dynamically

Parameters cannot be always resolved by SmartNames. For example, when we make a calculation with
attributes and need to pass this as a parameter.

To resolve this use the parameter requestparams. The content of this parameter will be
appended to the URL called by the server. The content of the parameter should have the format
paraml=valuel&param2=value2&...

Note that URL encoding should be used when appending to the external web connection URL.

If ExternalWebConfig has URL https://www.google.com/, then
GetExternalWebInfo.jsp?
ExternalWebConfigName=ExternalWebConfig
&requestparams=qg$3Dtest (URL encoded “g=test”)

will resolve to https://www.google.com/?g=test

Change Request Method

It is possible to call a service both with the GET or with the POST method. The default method will be
GET.

To choose the request method, add a parameter requestmethod which can have a value GET or POST.
For example

GetExternalWebInfo.jsp?
ExternalWebConfigName=ExternalWebConfig3
&method=POST

The parameter is available for GetExternalWeblnfo.jsp, myexternalwebinfo.jsp and
projdetailsexternalwebinfo.jsp
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Change Response Type

It is possible to have another result than HTML. To do that, you will have to pass which response type
you want. This can be done by adding a parameter reponsetype. The response type has to be a valid
MIME type. For example,

GetExternalWebInfo.jsp?
ExternalWebConfigName=ExternalWebConfig3
&responsetype=application/json

The parameter is available for GetExternalWeblnfo.jsp, myexternalwebinfo.jsp and
projdetailsexternalwebinfo.jsp.

Add Request Headers

It might be required to add request headers to some calls. It is possible to pass these headers along.
This can be done by adding one or multiple instances of the parameter requestheader.

These have to be in the following format: <request_name>:<request_value

GetExternalWebInfo.jsp?
ExternalWebConfigName=ExternalWebConfig3
&requestheader=Cache-Control:No-Cache
&requestheader=Pragma:No-Cache
&requestheader=Expires:0

The parameter is available for GetExternalWeblnfo.jsp, myexternalwebinfo.jsp and
projdetailsexternalwebinfo.jsp.

Add Request Body

For some calls, it might be required to add a request body to the call. It is possible to pass this body
along.

This can be done by adding the parameter requestbody, with the needed request body as value.
GetExternalWebInfo.jsp?

ExternalWebConfigName=ExternalWebConfig3
&requestbody= <soap:Envelope ..>..</soap:Envelope>

The parameter is available for GetExternalWeblnfo.jsp, myexternalwebinfo.jsp and
projdetailsexternalwebinfo.jsp.

19.3.3. Delete an External Web Connection
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« Todelete one or more external web connections, select it/them on the External Web Connections
page and select Delete External Web Connection(s) in the action menu.

1 Attention: Deleting a connection that is in use will break the pages that use that
connection. The system will show an error message on these pages.
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Configure Workflow Connections

19.4.1.

With a workflow connection, creating a project in WebCenter can automatically create a linked job in
Automation Engine or any JDF-enabled workflow.

This way, the project files can automatically be copied into the workflow job (if desired), and the job
parameters can be defined from WebCenter, based on project information and attributes.

This means that:
« WebCenter can act as the single interface for your customers, CSR and sales,
« all the data collected through WebCenter is available for workflow automation.

You can also define when the project will synchronize with the workflow job automatically, and if the
WebCenter Project Manager can synchronize them manually.

You can also use a workflow connection to save documents (only approved documents or all
documents) and the XML metadata about the documents and project to a network folder. This allows
you to archive your documents and metadata externally.

To Configure a Workflow Connection

1. Create a connection.
2. Addthat connectionin a project template.

3. Define when the workflow jobs created will be automatically synchronized to the linked WebCenter
projects.

Workflow Connections

Use Workflow Connections to synchronise your WebCenter Projects/Documents information with
Automation Engine and other third party workflow systems. You can send a JDF file containing
information about WebCenter project/document to Automation Engine or other systems. In
Automation Engine, this will result in an updated Job or a new Job.

In addition, you can use Workflow Connections to submit external workflows. For example, using this
connection, the Submit Workflow node can execute external workflows on your workflow systems.

You can also use Push Through Folders to integrate with such systems. However, these folders copy
the WebCenter documents to the specified destination.

When syncing with Automation Engine Jobs, the Workflow Connections map:

« Project/ Document attributes to Automation Engine Job Setup parameters including the customer
details.

»  Documents to Automation Engine job documents.
System History Logs

All Workflow Connections related events like

»  Workflow Connections created

»  Workflow Connections deleted and

«  Workflow Connections changed
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are recorded and stored in System History. Read this page on how to access the records.

JDF Service

Use JDF Service connection to export your projects as JDF files and automatically create jobs in your
Automation Engine. In this case, projects and documents will be communicated to Automation Engine
using JDF tickets. Also, you can execute a workflow in Automation Engine using this setup.

ZIP Folder

Enter the address of the network folder to use for archiving your documents and metadata. This must
be in an accessible network share, in UNC format.

Note: The ZIP file generated will contain:

+ [documentversion id].[extension]:thearchived document,

+ [documentversion id].[extension].xml:the XML file containing the metadata of the
archived document,

where [documentversion id] isaunique number corresponding to that version of the document
and [extension] isthe file extension of the original document.

JMF Service

A JMF Service is a service to which the JDF tickets can be posted encapsulated in JMF messages.

Setting up a JMF Service:

JDF Hot Folder

When your WebCenter drops a JDF file into the Hot Folder that is shared between WebCenter and
Automation Engine, the Automation engine processes it. When processing is finished, it writes the
result into the output folder associated with the JDF Hot Folder.

Note: This must be in an accessible network share, in UNC format (for example\\MyWorkflowServer
\MydJobContainer\HotFolder).

Attention: The JDF hotfolder does not support the execution of external workflows. The
Submit Workflow node in WebCenter workflows will fail when a Hot Folder is chosen for the
connection.

19.4.2. Create a Workflow Connection
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« Click Admin > Configuration > Workflow Connections.

The Workflow Connections page appears, listing the workflow connections already created (if any).
« Click New Workflow Connection.
« Enter a Configuration Name.
« Select your Connection type. Here you can choose JDF Service / Zip Folder or both:
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New Workflow Connection

Configuration Name *

Connection Type

WebCenter

JDF Service{Synchronize Project / External Workflows)

ZIP Folder(Synchronize Document + Metadata)

# Active Configuration

Options

Description

To export your projects as JDF files (and
automatically create jobs in your workflow
system from your projects)...

Use JDF Service connection to export your
projects as JDF files and automatically create
jobs in your Automation Engine. In this case,
projects and documents will be communicated
to Automation Engine using JDF tickets. Also,
you can execute a workflow in Automation
Engine using this setup. Read more.

To automatically archive your documents and
metadata (as a ZIP file) in a network folder...

Enter the address of the network folder to use
for archiving your documents and metadata.
This must be in an accessible network share, in
UNC format.

Note: The ZIP file generated will contain:

+ [documentversion id].
[extension]: the archived document,

+ [documentversion id].
[extension] .xml: the XML file
containing the metadata of the archived
document,

where [documentversion id] isaunique
number corresponding to that version of

the document and [extension] is thefile
extension of the original document.

JDF Service:

Use JDF Service connection to export your projects as JDF files and automatically create jobs in
your Automation Engine. In this case, projects and documents will be communicated to Automation
Engine using JDF tickets. Also, you can execute a workflow in Automation Engine using this setup.

a)

If your JDF Serviceis...

Follow this procedure...

JMF Service
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If your JDF Service is...

Follow this procedure...

Note: You need JMF Service to connect to
Automation Engine if it is not in the same LAN
or not publicly available.

You can setup a JMF connection following the
steps below:

1. Select whether your Automation Engine is:

« inthe same LAN or publicly available.
« connected through the Approval
and Tunnel Client. Read in Configure
Workflow Approval and Tunnel Clients on
page 379
2. If your Automation Engine connectionis:

« inthe same LAN/ public, specify
either the host address(e.g.:
192.168.1.1.1)orthe host name
(aeserver.brand.com).

« viaan Approval and Tunnel Client, select
the client from the drop-down.

3. Click Generate URL. The URL field above will
be filled in automatically.

Ah

Warning: A Workflow Connection
connected through an Approval and
Tunnel Client will block one concurrent
license.

JDF HotFolder

Select this option if your JDF tickets should be
placed in a shared Hot folder.

1. Inthe UNC field that appears, enter the
address of your workflow's JOF hot folders
(in which to place the JDF file).

This must be in an accessible network
share, in UNC format (for example\
\MyWorkflowServer\MyJobContainer
\HotFolder).
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If your JDF Service is... Follow this procedure...

VVVVVVVVVV

2. Click Test.

- Enable the Active Connection option to activate this workflow connection.

Note:

If you disable this option, there will be no synchronization between WebCenter and your workflow
system, but the connection data will be saved, so you can reactivate it later.

« Click Create.

19.4.3. Edit a Workflow Connection

1. Onthe Workflow Connections page, click the name of a workflow connection.
2. Change the workflow connection's settings as desired.
3. Click Save.

19.4.4. Delete a Workflow Connection

1. Onthe Workflow Connections page, select the workflow connection(s)to delete.
2. Click Delete Configuration(s)in the actions menu.

19.4.5. Add a Workflow Connection to a Project / Template

Once you have created a workflow connection, you need to add it to project templates that Projects
Managers will use to create projects. You can also add the connection to individual projects if desired.

1. Onthe Project Details page of the project or template, go to Configure > Workflow Connection.
2. Select Connect this project to a workflow.

This shows extra options.
3. Inthe Workflow Connection list, choose the workflow connection you defined.

4. Select Allow manual synchronization by the Project Manager if you want Project Managers to be
able to synchronize the workflow job to the project on demand.

If you select this, Project Managers will have an extra action on the Project Details page:
synchronize with workflow.
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Note: Whether you enable manual synchronization by Project Managers or not, the workflow job
will be automatically synchronized with the project when certain events occur (see Define When the
Project and Workflow Synchronize on page 371).

5. Define when to automatically synchronize the workflow job to the project:

+ select Synchronize on all statuses to synchronize whenever the project status changes,

« select Only synchronize on a completed status to only synchronize when the project has a
completed status.

Note: There can be more than one completed project status defined in the system.

Note: Make sure you have selected Project status change as event that will trigger an automatic
synchronization (see Define When the Project and Workflow Synchronize on page 371).

6. Select Copy documents when synchronizing if you want the project's documents to be copied to
the workflow job.

Note: When you are using a workflow connection that automatically archives your documents and
metadata in a network folder (see Create a Workflow Connection on page 366), Copy documents
when synchronizing is always selected.

You can also choose to copy Only approved documents, or Only documents in (a certain) folder
(select the project folder containing the documents to copy). This will work even you rename the
folder later. If you try to delete the folder, you will get a warning.

7. Define Additional Settings for the workflow job.

In Automation Engine, you can see these settings in the Job Setup. See the Automation Engine
documentation for more information.

Note:

You can use SmartNames to define those Additional Settings.

Click the Insert SmartName [1 button and select a SmartName in the list that appears next to the
button. SmartNames are shown between brackets, like [Project Name].

This list contains general project information ([Project Name], [Project ID], [Customer Name]...),
and all the attributes defined in WebCenter. The attributes don't need to have been added to the
project to be available here.

You can use several SmartNames if desired, or a combination of SmartNames and text, for example
WebCenter_[Project Name]_[Customer Name].

a) Fillinthe job's Order ID. This is mandatory as it allows WebCenter and Automation Engine to
identify the job.

We recommend you use the [AE_OrderID] SmartName (corresponding to the WebCenter
AE_OrderlID attribute created automatically when you created the workflow connection) for the
job Order ID.

b) Fillinthe job's Suborder ID if needed (this is optional).
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We recommend you use the [AE_SubOrderID] SmartName (corresponding to the WebCenter
AE_SubOrderlD attribute created automatically when creating the workflow connection) for
this.

c) If youwant to use a Automation Engine job template when creating the job (so that some of the
Job Setup information is already defined), define the template to use in Template Name.

1 Attention:

If using SmartNames, make sure that they resolve to an existing Automation Engine job
name.

SmartNames are resolved when the job is created via the JOF Hot Folder.

8. Click Save.

19.4.6. Define When the Project and Workflow Synchronize

Once you have created a workflow connection and added it to project templates, you need to define
what events will trigger an automatic synchronization between the workflow job(s)/network folders and
the WebCenter project(s).

You can set this for your whole WebCenter system, but you can also overrule in specific projects or
templates.

System-Wide
1. Go to Admin > Preferences > Notifications.

The Notifications page has a column called Synchronize with Workflow.
2. Select the events that will trigger an automatic synchronization.

This means that when one of the events you selected occurs in a project, and the project is
connected to another system, the synchronization will take place.

For example, if you select Upload new document, the workflow job created will be synchronized to
reflect the project when a user uploads a new document into the project.
3. Click Save.

At the Project/Template Level

1. Gotothe project or template's Notifications tab.
You can only do this as an Admin user.

2. Select the events that will trigger an automatic synchronization in the Synchronize with Workflow
column.
When one of the events you selected occurs in a project, and the project is connected to another
system, the synchronization will take place.

3. Click Save.
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19.5. Configure Asset Management Connections
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Asset Management Connections
You can configure Asset Management Connections to connect to external digital asset management
(DAM) system (for example, MediaBeacon or another WebCenter system. When you have successfully
configured a connection, your users can use it as a source for assets. You can also push a new version
of an asset (or a new asset) back to the external DAM. This feature allows you to keep your repositories
in an external system.

Once configured, these Asset Management connections can serve as Document Sources in
WebCenter.

Configuration
To create a new Asset Management connection,
1. Go to the Admin > Configure > Asset Management Connections page.

If you already have Asset Management Connections, they will be listed in this page. To edit a
connection, simply click on the name of the connection.
2. Click New MediaBeacon Connection or New WebCenter Connection or New ESKO Cloud
Connection.
Name, a unique name for the connection
4. Specify/ edit:

o

« Name, a unique name for the connection
« URL and the API key for a MediaBeacon connection or URL, User name and Password for
WebCenter connection.

To create a new New Esko Cloud Connection, follow the steps here.
5. After specifying the parameters, click Test Connection. Select Create to finalist and create the
connection.

Upload from external Asset Management connection

When successfully configured, you can use these connections as custom Document Creation
sources. When a DAM is used as a source, the user is able to select documents (with meta data)from a
MediaBeacon workspace or a WebCenter Saved Search.

These configurations allow you to push a new version of a document to the asset management system
using a workflow node. Specify the Asset Management connection and a mapping between the
WebCenter attributes and the meta-data of the external system, the node can be used in a workflow.

You can view the Asset management connection details in the Document information in WebCenter. In
the Document Details > Document Informationtab, view:

« Asset Management Origin - The name of the Asset Management Connection used to import the
document (+ link).

+ Asset Management Document ID - The ID of the original document that resides on the external
asset management system.

System History Logs

All connection related events like
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« Asset Management Connection Created
« Asset Management Connection Deleted

« Asset Management Connection Changed

are recorded and stored in System History. Read this page on how to access the recordsSystem History
on page 386

Esko Cloud

Esko Cloud is a cloud server environment in which all the Esko's cloud applications are deployed.
Dedicated services are made available which provides functionality to other applications for instance,
like WebCenter.

To connect to the cloud, the (service) URL needs to be provided together with the cloud token. The
token is used to authenticate the person/system that makes the request.

In WebCenter context, you can connect to cloud for

« Color

Note: To know more about setting an Esko cloud account read here.

« Archiving of documents

For the color specific functionality, WebCenter connects to the Color service. The cloud stores colors/
inks and color/ink books. We refer to these as Colors and Color Books. The colors and color books

can be uploaded to the cloud by the Color Pilot. WebCenter can read the colors and color books by
connecting to the Color Microservice.

Esko Cloud Account Creation

To connect to Esko cloud, an account has to exist in the Esko cloud. Most organizations may
require only one Esko Cloud Account, however multiple Esko Cloud Accounts can be maintained for
independent environments for segregation of data.

Follow the steps below to create an account with Esko cloud.

1. AnEskoidisrequiredto create an Esko cloud account which is provided for every customer.

2. Create an Esko Cloud account in this URL https://approve.next.dev.cloudi.city/
createNewAccount.html.

3. Cloud Account name can be given as required and the Cloud account number is auto generated.

Note: Creating a site within a cloud account is optional for Color and Archiving services.

4. Oncreation of the Esko Cloud Account, you are auto navigated to the My Network page.

Select Add Equipment Network option to create Equipment in My Network Page.

5. Click on the Equipment folder and select Add Equipment. Select WebCenter as the Equipment
Type and add an Equipment Name. An Equipment ID is generated.
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Equipment ID in the cloud account is required to enable connection to either Color Service or
Archiving service from WebCenter.

19.5.3. Configure Esko Cloud Connection in WebCenter
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An Admin user can setup the connection to the ESKO cloud. ESKO Cloud Connection can be set up for
Archiving or Color service. To begin with, navigate to Asset Management Connections page and select
New ESKO Cloud Connection.

Follow the steps below to configure the ESKO Cloud Connection in WebCenter.
Select New ESKO Cloud Connection to open the connection Details page.
Enter the Name of the Connection. This is a mandatory field to be entered.

Enter the URL of the Connection. This is a mandatory field to be entered.
Enter the Cloud Token. This is a mandatory field to be entered.

oo N

Choose the Cloud Service as either Archiving or Color. This is a mandatory field to be selected
and by default Archiving is chosen. In case the Cloud Service chosen is Color, additional steps are
required and are mentioned here.

6. Enter the Repository ID and Equipment. This is a mandatory field to be entered for Archiving only.
Repository ID will contain the ESKO cloud repository and the Equipment would hold the name of the
equipment created in the Esko Cloud.

7. Now you can test the connection with Test Connection before you Create.

Configure Color Cloud

A connection to the Esko cloud account can be established by the WebCenter Admin user in the Asset
Management Connections page, where the connection information is configured.

Setup of the connection to the Esko cloud with choosing the service as Color is the first step in the
Cloud Trace Solution from ESKO.

To begin with, enter the name, URL, Cloud token for the Esko Color cloud. On choosing the service as
color in the New ESKO cloud connection, additional fields are shown.

- Deployment Package: Import Assets while setting- up the Color Trace solution for the first time in
Web Center. These assets are part of the Deployment Package. Read more about it here.

« ColorInformation: Import Color Books into WebCenter for the first time when setting up the color
service. There is also an option to Force Update Color Books based on the requirements to update
the colors.

« Automatically Update Color Books every day: Select this option to update your Color books daily.

« Details: Expand to view the color books available at any point along with the last updated time. Also
information on the number of color books and colors processed during the last update including the
details of the number of color books that were updated or skipped or failed or obsolete is shown.

« Connection Status: Displays the status of the connection as Connected or Not Connected. Before
connecting for the first time, you can check whether all information provided is correct by clicking
on Test Connection. Select Create on save the information provided and create a new color service
Esko cloud connection.

- Connected When the Cloud Service can be reached, and the validation of the token was
successful

» Connection Failed When the import was not completed or the token could not be validated.
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Deployment Package

While setting up the Esko Cloud connection for Color service, the required WebCenter assets are
imported as Deployment package. This is installed once initially using Import Assets option to setup
the Color Trace solution in WebCenter and later these assets can be updated whenever required using
Check for Updates option.

Note: Subsequent Color Service setups does not require Deployment Package to be downloaded but
only updated if required.

Deployment Package comprises of WebCenter Projects and and Templates, Dashboards, Saved
Searches, Categories, Restricted Sets, Groups and Roles.

Deployment Package Import Assets...
nfo: Required assets are missing. It is strongly advised to import the Deployment Package
Color Information Import Color Books... Force Update Color Books...

Tip: Only use 'Force Update Color Books' in case the Color Library is corrupted

Automatically update Color Books every day

1. Project and Templates: Projects that are required to setup the Color Trace solution in Web Center
are

« #COLOR TEMPLATE :Template project where utility documents are placed. It also can configure
the landing page for the “#COLOR LIBRARY” project. This contains the following documents

1. #COLOR TEMPLATE: Template document for creating a new color document. Any document
2. #COLOR THUMBNAIL: Document used to create the color document thumbnail (SVG)

3. #COLOR CONDITIONS.xIs : Excel sheet containing valid values for the condition parameters
(For example: printing technique, substrate, ink type and finishing)

4. #COLOR ColorCertJob.ccj: Document that carries the category #COLOR ColorCertJob

« #COLORLIBRARY: Project where the documents representing colors are created. In this
project, each folder represents a color book and each document is a colors in the books. Meta-
data information of the color is added to the document attributes

« #COLORPALETTES: Project that serves as library for the palettes

« #COLORPALETTES TEMPLATE: Template for #ColorPalette Projects

+ #COLOR COLORCERT RULES LIBRARY: Library for the Color Cert Rules documents

+ #COLOR COLORCERT RULES TEMPLATE: Template for #Color Cert Rules library

« #COLOR ColorCertJob: Attribute Category to hold attribute values for the ColorCert Job

« #Color PROFILES

2. Categories Attribute categories for representing Color Palette or the Color or the conditions for
printing .
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Groups and Roles :For Admins for various purposes and others Users.

Restricted Sets: Consists of two restricted sets for Master/Dependent color and Color status
Saved Searches:Are available to access the color information as and when required.

Dashboards: To view the metrics of Colors, color books, Palettes, Rules profiles that are available.

LR

Store Color

Text

Assisted QA

19.6.1.

376

WebCenter Viewer now allows integration with third party external web QA (quality assurance) tools
namely InformalT and TVT for additional comparison features. You can configure a connection
between the Comparison tool with Web Center by navigation to Admin > Configuration > Assisted QA.

When the graphic documents ( PDF's and Adobe lllustrator documents ) are compared in WebCenter
Viewer, additional buttons are enabled if any external QA tools are connected. Once the comparison
session in the external tool is completed, reports and annotations are stored back into the WebCenter.
You can read about how to configure an external tool here.

You can read more about how it renders in the viewer here in the User documentation.
Navigation From other Menu locations

You can configure QA tools as Custom Action Buttons in the Menu Builder to make it available other
than the Viewer. This can be added to all pages(locations) where the list of Documents are shown.

System History Logs
All Assisted QA Tool connection related events like

- Assisted QA Tool Created
« Assisted QA Tool Deleted
« Assisted QA Tool Changed

are recorded and stored in System History. Read this page on how to access the recordsSystem History
on page 386

Configuring Assisted QA

As an Admin user, you can navigate to the configuring page from Configuration > Assisted QA Tools
> New 0A Tool. Depending on the QA Tool to be added, the configuration options may vary. Currently
options are available to add InformalT and TVT.

Navigate to Configuration > Assisted QA Tools page to add a new QA tool or edit the details of already
configured connection.

The parameters required for connection are:
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Name: An unique name for the connection.

Provider: Choose the QA Tool that you want to connect to.
URL: URL to the QA Tool to be added

Provider specific information:

N

a. InformalT:
+ User Group Add the User group in the InformalT. By default, the “CC Users"is given

« Compare Type: Choose the type of compare you wish to use the connection for, either Text
or Graphic or Hard Copy.

« Configuration ID: Enter the corresponding configured id in InformalT
b. TVT
+ User Name
» Password
« Options : Choose from a set of options(type of document) defined and available in
dropdown.
« Create Audit Trail Report:Select this check box for a second report to be saved to

WebCenter

+ Open TVT locally : Select this check box to open TVT on the application installed on the
local machine instead of a new tab

5. Report Location: Location to upload the external pdf report from the selected QA Tool after
comparing the documents

« Project Root Folder: Root folder of the project where the document resides
+ Folder of Current Document: Same folder as the original document

+ Custom Folder Choose the folder where you want the report from the QA tool to be saved.
Specify the location in the Target Folder field.

« You can add a suffix for the report name in the Report Name Suffix field for the external report
which isimported.

You can now Test Connection and then Create the connection. There is also an option to Delete this
connection in the Assited QA Tools page.
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19.7. Configure Push-Through Configurations for Workflow
Folders

19.7.1. About Workflow Folders

What is a workflow folder?

When creating a folder the Project Manager can define it as a workflow folder, using a push-through
configuration defined by the Admin.

Any file that is uploaded into this folder will be automatically copied to a location defined in the
configuration. For this reason, workflow folders are sometimes also referred to as “push-through
folders”.

Workflow folders are particularly useful when that other location is a hot folder of a workflow system
such as Nexus, Automation Engine or Odystar, so that the file will automatically be processed by the
workflow system.

Note: The Configuration for workflow folders needs to be defined by an Administrator.

Project Managers can then select one of the defined configurations when they create a new folder.

Recognizing workflow folders

Workflow folders have a yellow icon with an arrow on it.

Folders IE, ,f

[@y Project Documents
I FRegular folder

e Workflow folder

The files in a workflow folder have two extraicons:

The first B shows whether the copy of the file was successful or not.

The second ™ 'is a button to copy the file again to the location defined in the configuration.

System History Logs
All Push Thorough Configuration related events like

« Push Through Configuration created
« Push Through Configuration deleted and
« Push Through Configuration changed

378



ESKO

19.7.2.

19.8.

WebCenter

are recorded and stored in System History. Read this page on how to access the records.

Delete Push-Through Configurations

Click Admin > Configuration > Push Through Configurations.
Select the configuration you want to delete.

Click Delete Configuration in the actions menu.

Click OK to confirm.

N N

Configure Workflow Approval and Tunnel Clients

19.8.1.

When WebCenter and Automation Engine are not on the same LAN, this workflow approval and tunnel
client will establish a bi-directional communication.

Note: The Automation Engine Pilot needs to have the workflow approval client credentials to send
messages to WebCenter.

This is configured through Admin > Configuration > Workflow Approval Clients in WebCenter, and, in
the case of Automation Engine, in Tools > Configuration > Web Sites in the Automation Engine Pilot.

Attention:

Configure the WebCenter account first so that it can be tested from within the workflow
approval server.

WebCenter and the workflow approval server must use the same user name and password!

This is completely separate from a normal WebCenter user. Workflow approval clients may not log in to
WebCenter.

Two manual configuration steps must also be performed outside of WebCenter to ensure proper
communication between the workflow approval client and WebCenter systems that are not on the
same LAN.

System History Logs
All Workflow Approval and Tunnel Client related events like

«  Workflow Approval and Tunnel Client created
«  Workflow Approval and Tunnel Client deleted and
«  Workflow Approval and Tunnel Client changed

are recorded and stored in System History. Read this page on how to access the records.

Create a Push-Through Configuration

1. Click Admin > Configuration > Push-Through Configurations.

The Push Through Configurations page appears, listing the push through configurations already
created (if any).

2. Click New Push Through Configuration to add a new configuration.
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3. Enter a Configuration Name.
4. Inthe Destination UNC field, type the path to the target folder in UNC format (for example \
\MyWorkflowServer\Container Data\WebCenter).
5. Choose aFile Naming option:
« Document name: documents copied to the destination folder will keep their original WebCenter
name.

. [Project_name]_[Document_name]: the copied documents will get a file name consisting of
the project name, an underscore and the original document name.

« [Customer_name]_[Project_name]_[Document_name]: the copied documents will get a file
name consisting of the Customer name, an underscore, the project name, another underscore
and finally the original document name.

6. Choose the Workflow Type to enable additional integration functionality:
« Automation Engine,
+ Nexus,
» Odystar.

7. Enable the Active Configuration option to activate the push-through mechanism for this
configuration.
If you disable this option, files will no longer be copied, but the configuration data will be saved, so
you can reactivate it later.

8. Click Create.

19.8.2. Create a Workflow Approval and Tunnel Client

Click Admin > Configuration > Workflow Approval and Tunnel Clients.
Click New Workflow Approval and Tunnel Client.

Enter the User Name and Password for the workflow approval client user.
Click Create.

N

Note: If you have several Automation Engine, Nexus, or Odystar sites communicating with WebCenter,
you need to create a separate Workflow Approval Client for each site.

19.8.3. Change the Password for a Workflow Approval and Tunnel Client

1. Click Admin > Configuration > Workflow Approval Clients.
2. Click Change Password link next to the name of the client user.
3. Change the password and click Change.

19.8.4. Delete a Workflow Approval and Tunnel Client

1. Click Admin > Configuration > Workflow Approval Clients.
2. Select the client.
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3. Click Delete Client(s) in the actions menu.
4. Click OK to confirm.

19.8.5. Configure the Workflow Approval and Tunnel Client Software

Configure the access to WebCenter in the client application for your workflow server.

For instructions, please consult the documentation of your workflow server (Automation Engine,
Nexus or Odystar).

19.9. Upload Saved Search Results Template

You can upload an Excel file (. x1s)to be used as template when users download search results to Excel
files.

Note: This will only be used when downloading the results of global saved searches (you can upload
one template per global saved search).

1. Go to Admin > Configuration > Upload Saved Search Results Template.
2. Browse to the Excel file to use as a template for a saved search.

Note: Name it exactly as the saved search you want to use it for (ignoring the extension)!

3. If you want to update an existing template file (uploaded with the same name), select Overwrite if
template file already exists.

4. Click Upload.

When downloading search results using that template, you will find the results data in a sheet called
“Search Results".

Note:

You can upload a template containing charts and additional sheets referencing the main “Search
Results” data sheet (for example through Pivot tables).

In this case, remember to put referencing elements to “auto-update on open” to update the sheet
automatically when the Excel document is opened.

System History Logs

All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

19.10. View System Information

The System Info page lists various system statistics. Click Admin > Configuration > System Info to
view the system statistics and properties.
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System Info

WebCenter usage info

Number of Projects 113342

Number of Documents per type

Graphics 21354
Digital Film 53
Cape 256
CHILI Package 599
Other 34012
Text Content 126
ArtiosCAD 9110
Page List 208

Collada 1681

User management info

Number of licences 45
Number of Users 11812

MNumber of guaranteed access Users 13

19.11. Troubleshooting Tool

If you experience some problems with WebCenter, or if you want some real-time information on your
WebCenter system, you can run the Troubleshooting Tool. To do this, you can either:

« Go to Admin > Configuration > Troubleshooting Tool in the WebCenter user interface.
+ Gotohttp(s)://<server>/<instance>/tstools/index.html inyourweb browser.

Note:

« You can run the tool from this web page even if your WebCenter server is not running (some
tests will fail if WebCenter is not running).

«  When running this tool as a non-Admin user, you can only execute simple tests (advanced tests
require Admin access).

« You can execute all troubleshooting tests from localhost without the need to log in as an
administrator. This can be done by accessing the Web Server machine and navigating to: http://
localhost:8081/<instance>/tstools/index.htmi.

The tool starts automatically. For each test, the tool gives a status and some extra information. You can
use this information to troubleshoot your WebCenter installation and, if you cannot solve the problem,
to call Esko customer support.
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Test status Meaning

OK The test was executed and everything works as
expected.

BAD The test was executed, it could be working, but
something requires attention.

FAILED The test failed. Is is very likely that there is
something wrong with the system.

SKIPPED The test wasn't executed due to a lack of rights
(you didn't log in as an Admin user) or because a
previous (related) test failed.

19.11.1. Workflow Troubleshooting

If you run the test on the Workflow Engine at the Troubleshooting Tools page, it will result in :
«  OKif the Workflow Engine is running

» Badif the Workflow Engine is still starting up

- Failed if the Workflow Engine is not running.

You can also see the Workflow Database states such as:

» The total number of running workflows in the Workflow Engine
« The total number of tokens in these workflows

« The total number of triggers in these workflows

« The total number of wait triggers in these workflows

When you have a problem workflow, click on the Details section to know more about the specific tasks
and projects creating issues. You will also see a tip describing how to resolve the problem.

Read https://wiki.esko.com/pages/viewpage.action?pageld=170037353.

19.12. Workflow Engine

Use the WebCenter Workflow Engine page when the workflows get stuck, fail to complete or when a
workflow loops cause the system to crash. This is a convenient way to troubleshoot workflows.

Note: Since version 14, this component runs as a background process of JBoss running the workflows
in WebCenter. For versions before WebCenter 14, the Workflow Engine runs along with the JBoss.
Because of this, you have to restart the JBoss to restart the Workflow Engine.

To see the status of the Workflow Engine, go to Admin > Configuration > Workflow Engine.
« Started when the Workflow Engine is running (green)
« Starting when the Workflow Engine is still starting up (orange)

« Stopped when the Workflow Engine is not running (red)
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To change the status, use the following controls:

« Restart
. Start
« Stop

This page also displays the data on:

« <« The total number of running workflows in the Workflow Engine
+ The total number of tokens in these workflows
« The total number of triggers in these workflows
« The total number of wait triggers in these workflows

« The number of workflow events per second: This is the average number of Workflow Events
per second generated by the Workflow Engine within the past 20 seconds.

+ The workflow engine queues (Queue Name) and their sizes:
+ Internal Event Processing Queue
«  Workflow Step Processing Queue

« Trigger Processing Queue

System History Logs

All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

19.13. Cleanup Tool
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When objects are deleted, they remain in the database marked as “Deleted”. To permanently clear this
data, an off-line tool is used which can be scheduled for a time when the server load is low.

The Clean Up tool has to be run by System Administrator with operating system access to the
WebCenter Application server. To run the tool at regular intervals, the Windows Task Scheduler can be
used.

Running the Cleanup tool

« Onthe WebCenter Application Server operating system, navigate to
<WebCenter install directory> \ApplicationServer\Cleanup.

« Execute the batch script ‘cleanup.bat’(either by double clicking or executing in a command prompt).
This will connect to WebCenter and instruct it to scan through the database and purge obsolete
records.

The clean-up tool produces progress feedback in the displayed command prompt and also stores it in
the log file. To view the log, go to:

+ <WebCenter install directory> \ApplicationServer\Cleanup\logs
\cleanup.log
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Inspecting Cleanup Tool Status from browser

You (Admin) can view the status in the Admin > Configuration > Cleanup Tool page. The following
states are possible:

« Running. You can stop the tool by clicking the Stop button. You will be asked to confirm your stop
action.

« Stopping - a stop request was submitted to the server, but the cleanup tool is not yet stopped. In
this state, you cannot execute any aciton.

« Stopped
If the status is Stopped, you will be able to:

1. Specify the Minimal age of items to clean (in hours). The default is 0 hours.

2. Start the cleanup tool by clicking the Start button. If you Start the process, you will be asked
to confirm your start action. As soon as the cleanup tool starts up, the status will change to
Running.

Altering ProfileDefaults
You can prevent Stopping or Starting the Cleanup tool from browser.

« To prevent Stopping the Cleanup tool from browser, change the ProfileDefaults record
WC_CLEANUP_ENABLE_STOPPING to “0” by either of the following methods:

« Usethe URL:

<WebCenterlnstance>/siteconfig.jsp?key= WC_CLEANUP_ENABLE_STOPPING &value=0
« ordirectly by a SQL script.

« To prevent Starting the cleanup tool from the browser, set the ProfileDefaults record
WC_CLEANUP_ENABLE_STARTING to 0. You can use either of the following:

« Usethe URL:

<WebCenterlnstance>/siteconfig.jsp?key= WC_CLEANUP_ENABLE_STARTING &value=0
« ordirectly by a SQL script.

Note:

Once set, the value can no longer be changed from the siteconfig.jsp, but only altered in the database
directly. This allows efficiently blocking these features from being executed from the browser.

System History Logs

All changes/events in this page are recorded and stored in the System History page for Administrator
users. Read this page on how to access the records.

19.14. Site Service

19.14.1. View LogFiles

Go to Admin > Configuration > Site Service to:
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+ see system settings(click Show Site Defaults),

« set the maximum number of days to retain log files:

You can specify the Max Age of JBoss Log Files field as the number of days you want to retain the
logs.

Important: If you set a very high number of days, it will affect your hard drive disk space over time.
You have to watch the disk space and delete the log files manually.

« download JBoss and Tomcat log files.

19.15. System History
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WebCenter system configuration changes can be viewed in one location by Administrators. Navigate to
Admin > Configuration > System History and view the following information:

- EventDate

« Typeof the event

« User who made the change

. comment (system generated )

« Change comment (provided by the user)

The events can be filtered and viewed based on the date, the operator or the delegate or the event
type.

m Clear Settings

You can choose to view all the events or can specifically choose the events in which you are interested.
By default, the first 200 records matching the filter and sorting option are shown, however, this can be
increased or decreased, and it is possible to print the results matching the filter.

Events are tracked in the following pages in WebCenter
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|all Events -
o=
» Asset Management Connection Events
» Assisted QA Tools Events
» Attribute Category Events
» Attribute Events
» Characteristic Events
» Company Events
» Dashboard Events
» External Web Connection Events
» Generic Configuration Events
» JavaScript Rule Action Events
» Location Events
» Menu Events
» My Work Section Events
» Project Events
» Project Status Events
» Push Through Configuration Events
» Report Events
» Restricted Set Events
» S50 Instance Events
» Saved Search Events
» Specification Events
» Task Status Events 387

» Task Type Events
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Each of the page has different set of events captured and stored in history based on the nature of the
event.

19.16. Authentication
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Single Sign-on allows you to use a centralized system for authentication. For instance, you can use a
single credential on many systems including WebCenter.

You can configure:

« asingle set of credentials for all systems (like LDAP)
« freeaccess to WebCenter without a separate login page.

The two previously existing authentication mechanisms (LDAP and simple password authentication)
have been modified adding extra flexibility. You can either make all users authenticate with LDAP by
default or configure multiple LDAP servers.

Note:

You need a WebCenter Advanced License to configure more than a simple password authentication
and one LDAP server.

Table: Single Sign On Definitions

Single Sign-0n System The system providing authentication, (e.g.
yammer, SAML, LDAP)

System Administrator The administrator who deals with WebCenter
from both an application point view and froman IT
(operating system and database) point of view.

Administrator WebCenter Administrator

SS0 plug-in (SSOP) The full deployment of an integration with a Single
Sign-0n system. Will also be used as synonym for
the implementation of the Java 'ServiceProvider'
concept. The Service Provider is in fact part of the
deployment of the plug-in.

Single Sign-0n Instance configuration Defines an Instance and its place (priority and
availability) in the system.

Plug-in specific Instance configuration Part of the instance configuration that may differ
depending on the plug-in.

Single Sign-0n Instance A plug-in can have multiple instances. Its behavior
is determined by the plug-in and the instance
configuration.

User Configuration Configuration information for a specific user
Instance Specific User Configuration The user configuration dependent on the SSO
instance.
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Note: This configuration is dependent on the
instance and not the plug-in.

Standard Login Page Instance

The standard login page.

Custom Login Behavior Instance

The alternate page (or dialog) when a user is not
authenticated.

Default Single Sign - On Instance

The instance that will be selected by default.

User

Has access to WebCenter after login.

Database

Relational database. The primary location for
persisting data in WebCenter.

19.16.1. Add a plug-in to the system

You can add plug-ins that are not WebCenter standard by placing a set of . jar filesin
<installation root>/ApplicationServer/JBoss/sso-plugins folder.

These files contain the plug-in implementation and the associated libraries. To remove a plug-in, you
have to stop the application server. Restart the application server after replacing the . jar files.

Note:

1. You do not have to restart any of the WebCenter servers after installing a new plug-in.

2. When an Application Server is being updated, any existing SAML plugin version that might have
been there already when updating is replaced with the latest version provided by the WebCenter

installer.

19.16.2. Add a Single Sign-0On Instance

1. From the Configuration > Authentication (SSO) page, click on the New SSO Instance link.

Note: You cannot have more than one basic authentication.

2. Give the new Instance a Name.
3. Select the Plug-in from the drop down.

The Plug-in drop down will display all the SSO Plug-ins available in that particular WebCenter.

4. Click Create.

When the instance is created successfully, you will return to the Single Sign-On Instances list. The new

instance is also displayed as the last instance.

19.16.3. Manage Instances

Go to Configuration > Authentication (SS0) to get an overview of the configured Single Sign-On

Instances.
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Enabling the Allow Project Managers to change their users' access to SSO instances option will allow
the Project Managers to modify their users authentication settings at the user profile page.

When this is disabled, Project Managers will be prevented from changing their user’s access to SSO
instances. The PMs will not be able to see the Authentication drop downs to the user’s profile. In
addition, the disabled instances will be hidden.

Single Sign-On Instances New SSO Instance
Allow Project Managers to change their Users’ access to SSO instances.

Name Plug-in Password Recheck D Priority Enabled Listed TryNext Configure Default Delete
Basic password authentication Basic password authentication Yes 00002_0000000244 1 I Allow v | delete
SAML Esko SAML 2.0 (v1.0.11) No 00002_0000000247 2 4 edit Allow v | delete
LDAP LDAP password authentication Yes 00002_0000000245 3 ¥ edit Deny v | delete
Test SAML SAML 2.0 (v1.0.11) N/A 00002_0000000248 4 edit Deny v | delete

Bl

Name: Name of the Single Sign-0n Instance. Will be used for display in multiple places.
Plug-in: Name of the plug-in to which the Single Sign On Instance belong.

Password Recheck: Whether a particular instance supports password re-entry (upon submitting
approval) or not.

« Yes orNo: if the system supports password re-entry
« N/A:indicates that the information is currently not available. For example, if the instance is not
enabled or fails to load.

ID: the internal ID. As an administrator, you can use this while addressing an SSO provider directly. For
example, when redirecting from an external system.

Priority: determines the order in which the Instances are attempted for authentication. Also
determines the display order in several places (user settings and log-in page).

Enabled: indicates whether the instance is operational. You have to enable an instance to use it for
authentication. The options to change Instance specific user settings is only available for the enabled
Instances.

Listed: indicates that an explicit log-in button will be available when the Instance is enabled.

Try Next: when this is enabled, the next Instance will be tried after the default log-in fails. The log-in
attempts will stop at the first enabled Single Sign-0On Instance when the Try Next option is disabled.

Configure: displays the Edit links to configure the plug-in specific instance configuration.

Default: you can configure whether a user is allowed to or denied from using an Instance. You can allow
some users to authenticate at a specific Instance. The default can be changed in the user specific
configuration.
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Delete: use the Delete link to delete an Instance.

19.16.4. Configure a Single Sign On Instance

To access the Single Sign On Instance configuration page, click the configure link from the instances
row.

1. Go to the Configuration > Authentication (SS0) page. You will see the overview table of the
configured Single Sign-0n Instances.

2. Click Edit link in the row corresponding to the Instance to be configured.
This opens a plug-in specific configuration of an existing Single Sign On Instance.

Note: You cannot edit the Basic Password configuration.

3. Modify the configuration details.
4. Save.

To make it active, you need to check the enabled option. To make it listed on the login page, enable
listed. When you create a new User, the login options are determined by the status in the default
column.

If an instance is in the denied status for a user, he/she will not get that option listed on the login
page. The status specified in this page becomes the default in the user profile page.

19.16.5. Single Sign-0On Settings

You can view the Single Sign On settings specific to your User account in the My WebCenter > My
Password page. This page will display the Single Sign On Instances that are enabled for your User
account.

You may modify configuration details of the Single Sign On Instance depending on your permissions to
do so. If you have permission to modify, all your values will be saved.

Note: User specific settings are possible when the Single Sign On Instance supports user specific
configuration.

19.16.6. Configure LDAP(S)

LDAP

LDAP (Lightweight Directory Access Protocol)is an application protocol for querying and modifying
directory services running over TCP/IP.

In the context of WebCenter, it allows you to let users sign on to WebCenter with the same user name
and password they use to log on to the corporate network.

LDAPS

LDAPS is the more secure variant of the protocol, and it uses SSL connections instead of plain (i.e.
Unprotected) connections. It requires you to install certificates on the server, as described in Install
Certificates for LDAPS on the Application Server.

While logged in to the WebCenter web interface as an administrator:
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1. From the Configuration > Authentication (SSO) page, click on the New SSO Instance link.
2. Give the new Instance a Name and select the Plug-in as LDAP password authentication.

3. Click Create.
A new LDAP instance will be created.

4. Inthe overview table of the configured Single Sign-0On Instances, click Edit link corresponding to
the LDAP instance.

5. Modify the configuration details.
6. Enter the name or IP address of the LDAP Server.

Example: esko. com.
7. Type the User Distinguished Name (DN).

Example: CN=BG System,OU=Users,OU=Gent,0U=Belgium,OU=Locations,DC=esko,DC=com.
8. Provide the Password for the user you specified in the User Distinguished Name field in the
previous step, and confirm it.
9. Enable the option Use secure connection (LDAPS) to encrypt all communication between
WebCenter and the LDAP server.

10. You can specify additional elements in the Advanced settings field. For example, you can change
the default port that is used in the case of LDAP over SSL. Use the various lookup keys to match the
LDAP field against the WebCenter properties and then change the default LDAP keys. See below:

Options Description

ssl.port Default LDAP secure connection port

The default value is 636.

lookup.userinitials AD path used for LDAP login name lockup.

The default value is sAMAccountName.

lookup.firstname First name key

givenName (default)

lookup.lasthame Last name key

sn (default)

lookup.mailid Mail id key

mail (default)

lookup.phonenumber Phone Number key

telephoneNumber(default)

lookup.mobilenumber Mobile Number key

mobile (default)

lookup.title Maps to the Function in WebCenter

title(default)
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Options Description
autoupdate Enable this to look up user info and to update
during login(values: 0 or 1). Specify the value
as 1
The defaultis 0.
enforce Enable this to make the user info read only for
the user(values: O or 1).
The defaultis 0.

11. Click Save to save the setup.

Note: Every time you change a setting on the LDAP Setup page, you must re-enter the full LDAP
credentials.

19.16.7. Single Sign On Log-in types

You will have different SSO login behavior depending upon the configuration and priority of the Single
Sign On Instances.

Standard Login Page Instance (SLPI):

This will show the login page when not logged in. LDAP and plain password authentication are
examples.

Custom Login Behavior Instance (CLBI):

CLBI might redirect you to a portal or show a dialog. SAML is an example of the CLBI type.

WebCenter 14.0.1supports the SAML plug-in. Using this plug-in, WebCenter can communicate over
the SAML 2.0 protocol with Shibboleth, PingFederate and Active Directory Federation Services
(ADFS). WebCenter users can authenticate using their company-wide account. This will provide
seamless access to WebCenter.

Note:

You need WebCenter advanced license to enable this feature.

The plug-in supports the following SAML 2.0 profiles:

« SPPOST - 1dP POST
+ Unsolicited SSO(SP POST - IdP HTTP Redirect)

Note: SAML Artifact binding is not yet supported

Important: We recommend that you contact Esko solution architects for configuring the SAML plug-

In.

You can also access the login page by directly navigating to login.jsp. The different login behaviors can
again be triggered if the buttons for the wanted instances are listed on the login page.
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A plug-in may override the logout behavior. For example, logging out may lead you to a portal.

19.16.8. Single Sign on Passwords on Approval
When the Require password for approvals/rejections setting is enabled, your user is required to provide
his password during approval. This depends on the Single Sign On Instance used by the user.

When the Instance supports this setting, the password is the same as the one required for the Single
Sign On authentication.

19.16.9. Token Authentication

You can use Token based authentication to grant access to WebCenter without user credentials. For
instance, you can grant access to the document approval page for approval actions using a document
link.

» Token: A token is a piece of string that encodes various user data( username, expiration date,
signature, etc.)which acts as a substitute for credentials.

« TokenAuth: The WebCenter SSO plugin that is able to generate such tokens for WebCenter users
and authenticate users based on these tokens. This is installed during WebCenter installation.:

To allow Token based authentication, follow the steps below

1. Add a Single Sign-0On Instance on page 389 specifying a Token Authentication plugin.
2. Configure a Single Sign On Instance on page 391. Make sure that the instance is in the Allow status.

Settings

Expiration [#| Enable link expiration

validity 60 days 0 hours 0 minutes

The amount of time that a generated link or token will be valid to authenticate a User

m Back

3. Specify the Enable link expiration and Validity parameters and Save.

The Enable Link Expiration is on by default and the Validity is set to 60 days. This means that all the
links sent to authenticate using this instance will be expired after the validity period.

4. Tosendaloginlink to a User, click Mail Login Link from the User Profile page. The user can click on
this link to login.

@ Link Authentication | Default (Allowed) +
Login URL https:/frdvmwe11.esko-graphics.com/WebCenter_Inst/mytodolist.jsp?
jwt=eyJhbGciDiJIUzUxMiJ9.eyJzd WIiCilwMDAWMIBWMDAWMDA20D c3liwiZ XhwljoxNDkzMTMONT Q4fQ. ZyHcyWnWCegmCpCd4_
ChA41ZE9rhfH7gpbbwGgacVigPprMcrjJae 9yBfZpadgymreWpLBhUxWBO-jpbrXcmA

Mail Login Link

394



ESKO

WebCenter

The default landing page is the My Work page. If the token is expired, the user will see the Login
page with an error.

Whenever the token-authenticated user receives a notification with a link, the link contains a token
to authenticate without user credentials. This permits the users added to the approval cycle to login
using the approval links from the notification mails.

19.16.10. SAML Authentication

The SAML plugin will make it possible for WebCenter to communicate over the SAML 2.0 protocol
with Federated Identity Provider Services such as Shibboleth, PingFederate and Active Directory
Federation Services. This allows the users to authenticate through a Single Sign On (SSO) mechanism
with WebCenter using their federated identity.

The configuration page of an instance of the SAML 2.0 (v1) plugin consists initially out of four sections:

« SAML Profile - Used to specify which SAML profile to use.

« Identity Provider Details - Used to specify and submit metadata of the Identity Provider, as well as
configuring general customer specific settings.

Identity Provider Metadata:Update the URL to the meta data of the IdP or alternatively upload a
file containing the information.

Identity Provider Entity ID: Specify the ID to be selected from the metadata

Links WebCenter Username to : specify the field where WebCenter will look for the User
name in the response. It can either be Subject Name ID or the Attribute where you specify the
Attribute Name.

On error URL : specify the URL where the user will be redirected when error occurs in the
authentication process

On Logout URL:specify the URL where the user will be redirected during the Logout process

«  WebCenter Service Provider Details

Entity Id: This id will be auto generated when you save this page. By Default it points to the
current WebCenter Instance.

Assertion Consumer URL : This URL will be auto generated when you save this page.
Name Id Format: Specify the format of Name Id of the subject.

Formatting: Select Use URL Parameters if URL parameters has to be used in Assertion
Consumer Service URL.

Example:
https://domain.com/WebCenter_Inst/sso.wcr?ssoiid=00002_0000000004
Or:
https://domain.com/WebCenter_Inst/sso.wcr/00002_0000000004/end.wcr

Signing: If the request has to signed, upload the signing certificate.
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To be able to sign these outgoing authentication requests, WebCenter needs a private key and
its corresponding certificate. These can be uploaded in a Java keystore in the “SP Keystore”
field. This field appears along with the “Keystore Password”, the “Key Alias” and the “Key
Password” fields when the “Sign Authentication Requests” option is enabled.

- User Action Digital Signature: By selecting this option, you can use your SAML for credential
validation, when Approving Documents or for completion of Tasks.

« User Provisioning: Enable the option Allow User Creation on First Login to create new user in
WebCenter.

Following SAML attributes are required for the new user creation.

Attribute name Type Containing Required
WCR_USER_FIRST_MNAME String The first name of the user. Mo
WCR_USER_LAST_MAME String The last name of the user. Yes
WCR_USER_EMAIL String The email the user. Yes
WCR_USEFR._PHOME String The phone number of the user. Mo
WCR_USER_MOBILE String The mobile number of the user. | No
WCR_USER_FUNCTION String The job title of the user Mo
WCR_USER_GROUPS {Multi) The names of the WebCenter MNo
String groups to which the user should
be added.

« Authorization: Select Synchronize User Groups on login to synchronize the user membership
with the groups when the user log-ins to WebCenter.
» Save the changes and enable the SSO Instance in Single Sign-0n Instances page.

Now the |dP details from the URL or the uploaded file is displayed.

Check the information updated by clicking on WebCenter Service Provider Metadata which is used
to display the Service Provider metadata of WebCenter. This information can now be shared with
the Identity provider.

19.16.11. How to Login to WebCenter when the Single Sign On is broken
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You can access WebCenter overriding the Single Sign On configuration in emergency situations. This
can happen when the configured external system is down or when a mistake occurs leading to a broken
configuration.

Use basic password authentication locally from the web server to gain access to WebCenter.

Note:

«  You need direct access to the web server operating system to execute this.
« You have to remember a basic authentication password of a WebCenter Admin user. Or you should
have enabled Forgot Password feature.

System History Logs
All Single Sign on related events like

- Single Sign on Instance created
- Single Sign on Instance deleted and
- Single Sign on Instance changed
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are recorded and stored in System History. Read this page on how to access the records
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You can view Microsoft Office documents (and other file types)in WebCenter (16.1 onwards). This
feature requires configuration where you should specify the file extensions and corresponding OBGE

Workflow tickets.

Read in Configure Viewable Other File Types.

20.1. Steps to Configure Viewable Other Files

398

1. Modify: WebCenter Instance/custom/customizationConfig.xml.

Inside this configuration file, add a 'SupportedViewableOther' section. Within that tag, you can
place multiple instances of the extension tag, where you can define the file extension and the value

for ViewGenerationTicket (which refers to a Ticket on the OBGE).

<SupportedViewableOther>

<extension
ViewGenerationTicket="MSOffice to SVG"/>

<extension
ViewGenerationTicket="MSOffice to_ SVG "/>

<extension
ViewGenerationTicket="MSOffice to Pixel"/>

<extension
ViewGenerationTicket="MSOffice to Pixel"/>

<extension
ViewGenerationTicket="MSOffice to SVG"/>

<extension

ViewGenerationTicket="MSOffice to SVG"/>

</SupportedViewableOther>

value="

value="

value="

value="

value="

value="

.doc

.x1ls

.docx"

.ppt"

.pptx"

.xlsx"

Note:

WebCenter allows deployment of multiple web instances on one server and the configuration of
customizationconfig.xml is done per instance. However, the Workflow Engine and Dashboards are
shared across all instances. To make sure the settings work in a Workflow and in Dashboards, add

the following to the customizationconfig.xml file:

<MainInstance

value="true"/>

This should only be added to one WebCenter Instance. If it is added to multiple instances, these
configurations will overwrite each other. If it is not present in any instance, the extension list will be

ignored in Workflows and Dashboards.
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2. You need to create Custom Workflow Tickets (with a ScriptRunner Node) for OBGE according to the
mapping made in the customizationconfig.xml. See the examples for such Workflow Ticketsin
Recommendations and Examples on page 400.

« The ScriptRunner node should refer to the right server(can be the OBGE itself) where the right
conversion Script is located.

Read more in:Pixel Based Viewing Vs SVG Viewing on page 399

20.2. Pixel Based Viewing Vs SVG Viewing

You can view documents in pixel based or vector based formats depending on the view files that are
generated (as specified in the configuration.

Pixel based viewing
Use the pixel based setup if you need the graphical compare and channel information for the
documents. This setup will not render sharp text or text extraction.

To enable pixel based viewing, we propose the following structure in the OBGE Workflow Ticket:

« A Scriptrunner node to convert Other document to a viewable type, e.qg. PDF.
« ASelect Document node to select the generated document.
- APrepare for Viewing node to generate the pixel-based view files.

« AScriptrunner node to remove the temporary files created in the first step.

See Recommendations and Examples on page 400.

Vector based viewing
A vector based setup will enable you to extract text and view sharp text in deep zoom viewing.
However, the graphical compare and channel information are deactivated in this setup.

To enable vector based viewing, we propose the following structure in the OBGE Ticket:
« ConfigureScriptrunner node to convert Other documents to SVG files.

« Forsingle page documents, an SVG should go straight into the Job folder, which is passed as a
parameter to the script.

« For multi-page documents, an SVG for each page should go into a sub-directory of the Job Folder
with the page number as folder.

«  Werecommend generating a thumbnail for each page in the Script file. These need to go in the
same folder as the SVG file. The following files are needed:

1. <Document_name>.JPG, which is 200x200 pixels
2. <Document_name>_50.JPG, which is 50x50 pixels
3. <Document_name>_100.JPG, which is 100x100 pixels

See Recommendations and Examples on page 400.
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20.3. Recommendations and Examples

400

The setups detailed below will create 'viewable files'in two steps. The Microsoft Office documents will
be converted to PDF. In the next step, the PDF documents will be converted into SVG view files or pixel
based view files.

We recommend LibreOffice to convert the document to a PDF. This will just execute a “Save as PDF" on
the document. You can use MS Office which requires licensed MS Office to be present on the server.

The recommended solutions given below refers to the Tickets and Scripts given in the example folder.

Note: Remember to fill out the file paths mentioned in each of these Scripts.

See this KB Artcle for example scripts and tickets.


https://wiki.esko.com/pages/viewpage.action?title=How+To+Setup+Office+File+Viewing+for+WebCenter&spaceKey=KBAS
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21. Connecting to Automation Engine

You can connect to your or a client's Automation Engine from WebCenter. Using this connection, you
can:

« sendfiles
« push metadata
« launch a workflow

To establish a successful connection, you need to configure both the Automation Engine and the
WebCenter settings.

Read about configuring the Automation Engine here.
You can connect to Automation Engine:

« inthe same LAN or publicly available through an Automation Engine Host Address

Tip: The Host Address may look like '192.168.1.1 or 'aeserver.brand.com'.

« viaatunnel when not publicly available or not in the same LAN. Read in: Create a Tunnel between
WebCenter and Automation Engine on page 401

21.1. Create a Tunnel between WebCenter and Automation
Engine

When the Automation Engine is not situated in the same LAN and not available publicly, you need a
tunnel to send exchange workflow commands and data between WebCenter and Automation Engine.
To create such a tunnel, follow the steps below:

Web
1. Create a Workflow approval and tunnel client.

When WebCenter and Automation Engine are not on the same LAN, this workflow approval and
tunnel client will establish a bi-directional communication.

Note: The Automation Engine Pilot needs to have the workflow approval client credentials to send
messages to WebCenter.

2. Enter the Workflow approval and tunnel client credentials in the Automation Engine configure tool.

Fill out the client Name and Password and click the Check Connection button. This will check if the
user can log on successfully.

3. Save this configuration.

Tip: After configuring a new WebCenter site, it is recommended to close your Pilot and start it
again in order to see the updated list of WebCenter sites in your tickets.
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4, Optionally, you can check the connection between Automation Engine and WebCenter from the
admin > configurations > workflow and tunnel clients page. Click theStart Monitoring link to see if
the connection is active.

5. Click Admin > Configuration > Workflow Connections.

The Workflow Connections page appears, listing the workflow connections already created (if any).
Click New Workflow Connection.

Enter a Configuration Name.

Select the Connection type as JDF Service.

© ® N @

Now, specify the JDF Service as JMF service.

Note: You need JMF Service to connect to Automation Engine if it is not in the same LAN or not
publicly available.

10. Specify that your Automation Engine is connected via the Approval and Tunnel Client created in
step2. Select the Approval and Tunnel Client from the drop-down and click Generate URL.

Warning: A Workflow Connection connected through an Approval and Tunnel Client will
block one concurrent license.

11. Enable the Active Connection option to activate this workflow connection.

Note:

If you disable this option, there will be no synchronization between WebCenter and your workflow
system, but the connection data will be saved, so you can reactivate it later.

12. Click Create.
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SmartNames

A SmartName is a variable that refers to a value that is resolved according to the context, for example
[Project Creation Date] refersto the creation date of the current project. It is a placeholder
value for a property which will be replaced with an actual value when placed in the right context.

You can use SmartNames in different pages in WebCenter. They are displayed between square
brackets.

Folder: [Project Name] [1
You can also combine them with plain text.
Folder: [Project Mame]/designs []

Using SmartNames to specify a setting ensures that you can use the existing information without
having to remember it and thereby reducing errors.

For example, if you use [ Parent Project Name], the smartname will resolve to the name of the existing
Parent project(s) taking the current Project as the search context.

Using a SmartName

You can use SmartNames anytime you see the SmartName symbol «:in a text field.

1. Click:.
2. Inthe Select to append a SmartName field or Insert a SmartName dialog, select the desired
SmartName using one of the following methods:
a) During the autoname generation, browse to the desired SmartName in the Select to append a
SmartName field and select.
Alternatively, you can also double-click the SmartName.
b) Inthe Search using SmartNames, you can scroll in the main sections list and double-click on the
desired SmartName.

You can also search for a SmartName.

« The search field has support for AND and OR operators.

« Spaces can be used and will act as AND operators.

« Semicolons can be used and will act as OR operators.

- You can place your search term inside double quotes (") when an exact match is required.

Tip:

« You can type the first letters of the SmartName you are looking for to show it in the list.
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22.2. List of Available SmartNames
The following is the list of available SmartNames
Section SmartName Available Workflow  [Search AutoName
Attributes All WebCenter attributes are # #
available in both Workflow and
(Document) search
Attributes (Project) |All WebCenter attributes are # #
available in both Workflow and
search
Document [Document Description] #
[Document Extension] #
[Document ID] H
[Document Name] H #
[Document Version ID] # #
[Document Version Number] #
[Input Document Version Ids] #
[All Document Version IDs of #
Document]
[All except Latest Document Version #
ID]
[Document Version Revision] #
[Document Version Project] #
Other List # #
Project [Customer Legal Name] #
[Customer Location] # #
[Customer Name] # #
[Customer ShortName] # #
[Due Date] #
[Project Description] #
[Project ID] # #
[Project Name] # #
[Project Manager] #
[Project Manager Name] # #
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Section

SmartName Available

Workflow

Search

AutoName

Project Manager Location]

Project Manager Location Code]

Project Manager Last Name]

Project Name]

Parent Project ID]

T | | B B H®

Customer Location Code]

Salesperson]

[
[
[
[
[Project Template Name]
[
[
[
[

Project Creation Date]

Specifications

All WebCenter Specification
available only in Workflow

Task

[Workflow I1D]

Text/Table Content

[Content Status]

[Element Type]

[Language Status]

[Master Languages]

[ Text Content Value]

[Table Content Value]

[ Translation Languages]

Dates

[Current Date]

[Project Due Date]

[workflow Due Date]

[workflow Start Date]

B T T = - - - < =~ = S - < -~ - 5

User

[Requestor User Name]

[Requestor First Name]

[Requestor Last Name]

[Requestor Location]

[Requestor Company]

[Requestor Company Location
Code]

T " | B B K

F | OHF | | OB

Email

[Project Manger (E-mail)

[Sales Person (E-Mail)]

Workflow Task Owner (E-Mail)]
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Groups All Groups available in WebCenter #
Roles All Roles available in WebCenter #
Users All Users available in WebCenter #
Iteration Iterator Value #

Note: The EditField SmartName can be used only in the Suffix.
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23. Bill of Materials

23.1. What is a Bill of Materials?

A Bill of Materials (or “BOM")is a list of all parts and assemblies required to build a complete shippable
product. It shows what will be created and delivered during a project.

In WebCenter, this is a list of documents representing the deliverables. The documents can be actual
production files or placeholder documents.

23.2. Enabling the Bill of Materials Feature

By default, the Bill of Materials functionality is disabled for the entire WebCenter system. This means
that Bill of Materials features will not be visible.

To enable it, do the following:

1. Go to Admin > Preferences > General.
2. Under Bill of Materials, select the Use Bill of Materials option.
3. Click Save.

23.3. Viewing a Project's Bill of Materials

Every project has a Bill of Materials, which is by default empty.

If the Bill of Materials feature is enabled, you will see a Bill of Materials tab on your Project Details page.
The tab header indicates how many documents are linked to the Bill of Materials.

Note:
You will only see the document(s) in the Bill of Materials (and their attributes) if you are either:

« an Administrator,
» the Project Manager,
« invited to the Project, with view permissions on all documents in the Bill of Materials.

Otherwise, you will see a message stating that you don't have permissions to view the document(s)in
the Bill of Materials.
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Project: Drupal6_Library for Folding Carton

Manager: Keizer, Debbie (DEKE)

T i
st Upload Multiple Documents uetomer
Due On:

Mail link to Modified: Jul 6,2016

More...v Description:
Documents Bill Of Materials @  Tasks Discussions Characteristics ~ Attributes ~ More...~
More...~
[= Documents Count Folder Order Version Approval
+ W' LuMI_PLUS_ CARTON_BLUE.pdf (2.2M8) 1 foot Setup Approval Cycle
P Folder F !
+ | LUMI_PLUS_ CARTON_GREEN.pdf (s 4mB) 1 foct 2 Setup Approval Cycle
P Folder F Y
+ LUMI_PLUS_CARTON_ORANGE.pdf (13.6MB) 1 foot ERR Setup Approval Gycle
Folder
+ LUMI_PLUS_CARTON_PINK.pdf (4.8MB) 1 foot 4 Setup Approval Cycle
Folder
+ LUMI_PLUS_CARTON_PURPLEpdf Q. | & | & |= | i Foot 5 12| setupApproval Cycle
P Folder I !

m Copy || Add to Bill of Materials

When clicking this tab, you see the documents in the Bill of Materials, with information about the
documents (folder, version, approval cycle, tasks...)and their Count. This indicates how many copies of
that document are required for that project's Bill of Materials.

Note: The count is specific for a document within a project. This means that the same document can
be linked in multiple projects with a different count.

If adocument has an attribute category assigned, you will see a + button. Click it to show its attributes
(in list view), and click - to hide them again. To show/hide the attributes of all documents in the BOM,
click + or = in the header of the table.

Tip: By default, the “Default” view for the attribute category is displayed, but if the attribute category
has a view called “BOM", this view is shown.

23.4. Editing the Bill of Materials

23.4.1. Who Can Edit the Bill of Materials?
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Administrators and the Project Manager can always change the Bill of Materials. Other members can
be allowed to change it, if they have the Change BOM permission. This permission can be set on the
project’s Security page (see Project and Document Security in the User Guide).

Note: You can only set the Change BOM permission at the Project level, not at the folder level.
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If a user can change the attributes on the attributes page, he/she can also change them on the Bill of
Materials page.

Table: Permissions on Bill of Materials Documents

Administrators Project Managers |Users with Change |Users without
BOM Permission  |Change BOM
Permission
Can add/remove YES YES YES NO
documents to/
from the BOM in
active projects
Can add/remove YES YES NO NO
documents to/
from the BOM in
inactive projects
Can change the YES YES YES NO
count of BOM
documents

23.4.2. Adding Documents to the Bill of Materials

You can only add documents to the Bill of Materials if:

« youare an Administrator,
« you are the Project Manager,
« you have Add and Change BOM permissions on the Project.

Adding Documents to the Bill of Materials at Project Creation

If you want Project Managers to be able to already add documents to the Bill of Materials when creating
a Project, do the following:

1. Asan Administrator, go to the Project or Template that Project Managers will use to create
Projects, and click the Configure tab then Project Creation.

Tip: Use a Project or Template that contains a Bill of Materials with documents if you want Project
Managers to have the option to copy these documents into their new Project's Bill of Materials.

2. Select the Show check box for the Change Bill of Materials option.

If you want Project Managers to have to add at least one document to the BOM when creating the
Project, also select the Required check box.

Click Change.

3. When a Project Manager creates a Project from that Project or Template, he/she will see a Bill Of
Materials section on the Project creation page.

« when creating the Project from a Template, that section will contain the documents in the
Template's Bill of Materials.
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» when creating the Project from a Project, he/she will have to choose whether to copy the
documents from that Project's Bill of Materials into the new Project's Bill of Materials.

To copy them, the Project Manager should select including BOM in the Copy setup from an
existing project pop-up.

Note: A Project Manager will not see a Bill Of Materials section on the Project creation page when
creating a blank Project.

The Project Manager can still edit the Bill of Materials while creating the Project. He/she can:

« add documents using the Upload, Copy and New links,

« remove documents by clicking the - buttons in their rows,

» change the Count of Bill of Materials documents,

« edit the documents'attributes (by clicking + and filling them in).

Add Documents from the Bill of Materials Tab

From the Project's Bill of Materials tab, you can:

Upload a new document from your computer or network.
Copy a document from another Project.

Create a placeholder document from a document template.
Add a document already in the Project to the Bill of Materials.

Upload a Document from your Computer or Network

To upload a document into your Project's Bill of Materials:

1.

2.
3.

Click Upload at the bottom of the Bill of Materials tab.
Click the Browse button and browse to your document.
If desired, select a document template to use for your document.

Note: Thisis only available if the Project has been created from a Project/template containing
document templates, or if the Project itself has document templates configured.

The template you choose will determine what attributes are associated with the document.

If you don't select a document template, the document will have the attribute category associated
with its document type in the Configure > Document Creation tab of the Project (see Document
Types on page 100).

4. Fillin the attributes associated with the document (at least the required ones).

If desired, enter a new Name and a Description for your document.

Note: If Automatic Document Naming is set up for document creation in the Project, the Name will
be created automatically (you cannot enter it).

Enter the Count of this document (how many copies are needed for the Bill of Materials).

This can be a fraction or a decimal number.

Choose where to upload the document (in the Project's Root Folder or one of its sub folders).

Choose Default (Template) if you want to use the folder defined in the document template you
selected.
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Click Save.

Copy a Document from Another Project

To copy a document from another project into your Project's Bill of Materials:

s oo o

Click Copy at the bottom of the Bill of Materials tab.
Select a Project (or start typing a Project name) in the second drop-down list.
Select a document in that Project (or start typing a document name)in the third drop-down list.

If desired, select a document template to use for your document.

Note: Thisis only available if the Project has been created from a Project/template containing
document templates, or if the Project itself has document templates configured.

The template you choose will determine what attributes are associated with the document.

If you don't select a document template, the document will have the attribute category associated
with its document type in the Configure > Document Creation tab of the Project (see Document
Types on page 100).

Fill in the attributes associated with the document (at least the required ones).

6. If desired, enter a new Name and a Description for your document.

Note: If Automatic Document Naming is set up for document creation in the Project, the Name will
be created automatically (you cannot enter it).

Enter the Count of this document (how many copies are needed for the Bill of Materials).

This can be a fraction or a decimal number.

Choose where to upload the document (in the Project's Root Folder or one of its sub folders).
Choose Default (Template) if you want to use the folder defined in the document template you
selected.

Click Save.

Create a Placeholder Document from a Document Template

To create a placeholder document from a document template:

Note: Thisis only available if the project has been created from a project/template containing
document templates.

1.

2.

Click New at the bottom of the Bill of Materials tab.
In the pop-up that opens, select the document template to use and click OK.

The template you choose will determine what attributes are associated with the document.
Fill in the attributes associated with the document (at least the required ones).
If desired, enter a new Name and a Description for your document.

Note: If Automatic Document Naming is set up for document creation in the Project, the Name will
be created automatically (you cannot enter it).

Enter the Count of this document (how many copies are needed for the Bill of Materials).
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This can be a fraction or a decimal number.
6. Choose where to upload the document (in the Project's Root Folder or one of its sub folders).

Choose Default (Template) if you want to use the folder defined in the document template you
selected.

7. Click Save.

Add a Document Already in the Project to the Bill of Materials
To add a document already in the Project to the Bill of Materials:

1. Click Add to Bill of Materials at the bottom of the Bill of Materials tab.
2. Select the Project document to add to the Bill of Materials.
3. Enter the Count of this document (how many copies are needed for the Bill of Materials).

This can be a fraction or a decimal number.
4. Click Save.

Tip: In the Project's Documents tab, documents that are in the Bill of Materials have a BOM icon E£ You
can click this icon to see the Bill of Materials.

Add Documents from the Documents Tab
You can add documents that are already in the Project to the Project's Bill of Materials.

To do this, select the document(s) to add and click Actions > Add to Bill of Materials. This adds the
document to the Bill of Materials with a count of 1.

Add Documents from the Upload Page

You can also add a document to a Project's Bill of Materials while uploading a document using the
Upload button. You just need to select Add to Bill of Materials and specify a Count(see Uploading a
Document via Upload).

Note:
You can only do this if:

« youare an Administrator,
« youare the Project Manager,
« you have the Change BOM permission.

Add Documents from a Workflow

You can add documents to the Bill of Materials automatically using the workflow's Add to Bill of
Materials task.

In the task's Parameters, you can set the documents' Count.

Tip: You can use a SmartName (for example a document or project attribute) to set the count.
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Add to Bill of Materials

(]
(<] Count [BOM_count (Document)] []

Add to Bill of
Materials

Here is an example workflow using the Add to Bill of Materials task:

@o

Create Reports

e Y =] Ea— J (s
e G ®e , 3
Start Upload Add 1o BOM Data Collector s Ie van\n sta anp |9) Compieted
doc it
(@)
2 -]
U Fix comments
Check text
‘G}f °

Fix Ertor

Tip: You can use the Select Document task to select all the documents in the BOM (select the
Documents in the Bill of Materials option in the Parameters).

Add Documents from Automation Engine

You can add documents to a WebCenter Project's Bill of Materials using the Automation Engine Publish
on WebCenter task (from Automation Engine 12.1).

When you publish an Automation Engine Product to WebCenter, the Product Properties and
Product/Product Part Parameters will be taken as WebCenter attributes.

If there are existing WebCenter attributes with corresponding names, their values will be updated
during publishing.

The following Product (Part) properties and Product (Part) Parameters are synchronized with
WebCenter attributes:

Automation Engine Properties/Parameter WebCenter Attribute (Internal name)
Product Customer Reference ae.p.cusref
Product Custom Field 1 ae.p.categoryl
Product Custom Field 2 ae.p.category?2
Product Custom Field 3 ae.p.category3
Product Internal ID ae.p.id

Product ID ae.p.prodid
Product Name ae.p.name
Product Description ae.p.desc

Product Part Internal ID ae.ppid

Part Default Angle ae.pp.defaultangle
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Automation Engine Properties/Parameter

WebCenter Attribute (Internal name)

Part Default Dotshape
Part URL

Part Default Ruling

Part Preferred InkBook
Part Preferred InkBook Ul
Part Internal ID

Part Custom Field 3

Part Custom Field 2

Part File

Part Status

Part Status Nickname
Part Status User

Part Status Notes

Part Status Date

Part Folder

Part Custom Field 1

Part Name

Part Inks

Part Barcodes

Product Customer Name
Product Customer Description
Product Customer ID
MyProductParameter]

MyProductPartParameter2

ae.pp.defaultdotshape
ae.pp.url
ae.pp.defaultruling
ae.pp.preferredinkbook
ae.pp.preferredinkbookui
ae.pp.id
ae.pp.category3
ae.pp.category2
ae.pp.file

ae.pp.status
ae.pp.status_nickname
ae.pp.status_user
ae.pp.status_notes
ae.pp.status_date
ae.pp.folder
ae.pp.categoryl
ae.pp.name

ae.pp.inks
ae.pp.barcodes
ae.c.name

ae.c.desc

ae.c.id
ae.p.par.MyProductParameterl

ae.pp.par.MyProductPartParameterl

When a Product or Product Part is published, corresponding WebCenter documents are automatically

added to the Bill Of Materials of the Project.

The Product Amount for the Job (if given) becomes the Count property of the Bill of Materials.

23.4.3. Removing Documents from the Bill of Materials
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To remove a document from the Bill of Materials, select it in the Bill of Materials tab and click Actions >

Delete from Bill of Materials.

Note: Removing a document from a Project (or moving it outside that Project) removes it from the

Project's Bill of Materials as well.
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23.5. How to Search for a Bill of Materials

23.5.1. Search for Projects that have a Bill of Materials

When searching for Projects using the normal search, you can specify that you only want to see
Projects that have a Bill of Materials. To do this, select Only Projects with Bill of Materials in the Bill of

Materials option.

23.5.2. Viewing the Bill of Materials in a Project Search

When searching for Projects, you can view a summary of the Bill of Materials documents per approval

status for each Project found.

To do this, just select the View (List) option for Bill of Materials on the Search For Projects page. See
Search Result Options in the User Guide for more information about displaying search results.

Search Results

More...»

-_]!‘ Demo_00001
Demo_00002

_:—{/*/ Demo_00003

@ Demo_0004
@ Demo_0005
Y

Save This Search Save Search Results

Status

Bill of Materials

WY @ XK B

11 2 1 &

WX B
15 6

X
1
(1]

1

X
1

In the Bill of Materials column on the Search Results page, you can view the number of:

L4 approved documents,

W force approved documents,

ﬁ rejected documents,

2#* force rejected documents,

@ documents waiting for approval,

@ documents with a paused approval setup,

X documents without an approval setup,
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* E(all)documents,

... in each Project's Bill of Materials.

Tip: Click one of the approval statuses'icons (for example pending @)to show the BOM documents
with this status.

23.6. How to See if a Document is Part of a Bill of Materials

In the Project's Documents tab, documents that are part of the Bill of Materials have a BOM icon E=.
You can click that icon to go to the Project’s Bill of Materials page.

On the Document Details page, the BOM icon E indicates whether the document is a part of a Bill of
Materials. You can also click that icon to go to the Project’s Bill of Materials page.

Note: A document can be part of more than one Project's Bill of Materials (if it is linked into multiple
Projects).

23.7. Bill of Materials History

You can see all changes made to your Project's Bill of Materials in the Project History.
You can see for example:

« new documents added to the Bill of Materials,
« documents removed from the Bill of Materials,
« changestoadocument's count.

23.8. Email Notifications for Bill of Materials Changes
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To send email notifications when something has changed in your Bill of Materials:

1. Inyour Project, go to the Notifications tab and select who to Notify by E-Mail in the Bill of Materials
Changed row.

2. Click Save.
The recipients will get emails when:

« adocumentis added to the Bill of Materials,
« adocumentisremoved from the Bill of Materials,
« adocument's countis changed.
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23.9. Working on the Bill of Materials from ArtiosCAD
Enterprise

With ArtiosCAD Enterprise, you can see all your Projects and (ArtiosCAD) documents from WebCenter.

If you open a document in ArtiosCAD Enterprise, you can go to the Project’s Bill of Materials and see a
list of all the Bill of Materials documents.

Note: You need ArtiosCAD Enterprise 12.1to work with WebCenter Bills of Materials.

Database IPrn'EI-_-. Window Help

Project [nformation...

Project Bill of Materials...
s Project Refresh
Open Project in Web Browser...

Bill of Materials L

I [

In ArtiosCAD Enterprise, you can:

« change the count of ArtiosCAD files in the Bill of Materials,

. addadocument revision(a, B, C...)to an ArtiosCAD file (this is shown in the Version column of the
Bill Of Materials tab, and in the document's Action History),

Note: When you work with revisions on a Bill of Materials document, the latest version within a
revision is the version in the Bill of Materials.

« addaprintitemtoan ArtiosCAD file (this is shown in a separate column in the Bill Of Materials tab),

« change the order of the Bill of Materials documents.

Once you click OK, this is updated in WebCenter.

Note: You cannot add a document revision or a print item to an ArtiosCAD file, or change the order of
the Bill of Materials documents from WebCenter.
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24. Autonaming

24.1. Autonaming Projects / Documents

An administrator can configure a setup for automatically naming the projects and documents. You can
specify the rules for both Project and Document Autonaming.

Note: By default, this feature is not enabled.

24.1.1. Autonaming Structure

An Autoname consists of a Prefix, Suffix and Counter Length.

A Counter keeps track of the count when a new project is created or when a new document is
uploaded. The Counter Length is the fixed length of the Counter.

For example; If the Prefix is begin_, Suffix is _end and the Counter Length is set to 4, then the
Autoname will be begin_0001_end. The next one will be begin_0002_end.

begin_0001_end
| I I |

v

Prefix Counter Suffix

Note:

The Project / Document Autonames are generated during the Project creation or Document
submission.

Note:
» The Prefix field cannot be empty. The Prefix and Suffix fields are limited to 150 characters for
Counter Length field is 20.

« If the counter lengthis 0 or left empty, no numeric part will be added to the Autoname. The
maximum characters for Counter Length is set to 20.

24.1.2. Autonaming Projects

You can configure Autonaming for Projects in the following ways:
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Systemwide Project Autonaming on page 419

Autonaming in Projects / Templates on page 419

Systemwide Project Autonaming

You as an administrator can enable/disable systemwide Project Autonaming.

1.

2.
3.

Login to WebCenter as an Admin user.
Click Admin > Preferences > General. The General page appears.

In the Project Autoname Generation section, specify appropriate Prefix, Suffix and Counter
Length.

Click « to select required SmartNames. The EditField SmartName can used only in the Suffix.
Enable Use Automatic Naming for Creation of Blank Projects to apply the autoname generation
settings for projects created from a blank template.

Click Save to make the changes.

Autonaming in Projects / Templates

Use template based Autonaming setup to apply automatic naming to the Projects created from a
Template or another Project.

Note: If you setup Autonaming in an existing template, only the future Projects will be named
automatically.

Note: When you setup Autonaming in a template, only the future projects will be named automatically.
It does not alter the existing Projects created from the same template.

1.

2.
3.

Login to WebCenter as an Admin user.

Click Admin > Project Management > Projects or Templates.

Choose the Project or Template and go toConfigure > Project Creation tab. Enable the Use
Automatic Naming option. Then select:

« Use Custom Automatic Naming to specify an automatic naming setup just for this Project or
Template.
+ Use Default Automatic Naming, if you have configured Systemwide Project Autonaming.

You can apply the same settings by selecting the Use Default Automatic Naming option.

If you select the Use Custom Automatic Naming option, you have to enter the text boxes with
appropriate Prefix, Suffix and the Counter Length.

Note: Click:to select required SmartNames. The EditField SmartName can be used only in the
Suffix.

Click Change to make the changes.

24.1.3. Systemwide Autonaming for Different Document Types

The administrator can set up the document Automatic Document Naming settings per Document Type
in the following ways:
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«  System-Wide Document Autonaming on page 420

« Template/Project-based Document Autonaming on page 420

System-Wide Document Autonaming

The administrator can set up the document Automatic Document Naming settings per Document
Type.

The options available are None or Custom Automatic Naming options. The Custom option allows you to
customize the required autoname setup.

The option Apply Automatic Naming to Documents in Blank Projects allows you to setup autoname
generation for blank documents also. The Apply Default Attribute Categories to Documents in Blank
Project option allows you to add the default attribute category to documents which exits in blank
projects. For example: If you upload abc.ard file and the Prefix is [FolderName] the Counter Length is
set to &4 and the Suffix is empty, then the autoname will generated as DESIGN_0001.ard.

Using the Scope of the Counter option the administrator can specify whether the counter will
continue counting system wide, or whether it will reset for every project.If the option Reset per
Project is selected then, autoname will be generated as begin_0001_end and next document will be
begin_0002_end and so on.

If System wide Counter is selected and files already exists, autoname will be generated as
begin_0098_end and next can be begin_0112_end. The counter here depends on the number of files
which are uploaded to the system and not on each of the project.

1. Loginto WebCenter as an Admin user.
2. Click Admin > Preferences > Document Types. The Document Types page appears.
« Select the Apply Automatic Naming for Creation of Blank Projects check box to apply the
autonaming setup to the Projects created from blank template.

3. Set the corresponding Automatic Document Naming field to Custom.. Read more in:Document
Type Preferences on page 35
a) Specify a Prefix, Suffix and the Counter Length. Read also: Autonaming Structure on page 418
b) Specify the Scope of the Counter.

c) Optionally, you can enable File Extension Specific Counter for autonaming. This will make sure
that you have different counters for different types of documents.

If the option Reset per Project is selected, the Autonaming will be reset in every project and the
counter depends on the documents uploaded to any single Project.

If System wide Counter is selected, the Autoname will be generated counting the existing files (for
example: begin_0098_end). The counter here depends on the number of files which are uploaded to
the system and not on each of the project.

Note: Click: to select required SmartNames. The EditField SmartName can used only in the Suffix.

If you upload abc.ard file to the folder Design where the Prefix is [FolderName], the Counter Length
is set to & and the Suffix is empty, the name of the document would be DESIGN_-0001.ard.

4. Click Save to make the changes.

Template/Project-based Document Autonaming

« Template/Project-based document autonaming: The administrator can set up the document auto
name settings per document type on the Document Types page. The Document Types page allows
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to enable/disable specific document types and is extended to also have a section for setting auto
naming details per document type. The administrator can specify Prefix, Suffix and Length for each
of the Document Types available.

Note:
Only newly uploaded documents will have the correct auto naming settings applied to them.

When the option Apply automatic naming to Documents in Blank Projects is selected, the default
settings will be used when uploading documents in projects which are created without a template.

Counter Length | 5

suffix | _[editrield] [1

Using the Scope of the Counter option the administrator can specify whether the counter will
continue counting system wide, or whether it will reset for every project.

If the option Reset per Project is selected then, autoname will be generated as begin_0001_end and
next document will be begin_0002_end and so on.

If System wide Counter is selected and files already exists, autoname will be generated as
begin_0098_end and next can be begin_0111_end. The counter here depends on the number of files
which are uploaded to the system and not on each of the project .

The SmartName [Project Attribute]and [ Document Attribute] contains an extra option. When
selecting these options, an extra drop-down appears to select the attribute. It is advised to set
such attributes required in the creation view of the attribute category, else this part of the name
will remain blank.

Note: Changing or modifying the attribute value after creation of the project or document will not
change the existing name.

Login to WebCenter as an Admin user.

Click Admin > Project Management > Templates. The list of available templates appearsin the
Template Management page.

Click one of the required templates and then click Configure > Document Creation. The Document
Types page appears.

Select the required Document type and then in the Automatic Document Naming section choose
between None, Default or Custom options.

a) If you select the None option, the autonaming option is not selected.

b) If you select the Default option, the setting as per System wide Document Auto Naming
Settings are taken into consideration.

c) If you select the Custom option, you can enter the text boxes with appropriate Prefix, Suffix and
the Counter Length. The Scope of the Counter specifies whether you want the counter to work
on all the documents in the system, or only to work on the documents of the project when a new
document is created.

Note: Click:to select required SmartNames. The EditField SmartName can used only in the
Suffix.
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The SmartName [Project Attribute] and [ Document Attribute] contains an extra option. When

selecting these options, an extra drop-down appears in which an administrator can select a
required attribute.

5. Click Save to make the changes.

Note: When the Document Autonaming settings for a Template are changed, these are not applied to
all projects already created from this template.

24.1.4. Using SmartNames in Autonaming

You can use SmartNames to set the prefix and suffix in AutoNaming.

The SmartNames list contains general Project information and all the Attributes defined in the system.
You can use several SmartNames or a combination of SmartNames and free text.

Note: To know more on configuring project information see Project and Document Attributes on page

« Click the Insert SmartName button . and select a SmartName from the list that appears next to the
button.
Project Autoname Generation
Prefix | [Customer ShortNamel_ [1]
CounterLength 5
Suffix __[EditField] []

[Project Attribute] v

| Select to append a Smartname
[Customer Name]
[Customer Short Name]
[Customer Location]
[Customer Location Code]
[Edit Field]
[Project Template Name]
[Project Creation Date]
[Project Manager Last Name]
[Project Manager Name]
[Project Manager Location]
[Project Manager Location Code]
[Requestor Username]
[Requestor Last Name]
[Requester Locatior]
[Requester Company]

| [Requestor Company Location Code]

If you select:

- [Project Attribute],
« [Document Attribute],
- or[Project Creation Date],

you will get another Select to append a SmartName field in which you can select a required
attribute.

See below some examples of SmartNames in Autoname Generation:

Project Autoname Generation

Prefix | [Customer Location]_[Creation Date:dd MM.yyl_ [1
Counter Length 4

Suffix | _[EditField] [1
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The result will be, for example: Chicago 23.12.12 0001 printpromotion.

¥ ArtiosCAD Design v Custom None v None

prefixs | [Folder Namel_ [1
Counter Length | 4
Suffix | _[EditField]_[Customer Location] [1

Scope of the Counter  Reset per Project

The result will be, for example: CAD 0001 printpromotion Chicago.

Note:

The [EditField] SmartName can used only in the Suffix and if required, the administrator can edit
this field. If the [Edit Field]is empty, then it is not replaced by any text, but left blank.

Ensure that you do not use square brackets[ ]for other fields. The system will take it as a
SmartName.

You can use several SmartNames if desired, or a combination of SmartNames and text.
If a SmartName is selected and if it is empty or not found, the field will be blank in the Autoname.
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25. Program Management

25.1. Introduction

Many Brand Owners are tackling large, complex packaging programs (campaigns) which span across
packaging ideation to delivery of individual packaging to specific markets. Typically these efforts
involve several parallel and sequential projects. While a packaging project involves dealing with a
relatively short-term objective, a Packaging Program (Campaign)is much more complex and deals with
several short-term and long term objectives and requires a large pool of resources.

Accomplishing a program’s objectives involve planning and conducting a number of related projects,
multiple work streams with their own requirements and planning, the results of which are components
of the overall outcome.
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25.2. Program Management Related Components

WebCenter has features to specify components, create a group of projects in a Program hierarchy and
modify them as needed.

WebCenter Program management offers:

« Component definition and approval

« Creation of Child Projects under the hood of a Program

« Ability to attach (and remove) existing projects into a Program
« Communication between the Program and its Projects.

« Features to support multiple levels: for example, a Project/ Grouping /SKU/Component.

« Shared Projects and Components among different Programs

« A Program Overview with drill-down and Dashboard. The program overview will provide the status
and risk indicators.

25.2.1. Definition and Approval of Components

Program planning may require multiple iterations and produce multiple work products and
components. As a first step, you need a Program (Parent Project) setup which describes the outline,
rationale, launch criteria, important dates and involved regions and suppliers. The second part deals
with the individual or child projects within the Program which are entirely dependent on the products
and component planning.

Defining Products and Components in the Briefing Phase
To start a Program with new Products and Components, the Program Manager can use a placeholder
document(Document Templates on page 95). To define existing components, just refer to them
as Document References on page 306 or copy them to the current scenario. You can source the
components from existing libraries, contextual saved searches, or from a previous program.

If you have configured a duplicate action, the user can easily create a copy of the component (for
example, variants)including its meta-data and document references values.

See the example below. The following structure can be built into your Program Template using its
Attribute Category's document sources.
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-+ Add Product From Library =+ New
El=] Thumbnail Name

- i,  Getsetpng

Product components

= Upload New Component =+ Add Component from Library =+ New
- W EIM | Get Set_Multivitamins.png

MileStone Dates

Due Date Briefing
Due Date Legal Approval
Final Delivery

Roles

For example, when you initiate a Program for multiple SKUs, you can use Document Templates for new
SKUs. The Products can keep common approved Components as document references. Using the
document reference table, you can:

« Define products and components along with their master-child relationships,
« Easily duplicate a Component with its meta-data
« Process them through an approval process if needed

Artwork

)

)

See details about how to create Projects based on these documents in Adding/Creating Projects in a
Program on page 427.

Create Components

To streamline your Program's product and component definition, follow the steps below:
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« Create an Attribute category for the Parent Project Template with document references and other
Attributes.

Note: Read more about shared Attributes in: Create a Child Project on page 430.

« Add Document References to the Program Template's Attribute Category.
« Define Document Sources for your Documents
« Define how these documents should appear in the Template

« Configure duplicate option in the rendering of the document references

25.2.2. Adding/Creating Projects in a Program

Once you have defined a Program or Parent Project with components, you can add multiple Child
Projects as members in a few ways. You (as an admin user) need to configure actions in the menu for
any of these options to become available.

You can:
« Create Projects individually based on a Child Project Template.

This provides an interactive way of creating a child Project from the Program context. If you
have common Attributes configured in both the Program and Child Template, they can be shared
between the Parent and Child. For example, Program's Attributes such as milestones set in the
Program and Role setup.

The administrator has to configure a Create Child action for a Program Manager.

The Child Project Template can have Attributes and documents that are not shared with the
Program.

Note: The Child Projects are independent WebCenter Projects that can have their own planning,
workflows, folder structure etc.

Read more in: Create a Child Project on page 430.

« Create Projects using a workflow.

You can use workflow to create multiple Child Projects in one go. You can either add this step into a
workflow or create a dedicated workflow action in Project details page.

Tip: Create a custom workflow action for Project detail and apply it to the Program Manager's menu.
You can then select multiple documents and launch a workflow. You can use this more than once if
you want to launch your Program in waves.
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« Add an existing Project.

You can add existing Projects to a Program. For example, you may want to use an approved SKU-
project in a Program. The Attach action lets you select and add an existing Project as a child.

Read more details in: Attach Project Action in a Program on page 431

« Create a Sibling Project. Create sibling action allows you to copy the setup from your existing Child
Project to create exact replicas or variants with slight modifications. For instance, after creating
component Projects, you may see that you need an extra component with the same requirements.

It is possible to modify some Attributes after creation of a variant. Or you can disable copying of
some elements by unchecking them. The options are the same as in Create a Project Based on
Another Project

This action will be used when creating variants of the child project.

Note: All these actions are configurable and you can configure the actions that are most relevant in
your Program-Project hierarchy.

Notes

+ You need Change Property rights (in both levels) to establish a relationship between parent and
child.

« Aproject can have multiple children and can have multiple parents.

» Allrelationship changes are logged in the Project history.

Configure Create Child Action in Program's Details

As an Administrator user, you can customize the Project Details actions to include a Create Child
Project action.

« Go to Admin > Preferences > Menu > Actions > Project Details > Project Header.
« Select the Menu you want to edit.
« From the Action Gallery, drag the Create Child Project to one of the Custom boxes.
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Merms Project Lists  Project Details # = DocumentDetails ~ Search #  Cart My Work
Project Header #  Project Documents (Table)  Project Documents (Document)  Project Bill of Materials (Table)
Project Bill of Materials (Document)

| Custom Menu LY

Action Gallery

Left Actions Custom Jio) [ custom IR

Upload Multiple Documents upload Create Child Project
Mail link 1o

Upload Multiple Documents ‘Add Existing Child Pro..
Search

View History
Search N
Download View History

Add to Cart

Add to Favorites

Save As Template

Update

Copy Project

Delete Profect Yiou can drag) Available actions to) the)
Run Project Report @.u.S.tQm b‘G)X'é_S).

Top Actions

Available Actions
Copy/Create Multiple N.
Create Child Project
Link Existing Projects
JavaSeript

Read more in: How to Create a Custom Action Button on page 51

« Edit the settings of this Action. You can customize this to suit your needs. See more in: Action
Settings on page 49.

Edit Menu: Create Child Project
Lz; Create Child Project

Label Type [simple v
Label * [Create Child Project
o Llallusers
Administrators

“IProject Managers

_/Create Task Rights
Visible To * _Create User Rights

—Mormal Users

In Groups €

®all Groups
_'Specific Groups

Action Type Built-in
Praject Template | child Project Template v
Priarity | Default (visible if space available) ¥ |
Rendering [lcon and Label v
lcon [Proj-Createchild v
Color | Green v
Praject Visibility,

o o | Wparent ¥ |
Parent Menu Top Aclions

We recommend that you do the following optional steps:

a) Select the users for whom you want to make this Action Visible To. In the example, this Action is
set only for Project Managers.
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b) Select a Child Project Template. This will be the Template that will be loaded when a Project
Manager (user)click on this action.

Note: If a Template is not specified in this action, your user can:

« either select a Template that is available in the system
« orcreate aProject without a Template

c) Specify a Project Visibility characteristic.

1. Create a specific Characteristic for configuring a menu item. You can create characteristics
for your custom menu items as well as the default ones.

2. Select the specific Characteristic in the Project Visibility field of the action. You can select
this from the drop down list.

This menu item will appear in the Project Details page only if the specified Characteristic was
assigned to the project or the template.

As an administrator, you can switch this on and off in the Project Details > Characteristics page.
» Save.

Create a Child Project

To create a new Project as a child project of a Program, you (admin) can configure a Create Child
Action in the Program. Once configured, the Program Manager and the Project Members will be to
create Child Projects in your Program.

The Child Projects inherit the attribute values, role assignments and company information from the
Program, and they can have their own set of attributes and workflows.

The Project creation uses the Template configured in the menu.

For example, if the custom action links the template “Child Project Template”, then this is used in
creating the child Project.

The child inherits most of the setup from the Template except the values of:

« Company/ Location
« Attribute Values

+ Role Assignment



ESKO

WebCenter

Note:

The Attribute categories are inherited from the Template (used to create the child Project) and the
values of the common Attributes (present in both Parent and Child Templates) will be inherited from
the parent.

Note:

« Ifacommon attribute has an empty value in the Parent, the value will be taken from the Child's
template.

Similarly, the Roles are taken from the Template but the assignment of the Roles will be taken from
the Parent. If the Roles are not assigned in the parent, the assignment will be inherited from the
Template.

| Caution:

AR

If the Parent and the child Project's template have different role assignments, the
assignment of the parent project is taken.

If a Template is not specified in this action, your user can:

+ selectaTemplate that is available in the system.
« orcreate aProject without a Template

You can have a document source with a SmartName search to point to the parent Project

Attach Project Action in a Program

To add Projects to a Program, you need a Saved Search configured in your Program to list 'related'
Projects.

The administrator can specify the Saved Search that should be used to search and find these possible
child projects.

To create a custom Link Existing Projects Action in the Project Details (of the Program), follow the
steps below:

1.

Go to Admin > Preferences > Menu > Actions > Project Details > Project Header.

2. Select the Menu you want to edit.

3. From the Action Gallery, drag the Link Existing Project to one of the Custom boxes.

This Action is available in Project Search Results by default.

Edit the settings of this Action. You can customize this to suit your needs. See more in: Action

Settings on page 49.

a) Select the users for whom you want to make this Action Visible To. In the example, this Action is
set only for Project Managers.

b) Select a Saved Search. This will be the displayed in the pop-up to select a Project.
Specifying a Saved Search (for example, based on common attribute values)in the Attach action
allows you to configure a pop-up dialog with the most relevant projects.

c) Optionally, specify a Project Visibility characteristic. Select the specific Characteristic in the
Project Visibility field of the action.

This menu item will appear in the Project Details page only if the specified Characteristic was
assigned to the project or the template.
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As an administrator, you can switch this on and off in the Project Details > Characteristics page.

In the Program's details, you can use this Action to select Projects (from a Saved Search)and add to the
Program.

Add Sibling Projects

If you want to clone a Child Project within the context of a Program, configure the Create Sibling
Project action in the Project details page.

You have to configure the action in the Child Project Details and make sure that it is applied to the
Project Managers' menu.

The cloned sibling will be a copy of the child Project from which the action was started and it will also
have the same Parent Project.

Notes

« If the child Project has multiple parents, the cloned Project inherits all the parents where the
Project Manager has “change property” permissions.

« Inthe original parent project, an entry in the action history is added to indicate that the new project
was added as a child.

Create a Sibling Project

1. Click the Create Sibling action button from a child Project of your Program.

2. Inthe Copy setup from an Existing Project pop-up, select what you want to copy (and deselect
what you don't want to copy).

Copy setup from an Existing Project

#| Copy Project Manager
# Copy Members
¥ Copy Approval Settings
# Copy Folders
Including Documents
Including Bill of katerials
# Copy Attributes
#| Copy Characteristica
# Copy Tasks | From Source Project ¥
#| Copy Security Settings
# Copy Notifications

# Copy Discussions

cocet |3
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For Tasks, you can choose to copy the Tasks from the original Project or from another project by
typing in the template name. The default setting is to copy Tasks from the Project that is being
copied.

Click OK.

Fillin the new project's Details.

If desired, add Documents to the project.

Add Members to the project.

If the template has attributes defined, fill them in the Attributes section.

Click Create.

N oo r oo

This brings you to the new project's details page.
Creating a project adds an event and this is stored in the Project History.
This event will add following information to the Project History:

« The Project/Template from which the new Project is created.
+ Thename.

« The Project Manager.

- The Salesperson (if there is any).

« The Customer (if there is any).

« The Location(if there is any).

« The description (if there is any).

Note: When a project is created from a template or an existing project, then only the changes
(like deletion of attribute values or adding a new document) from the template or existing
project islogged in the events.

25.2.3. Remove Projects from a Program

You can configure and use Detach and Delete actions in a Program.

» If you want to remove child Projects permanently from the system, select them in the child Projects
tab of a Parent Project and click Delete action.

- Toremove some child Projects from a Parent, use the Detach action. This action removes them
from the parent, but does not delete them from the system.

This is a configurable action that has to be set up in the Saved Search displaying child Projects. Read
more in: Detach Child Projects on page 196.

Detach Child Projects

You can configure Detach Child Project(s) operation in a Saved Search. Program Managers can use
this in a contextual Saved Search configured in the Parent Project's details. The use case is that the
Project or Program Manager can select existing Child Projects displayed in the search tab and detach
them from the Parent Project.

Note: The action is only available to the users with Change Permissions of the parent and child
project.

433



ESKO

WebCenter

« Create aglobal Saved Search to search on child Projects. Enable the Search Result Layout option
Allow Detaching Child Projects.

« Apply the Saved Search into the Project Details menu of the Parent Project Manager.

« Todetach child Projects, go to the Child Projects tab with the saved search, select child Projects
and click Detach Child Project(s).

25.2.4. Program Dashboard with a Drill-down View

434

You can also build different types of overview on on-going programs as a way to easily monitor
your Program and Projects. The solution allows you to build overviews at all levels of your Program
hierarchy.

The admin can create searches with any relevant criterion and use them in different levels of the
Project drilldown.

To build a high level overview, use the following advanced the Saved Search features:

« Drilldown
« Dashboard

The drill-down feature allows you to quickly access the specific Projects or Components that require
special attention.

Drilldowns
You can use Project search based drilldowns to set up a:

« Drill-down into all levels of Projects. This feature allows the Program Manager to explore project
data beyond the overview. If you have a nested structure (Project / Grouping / SKU / Components)in
your Program, an expand button lets you access the next level.

« Drill-down into Components (documents) or Tasks
Read more in: Configuring a Drill down Search on page 179

The example screenshot gives an overview where the Program Manager can quickly zoom into
Programs based on their status (which in turn is based on the status of their child Projects).
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1. The parent Search with Programs. This example shows a Search Results Dashboard on page 180
with counters.

2. The second level of Drilldown which executes the Saved Search specified in the parent search. This
search contains a Dashboard with a Facet Graph.Configuring a Drill down Search on page 179

The third level of Saved Search with a Document Search.

4. The expand button to execute the drilldown.

o

Dashboards
The interactive dashboards can be configured with:
« Counters.

You can, for example, build a diagnostic overview of the status of your Program using counters. You
can, for example, show the Project Statuses in these traffic light counters( at risk, in delay, or on
track). With a simple click on one of these counters, you can zoom into the relevant Projects.

In the example above, a click on the “On Track” counter will display the search results for specified
in the counter configuration. The status is only an example, you can build your counters based on
any relevant Attribute that you may want to monitor. Each counter has it's own saved search and
displays the count of the results.

Read more in: Building a Search Based Counter on page 184.

« Charts to visualize your Program data.

You can configure facet based Charts in dashboards and use them in your Program hierarchy to
visually display the Program data. The Charts(based on facets) shows the distribution of values.

A simple click on a chart section(value) will refine the results. In the screenshot, the counters
provide the most high level overview where as the first level drill-down displays a pie chart which
shows the distribution based on Project Status.

Overview from Programs and Projects

In addition to the overview of all Programs and their drilldowns, you can also configure contextual
saved searches for your Parent Project Details menu. If you are a Program Manager workingin a
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Program's details page, you may need direct access to the child Projects. Likewise, from each of the
Child Project, there should be access to the parent or Program.

To configure this:

1. Create a Saved Search for Parent Projects. Similarly, create another Saved Search for Child Projects
and plug this into the Parent's Project Details menu.

Tip: Use SmartNames to use Saved Searches in the context of a Program or Project. If you set the
Parent Project as the [Project id], your results will list all the Child projects of the current project.
See more in: SmartNames in Search on page 174

2. Plugthese searches into Project Details menu and apply it to the relevant users (Program Managers
and Project Managers).

25.2.5. Communication Channels-Rules
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Since the projects are children or sub-projects of the overall program (campaign), there is a need for
communication among all levels, program to projects, projects to program and among projects. The
updates happening in a program have mutual consequences and therefore should be communicated in
both ways. You may want to setup the following channels:

« Alert the parent or arelated project about a new deliverable
« Alter the status of arelated Project depending on another
« Notify Program when a child Project encounters change: a status update or metadata change.

Rules in Programs and Projects
The Administrator of the system can configure "actions" "triggered" by an "event". These are Rules that
can be specified in the Program/ Project's templates. Rules enable you to start tasks automatically
based on events in your project.

The triggered actions will be implemented in the Program or Project specified in the attached
"action(Task based Action). You can use the JavaScript node in the Task to execute these actions.

The configuration of the Rules is based on Program/Project Template and therefore, once setup, can
be reused (or exported)in future Programs.

See some examples of Task based Actions below:

« Ifachild Project's status changes to Overdue, change the status of the Program to At Risk
» Change attribute values in a Program based on the values in the child Project
« Calculate task overdue status every hour and send reminders

The JavaScript node allows you to enables you to update crucial parameters of related Projects. See
details in the Workflow section.

Configure Rules in a Project

What is a Rule?

You can configure a Rule to execute specific Actions based on one or more Trigger events. The Rule
sets reside in Project Templates and will be applicable in all Projects created from them, including the
previously created ones. This administrator feature lets you establish communication between Child
and Parent Projects or between any two Projects. See an example use case at the end of this chapter.
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Note:

You need the WebCenter Task Management Advanced or WebCenter Life Cycle Management license
to be able to define Rules.

To set up Rules, go to Project Template > Configure > Rules Setuptab.

Note: Although Rules are configured within a Project Template, you can create Rules that are
triggered after the project is created from the template.

Triggers

A Trigger is an event that happens in the system (for example, the Child Project Status changes to
Completed). A successful Trigger condition will execute a Task based Action.

You can specify multiple triggers and actions in a Rule. When one Trigger event(as specified in the
Rule) happens, the system evaluates the Rule and executes the corresponding Action(s).

See the supported Triggers below:
« Project Status Change: The Action is executed when the Project Status changes.

- Project Attribute Change: The Action is executed when the specified Project Attribute changes.
You can specify the attribute from a drop-down.

« Project Due Date Change: Any change in the Project Due Date will trigger the specified Action.
- Date/Time Reached trigger lets you define an exact time stamp to execute the Rule. When the

server time passes the Trigger time, the Rule will be executed. There are 2 options:

« Specific Date: the actions will be executed on the specific date and time
« Datein Project + Offset: the actions will be executed on the selected Project Due Date or Date/
Time attribute plus or minus an offset of days and/or hours.

Note: The calculation is done in working days/hours.

Actions
« Start Task: This action launches a Task in the same Project where the Rule is configured. Specify
the Task by selecting it from the drop-down.
« Execute Javascript: This action launches a specified JavaScript Rule Action. You can specify one

from the Javascript Rule Actions configured in the system.

It is possible to configure multiple actions by clicking on the '+ sign. Use X’ to remove existing actions.

Example

See the example of a Project Template's Rule below. This Rule gets executed when the specified
Date/Time Reached.
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The Javascript Rule Actions are configured in Admin > Project Management > JavaScript Rule

Actions. See the example script below.

API.getProject () .getChildProjects(); if(children.length >
0){ var atRisk = false; var inDelay = false; for(var i =
i<children.length; i++){ var child = childrenl[i];

if (child.getStatusName () !=
'Completed'){ atRisk =

} if (atRisk){ API.getProject () .getAttribute ("mvbe

var children =
0;

true; } else if(child.getStatusName () ==

'Non-active') {

inDelay = true; }
Campaign
State") .setValue ('At risk'); } else if (inDelay) {
API.getProject () .getAttribute ("mvbe Campaign State").setValue ('In
delay'); }
else { API.getProject () .getAttribute ("mvbe Campaign

State") .setValue ('On
schedule'); } }

Two days before the milestone, this Rule will get executed. Depending on the child Projects'
statuses, the Program Project's status will be updated.
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26. Color Trace Solution

Color Trace structures the collection of color specifications, communicates it automatically to the
supply chain and returns a scorecard of each job. Automation and standard procedures ensure that
reporting is created with integrity, scoring the actual production against realistic specifications.

This solution is built by integrating the capabilities of software and cloud applications including
Esko Cloud, PantoneLIVE, Color Pilot, WebCenter, WebCenter Connector (for Adobe Creative Cloud),
Automation Engine, ColorCert and ColorCert ScoreCard Server. Most parts of this solution are
automated with workflow tasks and has the flexibility to allow you to do custom updates as required.

Detailed description of WebCenter parts can be found in the following pages.

Configure Cloud Connection in WebCenter

Configure Color in WebCenter

Import Deployment Package

Workflow Nodes that perform various automated tasks for Color Trace in WebCenter

soop o

« Color Preflight
« Create ColorCert Job
« Save Document Colors in Attribute

« Create Graphics Placeholders
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27. Packaging Content Management in
WebCenter

27.1. Introduction to Packaging Content Management in
WebCenter

WebCenter Packaging Content Management offers a simplified platform for creating, translating,
approving and managing text / copy assets.

The Packaging Content Management module offers:

« arepository/ library for your text content with GS1tagging

« re-use of your content across multiple projects

» support for a translation based or single language workflow.

« exporttoandimport fromindustry standard formats

« ability to view and edit your text in the context of your artwork in the WebCenter Viewer.
« acomplete approval workflow

» established content rights facilitating the ownership at different stages

27.2. Basic Concepts

27.2.1. Text Document and Text Elements

Text Content Document

The WebCenter Text Content Document (WebCenter Copy Content)isan XML file that contains:

Text that goes on Artwork. This includes the master text and the translated versions.
« Approval states

Clearly defined ownership rights

Element Types

A Text Document is a WebCenter Document Type and can have:

« Revisioning

+ The documents are housed in projects or libraries (for re-use)
« Attributes

» Can be streamed through a workflow

« Download rules

« Documentreferences from other documents. For example an artwork can refer to various text
content documents.
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Text Content Template. Read about it here Text Document Template on page 443

Text Content Statement

A Text Content document has two elements: the Master text and its translated statements. When a
Text statement is specified as the Master, it needs to be approved before approving the translation.

The Master and Translation Statements can be viewed together.

27.2.2. Text Content / Table Ownership via Permissions

Text Content Ownership

offers established ownership for different phases of the text and table creation and the approval
process. You have four default content permissions:

Content Manager
Editor

Approver

Add Language

These permissions, when mapped to the WebCenter roles, allows their assignees to perform specific
functions on the document.

Note:

To configure these permissions, the project manager needs to assign at least the Content Manager
rights to a relevant Role.

For example, you can configure a Role, Marketing to have the Content Manager function.

The Content Manager can then activate the Editor, Approver and Add Language permissions by
assigning them to relevant WebCenter roles.

If you do not assign a role to a specific permission, the specific permission will remain inactive for
the document.

The permissions are set at each text/table document (.wcc or .wtc ) level and will be passed on
along with the document and its versions when copied or moved.
It is not possible to add custom permissions.

Four Types of Permissions
CONTENT MANAGER:

The WebCenter Role with this permission facilitates the entire content management process to
ensure accuracy and compliance. For example, the role Marketing could have this permission where
the Marketing has the responsibility of the packaging content. The Content Manager will manage
the Master and Translated statements.

Note: The Content Manager Role is not associated with any specific language.

This role will manage all the permissions and the settings for the current document.

Note: Content Manager Role cannot act as an Editor or Approver unless this permission is granted
to the same role.

EDITOR
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The Content Manager typically assigns this right to the dedicated roles who will create, edit, revise
or translate the text. This can be assigned per language.

An Editor Role (for example, a Translator) can edit when a document is in the Draft state, not in
Signed-Off or Pending Sign-off state.

If the Editor also has Approver permission, then the documents are directly moved to Approved
state instead of pending sign off.

Note:
« The Content Manager Role has to configure the list of translation languages to make use of
multiple language based Editor permissions.

« You can configure Roles for all languages to which the content should be translated and grant
them the Editor permission.

3. APPROVER: A Role with this permission can approve the text content. This permission can also be
configured per language. The approver puts the Text Statement to Signed-0ff or Rejected state.
4. ADD LANGUAGE:

Any user with Add Language permission can add language to a text or table content document. The

users can be assigned with permission to add only specific languages.

Content Permission Language Role Assignee(s)
CONTENT MAMNAGER PCM_CONTENT MANAGER MRJN
EDITCR g English - International PCM_CONTENT MAMAGER MRJN
EDITCR g English - United States PCM_CONTENT MAMAGER MRJN
EDITCR §j Dutch - Belgium PCM_CONTENT MAMAGER MRJN
EDITOR 11 French - France PCM_CONTENT MAMAGER MRJN
APPROVER g English - International PCM_CONTENT MAMAGER MRJN
APPROVER g= English - United States PCM_CONTENT MAMAGER MRJN
APPROVER p1 Duich - Belgium PCM_CONTENT MAMAGER MRJN
APFROVER 11 French - France PCM_CONTENT MAMNAGER MRJN
ADD LANGUAGE g English - International PCM_LEGAL E"!IFUN .
MRJMN_USR2
ADD LANGUAGE §j Dutch - Belgium PCM_TECHNICAL E"IFIP'JN
MRJN_USR3
ADD LANGUAGE 1 | French - France PCM_CONTENT MAMAGER MRJN
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-REQUESTOR Role

To create new Text/Table Documents, edit, approve or to reuse content during the Project Creation
phase, you need to grant the relevant permissions to the _REQUESTOR role. You can give these
permissions in the libraries of Text/Table Document Templates, or Projects with approved Documents.

Delegation of Approvals in Text Content and Tables

An user can delegate his WebCenter tasks to another user. The delegated user can perform all actions
on behalf of the delegator. When the delegate approves text or table content, the password validation
is done on the delegate's password.

When a user has logged in on behalf of another user, and approves any text or table content, the
same can be viewed by clicking Approval Info in the ellipsis. Alternatively, it can also be viewed in the
Document > Action History.

27.2.3. Text Document Template

Text Document Template

An Administrator or Project Manager can create Text Document Templates using which the users can
generate new text documents.

You can create a Text Document Template with pre-configured:

« Element Type
« Master and Translation Languages
« Approval Setup

These templates can be later reused as Document Sources.

Note:

It is not possible to create Text Documents without configuring the Document Templates and
Document Sources.

When configuring a text document reference for a Task / Project Template, you have the option to
specify document sources. These are buttons that will allow you to create, or link, or copy or reference
documents in their respective documents tables.

27.2.4. Text Content Validity

Text statements may get obsolete over a period of time and to avoid using the redundant statements,
set a validity date for the content. A warning message is given when the statements are no longer valid.

To set up the validity for Text content, add the Date time attribute EXPIRY_DATE to the Attribute
cateqgory of the content document.

A warning message is shown for a document as Expired, when either of

« the current document or
« it'ssmart reference at any level has expired.
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For example, let us assume there are three documents named Docl, Doc2, Doc3 and Doclreferences
Doc2 and Doc2 reference Doc3.

In this case, Doclis considered as expired, if any of the documents out of Doc1, or Doc2, or Doc3 is
expired.

27.2.5. Text Content Element Types

Lk

Text Content Element Type

WebCenter uses the Element Types concept and terminology from the GS1standard to categorize
the Text Documents. The Text Content Element Type categorizes the documents and maps to the
WebCenter Content Types.

See the Element Type categorization below.



WebCenter

Nominal
Content

It is possible to add custom Element Types other than GS1types. Read more in Configure Element Types
asaList on page 451.

These are used when extracting Dynamic Content into WebCenter as well as exporting the artwork's
GS1XML.

27.2.6. Text Content Translation

You can configure workflows to draft, translate and approve text in this module. To translate Text
Elements (statements), in a translation software that uses XLIFF content (e.g. Trados or SDL), you can
export them in XLIFF format. To do the review and final approval, you can import the translated content
back in the same format.

You can either:

« automate the export-import process using the Workflow nodes
« oruse actions to manually export an XLIFF file and later import it back.

Note:

XLIFF is an industry standard format used in the industry to exchange data in a translation project.
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Invariant Text Document

If translations are not required, the Content Manager can specify the Document as an invariant to avoid
translating a Master statement. For example, a Text Document containing the Brand name.

You can set the Invariant status on a Text Document or Template.

Documents marked as invariant can have only one master language and are no longer considered as
invariant if there are more than one master language

Note: Invariant content which existed prior to 18.1and which has more than one master language will
become non-invariant.

See: Text Content Tab

27.2.7. Inherit Content

Whenever a new language is added to a Text content document, it is easy to follow the contents of
either the master or translation language that already has the content. This could also prove very
useful in cases where the two languages have mostly similar content like English-International and
English US.

To inherit content for the text statements in your document, Allow Inherit Content option has to be
chosen in the Configure Content in Text Information. When this option is enabled, you can choose to
either follow the Master Language or Default to the element type choice or choose None.

You can choose

« None to follow language, but no language is selected by default at the text content element level for
the newly added language.

« Default to follow the language in the language list. If no language is defined in the language list,
then None is selected at the element level. Language lists for Master and Translation languages are
configured initially when setting up the content management. To know more, read Configure Master
and Translation Language Lists and Attributes on page 453

« Master Language to follow the master language in the element widget.

Note: Irrespective of the option chosen at the content configuration, you can still change the
option at the element level.

You can choose to inherit only the SmartText content, when you want to inherit the content

from another language. While inheriting, if the text in the source language contains plain text or
SmartName, then the text in the target language are cleared but still follows the source language. List
of allowed special characters are maintained in SMART_INHERIT_WHITELIST. Only the characters
mentioned in this list are allowed with the smarttext.

Note: If the SMART_INHERIT_WHITELIST is not available, then the default whitelist is considered.

27.2.8. Text Approval

The Packaging Content Management module offers separate approval processes for the Master and
its translations. All the Approval information with regard to the Master and Translations stay within the
Text or Table Content Document.
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Note: This approval process is different from the regular WebCenter approval process.

The Approval process starts when a content Editor starts approval on a text statement or a table
element.

When you have configured the right permissions, the users who has the Approver permission can
perform the approval actions. To automate the approval, you can configure manual tasks in a workflow
and assign them to the relevant Roles.

Once approved, the master and the translated text remain locked for the reqular users.

Note: Only the Content Manager has the rights to change the text element to draft.

The text element can be in one of the following states:

« Draft: The initial state of the Text Document where the content is still being worked on.

+ Pending Sign-off: When drafting is complete, and the status is ready for its approval cycle. An
approver can review and approve or reject the document.

- Signed-off: When the approval cycle is completed and the content drafted in the document is
‘Signed Off".

- Sign-off Rejected: When the approval cycle is completed and the content drafted in the document
is 'Rejected'.

Note: Approver will be requested to re- enter the password before approving or rejecting any text
content document, provided the option is enabled by the Admin user.

Approval Types

Content Managers can set up the Approval Type for Text Content Documents. There are three Approval
Types:

« Default: Only one member has to approve. For example, if the Approver permission is assigned to
two Roles, only one member (from any Role) has to approve.

« One of role: One member of each Approver Roles (assignees) has to approve to complete the
signing off. In case a Role is assigned to several members (groups or users), any Group member or
user from that Role can approve.

« All of Role - One per Group : At least one member from each Role-Group has to approve. If there is
an individual User, then he or she has to approve as well.

27.2.9. Dynamic Content in WebCenter

Dynamic Content- Linking with Adobe® Illustrator®

Esko's Dyrg@amic Content for Adobe® |I|ustrator® brings the power of XML-based automation to Adobe®
lllustrator CSb, CS5.1, CS6 and CS7 on Mac and Windows.

Dynamic Content helps designers to be more efficient and win client confidence by minimizing the
errors. By eliminating the process of copying and pasting the revised text’, this minimises the errors.

In a typical case, the designer creates a design in Adobe lllustrator with “placeholders” for text
content. These are tagged with appropriate GS1Element Types(Content Types). You (brand owner) can
process and approve the corresponding text content (with Element Type tagging) in WebCenter.

Dynamic Content can keep this link active and import the dynamically tagged content into Copy sheets.
The edited and approved content can be exported back in GS1format.
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Why Dynamic Content?

Esko Dynamic Content allows packaging designers to add externally maintained content elements such
as legal copy or nutritional information to a packaging design. This solves an increasingly common
problem in the designer's day to day work: human error in copied content.

The ever growing number of stock keeping units that are brought onto the market by brand owners has
resulted in an explosive growth in the volume of artwork that needs to be created for all the packaging
of each unit. At the same time, the designs themselves become more and more complex in their
competition for the consumer's attention.

Many designs share pieces of content. Some content is mandatory, required by requlatory instances
such as the FDA, EMEA, or national bodies. Other content simply recurs on different variants of a
shared design.

The end result is the same: an increasing number of human interactions, often of the "copy-paste”
type, that at the same time increases the risk of errors slipping into the design. Errors in artwork are
wasteful, generating rework, delays in product launches and sometimes even requiring product recalls.

Brand owner Designer
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Benefits of Using Dynamic Content

The Dynamic Content plug-in helps automate the insertion and updating of externally maintained
content into a design. This prevents a number of common problems, and it saves valuable production
time by eliminating repetitive manual tasks.
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Some typical problems prevented by a Dynamic Content workflow:

Typing errors;
Wrong versions of copy text or barcodes are used in the final design;

Cut-and-paste errors (e.g. when copy text is provided in a Microsoft Word document or PDF, and the
designer has to manually copy this into the lllustrator document);

Text overflows;
Shared elements on design variants are not synchronised.

Because Dynamic Content allows you to keep this mandatory or shared content separated from the
lllustrator document, it also eliminates repetitive and time consuming updates: simply modify the
external XML file to update the text, barcodes, and nutrition tables on the design. Review cycles have
never been this easy.

A Typical Workflow in Dynamic Content

A typical Dynamic Content-based design workflow includes an exchange of information between brand
owners and designers. Often, the content to be used in a design will change multiple times during the
design and production process, and it is in these cases that Dynamic Content will prove its worth.

A sample workflow for the use of Dynamic Content could be the following:

Stage  |Description

1

The brand owner’s marketing department draws up the text that needs to appear on the
packaging design. The text is entered into a PDF form or a content management system,
which can export an XML file.

The brand owner sends the PDF form or XML file containing the text to the designer.

The designer produces a packaging design in Adobe lllustrator and links the text elements
from the XML file to text objects in the Illustrator template. In the GS1workflow, the
designer can generate the "Response" XML and send it back to the brand owner. This
Response message tells the brand owner what items were used in the artwork and how
many times.

Later, the brand owner makes changes to the text, produces a new XML file and sends this
to the designer.

The designer replaces the original XML file on his disk with the new version. Dynamic
Content automatically detects the changes, and immediately alerts the designer. It clearly
shows exactly what has changed, and where.

Based on the alerts displayed in Dynamic Content, the designer can very quickly accept
automatically updated text, or make any required formatting changes. There is no need for
copying, pasting, or any other manual and error-prone operations, and Dynamic Content
alerts the designer to problems such as text overflow.

Thanks to Dynamic Content, stages 4 - 6 can occur repeatedly without losing time or
introducing errors.
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XML Basics

XML stands for Extensible Markup Language, and it is a markup language similar to HTML. However,
where HTML describes the layout of a web page, XML markup describes the contents and the structure
of a document.

Below is an example of a basic XML document:

<?xml version="1.0" encoding="UTF-8"?>
<body>
<p> This is a very cool product! </p>
</body>

XML documents are often used to exchange data or textual content.
In the context of the Dynamic Content plug-in, XML is a useful format because:

« it separates content- the text itself- from layout and presentation, which will be defined by
[llustrator text objects.

« itdescribes and contains the structure of the text that must be used on a design.

For more information on the XML format, please refer to the Appendix “An Introduction to XML".

27.3. Essential Configuration Steps to enable Packaging
Content Management

To setup the foundation of a working Content Management System follow the steps below:

1. Enable the Text Content Document Type. Optionally also specify the Language Editor and Approver
Prefixes.

2. Configure Packaging Content Management related attributes. You can migrate the essential
configuration into your WebCenter or do it as follows:
a) Configure Element Types
b) Configure Master and Translation Language Lists and Attributes on page 453
c) Configure Text Reference Attributes on page 453
d) Create Text Document References with Rendering
e) Configure Language Index Attributes. These will be used when you Import Dynamic Content.
f) How to Configure a Setup to Extract Images, Symbols and Graphics on page 477

27.3.1. Packaging Content Management

Note: You need the Packaging Content Management license to be able to use this module.

Smart Role Names for Editors and Approvers
To work with language specific Smart Role Naming on page 460 specify your:

- Language Editor Role Prefix/ Language Editor Role Suffix
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« Language Approver Role Prefix /Language Approver Role Suffix

- AddLanguage Role Prefix/ Add Language Role Suffix

The specified prefixes and suffixes are used automatically to create Role names specific for each
language in the Role Mapping > Manage Permissions page.

If the Roles column in Manage Permissions is left blank, values in Language Editor Role Prefix,
Language Editor Role Suffix, Language Approver Role Prefix,Language Approver Role Suffix, , Add
Language Role Prefix and Add Language Role Suffix are taken to calculate the role names for Editor,
Approver Text Content and Add Language permissions.

A change in a Text document creates a new document version. To allow or prevent the users from
creating new Revisions use the Revision Raise option:

Select Raise revision when Master Text Contents are updated to allow raising a Revision when master
text is updated.

Select Never raise revision if master text changes should not be saved as a new Revision.

Note: This settingis independent of the Allow raising Document Revision when uploading a new
Document Version setting.

Copy comments from a text document

Choose either to Keep Comments or Remove comments if state reverted to Draft or Remove
Comments always when copying a document.

You can choose the option Keep Comments to copy all the comments when copying a document.

Comments are cleared if the state of the element is changed to draft, when the option Remove
Comments if state reverted to Draft is chosen.

Similarly, all the comments in the elements are cleared while copying, when the option Remove
Comment always is chosen.

Note: Same behavior is replicated in workflow when documents are copied using Copy/ Move
Document. Move document option does not respect this setting.

27.3.2. Configure Element Types as a List

You can categorize the packaging content using the Element Types list in WebCenter. You can use the
categorization from the GS1/ IPC standard or any other.

Note:

GS1is an international non-profit association dedicated to the design and implementation of global
standards and solutions. The GS1system of standards is the most widely used one in the packaging
supply chain standards system.

You can create a WebCenter List for configuring the Element types.

Note: Only Administrators can configure Lists.

» Create and upload your Excel (either .xls or .xIsx) document containing the element types to a
project named List Manager.
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A B c D BE
ELEMENT_TYPES HUMAN READABLE FORM ELEMENT CATEGORY PCM_ELEMENT_TY|COLOR
ACTIVE_INGREDIENTS_DECLARATION [active ingredients declaration Ingredients and Technical Facts TECHNICAL yellow
ACTIVE_INGREDIENTS_HEADER active ingredients header Ingredients and Technical Facts TECHNICAL yellow |
4| ADDITIONAL_PRODUCT_VARIANT_INFORMATION _|Additional product variant information Product Identity MARKETING red i
ALLERGEN_STATEMENT Allergen statement Global Warning & Caution Statements LEGAL blue
ASSEMBLY_INSTRUCTIONS assembly instructions Usage Instructions & Consumer Relations InfMARKETING red
BRAND_NAME 8rand name Product Identity MARKETING red
CONSUMER_GUARANTEE Consumer guarantee Various LEGAL blue
CONSUMPTION_CONTEXT Consumption context MARKETING red
CONTACT_INFORMATION Contact information Usage Instructions & Consumer Relations InfMARKETING red
CONTENT_CLAIM Content claim Marketing Copy, Claims & Endorsements | MARKETING red
COPYRIGHT TRADEMARK_STATEMENT Copyright trademark statement Patent, Trademark, Copyright, Legal LEGAL blue
CROSS_SELL Cross sell Various LEGAL blue
DECLARATION_CONTEXT_FOOTNOTE ElementslypeiDropzdowniinithe @ptienal Coleryused
DIET_EXCHANGES interfacees Various TECHNICAL o ;
DISCLAIMER Disclaimer Marketing Copy, Claims & Endorsements  |LEGAL TAmbails
DISPOSAL_INFORMATION Disposal information Usage Instructions & Consumer Relations Inf| MARKETING red
DISTRIBUTION_STATEMENT Distribution statement Distribution and Manufacturing TECHNICAL yellow
DRUG_FACTS Drug facts Ingredients and Technical Facts TECHNICAL yellow
ENVIRONMENT_STATEMENTS Environment statements Ingredients and Technical Facts TECHNICAL yellow
FUNCTIONAL_NAVE Functional name Product Identity MARKETING red
GROSS_CONTENT_STATEMENT Gross content statement Neminal Content TECHNICAL yellow
ICON_VARIABLE_TEXT Icon variable text Various MARKETING red
IMPORTER_STATEMENT Importer statement Distribution and Manufacturing TECHNICAL yellow
INACTIVE_INGREDIENTS_DECLARATION Inactive ingredients declaration Ingredients and Technical Facts TECHNICAL yellow v

25

W 4 » ¥ | Sheetl

Sheet? Sheet3

%2

e

a) Add the following mandatory columns to your worksheet:

+ ELEMENT_ TYPES should contain the Element Type tags.

+ HUMAN READABLE FORM with the Element Type names.

Note: This will appear as the Element Type drop-down in the interface. For example, in the

Text Document Details on page 461 page.

b) Optionally, you can add an ELEMENT CATEGORY column. This column can contain the
categories used to group Element Types.

c) Optionally, add the PCM_ELEMENT TYPE RESPONSIBLE (this name can be different)column.

This is column can have the Role names who would be responsible a particular Element Type.
For example, a role Legal would have the responsibility for the Element Type Consumer

Guarantee.

Tip: In your Workflow configuration, you can look up in this list to find the Role matching a
particular Element Type. Read more in the Workflow section.

d) Addthe Color column. Use this to specify the color coding for the Element Types.

If you have specified Red corresponding to Brand Name, your Text Document Thumbnail will be

color coded as Red.

Create a List named ELEMENT TYPES.

When configured, the Element Types will appear as a drop down in Text Document Details page.

If the Element Types are color coded using the Color column, you will see Text Document
Thumbnails in the system.

Configure Thumbnails for Text Documents

When you upload a Text Content Document, a thumbnail with it's name gets generated according to

the color code specified in the Element Types list.

If you update the color code of an Element Type in the List, the existing thumbnails will not be updated
immediately. Update the document's Element Type to generate a new thumbnail.
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If color code column is not defined, thumbnail will not have color code in it, but still Element Type will
be displayed.

Note:

If the Element Type name is longer than the thumbnail, it is truncated to fit in the thumbnail size.

Note:

Supported colors: green, blue, red, yellow, white, black, orange, cyan, magenta, pink, light gray and
dark gray. RGB colors (rgb(x,x,x)) are also accepted in the Element Types list.

27.3.3. Configure Text Reference Attributes

You need to create two attributes which are used in mapping the Dynamic Content data. When
Dynamic Content is imported, these are used to map the location and the instance sequence of the
text. These are later used in exporting the Content into GS1format as well.

Note: These are not visible to your users.

1. Create the following Attributes.

+ INSTANCE_SEQUENCE This will be a reference attribute (of a text document reference) keeps
the instance sequence (a number) of the Text Statements.

« LOCATION_LIST This reference attribute stores the specific location of the Text Element on
the artwork for each dynamic Text Element.

« EXPECTED_NUMBER_OF_OCCURRENCES This reference attribute store the number of
expected occurrences of a particular content( image, text, table, Barcode in an artwork.

2. Create an Attribute Category which will be used as a Reference Category when configuring Text
Document References (Copy Sheet).

Note: Specify the Visibility as Hidden (Keep Values).

Creating a Copy Sheet on page 332

When you are viewing an artwork document in the Viewer, the Text Documents are highlighted when
you click on them. The reference property Location_List is used in rendering this feature.

Add this reference category to Text Document attributes used in Copy Sheets.

27.3.4. Configure Master and Translation Language Lists and Attributes

You have to configure Master and Translation Lists for setting up the Packaging Content Management
module.

The master and translation languages can be added as WebCenter Lists and your users can easily
access and select the appropriate languages in the Attributes tab.

Note: Only Administrators can configure Lists.
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1. Create and upload your Excel (either .xls or .xIsx) documents to the ListManager project.

a) Create the Master Language document in Excel. Add the following mandatory columns to your
worksheet:

For example, English- United States.
LANGUAGE_CODE: Specify the code of the languages that you want to include

DESCRIPTOR: Describe the language code you specified

FLAG_FILENAME: Specify the name of the image file which has the flag of the country the
language is used. For example fr-ca will have Canadian flag whereas fr-fr will have French
flag.

LANGUAGE INDEX: 1,2, etc...

DIRECTION: Specify if the language is written right to left or left to right. This ensures that
the cursor is placed appropriately.

FONT FAMILY :Specify the font family that you want to use for the language

Note: Specify the name of the font family that you want to add as a customized font

for the PCM. To add a customized font in Packaging Content Management, follow

the steps given in the KB article https://wiki.esko.com/pages/viewpage.action?
spaceKey=KBAS&title=KB196429311%3A+WebCenter+-+How+to+support+custom+fonts+and
+languages.

And also add the fonts in the application server pcm/TablePreviews/custom/fonts
folder location.

LANGUAGE _INDEX: Thisis the corresponding field to locale Sequence tag in GS1XML
standard. This is used in Import Dynamic Content node to map the GS1 XML coming from
Dynamic Content.

Note:

When you add a language code in these Lists, a corresponding flag image will be available
foryouin the interface. The flags are installed in the WebCenter\WebServer\tomcat
\webapps\WebCenter Inst\images\country flags folder. Whenyouadd a custom
language to the Lists, place a corresponding flag image in this folder.

The flags are 16x16 in size. The subfolder webCenter\WebServer\tomcat\webapps
\WebCenter Inst\images\country flags\big containssame flagsinbigger
(32x32) sizes.

b) Create the Translation Language document in Excel. Add the following mandatory columns
specified in the Master text Language excel sheet.

2. Create Lists named MASTER TEXT LANGUAGE and TRANSLATION TEXT LANGUAGE.
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General list information
List Name* MASTER_TEXT_LANGUAGE
Description
Input Source Properties €
Document MasterLanguagelist xlsx
Sheet Mame  Sheetl
Leg File MASTER_TEXT_LANGUAGE_11.log
# Flush existing list data before updating the List. The existing data will be replaced by the new datal
¢ Database Username and password are required when deleting data from List
List Properties
Input Columns List Columns Unique Identifier €3
LAMGUAGE_CODE LANGUAGE_CODE
DESCRIPTOR DESCRIPTOR
FLAG_FILENAME FLAG_FILEMAME
LANGUAGE_INDEX LANGUAGE_INDEX
DIRECTION DIRECTION
FOMNT_FAMILY FOMT_FAMILY

Show List Data Delete List Data Delete List

3. Create the following attributes in Admin > Attributes > Attributes

» MASTER TEXT LANGUAGE

» TRANSLATION TEXT LANGUAGE

These attributes define the languages that are used by the Text Content as part of the Project's
Attribute Category.

4. Create an Attribute Category and add the language attributes to it.

5. Restrict Values to the language lists. And specify the Column as Descriptor.
To select more than one language, you need to enable Allow Multiple Values.

These attributes has to be added to the Project's or Templates Attribute Category. The User can then
select the Master Language and Translation Languages according to that Project's needs.

27.3.5. Configure Language Index Attributes

To map the Language Index (Locale Index) from Dynamic Content, you can create attributes. These
attributes are needed when you configure Import Dynamic Content node in the workflow.
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Note: Without setting these attributes, the import node will use default indices from the language
lists. We recommend that you create these attributes to be able to specify the language indices for

each project.

« Create the language attributes and add them to the Attribute Category.

See the example screen shot:

Remove Grid Layout

+50 ||+ || == | |+H] mme|| -F- || —
Insert:
+H || =0 ||

[Title]select the artwork languages.

[spacer]

PCM Artwork Language 1 | PCM Artwork Language &

PCM Artwork Language 2 | PCM Artwork Language 7

PCM Artwork Language 3 | PCM Artwork Language 8

PCM Artwork Language 4 | PCM Artwork Language 9

PCM Artwork Language 5 | PCM Artwork Language 1

[spacer]
[Title]Metadata

[spacer]

PCM Market PCM Brand

J( 3

LARE JNE IR

Details for selected cell:

Attribute |PCM Artwork Language 1
Aﬂrll:luute Text
Type:
Label Text: |Artwork Language 1
Label
Label: Image:
Position: Left v
Custom
Unit Label
Span T
Columns:
I Field v
Style:
tyle fdd Style Edit Style Delete Style €
il Editable v
S ladd Rule @
ALL_LANGUAGES_1 v
List v —
Restrict Copy List €
alues: \ DESCRIPTOR ¥ [ Configure List
Caolumn:
\id L
Rendering: Dropdown M i
Allow
Multiple
alues:
Info HTML page (name+extension)
Info Page: [<WebinstanceRoot>/custom/AttributesHelp/

« Configure Restrict Values as a Language List to get the attribute selector drop down listing all

languages.

Use this in the Template that is used to import Dynamic Content and the workflow step Import

Dynamic Text.
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Ensure that:

« you have invited the right Roles in your Project or Template with the Text document.

« you have added the Master and Translation Languages to the Project's Attribute Category to
configure Language specific Editor and Approver permissions. It isimportant to do role mapping in

asmart way.
« you have enabled the right Preferences.
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If you are a Project Manager / Admin, you can manage and assign content permissions.

Note:

A user without any of these permissions can only view (depending on the view permissions) the text
content documents.

1.

To manage Permissions, go to the Document details > Text Information > Role Mapping.

When you click on a Text Content Document Type icon, the Document Details will have the Text
Information tab with the following sub-tabs:

« Text Content
+ Role Mapping

« Compare

2. Click on Manage Permissions. This will open up the Role Mapping page.

3. Click Add Permission. Repeat this for as many permissions as you want.

Content  Role Mapping  Compare

Content has changed since last Save. m Cancel

For each Content Permission, select the Language. If the TALL OTHER LANGUAGES] option is selected under Language,
SmartMame is applied automatically to derive the Roles (if Role is not selected).
Click here to Manage Roles

Content Permission Language Role
CONTENT MAMNAGER - PCM_CONTENT MAMNAGER - b 4
EDITOR - [ALL OTHER LANGUAGES] - PCM_CONTENT MAMNAGER - X
APPROVER - [ALL OTHER LANGUAGES] - PCM_CONTENT MANAGER - X
ADD LANGUAGE - English - International - PCM_LEGAL - X
ADD LANGUAGE - Dutch - Belgium - PCM_TECHNICAL - X
ADD LANGUAGE - French - France - PCM_CONTENT MAMNAGER - X

4. Choose the Content Permission from the drop-down listing:

« Content Manager
- Editor

« Approver
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Add Language

5. Forthe Content Managers permission, define the appropriate Role.

Read about the permissions below:

1.

CONTENT MANAGER:

The WebCenter Role with this permission facilitates the entire content management process
to ensure accuracy and compliance. For example, the role Marketing could have this permission
where the Marketing has the responsibility of the packaging content. The Content Manager will
manage the Master and Translated statements.

Note: The Content Manager Role is not associated with any specific language.

This role will manage all the permissions and the settings for the current document.

Note: Content Manager Role cannot act as an Editor or Approver unless this permission is
granted to the same role.

EDITOR

The Content Manager typically assigns this right to the dedicated roles who will create, edit,
revise or translate the text. This can be assigned per language.

An Editor Role (for example, a Translator) can edit when a document is in the Draft state, not in
Signed-Off or Pending Sign-off state.

If the Editor also has Approver permission, then the documents are directly moved to Approved
state instead of pending sign off.

Note:
« The Content Manager Role has to configure the list of translation languages to make use of

multiple language based Editor permissions.

« You can configure Roles for all languages to which the content should be translated and grant
them the Editor permission.

APPROVER: A Role with this permission can approve the text content. This permission can also
be configured per language. The approver puts the Text Statement to Signed-0ff or Rejected
state.

. ADD LANGUAGE:

Any user with Add Language permission can add language to a text or table content document.
The users can be assigned with permission to add only specific languages.
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Content Permission %
COMNTENT MAMAGER
EDITOR

EDITOR

EDITOR

EDITOR

APPROVER

APPROVER

APPROVER

APPROVER

ADD LANGUAGE

ADD LANGUAGE

ADD LANGUAGE

Language

g English - International
#= English - United States
g § Dutch - Belgium

1 I French - France

g English - International
g= English - United States
g Dutch - Belgium

§ i French - France

g English - International

g 1§ Dutch - Belgium

1 I French - France

Role

95 PCM_CONTENT MANAGER
95 PCM_CONTENT MANAGER
25 PCM_CONTENT MANAGER
25 PCM_CONTENT MANAGER
25 PCM_CONTENT MANAGER
25 PCM_CONTENT MANAGER
25 PCM_CONTENT MANAGER
25 PCM_CONTENT MANAGER

25 PCM_CONTENT MANAGER

2= PCM_LEGAL

25 PCM_TECHNICAL

25 PCM_CONTENT MANAGER

WebCenter

Assignee(s)
MRJN
MRJN
MRJIN
MRJIN
MRJM
MRJM
MRJM
MRJM
MRJM

MRJN
MRJMN_USR2

MRJN
MRJN_USR3

MRJM

Note: You may choose to give more than one permission to a Role. For example, the Content
Manager can have Editor and Add Language permissions as well.

6. Define the Editor permission and assign it to a role. Select the corresponding Language from the

drop-down.

You can automatically create Editor and Approver Roles for all languages in one go. Read about
Smart Role Naming on page 460. To do this for the editor permission:

a) Make sure that the Admin preference section has the right Prefixes. Read here.
b) Next to the Editor permission, select All Other Languages.
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Content Permission €3 Language Role

EDITOR g English - International GLISH - INTERMNAT IDN
EDITOR §1 Dutch - Belgium 25 LANGUAGE DUTCH - BELGIUM EDITOR

EDITOR 1 1 French - France 2= LANGUAGE FRENCH - FRANCE EDITOR

APPROVER 2= English - International Preﬁxpﬁﬁd‘?ﬁfﬁ?m Role Names

APPROVER §1 Dutch - Belgium 2= LANGUAGE DUTCH - BELGIUM APPROVER
APPROVER 1 1 French - France 2=/ LANGUAGE FRENCH - FRANCE APPROVER

ADD LANGUAGE £z English - International 25| LANGUAGE ENGLISH - INTERNATIONAL ADD

ADD LANGUAGE 11 Dutch - Belgium 2 LANGUAGE DUTCH - BELGIUM ADD

LANGUAGE FRENCH - FRANCE ADD

2]

ADD LANGUAGE i French - France

7. Define the Approver permission and assign it to arole.

Select All Other languages to create Approver roles with default names in one go.

Note: You can configure Editors and Approvers individually for some languages and choose the
Smart Role Naming for the rest of the languages by selecting All Other languages.

8. To edit Content Permissions, click Manage Permissions and edit or change the assignment of a
permission.

« The Role Mapping page will list all the Content Permissions, respective languages, Roles and their
assignees (individual or Group).

The Roles will be clickable if they exist in the system and are invited to the Project.

« The Master Language of the Project will be highlighted in bold.

If you would like to give content editing and approving permission during Project Creation, assign
Editor and Approver permission to the REQUESTOR role.

For example,if you assign Editor permission to the  REQUESTOR role, the Editor can draft the text
during project creation.

2 BO, Manager (BO_MANAGER)

ish - Uni L] IEQUESTOR .. . \
EDITOR ge English - United States 8 REQUESTOR ‘s, Keizer, Debbie (DEKE)

Warning: During a Project's creation, you can assign another user as the Requester. If this
happens, the permissions defined for the REQUESTOR role does not get transferred. In this
scenario, some updates done during the Project creation may be lost.

27.4.1. Smart Role Naming

460

When your content workflow contains translations into different languages, you can have Editor

and Approver permissions assigned to Roles (text authors/editors and approvers such as legal or
marketing) associated with these languages. To automate the naming of such Roles, you can specify
prefixes for these placeholder Roles.
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Content Permission €

EDITOR

EDITOR

EDITOR
APPROVER
APPROVER
AFFPROVER
ADD LANGUAGE
ADD LANGUAGE

ADD LANGUAGE

Language

g English - International
§1 Dutch - Belgium

I 1 French - France

g English - International
g1 Dutch - Belgium

B I French - France

== English - International
g1 Duich - Belgium

j | French - France

WebCenter

Role

GLISH - INTERNATIDN

25 LANGUAGE DUTCH - BELGIUM EDITOR
2= LANGUAGE FREMCH - FRANCE EDITOR

Prefix and'SuffiX'in Role Names

2= LANGUAGE DUTCH - BELGIUM APPROVER
2=/ LANGUAGE FRENCH - FRANCE APPROVER
25 LANGUAGE ENGLISH - INTERNATIONAL ADD
27 LANGUAGE DUTCH - BELGIUM ADD

27 LANGUAGE FREMCH - FRANCE ADD

The names of the Roles will have the specified prefix and Suffix (In the example screenshot, Language
Editor) and the respective language code.

27.4.2. Text Document Details

When you click on a Text Content Document Type icon, the Document Details will have the Text
Information tab with the following sub-tabs:

« Text Content
« Role Mapping

« Compare
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Text Information Decumnent Information Approva Action History Annotations Projects Attributes References Characteristics Discussions Test doc view

Comtent  Role Mapping  Compare

Preparaticn instructions = M: SEEE T (] G
Master Text
£ English - International
2| 3
BE English - United States
Q
@
L]
Translations
B Dutch - Belgium
2| 3
11 French - France
2| 3

» Show languages which are not part of the Project.

27.5. Creating a New Text Document

An Administrator or Project Manager can create Text Document Templates using which the users can
generate new text documents.

Note:

It is not possible to create Text Documents without configuring the Document Templates and
Document Sources.

When configuring a text document reference for a Task / Project Template, you have the option to
specify document sources. These are buttons that will allow you to create, or link, or copy or reference
documents in their respective documents tables.

1. Create aProject or Template to host all your Text Templates ( a Text Document Template library).
2. Tocreate text document templates:

a) Upload Text Documents (.wcc)into this Project or Template. We recommend that you create
Templates per Element Type. This allows the users to create a new Text Document for each of
the Element Type.

Make sure that you have enabled the text document type in the Preferences section.

b) Go to Document Details > Text Information > Text Content tab of the Template and add the
corresponding Element Type to the template.

c) Also, specify Master and Translation languages for each template.
d) Specify the Approval Type as:

+ Default:Even if one user approves, the document is approved.
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» One of Role: At least one user per role assigned should approve the text content document

« All of Role - One per Group: From every group, at least one user should approve
e) Inthe Role Mapping tab, assign the Content Permissions.
f) Repeat for all the text document templates you want to create.

Note:

«  New documents created from this document template will inherit the settings.

« The approval cycle is different from other document Types. Read more about Text Document
Approval in our KB.

Create a Project Template for each kind of project that may be required by Project Managers.
In each of these Templates configure the Document Library as follows:

a) Inthe Project Details page, Configure > Document Templates.
b) Select Project or Template and select your document template library from the drop-down.

Documents asks Attributes  Project Information  Approval ~Members  Security | Configure
Workflow Connection ~ Document Templates  Project Creation ~ Document Types  Document Creation  Project Statuses

Please select the Template or Project that will serve as a Document Library

Do not use a Document Library
Template

® Project | PCM Text Templates -

When the Document library contains ARD files, how do you want to use these ARD files when creating a new Document?
® Always run the ARD as a standard
Run the ARD as a standard when the IsStandard Atiribute is set to 'yes'

Never run the ARD as a standard

c) Click Save.

When creating a Project from this Template, the user can click New and select a Text Document
Template from the Templates library to create new documents.

Create an Attribute Category for your Template.

a) Add Language Attributes and restrict them to Language Lists.
b) You need Document Reference Attributes. Create and add them to this Category.

To allow the user to create new documents from the Copy sheet (document references) attached to
this template, configure document sources for the individual reference attributes.

Tip: Use a Saved Search configured to search for Table Templates as a document source for better
user experience. You can, for example, add a Search Panel.

The user will be able to add New Text Documents from Template > Attributes section when
creating a Project.
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PCM Text Library Update Show Details

w Details

Note: The name of this Project will be created automatically.

Requestor

Me A

Description

w New / Update

Master Text English - United States v
Language(s)

Translation —Please Select— v
Language(s)

BocumentiSources;configured

withiajTiemplate

ki

27.6. Creating a Copy Sheet

464

Copy sheet is a term used to describe all the content together which are attached to a particular
artwork or printed item. A copy sheet containing aggregated content helps you to:

» validate the copy sheet templates for consistency, accuracy and compliance with the established
content management process.

« review, proof-read and approve copy sheet in one place.

You can create a copy sheet using Text Content Document References in an Attribute Category. This
gives the option to attach this copy sheet to your Projects or artwork documents.

The copy sheet categories allow you to:

« track the content on an artwork.
« easily reuse existing approved content
« configure separate permissions and approval system for each text document.

Tip:

By configuring Document Rendering for Text documents, you can attach copy sheets to Tasks. When
you configure Workflows with manual tasks for editing or approving, the users can work on the copy
sheet directly from their task.

An Attribute Category based copy sheet offers the following advantages:

- thelanguages. To view a particular translation corresponding to a master, just select that language
in the filter drop down.



ESKO

WebCenter

the Instance Sequence. See more in: Dynamic Content documentation

« theoptionto replace a text document with another

the button to duplicate a document with the same reference attributes

« advanced document reference options

You can Edit, Start Approval, Approve and Reject actions from the copy sheet depending on your
content permission.

Note:

The text document references are used when you import Dynamic Content into WebCenter. Read about
thisin: Import Dynamic Text.

See the example screen shot below. The configuration explained here is only an example. You can
configure your document references according to your needs.

Tip: You can configure the copy sheet with different Attribute Views to provide custom views to
your users. For example, a content collator and Translation Language Editors can have different
custom views of the same text document reference category.

Note: You can also add the languages by clicking on the + displayed in the text statement. On

deletion of a language, the * iconis again displayed to enable adding back the language. You can
configure the corresponding attribute category to display the languages one by one in a table.

o Hew b Madeding Sonterd Ribrary

= Text Widgets -
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Language Flags
QT — - e = ®l.
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) =] L
s ' Resycle stmenent [ " =i i L= oo
B 5 & "'\3'_15'-'\." (=11 n-‘ * ElIIEGS [
B Pactagag i 5. u [Geere ot M= ! BT ?oa

Adding or removing Master or Translation languages from a Project Attribute Category page or
Project Creation page or Document Attributes, or in a Task execution pages behaves differently now.

Adding any of the available languages is possible based on permissions on all text content in the
page including documents that are from other than current project.

Similarly, it is possible to remove the language when it is added recently but not saved

« Evenwhen text content document is referenced from other than the current project
« Evenifitisnotempty

« Evenifyoudo not have permission to remove languages
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27.6.1. Create a Table Rendering for Text Documents

466

You can configure a Text statement as document references and add them to a Project or Document
Attribute category. The configuration and rendering are similar for Task Specifications.

For each Copy Sheet (Product Content Sheet), which has Text Content documents as reference, you
can make different configurations to show text related data using advance table rendering option.”

1. Create a Table Rendering.

2. Inthe Edit Rendering Configuration pop-up:

Configure The result in the rendering table will be...
Master Text or Translation Master Text Statement or the Translation Text is shown in
Text a text widget along with its content in the edit field and all

related text content actions.

Note: The Visibility should be specified as Editable if you
want your users to edit the text. One or more columns can be
configured for the Master or Translations of the Master Text.

Master and Translation languages will either appear in a drop
down or you can choose Show Side by Side view.

You can also restrict the languages that will appear in the
drop down, by mentioning the languages ( pipe separated)
specifically in the details tab.

Text Language Flags The language drop downs for Master and Translation Text
columns.

Note: The master and translation languages are populated
from the project attributes MASTER_TEXT_LANGUAGE and
TRANSLATION_TEXT_LANGUAGE respectively.

Tip:

You can specify a default language code for Text statements. The selected language will be the
default in the document reference table. If default language is not specified, the first language from
the language drop down is selected as the default. WebCenter also supports right to left languages
like Arabic and Hebrew for text content.

3. Specify the width for Master Text and Translation Text.By default, the width of every column is set

to Auto. However, you can configure the width for the Document Name, Master Text, Translation
Text and the Translation Languages.



ESKO

WebCenter

Tip:

To change the width of the columns, specify pixels or a percentage (of the width of the table).

If the label of the column is too big for the width specified, the column width will be bigger to
accommodate this.

Edit Render Configuration

Name: PCM Text Reference_Default

) Hide Header

Open Links in new Tab
O Allow Bulk Operations
Limit Bulk Operations to Document References with matching Operations configured

1. You can also enable the Display Options in the Edit Render Configurations. You have four icons

Type

Document Property

ocument Name

Replace Buiton

Reference Property

Reference Property

Translation Text

Master Text

Delete Button

-

Details
Thumbnail
B Show Document Source
[ Show Document Description
L] Show Folder
[ Snow Document Template
Compact Rendering
ARTWORK_VARIABLE

INSTANCE_SEQUENCE

O Show Side by Side

DisplayOptions & &£ Q @

O Show Side by Side

DisplayOptions @& & @ @

Add Column Revert to default configuration

v (50 v px

Label

Thumbnail

Name

ARTWORK_VARIABLE

Instance Seq.

Translation Text

Mastar Text

Visibility

Read Only

Read Only

Read Only

Editable

Editable

Editable

Editable

Read Only

Width

auto

100px

auto

auto

75px

600px

E00px

auto

Collapse
O

buttons and are active by default.

« Status Button Show status column in default manner like basic view page when active. When
the button is inactive it shows status in the form of a colored strip based on the status of the

content. Green for approved, red for rejected, blue for pending approval and grey for draft.

« Inheritance Button Shows the inheritance icon when active.

« Comments Button Shows the comments icon button when active.

« Approval Info Button Shows the approval info button when active.

While Rendering of Master and Translation Language, if all the button options are disabled and
there is no message to show then more options “Ellipsis” button will also not be visible.

Configure the display of Text Language Flags. You can configure the Display as Show only Flags or
Show Flags and Languages.
These flags will be based on the Project Language Attributes.
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« Inthe copy sheet view, all the newly created text documents will have the current Project's
Language attributes as flags. You can read about how to customize flags for languages here.

- Allthe sourced content (referenced from other Projects) will have the flags based on the source
Project's language attributes. To add the current project's languages, select them from the
available flags.You can add or delete flags in this view.

5. You can allow the users to move areferenced document into the current project. To set this up,
create a column with Local / Remote setting. Specify the visibility as editable or read-only. You
can move all the referenced documents into the local project by hovering on the Location in the
header and selecting the option Copy All References into Current Project.

-+ Upload + Link -+ Search + Search

[=] Location = Thumbnail Name Version

opy All References into Current Project

Reference M Allergen statement

[r] ‘
RS ¢ TN (000 Textboc 00000814 PCMwee & & !
. __ Reference | | Best before date Q 3 8(F)
il © "SI 123Best before date.wce —
Reference M Dosage instructions
s :
N 123Dosage instructions.wcc Q2 !
eference JiH NCarrot11.p = =
R f s — IIC tl 1 df q " 1 t
= A
E=
e 1 LL
- 000000002 _Mutritional Facts_C.wcc Q i T
——

You can move any of the referenced document to the local by clicking on the Referenced field of the
required document and selecting the option Copy to Current Project.

[=] Location = Th

£ Copy to Current Project
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The users need to Change Properties and Add permissions to move a document to local folder. The
document reference will point to the local copies.

The user will be able to specify:

« anewname and description
« document template
« target folder

If the setting is Read-only, the user will see E'E indicating remote project.

If you are configuring Local / Remote button to allow copying of documents, ensure that you have
enabled or disabled Retain text document status.

When this option is turned off, if you copy to Local, the approval status of the Text Document is
reset to Draft.

If Retain text document status option is turned on when you copy the document, the document's
approval statusisretained as it is.

Define adequate permissions to view and edit Text Statements.

Whether or not your user can edit or perform approval actions on a Text Element is determined by
the following settings and permissions:

+ Visibility should be specified as Editable.

« If your Text Document Reference is a child of another document (for example an artwork), the
Expand Attributes (+) column of the Parent document should be configured as Editable.

« Theuser should have appropriate Content Permissions. Read more in: Managing Text
Permissions on page 456.

Tip:

Check these Project level permissions (Project Details > Security) to troubleshoot editing
problems:

« Change Properties

« Start/Stop Approval
« Upload new version
« Change Task

- Download

+ View

- Add
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Note: The Text widgets, related languages and statuses are rendered only for Text Document
References.

27.6.2. Configuring Document Sources for Text Documents

You can configure your Document Sources (such as a Project/template which serves as a library of
Text Documents / Artworks), a Saved search of your Text Documents, or your Document Templates)in
the Grid layout of an Attribute Category or Project Template.

Edit Document Sources Configuration

DEKE_DocRef_Symbols_Default

Source Label Details Operation Target Target Folder
Standard - Document Template selecter  Any Decument Template configured - ndd
o Document Templates - Copy
v § 5 . Replace
Mew « | CopyOperation | Basic Copy - O
SesrchName = — Select Search— - Copy
" Standard - [ Link Add Assembly
2] Saved Search - Document Template selector | Any Document Template configured  » [ Move ) Foolac
Search - Use by Reference B2 Replace Graphic Placeholder
Copy Operation | Basic Copy - @ Create Assembly

Add Document Source

Your configured sources will appear in the places (such as templates or forms you have designed)
where you set the document reference categories. Read more in: Adding Document Sources for a
Document Reference Attribute on page 316.

27.6.3. Replace a Document Reference
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You can configure a Replace option in your document reference table. When you replace the old
reference, the new document reference will have the same reference category as the old one.

Note: Project managers, Administrators or users with Change Properties rights can replace the
document reference.

Translation Text |Dutch - Netherlands ¥ | INSTANCE_SEQUENCE

o sEE—

Signed Link
= @ Browse
Mew
Search
| R T

When you configure a Replace button, it allow the you to

- replace the document via any of the configured document sources (upload, browse, etc.). If you do
not select any option, the first source is taken as the default.

« Undo the action before saving the new document reference.
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This document has its own Attribute Category but will keep the same Reference Category as the old
reference.

You can also select compact rendering option for this button.

27.6.4. Duplicate a Document Reference

You can configure a Duplicate option in your document reference table. When the user duplicates a
reference, a new row of document reference will be created. The duplicated document will have the
same content, document attributes and reference category as the previous one.

In the case of Text Document, Content file, then each element status in the file will be reset to draft.

Note: Only users who are Project managers, Administrators or with Change Properties rights can
replace the document reference.

Technical:

m Fram Library
Instance -
(G51) M Version
| PO step 1
(W8 ..p2  Documentisource 2 . i —
ASSEMELY Panding iSINew A - ?ﬂ
INSTRUCTIOL, e - 2 @
. step 1 O
step 2 Buplicated|row, ~
ASSEMBLY step 2 Clples] edire = %
INSTRUCTIO.. ®
v INGREDIENTS ®) =
§ " Magnesium Hydrexide Prep. i 2 =1 -
.:'::f;:_,-".".;l ’g;" {Magnesium Hydroxide, Starch), ® - a - L
Dicalcium Phesphate, Vitamin C Prep. -

When you configure a Duplicate button, it will allow the users:
« toduplicate a document row with Copy and New as document sources.

The duplicate documents are created in the current Project where the copied or newly created
documents are stored.

Tip:

« Thedocument willbe namedas [FileName] [Duplicate] [1], [FileName]
[Duplicate] [2],etc.

« Use the Rename document action to change the document name.

You cannot duplicate a document reference if the document source is:
» Browse/ Link/ Use by Reference / Remote.
Behavior while duplicating document and its reference properties:

« If Allow multiple values is turned off in the attribute category, the duplicate will replace the original
instead of adding a new document reference.

« Theduplicated document will have the same Attribute category including the child document
references. The Reference categories and its settings are copied at parent and child levels.

- The duplicated row inherits the entire hierarchy (if any) of the parent row including the attribute
values.
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« Itis possible to duplicate a newly created document row.

27.7. How to Configure a Setup to Extract Dynamic Content

472

This chapter provides an overview of what needs to be configured to have a functioning Content
Management setup in WebCenter.

To efficiently manage the content, you need a setup that addresses the packaging content in the
context of packaging artwork. To create such a system you need:

« Reusable text documents stored in the form of libraries

« Text Document Templates

« Artwork libraries and Templates

« Attribute Categories with Languages to be attached to the Projects
« Copy Sheet or Text Document References attached to Artworks

The steps below describe how to create a setup to import Artwork templates from Adobe lllustrator
(With Dynamic Content) along with the Text Content mapped to a Copy Sheet.

Note: Thisis an example configuration. Other than the essential steps, all other steps meant as
recommended, not mandatory.

Note: To get you started, we have created a migration setup that you can import into your system and
start on it. See in: Knowledge Base article.

1. Follow the Essential steps to configure the module.
2. Create Text Document Templates. You need these templates to create new Text Documents.

Important: You can create Text Templates with all the necessary configuration automatically. This
is recommended if you require a large number of templates. Contact Esko Professional to configure
your Text Templates automatically.

You can now start using these templates to create new Text Content Documents.


https://wiki.esko.com/display/KBAS/KB180113834%3A+WebCenter-+How+to+Import+a+Packaging+Content+Management+Scenario+for+Easy+Configuration
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More...~
Docurments Bill OF Materials Tasks Amributes  Project Infeemation  Approva Mermbers Security Configure
Falders B B [ F 0 Inspect & Update Moare...~
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3. Create WebCenter Projects as Text Libraries and Artwork Libraries and organize your assets in
them.

Do this for:

« Text Content Documents,
« Artworks,
« and more...

See more examples here.

To organize further, you can create advanced Text Searches.
4. Create copy sheets. They are Attribute Categories with Text Document References.

a) Create your text document reference attributes and add them to an Attribute Category. You
can use the advanced features available in the grid layout.

b) Add the mandatory Reference Category to these document references. This is used in matching
the Artwork's Dynamic Content elements to text references.

c) Create atable rendering with text related options. You can configure Master and Translated Text
widgets for your copy sheet. You can use all the advanced features available in the grid layout.

Depending on the User's permission (Editor, Approver or Content Manager), they can do content
actions in this page.

« Make the attributes editable (the visibility setting) to allow for text editing.

» Allow adding multiple documents by enabling allow multiple values.

d) Configure the document sources. Choose the operation(copy, link, move, or use by reference).
Read more in: Adding Document Sources for a Document Reference Attribute on page 316

document sources settings you configure here will be rendered in the text document table.

« Create acustom label.
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« Specify the source of the document. For example, a Saved search of text documents
for adding approved text. To create new text documents, the source will be Document
templates.

- Specify the type of operation: copy, move (move content to the local folder) or use by
reference (to use approved content from a library or saved search).

5. Create other attributes necessary for the document as per the requirement.

6. Create Import setup for Adobe lllustrator design files with Dynamic Content. This workflow will
map the content to the copy sheet attributes (text document references) created in the previous
step.

a) Create a Task Type for the import workflow.
b) Configure your workflow step to assign the Copy Sheet attribute category to
c) Create a step to extract the text content as Copy Sheet references of the artwork.

d) Configure the Import Dynamic Text step with document reference and document template
mapping. Specify the reuse policy for partial matches in this step.

e) Route the workflow depending on the text document status.
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In the example, when an artwork with Dynamic Content arrives at a Packaging Content Management
workflow, the following steps happen:

1. The workflow assigns a Document Attribute Category to the artwork (parent). This 'copy
sheet' category contains the document reference attributes to which the text content will be
imported.

Note: If this step is not in the workflow, the Import Dynamic Content will use the Project's
attribute as the default.

The category contains the Document Reference Attributes for:

+ technical text statements,
« legal statements and
« marketing statements

to serve as the copy sheet template.
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2. The Import Dynamic Content step maps the various Element Types to appropriate document
reference attributes as configured.

3. The Select Children nodes select the text documents (technical, legal and marketing) separately.
These documents can be processed as separate text documents while keeping the link between
them and the artwork alive.

Later in the production process, you can supply the approved textual content in the form of an XML
file. Read in: Export to GSTFormat. Using the Esko Dynamic Content plug-in, the designer can add
the approved content to the Illustrator document.

7. Create Approval Workflows to assign Tasks for different approval stages.

When you have assigned Content Permissions and assigned them to Roles, the assignees can
manually go into each text document and approve it. However with a workflow, you can assign Tasks
with Text Documents to those Roles automatically.

Note: You need to configure these Workflows according to your business needs.

Read more in the KB article:
8. Create other Workflows depending on your business needs.
9. Configure Project Templates to create projects to update or create new Artwork templates with
content.
a) Configure the Project Creation Form.
b) Invite Members (Roles and Groups) who will perform various tasks in the Project context.
These are important for activating the Content Permissions (from Document Templates). Read
more in: Managing Text Permissions on page 456
c) In Configure > Document Templates, link the text document templates to allow creating new text
documents.
d) Optionally create a custom setup for document sources in Configure > Document Creation.

e) Assign an Attribute Category. It should contain the following attributes and any other attribute
relevant to your Projects.

+ MASTER TEXT LANGUAGE

+ TRANSLATION TEXT LANGUAGE

Note: The MASTER TEXT LANGUAGE and TRANSLATION TEXT LANGUAGE attribtues
determine the languages of the Text Content documents located in that Project.

« Language Index attributes.

Note: If the Language Index values are not specified, the default values (from the Language
Lists) will be used as indices.

To determine the Master and Translation languages of a Project, you need to define these in the
Template > Attributes page.

f) Add the Workflow Tasks to the Template. The workflow tasks configured for import and approval
are configured to launch right after the project creation.
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27.8. How to Configure a Setup to Extract Images, Symbols
and Graphics

You need to create attributes which are used in mapping the Images, Symbols and Barcode to the
document templates. When images, symbols and Barcode are imported, these are used to map the
location. These are later used in exporting the content into GS1format as well.

Note: These are not visible to your users.

1.

Create the following Attributes.
For Symbols

+ SYMBOL_NAME: This is an attribute commonly used for storing the name of the symbol
presentin the artwork.

For Images

« EXTERNAL_IMAGE_PATH: This is an attribute commonly used for storing the path of the
image present in the artwork.

Note: If the incoming document is a chili document, ensure that the attribute
ARTWORK_VARIABLE is available.

For Barcodes

1. BARCODE_TYPE: Thisis an attribute for storing the type of Barcode present in the artwork.

2. BARCODE_BASECODE: This is an attribute for storing the base code of the Barcode present

in the artwork.
3. BARCODE_COMPOSITE_COMPONENT: This is an attribute to store the composite
component for GS1Barcodes.

Include the above attributes as required in the Attribute Category of the Document Template /
Document.

3. Ensure the following attributes are part of Reference Property of the document references.

« INSTANCE_SEQUENCE :This will be a reference attribute for the document.

« LOCATION_LIST: This reference attribute stores the specific location of the document.

You can view the imported images, symbols, and graphics in the Attribute category for the document.
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Migrating your Data

As an Administrator, you can migrate your WebCenter data to a different WebCenter server, for
example, to:

« testanewversionon atest server where you create new configurations. You can copy this to the
production server later.

. perform some tests on a test system with production data. You can export your production data (for
example a large number of groups with their visibility and download permissions) to the test system.

« rapidly deploy a solution developed by Solution Architects.

« copy data between different WebCenter installations.

« migrate the data to a third party system to archive them.

Note:
Before migrating a configuration, you need to migrate Users:

« Create Usersin the target system
« Optionally remove Users

Migrating Self-contained Data

28.1.1.
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From WebCenter 16 onwards, you do can do self-contained migration of Projects / Templates and this
saves the effort of migrating items individually. When you migrate a Template or Project with the setup,
the items are exported and imported in the correct order.

It is also possible to migrate individual items to a target system. Read in: Migrating other Data on page
484,

Exporting Templates or Projects

You can export Projects / Templates along with it's Attribute Category, Task Types, Documents,
Members (Groups, Roles, Users), Folders, Lists, Characteristics, Permissions and other settings. Itis a
self-contained export of all the items that are in a Project or Template.

You can choose whether you want to export the Projects with or without its Documents.

1. Go to Admin > Project Management > Templates / Projects.

2. Search for the required Templates or Projects. You can also select from the list.
o~
& Export to export an XML file without the Documents. For e.g.
ExportediWebCenterProjects.xml

& Export with Documents 14 aynort 3 ZIP file with its Documents. For e.qg.
WebCenterDownload.zip

Note: When lists are exported, it is exported in the zip file.
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3. Save the XML or ZIP file generated to your computer or a network location.

The below items are included in the Project / Template Export XML / ZIP:

Project Name, Due Date, Description, Project Status including icons, Project Manager (along with
Group)
Customer, Document template project

Note: The names are exported but the links are established only if they exist in the target system.

Project Members: Groups and Roles

Groups, Roles, along with their invitations and permissions: A merged list of all the Project Group
and Role members is exported. Read more inMigrating Groups / Roles on page 485

Attribute Categories along with Attributes and their values: Reference Categories, their attributes
and their values. Restricted sets and lists are also included. Document Reference attribute values
(both for Project and/or Document Attributes and/or Task Specifications)is exported along with
any additional Document Reference properties.

Note:

During the import, a search is made in the target Project for a Document with the same name as
the Document and Project on the system from where the Project was exported. If such a document
is found, the value of the Document Reference (including Document Reference properties) will be
restored. When a matching document is not found, a warning is displayed in the import feedback

page.

Irrespective of the version of the Document on the source,only the value in the latest version of the
the Document Reference attribute is updated on the target system.

A merged list of Project Attribute Category and default Document Types Categories is exported.
Read more in:Migrating Attribute Categories on page 487

Tasks (Sequence, Icons, Assignees, Allowed Assignees)and Task Types: See also: Migrating Task
Types on page 489

A merged list of Task Types along with icons of all Project Tasks and Tasks attached to Document
Types is exported.

Folders and Permissions settings on Folders (for Groups and Roles) and Role Assignments
Document Types settings:

« Autoname settings

« Task settings

« Attribute Category

Project Creation: Creation form settings and Project Autoname settings
Document Creation settings

Document Sources (Global Saved Searches)

Notifications

Document templates

Note: The library of templates should exist the target system.

Approval Setup:

+ Project

« Folder

+ Document

Thumbnails of Project, Folders and Documents

Note: The Thumbnails are exported only when you include documents in the export.

List of Documents and Folders
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« Documents if the option Export with Documents is selected.

+ Document Approval Status

Note: You can export Approval Statuses this for archiving purposes. But you cannot import it to
another WebCenter.

Warning: If you have turned on Add Approval Information to downloaded PDF turned on,
the approval details will be included in export and import.

« Documents added to Bill of Materials
Items not included in the export:

« Documents attached to Tasks

«  Workflow Connection

« Usersand Permissions

- If the company/location does not exist in the target location, then the company is not created.
« Submitted Document approval statuses

« Project, Task and Document Discussions

28.1.2. Importing Templates / Projects

When you import Templates or Projects:

« They will get created according to the contents of the import XML/ ZIP file.

« Documents will be added only if they do not exist in the target project. Upload will fail if a document
with the same name exists in the target project.

Go to Admin > Project Management > Templates or Projects.
Click Import from File on the Template Management page.
Click Choose File and then select the XML or ZIP file.

Click Import.

N s

When you import self-contained XMLs and ZIP files, you will get an overview of the items in the file.
You can choose to import them all or select the items individually:
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Tip:
The documents in the ZIP files will be imported by default.

If you don't want to import the documents, disable Import the Document(s) in the Project/
Template when importing Projects/ Templates.

Uncheck the items you do not wish to import and click Import.
The referenced objects will be imported first:

« Attribute Categories including the attributes and restricted sets will be imported. .
« Groups/ Roles with their settings..

« Task Types.

Caution: When you are importing a Workflow Task Type (during the export of a Project /
Template), objects referenced by the Task Types may not be linked properly. If you notice
an error, reimport the same Project and the links will be established correctly.

Select Enter Database Credentials to specify if the WebCenter Database has to create a table or
not. If yes, then the Database Username and Password has to be specified.

After importing these, the Project / Template with its setup will be imported. Check this list to see
what isincluded in the import.

The items that are not imported are listed below:

User members and permissions
Document Reference values
Company / Location

Document approval statuses
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« Project and Document discussions

28.1.3. Exporting Saved Searches
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You can export Saved Searches (Project, Task or Document)to in XML format.

Note:
Before migrating a configuration, you need to migrate Users:

« Create Usersin the target system
« Optionally remove Users

Note: When you intend to migrate Saved Searches, migrate the Projects / Templates first. This will
make sure that the search criteria(such as attributes or roles) exist in the target system.

1. Go to Admin > Search > Saved Searches. A list of Personal and Global Saved Searches is displayed.

2

-
Select any of the items from Global list and click = Export

3. Save the XML file generated (ExportedSavedSearches.xml)to your computer or a network
location

Note:

« Only Global Saved Searches can be exported.

Export of a Saved Search contains:

« Basic properties of each selected Saved Search

« Search Criteria

« Search Visibility Settings

« Referred Objects

« Groups, Roles, along with their invitations and permissions:

« Attribute Category used in Search along with their Attributes and values

Note: Document Reference values and the Document sources (Saved Searches) are not included in
the export.

« Restricted Set
« Task Specifications specified in Search

Note: The Specification Categories are not imported.

« Task Types along with its settings: See also: Migrating Task Types on page 489

Note: The Task Status will not get imported

Export of a Saved Search does not contain:

« Company and Location Visibility settings
« Project Status

« Characteristics

« Lists
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Note: Text Document Search export will not include the Element Type and Language Lists.

28.1.4. Importing Saved Searches

For Importing Saved Searches, use the steps below.

Note: You cannot import a Saved Search exported from a later version.

1. Admin > Search > Saved Searches > Import from File
2. Click Choose File and select the XML file.
3. Click OK.
You will see a warning about items that already exist and will be overwritten.
4. Uncheck the appropriate items and click Import.

If you encounter issues during the import process (for example, a missing Restricted Set on the target
server), you see a warning.

See more details about the import of externally referred search criteria below:
In a Project Search the following Search criteria are imported:

» Roles: When a match is not found, an error message is displayed and the import fails.

« Attribute (general) and Attribute Category: When a match is not found, an error message is
displayed and the import fails.

« Restricted Set value type: When a match is not found, an error message is displayed and the import
fails.

« Document Reference: When a match is not found, you get a warning and a feedback message is
displayed.
The Project Search criterion entities that do not get imported are:

« Project Status: When a match is not found, you get a warning and a feedback message is displayed.
« Characteristic: When a match is not found, you get a warning and a feedback message is displayed.

In a Document Search the Search criteria entities that get imported are:

» Search Layout- Show Project Creation Link: When a match is not found, you get a warning and a
feedback message is displayed.

In a Document Search, the Search criteria entities that do not get imported are:

« Element Type (Configurable Search field): When a match is not found, you get a warning.

+ Language (Text Document): When a match is not found, you get a warning.

« Document Type specific metadata: When a match is not found, the import fails with an error
message.

« Lists: When a match is not found, you get a warning.

In a Task Search, the Search criteria entities that get imported are:

« Task Type: When a match is not found, you get a warning. Import fails if the criteria is used on Task
Specification selection page.

« Task Specification: When a match is not found, an error message is displayed and the import fails.

« Search Layout- Show Project Creation Link: When a match is not found, you get a warning and a
feedback message is displayed.

In a Task Search, the Search criteria entities that do not get imported are:
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« Task Status: When a match is not found, you get a warning and a feedback message is displayed.
« Lists: When a match is not found, you get a warning and a feedback message is displayed.

Note: Limitations:

«  When you have Document Searches with Show Project Creation Link with Template from
Characteristics Path Layout, the search is imported but the option is not validated.

- Modified date related criteria does not consider the Time Zone difference into account.

- Referred Saved Searches(as a document source in a document reference) are not exported.

28.1.5. Importing and Exporting of Lists

In WebCenter 18.0.1, when a Project or a Template is exported, lists in the projects that are part of the
Attribute Categories or Task Types are also exported. A zip file containing List configuration and List
Documents are created along with the other project components.

WebCenter will now detect whether, if any of the exported objects is dependent on a List or not, and
exportitin the zip file when the project is exported.

The exported zip file has:

« ListManager folder: Contains all the documents needed to reconstruct the List. This folder can
have multiple sub-folders exactly as in the source project.

- XML file: Contains all the information of the Task Types / Attribute Categories / Project (without
documents)

Note: if more than one project is exported with documents, then a folder is created for each
project.

On importing of the project, one of the below options may occur.
« Check whether the list exists:

WebCenter will check whether the list already exists or not. This is done by using the name of the
imported list. If the List doesn't yet exist, we will create a new List otherwise we will update an
existing List.

Updating (overwriting) a List:

If the list preexists, WebCenter will check whether the table name used by the list matches the default
WebCenter List table name pattern ("WC_LIST...").

If it does, the list is deleted and a new List is created with the specified configuration.

Note: Import of the list may fail, if the lists are preexisting but unable to update to the current list
since the table names are not matching in the database.

- Creating new List: If the list is not available in the target project, then a new List is created with the
configuration found in the zip file.

28.2. Migrating other Data
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Tip: When you migrate a Template or Project with the setup, the items are exported and imported
in the correct order. We recommend that you do a Project or Template migration so that all items are
exported in the right order.

28.2.1. Migrating Groups / Roles

You can migrate your groups along with their visibility and download permissions to a target
WebCenter.

When importing Groups, the system will create Group(s) if it does not exist or update the Group when
the Group exists.

Export of Groups contains:
« Basic Information like:

« Group Name
- Visibility Type ( All Project Managers/Specific Project Managers/Admin)
+ Members
» Group Task Manager
« Group email including the address and language settings
» Notification settings
» Roles

+ GroupisaRole setting
» Roles, role invitations and assignments

Export of Groups does not contain:

« Role canadd another Role

Note: All these will get exported when you do a self-contained migration.

«  ToExport:
a) Go to Admin > Groups > Groups. The Groups page appears.
b) Search for the required group name(s) or select from the list available and then click Export
Groups in the Action Header.
c) Save the XML file generated (ExportediebCenterGroups . xml)to your computerora
network location.

See a sample below:

<group list>
<group id="00002_0000000001">
<deleted>0</deleted>
<name>EA SPORTS</name>
<empty group>0</empty group>
<notify group>1</notify group>
<group email address>email@test.com</group email address>
<group email language>fr</group email language>
<group vis_ type>2</group vis_ type>
<is role >0</is_role>
<user members>
<user>
<name>USER</name>
<group manager>0</group manager>
</user>
</user members>
<PM with visibility>
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<user>
<name>JT</name>
</user>
</PM_with_visibility>
<download_group_permission_list>
<download group_ permission_ view>
<group 1d="00002_0000000011">
<deleted>0</deleted>
<name>EA SPORTS</name>
<group vis_type>2</group vis_ type>
<is role>0</is_role>
</group>
<download format id="00002_0000000001">
<deleted>0</deleted>
<name>Native</name>
<short name>Native</short name>
<doc_type 1d>00001_0000000001</doc_type id>
<enabled>1</enabled>
</download_ format>
<download group permission id="">
<deleted>0</deleted>
<group 1d>00002_0000000011</group id>
<download 1d>00002_0000000001</download id>
<granted>0</granted>
</download group permission>

« Tolmport:

a) Go to Admin > Groups > Groups. The Groups page appears.

b) Click Import from XML on the Groups page.

c) Click Choose File and then select the XML file.

d) Click Import. After the import completes, you can see a basic Import Group Feedback.

Groups
Import Group feedback

Mumber of Groups Created 1
Number of Groups Modified
Mumber of Groups Mot Changed

o O O

Mumber of Groups Mot Imported

m Download Detailed Report in XML

e) Click the Download Detailed Report in XML link to download a detailed report of the import.
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Note:

« If there are no visibility settings in the XML, the imported Group(s) will be visible to All Project
Managers.

« Theimport will not create Users or Project Managers.

« The download permissions as specified in the Export XML will be granted to the Group(s).

28.2.2. Migrating Restricted Sets

The import of Restricted Sets will overwrite the existing ones with the same name. This is similar to all
other import functions.

Note: When you export Attribute Categories it will contain the Restricted Sets belonging to that
Category.
« ToExport:

a) GotoAdmin > Restricted Sets.

b) Select the Restricted Sets to export and go to Action Header > Export.

c) Save the XML file generated (exportRestrictedSets.xml)to your computer or a network

location.
The export will contain the following details of the exported Restricted Sets:

« Name
« Units
Note:

If the existing Restricted Sets (on the target system) have a different attribute unit, the
import will not succeed in updating them.

« Values

« Tolmport to the target system:

b)
c)
d)
e)

Go to Admin > Attributes > Restricted Sets.

Click Import on top right.

Click Choose File and then select the XML file from your export.

Click Import. After the import completes, you will see a basic Import Restricted Sets Feedback.
Click the Download Detailed Report in XML link to download a detailed report of the import.

28.2.3. Migrating Attribute Categories

The migration of Attribute Categories will create new Attributes and Attribute Categories if they are
not existing in the target system.

The Export / Import of Attribute Category contains:

« Basicinfo:
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+ Name
« Description
« Layout

« Views

« Attributes:

+ List of Attributes
« Name of the Attribute
« Attribute Type
« Visibility settings
« Attribute Input Option: Prompted / Calculated / Restricted
« Attribute Values
« All Document Reference Attributes with settings:

+ Bill Of Materials options
+ Versions/ Revisions settings
« Reference Category name and the Reference Category attributes

Tip: Export your Document Sources before the export of the Categories.

The Export / Import of Attribute Category does not contain:

. Document Reference Attribute Values (Documents)
o Lists

Tip: Export your Lists before the export of the Categories.

« To export Attribute Categories:

a) Goto Admin > Attributes > Attribute Categories.
b) Select the attribute categories to export and go to Action Header > Export .

ﬂ Warning: If your Attribute Categories were created in another version, it will ask you to
re-save the Category. The message will appear as:

The following Attribute Categories cannot be exported because
they are outdated. Open each Category and resave.

You also have to re-save the Categories when some Attributes are updated since the last
Save.

c) Savethe XML file generated (exportAttributeCategory.xml)to your computerora
network location.
See a sample XML below:

<category list>

<category id="00002 0000011548">

<deleted>0</deleted>

<name>Griet Category</name>

<description></description>

<category XML>XML blob describing the layout of the attribute category for the
different views</category XML>

<!—Mapping between the attribute category and the attribute -->
<attribute category list>

<attribute category id="00002 0000011549">

<deleted>0</deleted>

<attr i1d>00002_0000000302</attr id>

<category 1d>00002_0000011548</category id>
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<display order>1</display order>
</attribute category>

</attribute category list>

<!— List of attributes in the selected category -->
<attribute list>

<attribute id="00002_0000000302">
<deleted>0</deleted>

<name>GrietAttl</name>

<description></description>

<attribute unit id>00001 0000000001</attribute unit id>
<restricted set id></restricted set id>
<restricted set name></restricted set name>
<default expression></default expression>
<type>12</type>

<istask>0</istask>

<isdoc>1</isdoc>

<isproject>1</isproject>

</attribute>

</attribute list>
</category>

<!— List of the restricted sets used by the selected categories -->
<restricted set list>

<restricted set id="00002 0000000001">
<deleted>0</deleted>

<name>Countries Imported</name>

<attribute unit id>00001 0000000001</attribute unit id>
<allow manual>0</allow manual>
<restricted set value list>

<restricted set value i1d="00002 0000000004">
<deleted>0</deleted>

<restricted set i1d>00002_0000000001</restricted set id>
<value>Belgium</value>

</restricted set value>

</restricted set value list>
</restricted set>
</restricted set list>
</category list>

« Tolmport an Attribute Category:

a) Go to Admin > Attributes > Attribute Categories > Import.
b) Browse to the XML file that you saved during export and click Import.

| Caution:

«  When importing Attribute Categories, existing Categories with the same name are
overwritten. A warning message is displayed on the Import page.

« A warning message is displayed about the items that already exist.

c) Uncheck the items that you don't want to import and click Import.

28.2.4. Migrating Task Types

You can migrate your Task Types with its settings.
When Importing Task Types:

« the Task Types will be created with the settings mentioned in the XML file when they do not exist in
the target system. Dependencies to the task type including lists and categories are also imported.

If the document reference attributes of the imported categories/specifications have a reference
category, the reference category is also imported.
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If the imported Task Types do exist, they will be updated with the settings from import XML.

To export Task Types:
a) GototheTask Types > Types page. Select the Task Type(s) to export and click Export .
b) Save the XML file generated to your computer or a network location.

Export / Import of Task Types contain:

« Basic Settings

« Task Document's settings

« Discussions with Settings

+ Checklist items with Settings
+ Views

« Specifications:

« ListandOrder

» Names

« Type

« Grid Layout

« Visibility settings

« Input Option: Prompted / Calculated / Restricted

« Values

« Document Reference Specifications:

« Bill Of Materials options
« Versions/ Revisions settings
« Reference Category name and the Reference Category attributes

Tip: Export your Document Sources before the export of the Categories.

+  Workflow

. Task Status List with the icons( 18.0.1release onwards)
« Document Upload Settings

Export / Import of Task Types does not contain:

« Document Reference Values (Documents)

To Import:

a) Onthe Task Types > Types > Import from XML

b) Click Choose File and then select the XML file that you saved during the export.

c) Click Import.

d) You are redirected to Import Dependencies screen, where all the imported contents are shown.
You have the option to overwrite the existing contents or uncheck the contents which you do not
wish to import.
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Import Dependencies

Enter Database Credentials Return

Following items already exist on the system and will be overwritten!

To prevent this, uncheck the items before the Import.

Lists
¥ PCM_Size
# PCM_Seasonal
# PCM_Output
Categories

#| PCM Reference Properties ACat

Following items will be created in the system

Uncheck the items that you de not want to import.

Lists

#| PCM_Flavour
# PCM_Container
Task Types

#| -- PASH Copy ATTR Values -

e) Select Enter Database Credentials to specify if the WebCenter Database has to create a table or
not. If yes, then the Database User name and Password has to be specified. Click OK for one of
the option.

f) On completion of import, WebCenter shows the list of all contents updated and newly created
with warnings.

28.2.5. Migrating Workflows

You can export a Workflow from a Task Type to an XML file and migrate it to another Task Type either
on the same system or a target system.

To export:

a) Onyour Task Type's Workflow tab, click Export Workflow.

b) Save the XML file generated to your computer or a network location.
To import:

a) Onyour Task Type's Workflow tab, click Import Workflow.
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b) Browse to the XML file that you saved and click OK.
c) Anote of caution asks you if you are sure that you want to overwrite the current Workflow. Click
OK.

Note: You will get the following message:

Not all the items in the Workflow are available on this WebCenter
when the Task Types linked in the workflow are missing.
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29. Getting a list of existing projects

To get a list of existing projects based on given filter make a call to the following JSP page:
GetProjects.jsp
With parameters:

1. username
2. password
3. type

Parameter description:
« type: specifies category of projects to be listed. This field is mandatory. Supported values are:

1. my favorite projects
2. projectslamin

« name: limits returned projects to those having the specified string (name parameter)in its name.
It's possible to use special characters like in WCR GUI filters and search fields. For example
specifying “name=Toy*project” returns both “Toyota project” and “Toy Story project” if they exists in
WCR database. This is not applicable when type parameter is set to ‘6’ (type=6). In that case the full
name of required project (not case sensitive) has to be specified. This field is optional.

« projectid: ID of project to be returned. Ignored unless type parameter is set to ‘6.
This SDK call can be utilized by project managers (PMs) or administrators.

If type parameter is set to ‘6’ (project by ID or name), one of projectid and/or name parameters has to
be specified. projectid parameter has precedence. In this mode name parameter has to contain a full
name of the wanted project without any special “searching” characters.

Example:

To get list of all favorite projects of currently logged in user (PM or admin) that have "Active” status set
use the following call.

http://mywebcenter.mycompany.com/WebCenter_Inst/GetProjects.jsp?
username=myusername&password=YWJjZGVm&type=1&statusname=Active

To find projects managed by logged in user that contain particular string (“001")in their names use the
following URL. The example returns the first set (page) of 200 projects. If there are more you get the
rest by incrementing the curpage parameter value and calling the SDK again until it returns less than
200 records (projects) back. Note you can utilize sorting parameter to control what projects will be in
the first returned set (page).

http://mywebcenter.mycompany.com/WebCenter_Inst/GetProjects.jsp?
username=myusername&password=YWdJjZGVm&type=3&name=*001*&curpage=1&pagesize=200

Returns:

Successful execution returns a list of projects conforming to given criteria(s). If a problem occurs,
appropriate error message is returned.

<get project list>Getting a list of existing projects on page 493
<project list> <project id="00002_0000000135">
<deleted>0</deleted> <name>a05</name>
<description/>
<manager i1d>00001_0000000001</manager id>
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<manager_ type>user</manager type> <customer id/>
<location id/> <salesperson id/> <category id/>
<created date>1236947156000</created date>
<modified date>l434620655763</mod1fled date>

<is template>0</1s _template> <characteristic list/>
<attribute list/> <attribute value view list/> <!—
always empty # <folder list/>
<status_1d>00001_0000000001</status_id>

<due date>0</due date> <project doc list/>

<project creation form>

<project name show>SHOW</project name show>
<project manager show>SHOW</project manager show>
<customer show>SHOW</customer show>
<description_show>SHOW</description_ show>

<due date show>SHOW</due date show>

<upload doc show>SHOW</upload doc show>

<replace groups_show>SHOW</replace groups_show>
<invite memebers show>SHOW</invite memebers show>
<set attributes show>SHOW</set attributes show>
<set thumbnails show>SHOW</set thumbnails show>
<set planning show>SHOW</set planning show>

<set status_show>SHOW</set status_ show>

<default planning method>BACKWARD</default planning method>
<bom_show>SHOW</bom_show> </project creation form>
<autoname optlon>2</autoname _option> <manager
id="00001_0000000001"> <deleted>0</deleted>
<name>ADMIN</name> <location id/>

<last name>ADMIN</last name> <first name/>
<email>admin@ad.min</email> <phone number/>

<mobile number/> <function/>

<is prOJect _manager>0</is project manager>
<password last modified>- 36000OO</password last modified>
<password_forced_explred>0</password_forced_exp1red>
<deleted>0</deleted>

<has_guaranteed access>1</has_guaranteed access>
<max_ sessions>-1</max sessions>

<ldap user>0</ldap user>

<can_create task type>l</can create task type>

<can create user>0</can create user> <owner _id/>
<n_. consecutive failed loglns>2</n consecutive failed | logins>
<user _profile 1id="00001 0000000001"/> </manager>
<thumbna11_ur1>thumbnalls/prOJect gif</thumbnail url>
<project user permission> <permission>
<view>1</view> <add>1</add>

<update>1</update> <delete>1</delete>
<checkout>1</checkout> <download>1</download>
<change approval>1</change approval>

<change task>1</change task>

<change bom>l</change bom>

<can_manage_ this prOJect>1</can _manage_this project>
</permission> </project user permission>

<manager locaiton id="00001_0000000001">

<location view id=""> <location id="">
<deleted>0</deleted> <name/> <shortname/>
<addressl/> <address2/> <city/> <state/>

<zip/> <country/> <phone/> <fax/>

<company id/> </location> <company id="">
<deleted>0</deleted> <name/> <legal name/>

<type/> <menu/> </company> </location view>
</manager locaiton> </project> <project
id="00002_0000000290"> <deleted>0</deleted> .. other
project description </project> .. more projects
</project list>

<total filter projects>l</total filter projects>
<total projects>48</total projects>

</get project list>
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